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Accord de licence
Lisez attentivement les termes et conditions d’utilisation subor-
donnés à cet accord avant de déballer ce logiciel. Un usage 
partiel ou total de ce package impliquera une acceptation totale 
de tous les termes de cet accord.

Emagic vous accorde (au propriétaire), un usage non limitatif et 
non exclusif de tout le contenu de ce package, dans le respect 
des conditions énoncées.

Vous devez :

1. Utiliser ce logiciel sur un seul poste de travail.

2. Ne faire des copies de disquettes que dans le but d’une sau-
vegarde de données.

Vous ne devez pas :

1. Faire des copies de ce manuel ou du programme, même par-
tiellement, en dehors des conditions présentement définies.

2. Modifier le code du programme ou de l’une de ces copies, ni
chercher à désassembler le code.

3. Établir un droit de licence secondaire, louer, prêter, emprun-
ter ou accorder des droits sur ce logiciel autres que ceux déjà
accordés par nous-même.

4. Traduire verbalement ou par écrit ce manuel.

5. Diffuser par voie informatique, ou sur un quelconque réseau
de télécommunications, public ou privé, le code de ce pro-
gramme.

Conditions

Cet accord est effectif jusqu’à son terme. Vous pouvez le dénon-
cer à tout moment en détruisant le logiciel et toutes ses copies 
sous toutes leurs formes. Il s’annule également en cas de non 
respect des conditions de cet accord.
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Préface

Félicitations !

Avec SoundDiver, vous venez de choisir l'un des systèmes 
d'éditeur/bibliothécaire les plus puissants du moment. Sound-
Diver facilite et accélère le travail quotidien de nombreux 
producteurs, musiciens et techniciens des claviers de haut 
niveau. 

Nous sommes persuadés que vous allez apprécier le nombre 
incroyable d'appareils pris en charge, le haut niveau d'ergono-
mie, les bibliothèques universelles et la souplesse des éditeurs, 
qui ont conquis les utilisateurs de SoundDiver dans le monde 
entier.

Avec la version 3.0, vous allez découvrir une nouvelle interface 
utilisateur tout à fait étonnante, une utilisation encore simpli-
fiée et la souplesse incomparable qu'apportent les assignations 
de contrôleurs, qui rendront vos opérations dans SoundDiver 
encore plus rapides.

Si vous n'avez encore jamais utilisé SoundDiver, vous allez très 
vite pouvoir plonger dans les profondeurs jusque-là insoupçon-
nées de vos modules de sons.

Nous sommes certains que dès que vous vous serez familiarisé 
avec SoundDiver, vous ne pourrez plus revenir aux menus et 
aux paramètres obscurs des écrans LCD minuscules de la 
plupart des appareils MIDI.

La création de SoundDiver n'aurait pas été possible sans l'aide 
de nombreux développeurs externes, auteurs d'adaptations et 
béta testeurs. 

En outre, de nombreux utilisateurs “réguliers” de SoundDiver 
nous ont fait part de leurs remarques détaillées, qui nous ont 
poussés à ajouter de nouvelles fonctions et ont contribué à 
l'apparition de nombreuses améliorations présentes dans cette 
version 3.0. 

A tous, nous adressons...

Un grand merci !
5
Mode d’Emploi
Version 3.0



                                    
Nous vous souhaitons de grands moments aux commandes de 
SoundDiver!

Michael Haydn & l'équipe d'Emagic, septembre 2000

Nouveautés de la version 3.0

Pour les utilisateurs qui ont procédé à une mise à jour vers 
SoundDiver 3.0 à partir de la version 2.0 ou 2.1, voici les carac-
téristiques essentielles. Pour plus d'informations, veuillez vous 
référer aux mots clés correspondants dans l'index.

Généralités
• Nouveau graphisme semblable à celui de Logic Audio 4.x ; 

icônes photo-réalistes des périphériques 
• Certains termes ont été remplacés par d'autres, plus simples:

Memory Manager → Device window ; Surf! - → Audition; 
Dive! → Edit ; AutoSurf → AutoAudition

• Structure de menu semblable à celle de Logic Audio 4.x
• Quelques nouveautés dans la fenêtre Key Commands (Rac-

courcis clavier) 
• Bulles d›Aide
• Assignation de contrôleurs
• Nombreux nouveaux modules et adaptations

Gestion du MIDI
• Le traitement des signaux MIDI entrants a priorité sur les 

rafraîchissements d'écran
• Gestion MIDI In complète : les entrées MIDI peuvent être 

séparées (uniquement si nécessaire) 
• Test de boucle MIDI
6
Emagic
SoundDiver 



                                      
Fenêtre Setup (Configuration)
• L'icône des appareils s'affiche dans la colonne des paramè-

tres 
• Meilleur positionnement des icônes 
• Passage de la vue en mode icône à la vue en mode liste indé-

pendant de la taille de police

Préférences
• Nouvelle page “Display” (Affichage)
• Le nom du fichier des préférences par défaut a été changé, 

afin de faciliter la migration

Fenêtre d'installation
• L'icône du périphérique sélectionné s'affiche dans la colon-

ne de gauche
• La largeur de la colonne de gauche peut être modifiée

Fenêtre Device (Périphérique)
• Les banques de données d'un certain type peuvent être 

masquées dans la fenêtre Device 
• Le nom des entrées supprimées reste affiché

Fenêtre Editor (d'édition)
• A l'ouverture d'une seconde fenêtre d'édition, la fonction 

“Link window” (Lier les fenêtres) est désactivée dans tou-
tes les fenêtres d'édition

• Les modules peuvent ouvrir des fenêtres d'édition distinctes 
affichant des vues différentes. Exemple : VM-7100 EQs.

• La saisie de texte fonctionne désormais avec tous les types 
de paramètres. La valeur qui correspond le mieux à la ligne 
de commande saisie est choisie.

•   : menus déroulants multi-colonnes
•   : un clic rapide sur un menu déroulant le laisse ouvert, un 

second clic le referme
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Module Universel 
• Possibilité d'importer les icônes 
• Possibilité de supprimer AutoPlay 
• Commutateur “Has keyboard” (“Avec clavier”)
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Le défi…
Introduction

1.1 Le défi…
De nos jours, tout utilisateur de synthétiseurs a potentielle-
ment accès à des milliers de sons. Il faut y ajouter les effets, les 
baies de connexions MIDI et tous les périphériques qui vous 
laissent accéder à leurs données pour pouvoir les gérer et les 
archiver. 

Les synthétiseurs et autres appareils MIDI offrent des possibi-
lités limitées pour archiver ces données et les rendre disponi-
bles au moment voulu. En réalité, en termes de facilité 
d’emploi, leurs interfaces utilisateur ne soutiennent pas la 
comparaison avec un moniteur et une souris. Ils manquent en 
général de mémoire ou d’options de stockage, par exemple un 

Chapitre 1
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disque dur, ou même un lecteur de disquette. Et pour finir, ils 
disposent rarement de logiciels satisfaisants pour retrouver et 
trier vos sons au sein de votre bibliothèque toujours plus vaste 
de données de Patch. 

... et la solution
Toutes les difficultés ci-dessus peuvent être résolues grâce à 
votre ordinateur. Une machine équipée de MacOS ou de 
Windows 98 dispose de l’équipement et de la puissance de 
calcul nécessaires pour charger en mémoire des dizaines de 
banques et de bibliothèques de sons.

SoundDiver relie de façon intelligente votre ordinateur et vos 
appareils MIDI. SoundDiver est tout d’abord un programme 
destiné à gérer vos sons. Sans doute avez-vous déjà rencontré 
des programmes de type “utilitaires de transfert”, “gestionnai-
res de sons” ou “bibliothécaires”. Tous ces logiciels gèrent des 
données de synthétiseurs, de boîtes à rythmes, de processeurs 
d’effets, de baies de connexion MIDI, etc. Evidemment, 
SoundDiver peut lui aussi faire tout ça, mais il peut surtout 
faire beaucoup plus.

Universel, mais adapté tout spécialement à 
chaque périphérique
SoundDiver est un système modulaire conçu pour fonctionner 
avec n’importe quel appareil MIDI. Les modules destinés à de 
nombreux appareils sont déjà fournis avec le logiciel. Le code 
du programme correspondant à chaque appareil est stocké dans 
un fichier de module distinct. L’intérêt de cette approche, c’est 
que seuls les modules dont vous avez besoin à un moment 
donné viendront occuper la mémoire vive de votre ordinateur 
et celle de votre disque dur.

Outre les modules, SoundDiver vous permet également de créer 
et de sauvegarder les adaptations que vous aurez conçues pour 
vos propres appareils MIDI. Cela signifie que vous pouvez ajou-
ter des appareils à votre système SoundDiver sans attendre 
qu’Emagic ou d’autres développeurs les programment. C’est la 
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fonction du Module Universel. Ce module universel peut gérer 
plusieurs adaptations à la fois. Votre logiciel SoundDiver est livré 
avec un grand nombre d’adaptations prêtes à l’emploi. Si vous 
souhaitez créer vos propres adaptations, il existe une version du 
manuel de programmation sous forme de fichier texte.

Pour vous procurer une copie de ce fichier, veuillez contacter 
votre distributeur national, ou vous rendre à l’adresse http://
www.emagic.de pour le télécharger. 

Contrairement à de nombreux programmes universels, Sound-
Diver connaît dans le moindre détail chacun des appareils pour 
lequel il possède un module, ce qui lui permet de tirer pleine-
ment parti de ses caractéristiques spécifiques. Par exemple, le 
module de SY 99 de SoundDiver est capable de convertir des 
sons de DX 7 et le module Microwave sait gérer les tables 
d’ondes.

SoundDiver dispose d’un mode télécommandable, grâce 
auquel chaque paramètre peut être contrôlé par n’importe quel 
message MIDI - les cadres de faders se prêtent particulière-
ment bien à cet usage.

Le centre de contrôle
SoundDiver peut devenir le centre de contrôle de tout votre 
système MIDI. Il connaît chacun des appareils qui y sont 
connectés ainsi que le contenu de leur mémoire. A chaque fois 
que vous effectuez une modification, SoundDiver prend auto-
matiquement en compte l’ensemble des répercussions qui en 
découlent. Il vous devient ainsi pratiquement impossible de 
modifier ou de détruire accidentellement un de vos fichiers.

SoundDiver dispose d’une fenêtre “Device” (Appareil) dont le 
contenu représente en permanence l’image fidèle du contenu 
de la mémoire de l’appareil correspondant. Si une différence 
apparaît - par exemple lorsque vous copiez un son au sein de 
l’appareil lui-même - vous pouvez revenir aux données 
d’origine grâce à quelques commandes simples.

La Gestion de la dépendance des Entrées de SoundDiver assure 
également l’intégrité des connexions entre Patches modifiés et 
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patches d’origine. Admettons que vous ayez par exemple créé 
une voix pour un Yamaha EX5 et que vous la sauvegardiez vers 
un nouvel emplacement mémoire. Toutes les performances qui 
se réfèrent à cette programmation sont automatiquement mises 
à jour pour prendre en compte ce transfert - vous n’avez pas 
besoin de vous en occuper.

Et le meilleur, c’est qu’avec SoundDiver, vous pouvez gérer 
tous vos sons directement sur l’écran - sans jamais avoir à 
toucher l’appareil lui-même.

Gérez des milliers d’entrées grâce aux 
bibliothèques mixtes
Inutile également de parcourir une à une chaque bibliothèque 
de chaque synthétiseur pour trouver certains types de sons. 
SoundDiver vous permet de rassembler des sons appartenant à 
des synthétiseurs différents au sein d’une même bibliothèque. 

Ouvrez votre bibliothèque de “Sons de Basse” et en un clin 
d’œil vous avez sous la main tous les sons de basse de votre 
studio MIDI, quels que soient les appareils auxquels ils appar-
tiennent ! Tout ce qu’il vous reste à faire est de cliquer sur les 
entrées : SoundDiver envoie automatiquement les sons aux 
bons synthétiseurs et fait en sorte que votre clavier maître 
pilote le synthétiseur désiré.

Cette fonction vous décharge de cette corvée de gestion fasti-
dieuse et vous laisse l’esprit libre pour ce qui compte vraiment : 
vous concentrer sur la musique et disposer des bons sons au bon 
moment.

Reconnaissance automatique des appareils 
connectés
SoundDiver peut identifier votre configuration MIDI tout seul. 
Depuis la fenêtre Install, vous pouvez demander à SoundDiver 
d’examiner automatiquement votre système MIDI et d’instal-
ler les appareils identifiés. Le contenu de leur mémoire peut 
être transféré automatiquement à l’ordinateur.
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Éditeurs pratiques dans SoundDiver
Il existe des Éditeurs pour presque tous les appareils reconnus 
par SoundDiver. Cette abondance d’Éditeurs n’empêche pas 
chacun d’entre eux de disposer du même nombre et du même 
type de fonctions que ce que vous pensiez ne pouvoir trouver 
que dans des logiciels dédiés à un seul appareil à la fois. Des 
caractéristiques comme :

• l’affichage et l’édition graphique de tous les paramètres, y 
compris les enveloppes, la structure du son et les effets ;

• une Easy Page, dans laquelle vous pouvez effectuer des 
modifications globales très rapidement grâce à une poignée 
de paramètres ;

• des fonctions de copier/coller/couper de groupes de paramè-
tres entre voix et éléments ;

• des fonctions aléatoires.

Bien que chaque Éditeur soit adapté individuellement à un 
appareil en particulier, tous les Éditeurs adoptent le même plan 
général et les mêmes conventions. Il suffit ainsi d’apprendre le 
maniement d’un seul Éditeur pour être capable de maîtriser 
n’importe quel autre. 

Un logiciel ergonomique
Malgré ce grand nombre d’options différentes, SoundDiver est 
un logiciel simple d’emploi.

Les fonctions sont regroupées de façon logique et pratique au 
sein de menus locaux contenus dans les fenêtres elles-mêmes 
ou insérés dans la barre de menus.

Nous avons tenté de standardiser les menus et les raccourcis 
clavier chaque fois que cela était possible. Par exemple, les 
menus standards et les raccourcis clavier sont exactement les 
mêmes que ceux figurant dans les autres logiciels d’Emagic. 
Ces raccourcis clavier sont évidemment personnalisables afin 
de s’adapter à vos besoins spécifiques.
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La technologie des fenêtres de SoundDiver permet d’ouvrir 
plusieurs fenêtres d’une banque de sons ou d’une bibliothèque 
et de configurer l’affichage de vos sons à votre convenance. 
Vous pouvez sauvegarder 90 de ces configurations appelées 
Screensets et les rappeler instantanément à l’aide d’un 
raccourci clavier.

Voici à nouveau un rapide survol des caractéristiques principa-
les :

• SoundDiver est universel : il est conçu pour fonctionner avec 
n’importe quel appareil MIDI. Il est livré avec des modules 
ou des adaptations puissants adaptés à la plupart des appa-
reils. Vous pouvez créer vos propres adaptations pour tous les 
autres appareils.

• SoundDiver est ergonomique - nul besoin d’être un spécia-
liste des données de Système Exclusif pour vous servir du 
programme principal. Vous n’avez pas davantage besoin de 
savoir ce qu’est une dump request ou une ID de construc-
teur. Vous pouvez donc vous concentrer pleinement sur vos 
sons. Néanmoins, si vous êtes un pro du MIDI, SoundDiver 
vous offre toutes sortes d’options pour éditer les adaptations 
pré-livrées et les modeler à votre goût, ou pour créer vos 
propres patches ex nihilo.

• SoundDiver vous donne immédiatement accès aux bons 
sons. Quel que soit le nombre de bibliothèques que vous 
créerez et le nombre d’entrées qu’elles contiendront, vous 
serez toujours à même d’y faire des recherches et de les trier. 
Dans SoundDiver, vous pouvez également rassembler dans 
une même bibliothèque des données provenant d’appareils 
différents. 

• SoundDiver garde une vue d’ensemble de toute votre confi-
guration. Il conserve en mémoire la structure des données de 
tous vos appareils et ajuste automatiquement toutes les 
données liées les unes aux autres pour prendre en compte et 
répercuter toutes vos modifications.
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• En plus de tous ces atouts, SoundDiver offre à vos appareils 
des Éditeurs pratiques. Bien que chaque Éditeur soit spécia-
lement conçu pour un appareil en particulier, leur manie-
ment reste le même pour tous.

La chapitre Installation à partir de la page 41 et suivantes vous 
expliquera comment installer SoundDiver et organiser votre 
configuration MIDI. A la page 89 vous pourrez mettre en prati-
que ce que vous venez d’apprendre en nous suivant dans un 
tour d’horizon des différents niveaux de SoundDiver. 

Amusez-vous bien !

1.2 Les versions de SoundDiver
SoundDiver est un logiciel extrêmement puissant qui vous 
permet de gérer vos sons et autres données SysEx de façon 
homogène en vous donnant directement accès à vos données à 
tout moment.

Il existe en plusieurs parfums :

Versions Macintosh contre versions Windows 
SoundDiver existe en versions à peu près identiques pour 
Windows 98/2000 et Mac OS. Les variantes entre les différen-
tes versions du logiciel ne concernent que :

• le détail des procédures de gestion des fichiers et des fenê-
tres utilisées par les différents systèmes d’exploitation ;

• la prise en charge des couleurs et des polices ;

• le contenu de la fenêtre de préférences 

• la fenêtre de recherche (§ La fonction Find (Recherche) à partir 
de la page 266 et suivantes)

• les différents accessoires matériels - en particulier les ports 
MIDI disponibles et les interfaces MIDI ;

• la prise en charge des extensions système MIDI telles que 
MIDI Manager ou OMS.
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Versions OEM de SoundDiver 
Certains appareils sont livrés avec des versions spéciales de 
SoundDiver, par ex. “SoundDiver EOS” ou “SoundDiver 
K5000”. Les différences par rapport avec la version du 
commerce sont les suivantes :

• SoundDiver OEM n’est pas modulaire mais ne dispose que 
d’un Module unique intégré au code du programme. On ne 
peut pas changer de Module.

• SoundDiver OEM n’est pas protégé contre la copie. Pour 
l’installer, il suffit de lancer le logiciel.

• Au lancement du logiciel, la fonction Scan (ou recherche des 
appareils connectés) se déclenche automatiquement. Si 
l’appareil n’est pas trouvé, vous pouvez l’installer manuelle-
ment.

• Cette version ne peut gérer qu’un seul appareil.

• SoundDiver OEM ne peut ouvrir qu’une seule bibliothèque 
à la fois. L’ouverture d’une seconde bibliothèque provoque 
la fermeture préalable de celle ouverte précédemment.

• Aucun Module Universel n’est disponible, il n’est donc pas 
possible de créer des adaptations.

Si vous avez reçu ce manuel avec SoundDiver OEM, veuillez 
prendre en compte les limitations indiquées ci-dessus. Si vous 
êtes intéressé par la version commerciale de SoundDiver, 
veuillez noter que :

• tous les fichiers créés avec SoundDiver OEM (Bibliothè-
ques, préférences) sont totalement compatibles avec Sound-
Diver.

• SoundDiver contient tous les Modules des versions OEM.

En tant qu’utilisateur de SoundDiver OEM, vous bénéficierez 
de conditions spéciales pour acquérir la version commerciale de 
SoundDiver en contactant le distributeur Emagic de votre 
pays. 
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1.3 A propos du présent manuel
Le présent manuel de SoundDiver couvre à la fois les versions 
Macintosh et Windows versions de SoundDiver. Les différen-
ces entre les deux systèmes d’exploitation y sont expliquées et 
les paragraphes concernés sont repérés grâce à une icône (voir 
ci-contre à droite).

Les paragraphes qui ne s’appliquent qu’à la version Macintosh 
sont marqués d’une “  :”.

Veuillez contacter le distributeur Emagic de votre pays pour 
connaître la disponibilité de la documentation de SoundDiver 
en d’autres langues.

& Les manuels Emagic sont toujours aussi à jour que possible. Cependant, il arrive que 
des améliorations ou des ajouts soient apportés aux logiciels après l’impression du 
mode d’emploi. Ces modifications sont couvertes par un fichier Readme (Lisez-moi) 
figurant sur le disque du programme. Nous vous conseillons d’imprimer ce fichier et 
de le conserver avec votre manuel de SoundDiver. Vous aurez ainsi l’ensemble des 
informations sous la main lorsque vous utiliserez le logiciel.

Le présent manuel concerne la version 3.0 de SoundDiver. Si 
votre version du logiciel est plus récente, vous trouverez la liste 
de toutes les modifications dans le fichier Readme (Lisez-moi) 
mentionné plus haut.

Concepts
SoundDiver (le programme) existe en plusieurs langues.

Si un concept vous paraît obscur, vous trouverez des éclaircisse-
ments dans le glossaire contenu dans l’annexe au manuel. Tous 
les concepts de SoundDiver (par ex. entrée, module) y sont 
expliqués.

Fonctions des menus 
Les fonctions de menus apparaissent dans la typographie 
suivante : Fonction.

Si une fonction peut être atteinte via un menu hiérarchique, les 
différents niveaux sont séparés de la manière suivante : Menu > 
Article de menu > Fonction.
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X

Raccourcis clavier
La plupart des raccourcis clavier de SoundDiver peuvent être 
configurés par l’utilisateur. En conséquence, on ne trouvera 
dans le présent manuel que les assignations fixes et les touches 
mortes en texte clair.

Lorsqu’il s’agira de raccourcis clavier configurables par l’utilisa-
teur, seul le symbole ci-contre apparaîtra. Le raccourci clavier 
actuellement assigné est affiché par SoundDiver à droite de 
l’article de menu ou dans la fenêtre Key Commands (raccourcis 
clavier).

Certains raccourcis clavier et certaines touches mortes diffèrent 
entre les versions Macintosh et Windows. On les trouvera abré-
gés comme dans l’exemple suivant : ç ( : S). Ce qui signifie : 
sur Windows, maintenir la touche ç enfoncée, et sur Macin-
tosh la touche S.

Explications
& Les trucs et astuces supplémentaires qui ne sont pas indispensables au maniement 

de SoundDiver sont affichés comme ceci.
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Installation

2.1 Contenu du coffret
Le coffret de votre SoundDiver contient les éléments suivants :

• le CD de SoundDiver
• le présent manuel
• un formulaire d’enregistrement.

Veuillez remplir le formulaire d’enregistrement dès que possi-
ble et renvoyez-le au distributeur de votre pays.

Ce n’est qu’à la suite de votre enregistrement que vous aurez 
accès...

• aux mises à jour régulières et au support technique sur Inter-
net : http://www.emagic.de

• au support technique via notre Hotline :
aux Etats-Unis par téléphone au 1-530-477 1050, par fax au 
1-530-477 1052
en Allemagne par téléphone au +49- 41 01-4 95-1 10
dans les autres pays : veuillez vous adresser au distributeur 
Emagic de votre pays.

& Les utilisateurs de SoundDiver OEM (c-à-d. les versions spéciales livrées gratuitement 
avec certains équipements MIDI) n’ont pas accès à la hotline téléphonique. Ils sont 
priés d’utiliser les services Internet mentionnés plus haut.

2.2 Système requis

Système requis pour ordinateurs Windows
• Ordinateur Pentium 

• Windows 95, 98, NT 4.0, 2000. Windows 98 Seconde Edition 
conseillé.

Chapitre 2
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• Interface MIDI avec pilote 32 bits compatible Windows. 
Pour plus de détails se reporter à la § Brancher une interface 
MIDI à la page 42;

• Grand écran haute résolution conseillé

• Autolink avec Logic Audio Version 4.0 ou supérieure. 

• Prise en charge de : Microsoft IntelliMouse(tm), souris à 3 
boutons et plusieurs moniteurs sous Windows 98 et 
Windows 2000.

Système requis pour ordinateurs 
Macintosh
• Power Macintosh (les Mac 68 k ne sont plus pris en charge à 

partir de la version 3.0).

• Système 7.1 ou supérieur. Mac OS 9.0 ou supérieur conseillé.

• Interface MIDI. SoundDiver prend en charge les interfaces 
suivantes :

- toutes les interfaces Emagic (Unitor8, Unitor8 MkII, 
AMT8, MT4) par connexion soit série soit USB 

- toutes les interfaces compatibles MTP (par ex. MIDI Ex-
press, MIDI Time Piece I/II/AV, Studio 4/5).

- toutes les interfaces avec pilote OMS 
- toutes les interfaces avec pilote MIDI Manager 

• Grand écran haute résolution conseillé.

2.3 Brancher une interface MIDI

Windows
Pour utiliser SoundDiver avec Windows 95/98 ou Windows NT 
4.0/2000, il va vous falloir une interface MIDI. L’interface 
MIDI est un accessoire en option, elle n’est pas livrée avec le 
PC. Il en existe de toutes sortes, sous la forme de cartes ISA ou 
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de périphériques externes qui se branchent au port impri-
mante, série ou USB.

Vous pouvez utiliser sans problème toute interface MIDI qui 
dispose d’un pilote Windows compatible 32 bits. Veuillez noter 
que les pilotes pour Windows 3.1x peuvent éventuellement 
fonctionner avec Windows 95/98, mais pas avec Windows 
NT4.0/2000. Pour ce système d’exploitation, il vous faudra des 
pilotes dédiés.

Les différences entre interfaces MIDI concernent essentielle-
ment le nombre de connexions et de fonctionnalités supplé-
mentaires, comme par exemple la synchronisation SMPTE. 
Pour de petites configurations, nous vous conseillons l’Emagic 
MT4, pour des configurations plus conséquentes l’AMT 8 et 
l’Unitor 8 MkII. Ces interfaces sont entièrement compatibles 
avec Logic Audio et SoundDiver. 

& Si vous utilisez une Opcode 8Port/SE, choisissez la version de pilote 1.62 et activez 
“Backwards compatibility” dans le panneau des propriétés du pilote. Les versions de 
pilote 1.50 et 1.60 ne fonctionnent pas.

& Si vous utilisez une interface MotU (par ex. la MIDI Express XT), choisissez la version 
de pilote 1.01. La version de pilote 1.04 ne fonctionne pas de façon fiable avec les 
données de SysEx.

& De nombreuses cartes son disposent d’une interface MIDI intégrée. La plupart 
d’entre elles se heurtent à une restriction de taille : elles n’autorisent pas la transmis-
sion et la réception simultanée des données MIDI (ce que l’on nomme mode full 
duplex - à ne pas confondre avec le mode full duplex pour l’entrée et la sortie audio). 
Cette fonction est capitale pour une utilisation fiable de SoundDiver. Il est tout aussi 
important que le pilote MIDI transmette fidèlement les données de Système exclusif. 
Cela n’est malheureusement pas le cas pour de nombreuses cartes son. Si vous 
rencontrez des difficultés, vous devrez sans doute envisager l’acquisition d’une inter-
face MIDI dédiée.

Macintosh
Pour utiliser SoundDiver, il va vous falloir une interface MIDI 
branchée au port modem, imprimante, et/ou USB. L’interface 
MIDI est un accessoire en option, elle n’est pas livrée avec le 
Macintosh. Si vous ne possédez pas d’interface MIDI, deman-
dez conseil à votre revendeur habituel d’instruments de musi-
que sur le choix d’un modèle approprié.
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Vous pouvez utiliser n’importe quelle interface MIDI. Les 
fonctionnalités spécifiques de l’Unitor8 d’Emagic sont directe-
ment prises en charge par SoundDiver. C’est également le cas 
des interfaces d’Emagic Unitor8 MKII, AMT8, MT4. La 
MIDI Time Piece (de Mark of the Unicorn) MIDI Express, 
MTP II et MTP AV, ainsi que les Studio 4 et Studio 5 
d’Opcode, elles aussi, prises en charge.

Les différences essentielles entre les diverses interfaces MIDI 
reposent sur le nombre de ports dont elles disposent et la 
présence ou non d’un synchroniseur (SMPTE). Pour de petites 
configurations, nous vous conseillons l’Emagic MT4 et, pour 
des configurations plus importantes, l’AMT 8 et l’Unitor 8 
MkII. Ces interfaces sont entièrement compatibles avec Logic 
Audio et SoundDiver. 

2.4 Connecter votre système
SoundDiver fonctionnera mieux si vous connectez votre instal-
lation MIDI en vous conformant aux conseils suivants :

1. Chaque appareil MIDI avec lequel SoundDiver devra tra-
vailler doit être connecté à l’ordinateur dans les deux sens. 
Si vous utilisez une ou plusieurs baies de raccordement, 
veuillez vous reporter au § Baies de raccordement MIDI (Pat-
chbays) à la page 46.

2. Connectez la sortie MIDI (Out) de l’appareil à l’entrée 
MIDI (In) de l’interface MIDI et vice-versa.

& En théorie, on peut connecter plusieurs appareils à une interface MIDI simple, en les 
chaînant via leur port MIDI Thru. L’inconvénient est que dans ce cas, les sorties MIDI 
des appareils n’étant pas connectées à l’ordinateur, SoundDiver ne peut communi-
quer avec ceux-ci que dans une seule direction. Vous perdez par conséquent le béné-
fice d’un certain nombre d’options de SoundDiver (la reconnaissance automatique 
ou l’auto request, par exemple).

& Nous conseillons vivement de choisir un système d’interface MIDI qui autorise le 
branchement direct de tous les appareils MIDI à l’ordinateur dans les deux directions. 
Prévoyez d’utiliser une entrée et une sortie MIDI par unité et évitez le chaînage en 
MIDI thru. Le système évolutif Unitor8 MkII/AMT8 est parfait à cet égard.
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X

• Vous trouverez des informations plus détaillées sur la 
manière de configurer vos appareils dans l’aide en ligne pour 
l’appareil concerné. Pour faire apparaître l’aide en ligne, 
cliquez sur l’appareil dans la fenêtre Setup et sélectionnez 
Windows > Help. Vous y trouverez en général des instruc-
tions sur “l’Installation”.

Quelques règles concernant la configura-
tion MIDI 
Si votre configuration MIDI est correcte, SoundDiver peut 
vous épargner de devoir reprogrammer vos baies de raccorde-
ment ou de brancher et débrancher vos câbles, en établissant 
automatiquement toutes les connexions. Pour éviter toute 
fausse manœuvre et garantir l’intégrité de vos données, nous 
vous conseillons de suivre ces quelques règles simples :

• un appareil ne doit pas être connecté à deux baies de raccor-
dement différentes à la fois, bien qu’il soit possible de 
connecter la sortie MIDI (Out) d’un appareil à une baie de 
raccordement et l’entrée MIDI (In) à l’ordinateur, et vice-
versa.

• l’entrée d’un appareil ne doit pas être connectée directe-
ment à l’ordinateur lorsque sa sortie est connectée à l’entrée 
d’une baie de raccordement, la fonction Scan de SoundDiver 
n’étant pas en mesure de reconnaître cette combinaison.

• bien qu’il soit possible d’utiliser deux appareils identiques 
(par ex. deux Yamaha EX5R) avec le même Device ID, il 
faut les connecter à des ports MIDI de l’ordinateur diffé-
rents (cela s’applique également aux appareils dépourvus de 
Device ID, par ex. le Matrix-6/6R/1000 d’Oberheim et tous 
les appareils d’Alesis). Toutefois, il sera toujours préférable 
d’utiliser des Device ID différents.
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La gamme Unitor d’Emagic et les autres 
baies de raccordement
Tous les matériels MIDI d’Emagic (Unitor8, Unitor MkII, 
AMT8, MT4) offrent des fonctions qui vont au-delà de la 
simple baie de raccordement : ils disposent des fonctionnalités 
d’une interface MIDI multiport. En général, les baies de 
raccordement possèdent des fonctions d’édition en façade. La 
possibilité d’éditer depuis SoundDiver ou via Unitor8 Control 
élimine le besoin de ces fonctions d’édition en façade.

Les modules pour baies de raccordement dans SoundDiver 
peuvent commander les assignations au sein de la baie pour 
connecter un appareil à votre ordinateur dans les deux direc-
tions.

Baies de raccordement MIDI (Patchbays)
Si vous disposez d’une baie de raccordement MIDI, SoundDi-
ver la prendra totalement en charge. Mieux encore, elle pourra 
également être entièrement contrôlée depuis SoundDiver. 
Toutes les baies de raccordement courantes sont directement 
prises en charge. SoundDiver peut ainsi reprogrammer par 
SysEx les trajectoires des données au sein de la baie. Pour les 
baies de raccordement non adressables par SysEx, SoundDiver 
emploiera des commandes de Changement de Programme. 
Dans ce cas, il vous faudra configurer à la main les patches 
concernés.

La souplesse de cette formule de gestion des baies de raccorde-
ment offre les options suivantes :

• il est possible de connecter plusieurs baies de raccordement 
à la fois

• chaque baie de raccordement peut être connectée à une sor-
tie de l’ordinateur différente 

• on peut connecter aux sorties de l’ordinateur autant d’en-
trées de baie de raccordement que l’on veut, de même que 
l’on peut connecter aux entrées de l’ordinateur autant de 
sorties de baie de raccordement que l’on veut. Ceci est im-
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portant si vous souhaitez utiliser votre séquenceur avec plus 
de 16 canaux MIDI, ou si la bande passante d’un câble MIDI 
est insuffisante.

& SoundDiver détecte automatiquement le câblage. Néanmoins, il utilisera toujours la 
première entrée et la première sortie détectées lors de l’accès à un appareil pour un 
transfert de données de SysEx. Par conséquent, si vous avez modifié le câblage après 
la configuration initiale, lancez une nouvelle fois la fonction Scan, ou saisissez les 
modifications dans la section des Paramètres Spéciaux de SoundDiver.

• vous pouvez effectuer les branchements à la baie de raccor-
dement dans n’importe quel ordre - l’ordre exact n’a pas 
d’importance.

Grâce à des modules dédiés, SoundDiver prend en charge les 
modèles de baies de raccordement MIDI suivants :

• J.L.Cooper Synapse, MSB 16/20, MSB Plus et MSB Plus 
Rev2

• Digital Music MX-8
• Ensoniq KMX-8 and KMX-16
• MIDITEMP PMM-44/PMM-88
• Roland A-880
• Waldorf Midibay

J.L.Cooper Synapse
Define the MIDI In which is connected to the computer as “Remote In”. To do this hold down the [MODE] key, press key [18] and set the parameter with keys [12] and [13].

❏ Définissez la sortie MIDI (Out) de la Synapse qui va à
l’ordinateur comme “Remote Out”. La procédure est iden-
tique à celle décrite ci-dessus mais avec les touches [14] et
[15] cette fois. Si vous connectez par la suite une autre sor-
tie MIDI (Out) à l’ordinateur, il vous faudra lancer une
autre opération de scan (ou balayage) de la baie de raccor-
dement.

❏ Réglez le canal de télécommande (Remote Channel) sur
16. En mode PC, réglez Remote Channel à l’aide des bou-
tons [16] et [17].

❏ Ne sauvegardez aucune donnée sur l’emplacement
mémoire 64 de la baie de raccordement ; elle serait écrasée
par SoundDiver lors de l’opération de scan, ainsi qu’à
l’extinction de la baie de raccordement.
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J.L.Cooper MSB-16/20
❏ N’oubliez pas que toutes les commandes transmises à la

MSB 16/20 doivent parvenir au port d’entrée (INPUT
PORT) assigné au port de sortie (OUTPUT PORT) n°20
et que les données émises le seront depuis le ou les ports
de sortie (OUTPUT PORT) assignés au port d’entrée
(INPUT PORT) n°16.

❏ Veuillez vérifier dans le manuel de la MSB quelle est
l’entrée qui accepte les données de SysEx.

❏ Vous trouverez des informations complémentaires dans le
fichier d’aide.

J.L.Cooper MSB Plus et MSB Plus Rev2
❏ L’octet 16 commande l’assignation du port de sortie SysEx

(Output Port) (0 = port 1, 1 = port 2, etc.)

❏ Les infos de SysEx sont transmises à ce port de sortie.

❏ Vous trouverez des informations complémentaires dans le
fichier d’aide.

Digital Music MX-8
❏ Routez l’entrée MIDI (In) connectée à l’ordinateur vers le

processeur A. Sélectionnez l’écran In/Out à l’aide de la tou-
che “Function”, positionnez le curseur sur le chiffre situé à
gauche de “→A” et saisissez l’entrée appropriée à l’aide
des touches de données.

❏ Si vous rencontrez des difficultés, assurez-vous que la ver-
sion du firmware de la MX-8 est au moins la 1.51. Le
numéro de version s’affiche à l’allumage.

Ensoniq KMX-8 et KMX-16
Tenez compte des instructions suivantes en installant l’une ou 
l’autre de ces baies de raccordement :

❏ Connectez l’ordinateur à l’entrée MIDI (Input) 1 (et éven-
tuellement 2) de la baie de raccordement, pas aux entrées
3 à 8 ni 16.
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❏ Avec la KMX-16, assurez-vous également que l’entrée
(Input) et la sortie (Output) MIDI de l’ordinateur sont con-
nectées au même port de la baie de raccordement. De la
sorte, si la sortie MIDI (Out) de l’ordinateur va vers l’entrée
MIDI (In) 1 de la KMX-16, l’entrée MIDI (In) de l’ordina-
teur doit aller à la sortie MIDI (Out) 1 de la KMX-16.

❏ Réglez le canal MIDI de la KMX-16 et le Device ID sur les
mêmes valeurs dans SoundDiver.

MIDITEMP PMM-44/PMM-88
Configurez la sortie de l’ordinateur comme étant l’entrée 
maîtresse de la baie de raccordement :
❏ double-cliquez sur mode
❏ edit
❏ touche 6
❏ à présent appuyez sur le numéro correspondant à l’entrée.

Vous pouvez voir s’afficher les canaux MIDI des comman-
des de Changements de Programme (U signifie
“inchangé”, c-à-d. tous les canaux). Assurez-vous que cela
ne provoque pas de conflit avec les canaux MIDI des autres
appareils.

Ne sauvegardez aucune donnée sur l’emplacement mémoire 
128 de la baie de raccordement ; elle serait écrasée par Sound-
Diver lors de l’opération de scan (ou balayage), ainsi qu’à 
l’extinction de la baie de raccordement.
Pour des raisons de vitesse, seules les valeurs 11 à 20 sont 
reconnues comme étant des Device ID possibles, bien que 
l’appareil reconnaisse les valeurs de 0 à 127.
La PMM-44/PMM-88 ne pourra traiter les données de SysEx 
que si celles-ci parviennent à l’entrée maîtresse. Si l’appareil ne 
répond pas, vérifiez que tel est bien le cas.
La PMM-44/PMM-88 ne pourra traiter les données de SysEx et 
de Changements de Programme que si celles-ci arrivent à cette 
entrée.
Afin de permettre à l’appareil de réagir aux SysEx, définissez 
l’entrée maîtresse :
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❏ Double-cliquez sur MODE, 1x EDIT et enfin le bouton 6
“U”. Appuyez à présent sur le bouton correspondant au
numéro de l’entrée connectée à l’ordinateur.

Assurez-vous que la version de logiciel de votre PMM est au 
moins la 2-4. Le numéro de version s’affiche à l’allumage. Si 
votre version est plus ancienne, veuillez contacter MIDI-
TEMP.

Roland A-880
❏ Assurez-vous que la version de firmware de votre A-880 est

au moins la 1.03. Si vous rencontrez des problèmes,
veuillez contacter Roland. 
Vous pouvez déterminer la version de la A-880 en allumant
la baie de raccordement tout en appuyant sur les boutons
Output 1 + 2 + 4 + 8 (tous à la fois). Les LED vous indi-
quent le numéro de version : LED 1 = 0.01, 2 = 0.02, 3 =
0.04, 4 = 0.08, 5 = 0.16, 6 = 0.32, 7 = 0.64, 8 = 1.28. Addition-
nez les LED pour obtenir le numéro de version.

❏ Configurez l’entrée MIDI (In) connectée à l’ordinateur
comme “Control In” : maintenez la touche correspondant à
l’entrée tout en mettant la A-880 sous tension.
Les messages de SysEx et de Changement de Programme
ne sont traités qu’à partir de cette entrée.

❏ Le Device ID est identique au canal de Changement de
Programme. Il peut être réglé sur l’appareil en enfonçant à
la fois les boutons “MEMORY” et “WRITE” tout en
appuyant sur le bouton du numéro correspondant.

❏ Définissez la sortie MIDI (Out) de la A-880 connectée à
l’ordinateur comme la sortie mix.

Waldorf Midibay
❏ Connectez l’ordinateur à Source 1 et Destination 1.

❏ Ne réglez pas le numéro d’unité sur “off” ou “omni” :
appuyez cinq fois sur [Mode]. L’écran affiche “un” suivi du
numéro d’unité. Utilisez les flèches Haut et Bas pour défi-
nir une valeur entre 1 et 16.
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Ne sauvegardez aucune donnée sur l’emplacement mémoire 
99 de la baie de raccordement ; elle serait écrasée par SoundDi-
ver lors de l’opération de scan (ou balayage), ainsi qu’à l’extinc-
tion de la baie de raccordement.

Autres baies de raccordement 
La prochaine section vous montrera comment lancer SoundDi-
ver pour la première fois. Il sera donc tout indiqué de configurer 
votre baie de raccordement de telle façon que SoundDiver 
puisse adresser à travers elle tous les appareils connectés. Avant 
de lancer SoundDiver, il sera bon de configurer votre baie de 
raccordement de façon à ce que :
❏ La sortie MIDI (Out) de l’ordinateur puisse adresser toutes

les entrées MIDI (In) des appareils connectés 
❏ Les sorties MIDI (Out) des appareils connectés soient con-

nectées à une entrée MIDI (In) de l’ordinateur.
Si votre baie de raccordement ne permet pas de connecter 
simultanément les sorties MIDI (Out) des appareils connectés 
à l’entrée ou aux entrées MIDI (In) de l’ordinateur, veuillez 
vous reporter au § La fenêtre Setup à la page 189 du Chapitre 5 La 
fenêtre Setup.
Si une boucle de MIDI Thru apparaît au début de l’opération 
de scan (ou balayage), réglez la baie de raccordement sur un 
programme vide et reprogrammez les connexions.

Spécificités du Macintosh 

Les interfaces Emagic connectées au port USB d’un Macintosh

SoundDiver prend en charge les interfaces d’Emagic Unitor8 
Mk II, AMT8 et MT4 connectées par l’intermédiaire du port 
USB. OMS n’est pas nécessaire. On peut brancher et débran-
cher à chaud.

Les interfaces Emagic connectées au port USB d’un Macintosh

SoundDiver prend en charge les interfaces d’Emagic Unitor8 
Mk II, AMT8 et MT4 connectées par l’intermédiaire du port 
USB. OMS n’est pas nécessaire. On peut brancher et débran-
cher à chaud.
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Ordinateurs Macintosh dépourvus de port Modem/Imprimante 

Les ordinateurs Macintosh dépourvu de port modem et/ou 
imprimante sont reconnus et affichés comme tels dans les 
préférences : les ports ne sont pas disponibles. 
& Si un GeeThree Stealth ou un Griffin gPort a été installé dans un G4 ou un G3 bleu/

blanc, il faut installer l’extension Système appropriée (“Stealth Serial Port Software 
1.0.3” téléchargeable à l’adresse <http://www.geethree.com/download.html>, ou 
“gPort Pilote 1.1”, téléchargeable à l’adresse <http://www.griffintechnology.com/
g3/>). Sinon, SoundDiver ne pourra pas reconnaître ces extensions du port modem.

Ports MIDI modifiés sous Windows
Lorsque des pilotes MIDI MME sont rajoutés ou supprimés 
(ou si leurs réglages ont été changés), la numérotation des ports 
MIDI peut en être modifiée. SoundDiver en tient compte. Si 
un port n’est pas trouvé, un message d’alerte correspondant 
s’affiche (“MIDI Port xxxx not found”). Cela facilite de beau-
coup la recherche du port manquant.
Dans certains cas, il sera judicieux de vérifier le bon fonction-
nement de la connexion MIDI, avec Options > Loopback test.... 
Une description détaillée figure au § Loopback Test à partir de la 
page 159 et suivantes.

2.5 Installation de SoundDiver

Protection contre la copie
SoundDiver est protégé contre le piratage grâce à une protec-
tion logicielle spéciale. Cette protection est transparente et 
figure sur le CD de SoundDiver. Vous pouvez installer sur 
disque dur autant de copies de SoundDiver que vous le souhai-
tez mais elles ne pourront fonctionner que si le CD de Sound-
Diver est inséré temporairement.

Afin d’éviter d’avoir à insérer le CD de SoundDiver chaque fois 
que vous lancez SoundDiver, il vaudra mieux autoriser le 
disque dur. Cette autorisation peut être désinstallée si vous 
souhaitez revendre votre licence de SoundDiver. L’installation 
est traitée dans la section suivante.
52
Emagic
SoundDiver 



Installation de SoundDiver
• L’autorisation est sauvegardée dans la partition de démar-
rage (Windows) ou le volume de démarrage (Mac). Si vous 
avez démarré à partir d’une partition ou d’un volume diffé-
rents, veuillez également autoriser cette partition ou ce 
volume.

• Plusieurs copies de SoundDiver peuvent être utilisées à 
différents endroits de votre machine - il suffit d’une seule 
autorisation. Le fichier programme lui-même ne contient 
aucune information concernant l’autorisation, si bien que ce 
fichier peut être librement supprimé, copié ou déplacé.

Le CD vous sera réclamé de temps à autre pour vérifier qu’il est 
toujours en votre possession.

A partir d’une semaine avant l’expiration de la période d’auto-
risation, un message d’alerte s’affichera au démarrage de 
SoundDiver. Insérez le CD de SoundDiver dès que possible 
pour renouveler l’autorisation. 

Installer un nouveau programme sur un 
disque dur
Sur le CD de SoundDiver se trouve un logiciel d’installation. 
Démarrez ce logiciel et lisez attentivement les explications.

Vous pouvez copier le fichier programme de SoundDiver autant 
de fois que vous le voulez sur plusieurs disques durs. Cepen-
dant, pour obtenir une copie qui fonctionnera sans devoir insé-
rer le CD de SoundDiver, vous devrez autoriser le disque dur 
(voir § Autoriser le disque dur à la page 54).

Mettre à jour un programme existant
Si vous souhaitez effectuer une mise à jour de SoundDiver à 
l’aide d’un CD de mise à jour, ou installer de nouveaux modu-
les, installez le fichier comme d’habitude - soit dans un 
nouveau dossier ou en écrasant les fichiers existants. L’autorisa-
tion du disque dur n’est pas affectée et vous pouvez lancer la 
nouvelle version sur-le-champ.
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& Si vous procédez à une simple mise à jour de modules ou d’adaptations - par 
exemple par téléchargement à l’adresse http://www.emagic.de - copiez tout simple-
ment les nouveaux fichiers dans le dossier Diver. Si un message d’alerte s’affiche pour 
vous prévenir que le fichier existe déjà, cliquez sur Replace ou Replace All. Au 
prochain lancement, SoundDiver utilisera automatiquement la nouvelle version du 
Module ou de l’Adaptation.

Autoriser le disque dur
Si l’autorisation vous est réclamée, ou si vous souhaitez procé-
der à la première autorisation, veuillez suivre les étapes suivan-
tes :

❏ Démarrez SoundDiver en double-cliquant sur l’icône de
SoundDiver (Windows : également en sélectionnant l’article
de menu Programmes > Emagic > SoundDiver > Sound–
Diver dans le menu Démarrer).

❏ Si le CD original n’est pas inséré, il vous sera réclamé.

❏ La fenêtre d’autorisation apparaît.

❏ Sélectionnez Authorize pour permettre à SoundDiver d’être
lancé depuis votre disque dur. A partir de maintenant, vous
allez pouvoir démarrer SoundDiver sans le CD original de
SoundDiver. Un message de confirmation va apparaître :

SoundDiver has been successfully authorized. 
You can authorize at any time from CD.

❏ Sélectionnez Quit et la procédure d’installation sera aban-
donnée.

Renouveler l’autorisation 
De temps à autre, il vous sera demandé de renouveler l’autori-
sation. Le message suivant apparaîtra :

Hard disk authorization will expire in 7 days. Do you want to 
reauthorize now or later?

L’autorisation expirera 7 jours après la première apparition du 
message. Le fait que SoundDiver ait été utilisé ou non pendant 
cette période n’y change rien.
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Après expiration du délai, ce message apparaîtra :
Hard disk authorization has expired. You have to re-authorize 

from CD.

Renouvelez l’autorisation dès que la demande vous en est faite 
afin d’éviter cette petite corvée.

Supprimer une autorisation (Désautoriser)
La suppression de l’autorisation n’a aucun effet sur le fichier 
programme ou sur les bibliothèques que vous aurez créées. 
Seul le fichier d’autorisation est supprimé (si vous voulez 
supprimer des fichiers, reportez-vous au § Supprimer complète-
ment SoundDiver du disque dur à la page 56). 

❏ Démarrez SoundDiver.

Ouvrez les réglages globaux à partir de Options > Settings > 
Global Settings. Cliquez sur le bouton de Désinstallation. Un 
message d’alerte s’affiche :

Il n’est pas nécessaire d’insérer le CD pour désinstaller.

Lancer SoundDiver sans autorisation 
Vous pouvez également lancer SoundDiver sans autorisation. 
Cela peut se justifier si vous voulez utiliser le logiciel temporai-
rement sur un autre ordinateur que le vôtre. Pour cela, il vous 
faudra quand même toujours le CD original de SoundDiver :

❏ Insérez le CD original de SoundDiver 

❏ Copiez SoundDiver sur le disque dur désiré et démarrez la
copie en double-cliquant sur son icône de SoundDiver. Le
dialogue d’autorisation apparaît

❏ Sélectionnez Continue et SoundDiver démarre.
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Logiciels d’optimisation 
La protection de SoundDiver contre la copie n’est pas touchée 
lors des opérations d’optimisation du disque et de défragmen-
tation des programmes. Vous pouvez utiliser des programmes 
tels que Speed Disk ou DiskExpress II aussi souvent que 
voulu.

Formatage du disque dur
Si vous formatez ou partitionnez un disque dur autorisé pour 
SoundDiver, il vous faut ensuite autoriser SoundDiver.

Il ne suffit pas de faire une sauvegarde du fichier sur le disque 
dur et de la rétablir après le formatage.

Supprimer complètement SoundDiver du 
disque dur
Pour supprimer complètement SoundDiver du disque dur : 

❏ supprimez l’autorisation en suivant les instructions don-
nées plus haut, puis

❏ supprimez du disque dur le fichier SoundDiver, le dossier
Diver, les bibliothèques et les préférences ( : n’oubliez pas
le fichier SoundDiver 3.0 Preferences dans le dossier Prefe-
rences de votre dossier Système).

2.6 Lancer le programme pour la 
première fois

Lorsque vous démarrez le programme pour la première fois, 
SoundDiver lance quelques routines automatiques destinées à 
permettre une installation aussi rapide et correcte que possible 
de votre système MIDI. Afin d’assurer un fonctionnement 
optimum de l’ensemble, vérifiez, avant de lancer le programme 
pour la première fois :
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❏ que tous les appareils ainsi que les éventuelles baies de rac-
cordement utilisés sont correctement connectés dans les
deux directions à l’ordinateur

❏ que tous les appareils sont sous tension et que les paramè-
tres MIDI sont correctement configurés. Assurez-vous tout
spécialement que leurs fonctions de Système Exclusif sont
activées, et que les appareils semblables ou identiques ont
reçu des Device ID ou des canaux MIDI différents

❏  : qu’AppleTalk est désactivé s’il utilise LocalTalk. Local-
Talk interfère avec les communications MIDI et peut pro-
voquer des problèmes de transmission.

Lorsque SoundDiver est lancé pour la première fois, une série 
de boîtes de dialogue s’affiche pour vous présenter la marche à 
suivre avant le scan (c-à-d. la recherche des appareils connec-
tés).

 : SoundDiver commence par ouvrir la fenêtre Preferences 
dans laquelle vous définissez le ou les ports MIDI par lesquels 
les appareils et l’ordinateur communiquent. A ce niveau, il 
suffit d’activer le port imprimante si vous disposez d’une inter-
face MIDI connectée au port imprimante.

Choix de la langue dans SoundDiver
Tous les menus et les boîtes de dialogue s’affichent en anglais 
ou en allemand, selon le choix du clavier actuellement sélec-
tionné. Ce choix se fait automatiquement - aucune configura-
tion n’est nécessaire ; chaque fichier de programme et de 
module contient l’ensemble du texte dans les deux langues.

Si vous souhaitez utiliser SoundDiver dans une langue diffé-
rente de celle du réglage de clavier, veuillez vous reporter au § 
Langue à la page 413 et au § Language (Langue) à la page 403.

& La prise en charge de langues supplémentaires est possible. Si vous êtes intéressé, 
veuillez prendre contact avec le distributeur Emagic de votre pays. Si vous le désirez, 
vous pouvez commander un exemplaire du manuel de SoundDiver en allemand ou 
en d’autres langues.
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2.7 Installer d’autres appareils
SoundDiver ouvre automatiquement les fenêtres Setup et 
Install lorsqu’il est lancé pour la première fois. Vous pourrez 
plus tard les ouvrir manuellement en sélectionnant l’article de 
menu Windows > Install afin d’installer des appareils. L’instal-
lation est nécessaire pour établir des communications ultérieu-
rement. 

L’installation est une opération très simple : il vous suffit de 
sélectionner les appareils que SoundDiver doit installer et 
d’appuyer sur R. SoundDiver se charge du reste lui-même.

Une autre méthode consiste également à cliquer sur Scan all, 
auquel cas tous les appareils pris en charge par SoundDiver 
seront recherchés par balayage de tous les ports. Notez que 
cette opération peut prendre un certain temps.

Les sections suivantes traitent de l’installation d’appareils de 
façon détaillée.

La fenêtre Install

La fenêtre Install est l’endroit où vous demanderez à SoundDi-
ver de scanner les appareils et où vous pourrez les installer à la 
main.
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Sélectionner les modèles
Sélectionnez tout d’abord les appareils désirés dans la fenêtre 
Install avant de scanner ou de les ajouter manuellement. Vous 
pouvez sélectionner un ou plusieurs modèles. Si vous sélec-
tionnez plusieurs modèles, SoundDiver effectue l’opération 
pour chacun des modèles l’un après l’autre. SoundDiver affiche 
l’icône de l’appareil sélectionné sous les boutons.

Ce que vous pouvez sélectionner :

• Pour sélectionner un seul modèle, cliquez sur sa ligne.
• Pour sélectionner plusieurs modèles, cliquez sur chacune 

des lignes concernées tout en appuyant sur ç ( : S).
• Un second ç ( : S) clic sur une ligne la désélectionne.
• Pour sélectionner tous les modèles, sélectionnez Edit > Se-

lect All. Dans ce cas, Toggle selection (Inverser la sélection) vous 
permet d’annuler ce que vous venez de faire. N’oubliez pas, 
néanmoins, que scanner tous les appareils pris en charge par 
SoundDiver est une opération de longue durée, le nombre 
d’appareils pris en charge étant très élevé.

Scanner à l’aide des touches
La fenêtre Install vous permet d’atteindre avec précision des 
noms d’appareils à l’aide du clavier de l’ordinateur. Au vu du 
nombre grandissant de modules et d’adaptations, cette 
méthode s’avère bien plus rapide que de faire défiler la liste.

Pour trouver un appareil donné, activez Verr. Maj. avec Y (la 
touche située au-dessus de S—le voyant Verr. Maj., intégré à la 
touche Y sur les claviers Mac, doit s’allumer. Sur les claviers 
PC, il est situé au milieu des trois voyants du clavier) et saisis-
sez les premières lettres du nom du modèle tandis que la fenê-
tre Add New Devices reste ouverte. Le témoin de sélection ira 
se positionner sur le résultat le plus proche de votre requête.

Si vous tapez quelque chose comme “DX4”, SoundDiver trou-
vera le DX7, puisqu’il verra les lettres DX contenues dans 
plusieurs noms de modèles, mais pas le “4”. Le premier 
nombre supérieur qu’il trouvera dans ce cas précis est le “7”. 
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& Cette fonction ne s’applique qu’aux noms de modèles, pas aux noms de construc-
teurs.

La touche T vous permettra d’avancer dans la liste par ordre 
alphabétique ascendant. Même chose avec ST dans l’ordre 
descendant.

Scanner
Cliquez sur le bouton Scan pour démarrer l’opération. Vous 
pouvez aussi appuyer sur R ou double-cliquer sur le nom. 
SoundDiver analyse maintenant votre système MIDI, et 
installe automatiquement les appareils qu’il y trouve, avec leur 
configuration de connexion correcte.

& Cette option est préférable à l’installation manuelle car elle permet à SoundDiver de 
collecter le maximum d’informations sur les appareils et d’éviter les erreurs humaines 
(mauvais réglage de paramètres MIDI ou de connexions).

A la suite du scan, un dialogue apparaît dans laquelle vous 
pouvez commander à SoundDiver de récupérer directement le 
contenu de la mémoire de tout appareil trouvé.

Si le Scan ne fonctionne pas, veuillez vous reporter à l’Annexe 
C - Dépannage, à la page 421. Vous y trouverez la solution 
détaillée à divers problèmes.

N’oubliez pas : dans la mesure où la plupart des modules de 
SoundDiver s’appliquent à toute une gamme de modèles, le 
scan de recherche d’un appareil spécifique ramène souvent des 
appareils apparentés, comme un TG 77 par exemple, alors que 
vous vouliez un SY 99.

SoundDiver prend généralement en charge les baies de raccor-
dement MIDI et peut contrôler automatiquement l’ensemble 
des communications avec la baie de raccordement chaque fois 
que possible. Les baies de raccordement, par exemple, 
peuvent être reprogrammées par SysEx pour pouvoir scanner 
des appareils non connectés à l’ordinateur dans le programme 
actuellement actif dans la baie.

Un conseil important lorsque vous utilisez des baies de raccor-
dement :
60
Emagic
SoundDiver 



Installer d’autres appareils
• La prise en charge spécifique de baies de raccordement 
MIDI n’est possible qu’avec les baies pour lesquelles il exis-
te un module dédié. Vous en trouverez la liste au § Baies de 
raccordement MIDI (Patchbays) à la page 46.

• Si vous scannez les appareils un à un, il vaut mieux commen-
cer par scanner les baies de raccordement, sous peine de ne 
pas trouver les appareils qui y sont connectés. Vous pouvez 
abandonner la procédure en appuyant sur ™ ( : ™ ou 
C…).

• Avant de commencer le scan, il vaut mieux configurer la baie 
de raccordement de façon à éviter les boucles MIDI avec 
l’ordinateur. En cas de boucle, non seulement le scan pren-
dra plus de temps, mais en outre de mauvaises connexions 
pourront empêcher la reconnaissance de certains appareils.

Modèles qui ne peuvent pas être scannés
Certains appareils ne sont pas détectés par l’option de scan soit 
parce que :

• ils ne possèdent pas de sortie MIDI 
• ils ne peuvent pas traiter les messages de requête, et ne peu-

vent donc pas livrer leur identification
• l’adaptation n’est pas dédiée à un appareil donné (par ex. 

Generic) et le scan est impossible
• l’adaptation développée pour l’appareil ne gère pas encore la 

fonction de Scan.
Dans ce cas, les appareils concernés ne sont pas scannés, et leur 
noms apparaissent en italique.
Un message approprié s’affichera à la fin de l’opération de scan.

Scan All
Si vous ne savez pas exactement quels appareils sont connectés 
à l’ordinateur, ou que vous ne souhaitez pas sélectionner à la 
main les modèles à scanner, contentez-vous de cliquer sur ce 
bouton. SoundDiver entamera alors un scan recherchant tous 
les modèles pris en charge. Cela peut durer un certain temps, 
en fonction de vos interfaces MIDI et de vos baies de raccorde-
ment.
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Ajouter manuellement des appareils à la 
configuration 
Vous pouvez aussi ajouter manuellement les appareils sélec-
tionnés à la configuration. Il vous faudra dans ce cas régler les 
paramètres à la main, comme notamment leur Device ID et 
leurs connexions.

& Il ne conviendra d’ajouter un appareil manuellement que lorsque celui-ci ne peut être 
scanné (par ex. s’il ne possède pas de sortie MIDI ou ne gère pas le scan), ou pour 
des opérations de test.

Pour ajouter manuellement des appareils à la configuration,

• cliquez sur le bouton Add,
• ou appuyez sur çd ( : Cd),
•  : ou O-double cliquez sur l’un d’entre eux.
& Si la configuration intègre déjà un appareil compatible, il vous sera demandé de 

confirmer que vous souhaitez ajouter le nouvel appareil. SoundDiver attribuera à 
l’appareil nouvellement ajouté un nouveau Device ID : vous devrez modifier à la main 
l’ID sur l’appareil lui-même pour qu’il soit conforme à celui de SoundDiver.

& Le message “No more Device Ids” signifie que tous les ID disponibles sont en cours 
d’utilisation sur la sortie actuellement employée (ou que l’appareil ne possède pas de 
Device ID). Il conviendra dans ce cas de connecter l’un des appareils existants à une 
autre sortie de l’ordinateur.

&  : vous pouvez double-cliquer sur les fichiers de module ou d’adaptations dans le 
Finder, ou les faire glisser sur l’icône de SoundDiver. La fenêtre d’Installation s’ouvrira 
alors, et les modèles concernés seront sélectionnés. Un dialogue vous permet de 
choisir entre le scan et l’installation manuelle.

Done (Terminé)
Lorsque l’opération de scan ou l’installation des appareils est 
terminée, cliquez sur Done. La fenêtre se referme. Vous pouvez 
également appuyer sur ™ ou ç£ ( : ™ ou Cw).

Help (Aide)
Dans la fenêtre d’Installation, l’aide en ligne de SoundDiver 
vous présente le message d’aide concernant le premier modèle 
sélectionné. Pour ouvrir l’aide, sélectionnez Windows > Help 
ou cliquez sur le bouton Help.
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 : si vous ouvrez l’aide avec OH, elle se transforme en 
“fenêtre flottante”. (Avec Windows, utilisez le menu “Aide”). 
Vous trouverez plus d’informations au § L’aide en ligne à la page 
170 du Chapitre 4 L’interface utilisateur de SoundDiver.

Créer la liste des modèles
Vous pouvez copier dans le presse-papiers tout ou partie de la 
liste des modèles disponibles afin de l’éditer dans un traite-
ment de texte ou de l’imprimer.

Sélectionnez les appareils désirés et sélectionnez Edit > Copy.

& La liste complète des modèles figure sur le CD de SoundDiver. Double-cliquez sur le 
fichier SoundDiver 3.0 Model List. 

Vérifier la connexion MIDI
En cas d’échec du scan, il est prudent de vérifier la connexion 
MIDI à l’aide de Options > Loopback test… Vous en trouverez 
la description détaillée au § Loopback Test à partir de la page 159 
et suivantes.

2.8 Raccourci/Alias du fichier 
programme

Sous Windows 95/98, vous pouvez créer un raccourci de Sound-
Diver sur le bureau. En double-cliquant sur cette icône, vous 
pouvez démarrer SoundDiver très vite.

Depuis l’apparition du Système 7, vous pouvez créer un alias de 
SoundDiver et conserver l’alias sur le bureau ou dans le Dossier 
Menu Pomme au sein du dossier Système. Vous aurez ainsi le 
logiciel constamment sous la main sans avoir à le rechercher. 
Bien évidemment, vous pouvez de même créer un alias pour 
une bibliothèque et démarrer SoundDiver directement depuis 
cette bibliothèque.
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2.9 Le dossier Diver
Tous les fichiers de modules et d’adaptations utilisés par 
SoundDiver sont placés dans un dossier spécifique, nommé 
Diver, dans lequel SoundDiver les retrouve facilement. Ce 
dossier se crée automatiquement au premier lancement du 
programme SoundDiver (s’il n’existait pas déjà).

 : si le volume sur lequel SoundDiver est installé ne dispose 
pas de suffisamment d’espace, vous pouvez déplacer le dossier 
Diver vers un volume différent. La procédure est la suivante :

❏ Déplacez le dossier à l’emplacement désiré.

❏ Supprimez l’ancien dossier.

❏ Créez un alias du nouveau dossier (sélectionnez Créer un
alias dans le menu Fichier du Finder).

❏ Déplacez cet alias à l’emplacement de l’ancien dossier
(dans le même dossier que l’application SoundDiver).

❏ Effacez le suffixe “Alias”, ce qui renomme l’alias “Diver”.

Cela fonctionne de la même manière pour le dossier Libraries.

2.10 Types de fichiers Windows
SoundDiver utilise différents types de fichier pour sauvegarder 
les bibliothèques de sons, les fichiers d’aide ou les modules. Il 
utilise les extensions de noms suivantes, qui vous aideront à 
reconnaître les types de fichiers auxquels vous avez affaire:

Type Suffixe Description Créé par
Bibliothè-
que

∗ .LIB Fichier de bibliothèque conte-
nant des sons ou d’autres pro-
grammes d’effets appartenant 
à divers appareils MIDI

SoundDiver en s
“Save” dans le 

Module ∗ .DLL 
(Windows)

Module destiné à un appareil 
MIDI spécifique

Le programme d
de l’installation 

Adapta-
tion

∗ .ADA Fichier du module universel 
contenant l’adaptation desti-
née à un appareil MIDI

Le programme d
de l’installation 
tion
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2.11 Installer des modules et des 
adaptations

La fenêtre d’Installation de SoundDiver n’affiche que les 
modules et les adaptations actuellement situés dans le dossier 
Diver.

Supprimer des modules inutiles
Vous pouvez récupérer de la place sur votre disque dur en 
supprimant des fichiers de modules et d’adaptations du dossier 
Diver ou en les déplaçant ailleurs. La liste s’en trouve automa-
tiquement réduite dans la fenêtre Install.

A voir également le§ Reconstruire le Contenu de la Fenêtre Install à 
partir de la page 412 et suivantes.

Supprimer des adaptations inutiles 
Si vous changez le contenu du dossier Diver (qui héberge les 
adaptations et les modules), le changement ne sera reflété dans 
la liste d’Install Device de SoundDiver qu’une fois que vous 
aurez supprimé le fichier Universal Module Cache du dossier 
Diver. Ceci force le module Universel à reconstruire sa liste 
d’adaptations au démarrage suivant de SoundDiver. Cette 
opération peut prendre un certain temps.

A voir également le § Reconstruire le Contenu de la Fenêtre Install 
à partir de la page 412 et suivantes.

Fichier 
d’aide

∗ .HLP Fichier texte de l’aide en ligne 
dans un module ou une adap-
tation

Le programme d
de l’installation 
d’une adaptatio

Préfé
rences

∗ .PRF Réglages par défaut mémori-
sables

SoundDiver lors
ou que vous sél
Preferences as..

Type Suffixe Description Créé par
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2.12 SoundDiver et la gestion du 
MIDI

SoundDiver peut fonctionner soit seul soit en même temps que 
d’autres programmes sur votre ordinateur.

SoundDiver est compatible avec AutoLink.

 : SoundDiver est également compatible avec les systèmes 
multitâches MIDI OMS et MIDI Manager.

SoundDiver se comportera de manière légèrement différente 
selon l’environnement de gestion du MIDI auquel il sera 
confronté.

AutoLink
Le mode AutoLink de Logic Audio vous offre de nombreuses 
options. Voir les détails page 355.

La gestion MIDI sur Macintosh

OMS

Quelques explications sur OMS

OMS ou “Open Music System” (auparavant “Opcode MIDI 
System”) est une extension Système qui fonctionne entre des 
programmes applicatifs et les ports MIDI physiques. OMS 
vous permet de définir des “nœuds” qui représentent, un à un, 
des appareils de votre configuration MIDI. Ces nœuds (en 
général dénommés “Devices”, ou “Appareils”), sont constitués 
d’un nom, d’informations sur l’endroit ou l’appareil est 
connecté, sur les canaux MIDI qu’il reçoit, etc. On peut créer, 
modifier ou supprimer des Appareils OMS à l’aide de l’applica-
tion OMS Setup. Pour plus d’informations, veuillez vous repor-
ter au manuel d’OMS.

Lorsque vous utilisez OMS comme pilote de votre système 
MIDI, SoundDiver ne dispose d’aucune information sur vos 
interfaces MIDI ou sur les ports physiques réels. Toutes ces 
informations sont enfouies à l’intérieur du système OMS et 
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sont inaccessibles à des applications comme SoundDiver. La 
communication s’effectue alors avec les Appareils fournis par 
OMS et c’est OMS qui assure la bonne gestion des flux de 
données entre les Appareils, dans le cas où des flux de données 
doivent être fusionnés.

L’avantage principal d’OMS par rapport à Autolink par exem-
ple est de permettre l’utilisation simultanée de plusieurs 
programmes MIDI provenant de différents éditeurs.

Quand faut-il utiliser OMS ?

SoundDiver prend en charge toutes les fonctions MIDI d’OMS 
et est compatible avec les versions 1.2.3 et 2.x (le Name Mana-
ger et le Time Manager ne sont pour l’instant pas pris en 
charge).
Néanmoins, il est conseillé de n’utiliser OMS que si vous 
comptez utiliser en même temps d’autres programmes MIDI 
qui ne gèrent pas AutoLink avec SoundDiver, comme Cubase 
de Steinberg ou Vision d’Opcode.
OMS n’est pas indispensable pour utiliser une interface MIDI 
d’Opcode. On peut utiliser la Studio 4 comme la Studio 5 en 
mode d’émulation MTP sans limitations, sauf si on veut 
connecter plusieurs Studio 5 à un port série. 
& Utilisez SoundDiver en mode OMS avec OMS 2.2 ou plus récent sur les modèles 

PowerBook 1xx. Ceux-ci présentent un problème avec le Power Manager, qui est une 
partie du logiciel Système à cause duquel les octets MIDI reçus peuvent être “avalés” 
si on n’utilise pas OMS.

Quand OMS est-il actif ?

OMS n’est actif (autrement dit il n’accède aux ports série) que 
tant qu’au moins un programme lui a signifié sa présence. Il 
n’est donc pas nécessaire de déplacer OMS hors du dossier 
Système pour le désactiver. Il suffit de quitter toutes les appli-
cations OMS.

Cela s’avère infiniment pratique lorsque vous possédez une 
interface Opcode mais que vous ne voulez pas utiliser Sound-
Diver avec OMS. Ces interfaces ont besoin du programme 
OMS Setup pour configurer l’émulation MTP et pour générer 
du code SMPTE. 
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& Avant de démarrer SoundDiver (sans OMS), veuillez quitter le programme OMS 
Setup pour désactiver OMS à nouveau. Dans le cas contraire, SoundDiver se plaindra 
de ne pouvoir accéder aux ports série.

SoundDiver en mode OMS 

Pour utiliser SoundDiver avec OMS, sélectionnez Options > 
Settings > MIDI Interface Communication... et réglez Use OMS if 
available sur always.

Lorsque OMS est installé, SoundDiver passera instantanément 
en mode OMS.

Pour chaque appareil installé dans SoundDiver, l’assignation 
de sortie est stockée séparément pour l’utilisation sous OMS et 
sans OMS. Vous pouvez ainsi facilement passer dans SoundDi-
ver du mode avec OMS au mode sans OMS, sans devoir réassi-
gner les sorties à chaque changement de mode.

Scanner en mode OMS 

SoundDiver peut scanner votre studio MIDI en mode OMS. Il 
faut toutefois qu’un Appareil OMS soit défini pour chaque 
sortie de vos interfaces MIDI. En général, cela se fait automa-
tiquement à l’installation d’OMS 2.x.

Pour les interfaces MIDI compatibles MTP (y compris 
l’Unitor8 et la MIDI Express d’Emagic), la procédure d’instal-
lation d’OMS rajoute habituellement un nœud “de niveau 
supérieur” qui transmet sur toutes les sorties. SoundDiver 
néglige ces nœuds pendant la procédure de scan, dans la 
mesure où ceux-ci n’apportent aucune information utile à la 
recherche des bons câblages.

La prise en charge des baies de raccordement MIDI décrite au 
§ Baies de raccordement MIDI (Patchbays) à la page 46 peut égale-
ment se faire en mode OMS. Cela n’a toutefois rien à voir avec 
la définition des baies de raccordement MIDI dans OMS.

Synchronisation des assignations de port avec/sans OMS

SoundDiver synchronise automatiquement les assignations de 
port avec et sans OMS :
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• lorsqu’un appareil a été scanné sans OMS, il recevra automa-
tiquement la bonne assignation de port par OMS en passant 
en mode OMS.

• et vice-versa

Vous pouvez ainsi alterner le scan avec et sans mode OMS, et 
empêcher la création d’appareils en double dans la fenêtre 
Setup. 

& Naturellement cette fonction n’opère qu’avec des interfaces MIDI qui acceptent 
OMS (en général via un pilote pour OMS fourni par le constructeur) mais qui peuvent 
fonctionner sans.

MIDI Thru et mini-séquenceur en mode OMS

Les fonctions de MIDI thru et de mini-séquenceur de Sound-
Diver existent également sous OMS, mais uniquement tant 
que SoundDiver reste au premier plan. Si vous avez configuré 
votre séquenceur OMS pour générer des événements MIDI 
Thru même en tâche de fond, il vaut mieux désactiver MIDI 
Thru et AutoPlay dans SoundDiver.

Communication avec Logic en mode OMS

On peut utiliser OMS et AutoLink simultanément dans Logic 
et dans SoundDiver. On bénéficie ainsi d’AutoLink tout en 
conservant la capacité de faire tourner des programmes OMS.

Dans ce mode, Logic et SoundDiver échangent des informa-
tions de sortie MIDI au format OMS (plutôt que de numéro de 
câble MTP).

Pour permettre l’action simultanée d’OMS et d’AutoLink, acti-
vez simplement les options Use AutoLink if available et Use OMS 
if available dans Logic, ainsi que l’option Use OMS if available 
dans SoundDiver.

Toutes les options d’AutoLink sont à présent disponibles. Pour 
plus de détails, veuillez vous reporter au § AutoLink à la page 
355.

& Si vous utilisez Logic et SoundDiver simultanément, il n’est pas possible d’utiliser l’un 
sans OMS si l’autre utilise OMS.
69
Mode d’Emploi
Version 3.0



 – Installation
Communication avec d’autres programmes en mode OMS 

Sous OMS, le bus appelé Bus IAC est disponible (IAC signi-
fiant “Inter-Application Communication”). Il vous permet de 
transmettre des données MIDI d’une application à une autre 
au sein de l’ordinateur. Vous pouvez ainsi enregistrer des chan-
gements de paramètres ou des téléchargements dans un 
séquenceur.

Enregistrer des données de SoundDiver dans le séquenceur

❏ Assurez-vous que le Bus IAC a été activé comme entrée du
séquenceur 

❏ Démarrez l’enregistrement

❏ Passez dans SoundDiver

❏ Assignez au Bus IAC la sortie de l’appareil dont vous vou-
lez enregistrer les données, (dans la case des paramètres
d’appareil)

❏ Générez les messages MIDI concernés, par ex. les mouve-
ments d’un curseur dans un éditeur

❏ Rétablissez les réglages d’origine de sortie de l’appareil.

Si vous souhaitez utiliser cette fonction fréquemment, il vaudra 
mieux

❏ Définissez un Patch OMS avec un “Virtual Instrument”
qui transmettra au nœud OMS ainsi qu’au Bus IAC, à l’aide
d’un “Splitter Object” ou “séparateur”. Pour plus de
détails, veuillez vous reporter au manuel d’OMS ou à celui
de votre interface Opcode.

❏ Sélectionnez ce “Virtual Instrument” comme sortie de
l’appareil dans SoundDiver.

& Si vous trouvez cela trop complexe, utilisez plutôt Logic et AutoLink. Vous n’aurez 
cette fois rien à configurer et vous pourrez même démarrer l’enregistrement depuis 
SoundDiver. Voir également le § Enregistrer les changements de paramètres dans 
Logic à la page 370.
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Afficher les données enregistrées dans SoundDiver à la lecture

❏ Créez un “Virtual Instrument” qui transmet les données à
l’appareil ainsi qu’au Bus IAC, comme décrit ci-dessus

❏ Sélectionnez ce “Virtual Instrument” dans la piste qui con-
tient les données enregistrées

❏ Démarrez la lecture.

& Une fonction similaire existe également dans AutoLink. Voir le § Afficher les change-
ments de paramètres enregistrés dans SoundDiver  à la page 373.

MIDI Manager
SoundDiver est compatible avec le MIDI Manager d’Apple, 
qui fut le pilote standard de la quasi-totalité des logiciels MIDI 
avant l’adoption d’OMS. Nous ne conseillons l’utilisation du 
MIDI Manager que si vous voulez utiliser SoundDiver en 
parallèle avec d’autres applications MIDI qui ne gèrent ni 
AutoLink ni OMS.
Pour installer le MIDI Manager, faites glisser les fichiers 
“MIDI Manager” et “Apple MIDI Driver” sur le dossier 
Système. Ils seront automatiquement rangés aux bons empla-
cements. Il faut également installer “Patchbay™”.
Utilisez MIDI Manager 2.0 ou une version plus récente. Des 
versions plus anciennes peuvent causer des problèmes de 
communication.
Après l’installation du MIDI Manager, veuillez redémarrer 
l’ordinateur.
Vous disposez de sept entrées et sorties logicielles séparées que 
vous pouvez configurer dans “Patchbay”. Les réglages que 
vous effectuerez seront mémorisés dans SoundDiver et rappe-
lés automatiquement à la prochaine session. Vous n’avez pas 
besoin de le faire vous-même dans “PatchBay™”.
Pour plus d’informations sur les fonctions du MIDI Manager et 
de Patchbay, veuillez vous reporter à l’aide de “Patchbay™”.

Autres systèmes de gestion MIDI
Assurez-vous qu’aucun autre programme lancé en parallèle 
avec SoundDiver n’utilise également le port imprimante ou 
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modem, ces ports ne pouvant être assignés qu’une seule fois. 
Cela inclut, par exemple, les logiciels d’impression ou de 
communication. Il convient de désactiver AppleTalk pendant 
l’utilisation de SoundDiver (avec l’accessoire de bureau 
“Sélecteur”, installé en général dans le menu Pomme) si vous 
utilisez LocalTalk. Néanmoins, si vous voulez imprimer à partir 
d’une imprimante AppleTalk, réactivez AppleTalk.

& Si, parallèlement à SoundDiver, vous exécutez des programmes très actifs en tâche 
de fond, leur activité peut perturber le logiciel. Il vaut donc mieux si possible désac-
tiver le partage de fichiers, à l’aide du tableau de bord “Partage de fichiers”.

Gestion MIDI sous Windows

Pilotes MIDI multi-clients
Si vous voulez exécuter plusieurs programmes MIDI à la fois 
sur PC/Windows, ils doivent tous pouvoir accéder aux ports 
MIDI. Cela implique que le pilote MIDI puisse être ouvert par 
plusieurs programmes (clients). De tels pilotes sont appelés 
pilotes MIDI “multi-clients”. Malheureusement tous les pilo-
tes MIDI n’ont pas cette capacité, cette fonction n’étant pas 
requise par les applications “normales” comme les jeux.

Les pilotes MIDI classiques ne peuvent être utilisés que par 
une seule application à la fois :

Si une autre application tente d’ouvrir le pilote MIDI, elle n’y 
parvient pas et génère un message d’erreur approprié. La raison 
de ce comportement plutôt anti-ergonomique tient au simple 
fait qu’il est plus facile de programmer un pilote équipé d’une 
seule entrée et sortie.

Un pilote multi-client, lui, est capable de délivrer les données 
MIDI reçues à toutes les applications et fusionne les données 
de sortie correctement :

MIDI
Input
Driver

Application 1
MIDI
Output
Driver
72
Emagic
SoundDiver 



SoundDiver et la gestion du MIDI
Interfaces MIDI avec pilotes multi-clients

Heureusement, il existe des pilotes MIDI multi-clients pour la 
plupart des interfaces MIDI et des cartes son du marché. 
Veuillez contacter le constructeur de votre interface ou de votre 
carte son pour vous procurer la version la plus récente du pilote.

VPilotes MIDI virtuels 

Il existe des solutions pour les interfaces MIDI dépourvues de 
pilote multi-client. Il serait en effet impossible d’écrire des 
pilotes MIDI différents pour les dizaines, voire les centaines de 
cartes MIDI et d’interfaces existantes. On trouve donc à leur 
place des pilotes multi-clients capables d’ouvrir les pilotes clas-
siques comme clients et de transmettre tout simplement les 
données MIDI :

Il existe plusieurs “pilotes virtuels” différents, en voici 
certains.

MultiMID

Multimid est sans doute le pilote virtuel le plus connu. Il s’agit 
d’un logiciel du commerce (39,95 dollars US), mais il en existe 
une version démo “réduite” librement copiable.

Les connexions aux pilotes “classiques” sont définies dans le 
dialogue de configuration de MultiMID. Pour chaque pilote 
ouvert (par ex. “Soundblaster In”), un équivalent doté de fonc-

Multi
Client
Input

Application 1
Multi
Client
OutputApplication 2

Application 3
Driver Driver

Multi
Client
Driver

Application 1

Multi
Client
Driver

MIDI
Input
Driver

MIDI
Output
Driver

Application 2

Application 3
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tionnalités multi-clients est créé (par ex. “Multi-Soundblaster 
In”), capable d’être ouvert par plusieurs applications.

Un “pipeline” de sorties permet aux données MIDI d’être 
acheminées d’une application à une autre. La version complète 
permet également de renommer les entrées et les sorties, ainsi 
que d’utiliser des plug-ins capables de manipuler les données 
MIDI en temps réel - semblable en cela à l’environnement de 
Logic.

Coordonnées : Hermann Seib
Am Tabor 12/1/24 - A-1020 Wien - Autriche

Email: seib@t0.or.at

Hubi’s MIDI Loopback Device

Ce progiciel est un freeware, ou graticiel (autrement dit, il peut 
être utilisé et copié gratuitement) et consiste en un pilote 
(“Midlpbk.drv”) qui installe jusqu’à quatre “loopback nodes” 
(LB1 à LB4), ainsi qu’une application qui connecte une entrée 
MIDI avec une sortie MIDI. D’où son nom “Hwmd-
cabl.exe”—la fonction de ce programme peut être comparée à 
celle d’un câble MIDI ; vous pouvez cependant définir des 
filtres supplémentaires.

L’utilisateur peut ensuite ouvrir plusieurs exemplaires de 
“Hwmdcabl.exe” et connecter chaque entrée à chaque sortie. 
C’est une solution très souple, qui permet aussi de connecter 
l’entrée d’un programme à la sortie d’un autre programme.

“Hubi’s MIDI Loopback Device” nécessite très peu de 
mémoire, offre un excellent timing avec une grande fiabilité.

Par autorisation spéciale de l’auteur, nous avons pu inclure cet 
outil sur le CD. Le fichier se nomme “MDLBK251.ZIP”. Il vous 
faudra PKZIP, WinZip, StuffIt Expander ou un outil de ce type 
pour décompresser ce fichier. Les coordonnées se trouvent sur 
le fichier “MIDLPBK.TXT”.

Comment bloquer les ports MIDI (Windows:)
Il est possible d’empêcher SoundDiver d’ouvrir certaines 
entrées et sorties MIDI :
74
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❏ Ouvrez le fichier “WIN.INI” dans votre dossier Windows 

❏ Si vous avez lancé SoundDiver au moins une fois, vous
trouverez une section [SoundDiver]. Sinon, ajoutez ce nom
de section au fichier (n’oubliez pas les crochets).

❏ Si vous avez lancé SoundDiver au moins une fois, vous
trouverez une ligne “portname=1”pour chaque port. Pour
chaque port que vous ne voulez pas voir ouvrir par Sound-
Diver, changez la ligne en “portname=0”.

Par exemple, si vous n’avez pas besoin des entrées et sorties 2 
d’une Unitor8, WIN.INI doit contenir : 
[SoundDiver]
MidiIn_Unitor_In_02=0
MidiOut_Unitor_Out_02=0

Cette fonctionnalité prend toute son importance avec des 
cartes son dont le pilote plante ou se bloque lors de la transmis-
sion de SysEx au générateur de table d’ondes interne. Certains 
pilotes ont cette réaction même lorsqu’il sont ouverts pendant

le lancement de SoundDiver. Dans ce cas, ils ne gèreront pas 
les SysEx et ne pourront de toute manière pas être utilisés avec 
SoundDiver.

Pour éviter l’apparition de boucles MIDI avec Hubi’s MIDI 
Loopback Device, utilisez :
…
[Logic]
MidiIn_LB1=0
MidiOut_LB2=0
…
[SoundDiver]
MidiOut_LB1=0
MidiIn_LB2=0

SoundDiver en tâche de fond
Si vous exécutez plusieurs applications et que vous disposez de 
suffisamment d’espace à l’écran, vous pouvez garder ouvertes 
en permanence autant de fenêtres que vous vous le souhaitez 
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tout en travaillant avec les autres applications MIDI. On trou-
vera utile dans ce cas d’avoir deux moniteurs.

Certaines activités (par ex. l’affichage de messages d’erreur) 
sont interrompues lorsque SoundDiver se trouve à l’arrière-
plan. Ces messages réapparaîtront dès que SoundDiver sera 
réactivé.

2.13 Compatibilité des versions 
Windows, Macintosh et Atari

Convertir des fichiers entre les trois plate-
formes
Les formats de fichier des versions Windows et Macintosh de 
SoundDiver sont compatibles entre eux. Cela s’applique aussi 
aux anciennes versions Atari. C’est d’un grand intérêt s’il vous 
arrive d’utiliser SoundDiver sur ces trois plate-formes différen-
tes, ou si vous collaborez avec d’autres utilisateurs de SoundDi-
ver. Les fichiers créés par SoundSurfer, SoundDiver et les 
versions OEM de SoundDiver sont également compatibles.

Les bibliothèques, les adaptations et les ressources de fichiers 
d’aide sont compatibles. Il suffit de les copier d’un ordinateur à 
un autre. Au besoin, vous aurez tout juste à ajuster les noms de 
fichiers :

Tableau 1 Extensions de noms de fichier Windows/Atari et Type/
Créateur sous Macintosh

Type de fichier Extension
Type 
Macintosh

Créateur Macin-
tosh (SoundDiver)

Bibliothèque .LIB EM9F EMA6

Adaptation .ADA EM7F EMA6

Ressource de fichier 
d’aide

.ADT TEXT any
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Les fichiers de module ne fonctionnent toutefois que sur une 
seule plate-forme. Pour utiliser un module sur une plate-forme 
différente, il vous faut la version appropriée du fichier, téléchar-
geable sur le site web d’Emagic (voir le § Contenu du coffret à la 
page 41).

A partir de la version 2.0.7, les conventions de noms de fichiers 
ont été uniformisées :

•  : les fichiers d’adaptation se terminent par .ADA même sur 
Macintosh afin d’améliorer la compatibilité avec les adapta-
tions créées sous Windows.

• Le nom de fichier d’une adaptation vient du nom de l’appa-
reil pris en charge par l’adaptation. Ce nom peut contenir des 
caractères non autorisés dans les noms de fichier d’une des 
plate-formes. Ces caractères sont désormais remplacés par 
“_” sur toutes les plate-formes.

Exemple: le fichier d’adaptation “DX21/27/100” se nomme à 
présent “DX21_27_100.ADA”, sur Macintosh comme sous 
Windows.

Convertir des fichiers vers et depuis un Macintosh
Il vous faut un programme Macintosh comme Echange de 
fichiers, Echange PC, DOS Mounter, Access PC, ou Smart 
Link pour que le Macintosh puisse lire les disquettes DOS. 
Echange PC appartient au Système 7.5. Echange de fichiers fait 
partie de Mac OS 8 et 9.

Fichier MIDI 
standard

.MID Midi any

SYX / MidiEx .SYX TEXT any

Tableau 1 Extensions de noms de fichier Windows/Atari et Type/
Créateur sous Macintosh

Type de fichier Extension
Type 
Macintosh

Créateur Macin-
tosh (SoundDiver)
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Pour que le Macintosh puisse reconnaître les fichiers Windows 
ou Atari sans restrictions, vous devrez modifier le Type et le 
Créateur d’un fichier provenant d’un PC ou d’un Atari.

De nombreuses versions plus récentes de logiciels permettant 
de monter les disques PC, de même qu’Echange de fichier, le 
font automatiquement dès que vous avez saisi l’extension de 
nom de fichier ainsi que le Créateur et le Type Macintosh. 
Veuillez vous reporter aux manuels de ces logiciels pour plus de 
détails.

Si vous n’avez pas ces programmes mais que vous possédez 
ResEdit, File Buddy, FastFind ou l’équivalent, vous pourrez 
modifier manuellement le Créateur de façon tout aussi efficace 
(quoique moins pratique).

Lors de la conversion de fichiers Windows ou Atari vers Macin-
tosh, l’extension de nom de fichier des fichiers de bibliothèque 
peut être conservée. Avec les MIDI files standards et les 
fichiers SYX, cela n’est toutefois pas nécessaire tant que le type 
du fichier est correct (voir également le § Importer des Fichiers 
MIDI Standard (SMF) à la page 274).

Les fichiers d’adaptation doivent comporter l’extension .ADA 
même sur Macintosh. Pour les fichiers de ressource d’aide, 
l’extension .ADT doit être conservée (pour plus de détails, 
veuillez vous reporter au manuel “Universal Module Program-
ming”).

2.14 Raccourcis clavier et 
télécommande MIDI

Vous pouvez déclencher la plupart des fonctions de SoundDi-
ver avec un raccourci clavier ou un message MIDI. La fenêtre 
Key Commands est celle où vous assignez les raccourcis clavier 
aux touches ou aux messages MIDI. 

& Chaque fois que ce manuel fera référence à un raccourci clavier, il s’agira d’une 
commande qui peut être rappelée par la frappe d’une touche ou un message MIDI. 
Vous pouvez ainsi entièrement adapter SoundDiver à vos habitudes de travail.
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Les raccourcis clavier décrits dans le présent manuel sont basés 
sur les assignations de touches par défaut de Windows et du 
Macintosh. Si vous effectuez des modifications dans la fenêtre 
Key Commands, les raccourcis clavier mentionnés dans ce 
manuel peuvent ne plus correspondre à votre installation de 
SoundDiver.

Touches mortes Macintosh et Windows
Le Macintosh possède une touche morte (C) qui n’existe pas 
sur la plate-forme Windows. En outre, les touches mortes 
portent des noms légèrement différents.

Pour simplifier, disons que sous Windows on utilisera souvent 
la touche ç là où la touche morte C sera indiquée sur Macin-
tosh.

Pour créer une “variante” de raccourci clavier, on utilise 
souvent la combinaison de touches CO sur Macintosh et çS 
sous Windows. Par exemple, la commande “Quit without 
saving”, COq s’obtiendrait avec ç‚q sous Windows.

Veuillez noter que les remarques ci-dessus ne s’appliquent que 
dans le cas de l’assignation des raccourcis clavier par défaut. 
Vous pouvez les changer si vous le souhaitez.

Sous Windows S et ç ont la signification inverse de celle 
qu’elles ont sur Macintosh concernant la sélection multiple.

Le reste des touches mortes utilisées dans SoundDiver s’appli-
que indifféremment à Windows et au Macintosh.

Sauvegarder vos réglages personnels
Vos assignations personnelles de touches sont mémorisées 
(ainsi que les réglages définis dans les pages de Preferences) 
dans un fichier intitulé “SoundDiver 3.0 Preferences” sur 
Macintosh et “SoundDiver 3.0 Preferences.PRF” sur PC 
Windows. Ces réglages peuvent être mémorisés dans n’importe 
quel fichier, n’importe où sur le disque dur, avec File > Save 
Prefs as... Il est prudent :
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• de faire une copie de sauvegarde de ce fichier à un autre 
emplacement de votre disque dur ;

• d’en faire une copie de sauvegarde sur disquette, au cas où 
vous auriez à utiliser un Système SoundDiver sur un autre 
ordinateur.

• Lorsque vous mettez à jour votre version de SoundDiver, 
vos raccourcis clavier personnels ne sont pas touchés.

Menus et Dialogues
Vous pouvez répondre à toutes les sollicitations et dialogues via 
votre clavier d’ordinateur conformément aux conventions de 
votre système d’exploitation. Utilisez R (Retour) ou ‰ pour 
valider le bouton OK, ™ pour activer le bouton Cancel (Annu-
ler).

Sous Windows, vous pouvez également gérer tous les menus au 
clavier.

• Même les raccourcis clavier généraux fixes des anciennes 
versions peuvent maintenant être configurés par l’utilisa-
teur. Pensez néanmoins qu’il sera préférable de ne pas modi-
fier certaines commandes comme Undo (Annuler), Save 
(Enregistrer), Quit (Quitter), New (Nouveau), Open (Ouvrir), Cut 
(Couper), Copy (Copier), Paste (Coller)..., qui obéissent à des 
“conventions communes”.

• Les raccourcis clavier attribués s’affichent en face des 
entrées de menu correspondantes.

Touches spéciales 
Certaines touches remplissent des fonctions spéciales :

• Les touches mortes S, ç et A ( : ç, O, S et C) ne 
peuvent être utilisées qu’associées à d’autres touches.

• La touche d’effacement (B) conserve de façon fixe la fonc-
tion “supprimer les objets sélectionnés”. On ne peut lui assi-
gner une fonction qu’en conjonction avec les touches mortes 
S, ç et A ( : ç, O, S et C).
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• Sous Windows seulement : la touche ç£ (fermer la 
fenêtre) et la combinaison de touches A£ (fermer l’appli-
cation) ne peuvent pas être réassignées.

• Les touches + et _ augmentent ou diminuent d’une unité 
toute valeur de paramètre. Elles peuvent toutefois recevoir 
d’autres attributions, qui remplaceront alors cette fonction.

La fenêtre Key Commands (Raccourcis-
clavier)
La fenêtre Key Commands s’ouvre avec Options > Settings > 
Key Commands…

Tous les raccourcis clavier disponibles sont listés à droite. Ils 
sont regroupés en fonction des catégories suivantes :
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• Global commands (Commandes globales)
• Functions affecting all windows (various windows) (Fonc-

tions affectant toutes les fenêtres (fenêtres diverses))
• Functions affecting Libraries (Fonctions affectant les biblio-

thèques)
• Functions affecting the Setup window (Fonctions affectant 

la fenêtre Setup)
• Functions affecting the Device window (Fonctions affectant 

la fenêtre Device)
• Functions affecting the Editor window (Fonctions affectant 

la fenêtre d’édition)
• Functions affecting the Install window (Fonctions affectant 

la fenêtre d’installation)
• Functions affecting the MIDI Monitor window (Fonctions 

affectant la fenêtre MIDI Monitor)
• Functions affecting the Controller Assignments window 

(Fonctions affectant la fenêtre des assignations de contrô-
leurs)

Un “•” (Macintosh) ou un “*” (Windows) placé devant la 
description de la fonction indique que la fonction n’est dispo-
nible que sous la forme d’un raccourci clavier ou d’une 
commande MIDI. A gauche se trouve la touche actuellement 
assignée et, encore plus à gauche, le message MIDI assigné. Un 
tiret à cet endroit signifie qu’aucune assignation n’a été attri-
buée.

Assigner une fonction à une touche
❏ Cliquez sur le bouton Learn Key (littéralement, “Apprendre

la touche”).

❏ Sélectionnez la fonction désirée à la souris.

❏ Appuyez sur la touche désirée, au besoin avec la ou les tou-
ches mortes désirées (S, ç, O et C sur le Macintosh et
S, ç et A sous Windows).

❏ Si vous voulez effectuer une autre assignation, répétez les
points 2 et 3.

❏ Désactivez “Learn Key”.
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Vous pouvez aussi choisir la touche et la touche morte depuis 
les menus déroulants de la case des paramètres (en haut à 
gauche).

Learn Separate Key
Learn Separate Key (littéralement, “apprendre la touche 
distincte”) fonctionne de la même manière, à cette différence 
près qu’ici, ce n’est pas un code ASCII qui sera mémorisé, mais 
le code spécifique de la touche choisie.

Dans la pratique, cela signifie que vous pouvez, par exemple, 
assigner aux touches des chiffres du pavé numérique des 
commandes différentes de celles attribuées aux touches des 
chiffres de la partie principale du clavier - et cela vaut aussi pour 
les différentes touches  et — du pavé numérique et du clavier 
principal. Le seul inconvénient est que c’est le code de la 
touche (soit un chiffre) qui s’affichera dans la fenêtre Key 
Commands au lieu du symbole ASCII, plus facile à repérer.

& S’il n’existe qu’un seul raccourci clavier défini pour la touche, il sera utilisé indiffé-
remment pour les deux touches identiques.

& Si deux raccourcis clavier ont été définis (un pour le pavé alphanumérique et un pour 
le pavé numérique), c’est le raccourci clavier concerné qui sera utilisé.

Assigner une fonction à un message MIDI
❏ Cliquez sur le bouton Learn MIDI.

❏ Sélectionnez à la souris la fonction désirée.

❏ Transmettez le message MIDI désiré depuis votre contrô-
leur.

❏ Si vous voulez effectuer d’autres assignations, répétez les
étapes 2 et 3.

❏ Désactivez Learn MIDI.

& Si vous souhaitez assigner un message de Note On (“début de note”), pensez à 
désactiver Learn MIDI avant de relâcher la touche en question (et par conséquent de 
transmettre un message de Note Off, ou “fin de note”). C’est toujours le dernier 
message reçu qui sera utilisé.
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Vous pouvez définir le type de message, le canal, le premier et 
le second octet de données dans la case des paramètres, à l’aide 
des menus déroulants ou à la souris.

Supprimer des assignations
❏ Cliquez sur Learn Key, pour effacer les assignations de tou-

ches, et/ou sur Learn MIDI, pour effacer les assignations
MIDI.

❏ Utilisez la souris pour sélectionner la fonction dont vous
voulez effacer l’assignation de touche ou l’assignation
MIDI.

❏ Appuyez sur B.

❏ Pour effacer d’autres assignations, répétez les étapes 2 et 3.

❏ Désactivez le bouton Learn Key et/ou Learn MIDI.

Activer/désactiver la télécommande MIDI 
Avec le bouton MIDI Remote (“télécommande MIDI”) vous 
pouvez activer/désactiver de façon globale la réaction à tous les 
messages MIDI. La commande MIDI qui régit cette fonction 
(Toggle MIDI remote, ou “inverser la télécommande MIDI”) 
est active en permanence, même lorsque MIDI Remote est 
désactivé, et reste donc toujours disponible.
& Si vous avez assigné des commandes MIDI Remote à toutes les touches de votre 

clavier maître, nous vous conseillons d’utiliser pour la fonction Toggle MIDI Remote 
une deuxième pédale ou un bouton programmable sur votre clavier, que vous serez 
sûr de ne pas enclencher involontairement pendant l’enregistrement. Si vous n’avez 
rien de tel, utilisez une touche difficile à enfoncer par erreur (par exemple la touche 
la plus basse ou la plus haute) - mais rappelez-vous que, du coup, cette touche ne 
sera plus disponible pour enregistrer des notes.

Disable MIDI Remote désactive la télécommande MIDI.

Vérifier la fonction d’une touche
Désactivez Learn Key et Learn sep. Key puis enfoncez la touche 
dont vous voulez vérifier la fonction. La fonction sera automa-
tiquement sélectionnée et affichée au milieu de la fenêtre.
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Rendre l’affichage plus clair
Vous pouvez, grâce aux boutons Hide Used (Masquer utilisés) et 
Hide Unused (Masquer inutilisés), faire disparaître de la fenêtre 
tous les raccourcis clavier utilisés ou inutilisés.
Toutes les autres fonctions de la fenêtre Key Commands 
restent valides.

Rechercher des raccourcis clavier
Le grand nombre des raccourcis clavier possibles peut parfois 
rendre difficile la recherche d’un raccourci clavier spécifique. 
SoundDiver propose à cet effet une fonction de recherche, 
Find (“rechercher”), qui permet de lancer la recherche en 
saisissant le nom du raccourci clavier (ou une partie du nom).

Cliquez simplement sur l’espace blanc à droite du bouton Find: 
et saisissez la chaîne de caractères que vous recherchez. La 
fenêtre n’affiche plus alors que les raccourcis clavier qui 
contiennent cette chaîne de caractères (plus le raccourci actuel-
lement sélectionné, même s’il ne contient pas cette chaîne).

La fenêtre Key Commands reste active, même en mode Find ; 
il n’est pas nécessaire de quitter ce mode pour effectuer de 
nouvelles assignations.

& La fonction Find n’est pas sensible à la casse et ne fait donc pas la distinction entre 
majuscules et minuscules.

Les boutons Hide Used et Hide Unused agissent en collaboration 
avec Find, ce qui signifie qu’il faut évidemment les désactiver 
tous deux pour pouvoir voir toutes les commandes qui corres-
pondent aux critères de recherche, quelle que soit leur assigna-
tion actuelle.

Le bouton Find: active ou désactive le mode Find. Le bouton 
est automatiquement activé si une chaîne de caractères est 
saisie.
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Scroll to Selection
Le menu Options > Scroll To Selection fait défiler la fenêtre des 
raccourcis clavier jusqu’au raccourci sélectionné. Désactiver le 
bouton Find: accomplit automatiquement la même fonction.

Imprimer la liste des raccourcis clavier
La fonction Options > Copy Key commands to Clipboard copie 
les raccourcis clavier dans le presse-papiers au format texte. A 
partir de là, rien de plus facile que de coller le résultat dans un 
document de traitement de texte, de le formater à votre guise 
et de l’imprimer.

La fonction Copy Key commands to Clipboard prend égale-
ment en compte les réglages des fonctions Hide et Find:. Cela 
permet, par exemple, de n’exporter qu’un groupe de raccourcis 
clavier donnés (par ex. tous ceux contenant une chaîne précise 
de caractères). Le contenu de la fenêtre est le fidèle reflet de ce 
qui sera exporté.

Sauvegarder des assignations de raccour-
cis clavier
Vos assignations sont automatiquement mémorisées dans le 
fichier Preferences lorsque vous quittez le programme. Vous 
pouvez néanmoins sauvegarder vos raccourcis clavier à la main, 
avec File > Save Preferences. Cela mémorise également tous les 
autres réglages de Preferences.

Importer des raccourcis clavier
Cette fonction prend tout son intérêt si vous devez travailler 
temporairement sur une autre installation que la vôtre ; vous 
voudrez pouvoir y utiliser vos assignations de touches person-
nelles mais sans modifier les réglages Système.

La fonction Options > Import Key commands... de la fenêtre 
Key Commands vous permet d’importer les assignations de 
touches de tout fichier “SoundDiver 3.0 Preferences.PRF”, à 
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l’aide d’un sélecteur de fichier typique au travers duquel vous 
pourrez aller rechercher votre fichier SoundDiver 3.0 Preferen-
ces personnel.

Le fichier Preferences du dossier Diver qui était utilisé 
jusqu’alors sera renommé “SoundDiver 3.0 Preferences.bak”. 
Il contient les anciens raccourcis clavier.

Il n’est pas nécessaire de relancer SoundDiver pour continuer.

Initialiser des assignations de touches ou 
d’événements MIDI 
La commande Options > Initialize > ... initialise soit l’ensemble 
des options de Préférences (... All Preferences except 
Commands), soit l’ensemble des assignations de touches (... All 
Key commands) soit l’ensemble des commandes MIDI (... All 
MIDI Commands). Toutes les assignations sont alors ramenées à 
leur valeur par défaut.

Notez bien que toutes vos assignations personnelles de 
raccourcis clavier seront perdues si vous n’avez pas créé votre 
exemplaire personnalisé du fichier “SoundDiver 3.0 Preferen-
ces.PRF”.

 : Toutes les assignations “OMS” sont effacées lorsque vous 
utilisez ...All Preferences except Commands.

Saisir des nombres
Il vaut mieux utiliser les touches de chiffres du pavé numéri-
que si le nombre appartient à un raccourci clavier (exemple : 
C(). Naturellement, les touches des chiffres du clavier alpha-
numérique fonctionnent aussi, ce qui vous permettra, si vous 
n’avez pas de pavé numérique (par ex. si vous avez un Power-
Book), d’utiliser la touche 5 au lieu du % du pavé numérique.
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Visite guidée de 
SoundDiver

Nous vous avons préparé une visite guidée rapide de SoundDi-
ver afin de vous familiariser avec le logiciel aussi vite et aussi 
facilement que possible. Vous êtes libre de vous arrêter à 
chaque étape de cette visite et de tenter vos propres expérien-
ces avec SoundDiver.

Il nous semble utile que vous commenciez par consacrer une 
demi-heure à ce tour d’horizon qui vous fera gagner beaucoup 
de temps par la suite. En attendant, vous bénéficierez d’une 
vue d’ensemble du logiciel avant de vous plonger dans les 
détails.

Avant de commencer la visite :

installez SoundDiver :

❏ connectez au moins un appareil - l’idéal étant d’en connec-
ter au moins deux

❏ assurez-vous que vous disposez de suffisamment d’espace
sur disquette ou sur disque dur pour pouvoir créer une
bibliothèque.

L’appareil utilisé dans la plupart des exemples est le Yamaha 
EX5. Le Yamaha SY99 et l’access Virus sont également 
employés. Vous n’êtes bien sûr pas obligé d’utiliser ces machi-
nes. Vous pouvez au contraire utiliser l’appareil de votre choix, 
les fonctions de SoundDiver étant sensiblement les mêmes 
pour tous les appareils.

Paré au décollage ? C’est parti...

Chapitre 3
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3.1 Démarrage
La visite débute par un double-clic sur l’icône du programme 
SoundDiver. SoundDiver démarre.

 : il faut commencer par configurer les ports. Veuillez vous 
reporter au § OMS à la page 66

Au bout de quelques instants, la fenêtre “Install” s’ouvre et un 
dialogue de bienvenue apparaît, dans lequel vous allez devoir 
sélectionner les appareils dont vous disposez puis taper R.
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3.2 Étape 1 : les fenêtres Setup 
et Install

La fenêtre Setup (fenêtre de configuration) affiche le système 
MIDI connecté sous forme d’icônes (symboles). Vous pouvez y 
sélectionner les appareils que vous souhaitez éditer. Si vous 
n’avez encore installé aucun appareil, la seule icône visible sera 
celle de votre ordinateur. Cela changera dès que SoundDiver 
aura automatiquement localisé et installé les appareils connec-
tés à l’aide de la fonction Scan. (Si vous avez déjà lu le chapitre 
Installation à partir de la page 41 et suivantes et que vous avez 
réussi à installer votre système, vous pouvez sauter les deux 
étapes d’installation suivantes). 
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Scanner
Pendant l’opération de scan, SoundDiver examine tous les 
ports MIDI pour y détecter la présence de l’appareil recherché. 
Il commence pour cela par charger le module ou l’adaptation et 
envoie des “Requêtes” MIDI. Si un appareil répond, SoundDi-
ver l’installe et le rend disponible.

Assurez-vous que vos appareils sont branchés dans les deux 
directions. A droite de la fenêtre de Setup, vous devez voir la 
fenêtre Install (fenêtre d’installation). Si ce n’est pas le cas 
(notamment si vous avez déjà installé un appareil, auquel cas la 
fenêtre Install ne s’ouvre pas automatiquement), sélectionnez 
New > Install... dans la fenêtre Setup. Pour pouvoir voir ce 
menu, la fenêtre Setup doit être la fenêtre active.

Cliquez sur le bouton Scan All (Tout scanner). La procédure de 
scan commence. Si SoundDiver trouve un appareil, une icône 
apparaît dans la fenêtre Setup.

La fenêtre Setup doit finir par ressembler à ceci :

Cela signifie que vos appareils ont été installés.

Si vous rencontrez un problème, veuillez vous reporter au § 
Exploration (Scanning) à la page 427, Annexe C Dépannage.
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Si au terme de l’opération de scan, tous les appareils de votre 
système n’ont pas été installés, la prochaine étape consistera à 
ajouter ces appareils à la main.

Installer des appareils à la main
Si la fenêtre Install n’est pas encore ouverte, sélectionnez New 
> Install... dans la fenêtre Setup.

Nous allons à présent installer un appareil manuellement. La 
liste se présente dans l’ordre alphabétique, en fonction du nom 
du constructeur et de celui du modèle. Trouvez l’entrée corres-
pondant à “Waldorf microWAVE XT”, cliquez dessus puis 
cliquez sur le bouton Add.

& Si vous possédez déjà un Microwave dans votre système, installez quand même ce 
deuxième exemplaire, cela n’affectera pas les réglages du Microwave d’origine.

L’icône concernée (affichée en vidéo inverse) apparaîtra dans la 
fenêtre Setup. Fermez à présent la fenêtre Install en cliquant 
sur le bouton Done. Nous reviendrons plus tard à ce Microwave 
nouvellement installé.

Utilisation des fenêtres
Avant que nous en arrivions aux fonctions de Setup elles-
mêmes, il sera bon de vous familiariser avec les fonctions rela-
tives à la configuration des fenêtres. Ces fonctions sont accessi-
bles dans les fenêtres Setup, Library et Device de SoundDiver.

Agencement des fenêtres 
A gauche de la fenêtre Setup se trouve la case des paramètres. 
Elle affiche les paramètres de l’appareil actif et vous permet de 
les ajuster à votre goût et aux spécificités de votre système.

Un petit triangle se trouve dans le coin supérieur gauche de la 
case des paramètres. Un clic sur ce triangle agrandit ou rétrécit 
cette case. Cette fonction est également présente dans les 
autres fenêtres de SoundDiver.

Déplacez maintenant le pointeur de la souris sur la ligne verti-
cale vers la limite gauche de la région des icônes. Le pointeur se 
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transforme en symbole de double-flèche. Maintenez le bouton 
de la souris enfoncé et déplacez la souris latéralement. Grâce à 
cette méthode, vous pouvez adapter chaque fenêtre de Sound-
Diver à toutes les situations. Cette fonction se révèle particu-
lièrement utile si les noms des ports MIDI sont en partie 
cachés. Ramenez la ligne verticale à sa position d’origine. 

Menus locaux
Vous avez déjà utilisé le menu local “New” pour installer vos 
appareils MIDI. 

Windows: la plupart des fenêtres de SoundDiver possèdent des 
menus supplémentaires spécifiques (“menus locaux”) dans 
leur barre de menus - placés entre les menus Options et 
Windows - et dont les fonctions ne s’appliquent qu’à la fenêtre 
en question.

 : La plupart des fenêtres de SoundDiver contiennent aussi 
une barre de menus locaux dont les fonctions ne s’appliquent 
qu’à cette fenêtre. La barre de menus principale reste visible.

Sélectionnez à présent View > Parameters dans le menu local 
de la fenêtre Setup. La case des paramètres disparaît, libérant 
toute la fenêtre pour la configuration MIDI. Si vous sélection-
nez à nouveau le même article de menu, la case des paramètres 
réapparaît.

Faire défiler le contenu de la fenêtre
Dans d’autres logiciels, vous avez certainement déjà rencontré 
les barres de défilement situées le long du bord droit et du bord 
inférieur des fenêtres. Dans SoundDiver, elles sont plus prati-
ques, puisque le contenu de la fenêtre se déplace au fur et à 
mesure que vous faites glisser les ascenseurs. De cette façon, 
vous savez toujours où vous vous trouvez. 

Cliquez n’importe où dans la zone vide située à l’opposé de 
l’ascenseur dans la barre de défilement. Le contenu de la fenê-
tre se déplace d’exactement une page dans la direction voulue.

Avec un clic maintenu sur l’outil de défilement x/y (une petite 
case au coin inférieur gauche de toutes les fenêtres) vous 
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pouvez déplacer la section visible de la fenêtre à la fois horizon-
talement et verticalement. Cela fonctionne également avec la 
molette d’une souris à molette.

La case des paramètres 
La case des paramètres de la fenêtre Setup est l’endroit où se 
configurent les paramètres de chaque appareil : SoundDiver 
utilisera ces réglages pour communiquer avec l’appareil.

Cliquez sur l’icône d’un appareil pour le sélectionner (il s’affi-
che en vidéo inverse). Le contenu de la case des paramètres 
change pour afficher les paramètres correspondant à cet appa-
reil. Si vous cliquez à présent sur l’icône du Microwave XT que 
vous venez d’installer, l’écran doit ressembler à ceci :

Nous allons commencer par attribuer un nouveau nom au 
Microwave XT de façon à pouvoir l’identifier clairement. 
Cliquez sur la ligne de nom dans la case des paramètres pour 
faire apparaître un champ texte. Saisissez “Waldorf 1” (notez 
que si vous tapez w le contenu précédent est remplacé par un 
W). Si vous appuyez maintenant sur R, le nom est validé. Nous 
reviendrons en détail sur les autres paramètres de la case des 
paramètres lorsque nous arriverons à la page 189.

Nous allons maintenant supprimer ce Microwave dont nous 
n’avons en réalité pas besoin.
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Il suffit pour cela de cliquer sur le symbole du Microwave et de 
sélectionner Edit > Clear. Le dialogue qui apparaît vous 
demande par sécurité de valider cette suppression, ce que vous 
confirmez avec OK.
Pour résumer brièvement, la fenêtre Setup est le reflet exact de 
votre configuration MIDI. C’est l’endroit où vous pouvez scan-
ner vos appareils, les installer à la main et les supprimer, ou 
encore ajuster leurs paramètres.
Passons à l’étape suivante…

3.3 Étape 2 : la fenêtre Device
De la même façon que la fenêtre Setup est le reflet exact de 
votre configuration MIDI, la fenêtre Device (fenêtre des péri-
phériques) décrit exactement le contenu de la mémoire d’un 
appareil.

Contenu de la fenêtre Device 
La fenêtre Device affiche tous les emplacements mémoire des 
sons, des multis, des tampons d’édition, des kits de batterie et 
de tout autre donnée contrôlée par l’appareil en interne ou sur 
carte. SoundDiver peut ainsi exploiter pleinement toutes les 
options MIDI de l’appareil.

Grâce au “Entry Link Management” (système de gestion des 
liens entre les entrées), SoundDiver peut voir si l’entrée actuel-
lement en cours d’édition (par ex. copiée ou déplacée) est utili-
sée par une autre entrée, et s’assure que ces références croisées 
restent intactes.

Exemple: Si vous déplacez une entrée (“entrée fille”) utilisée 
par une autre entrée (“entrée parent”), SoundDiver met auto-
matiquement à jour les paramètres correspondants dans 
l’entrée parent de façon à ce que celle-ci continue à utiliser le 
bon son. Cela signifie que vous pouvez déplacer vos sons à 
votre gré et que SoundDiver se charge du reste.

SoundDiver affiche ces entrées en gras pour une meilleure 
visualisation.
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Regardons de plus près la fenêtre Device. Pour les expériences 
suivantes, il va nous falloir un clavier MIDI avec un synthéti-
seur. Nous utiliserons un Yamaha SY99, mais on peut faire ces 
expériences avec n’importe quel clavier ou expandeur MIDI. 
Ouvrez la fenêtre Device en double-cliquant sur le symbole de 
votre appareil dans la fenêtre Setup. La fenêtre Device sera 
tout d’abord vide, à la possible exception d’entrées stockées 
dans la ROM.

Bien entendu, SoundDiver doit d’abord recevoir le contenu de 
la mémoire du clavier qui sera utilisé comme base des expé-
riences ultérieures. S’il vous manque un certain groupe de para-
mètres, ou si cette fenêtre est entièrement vide, sélectionnez 
View > Data types > Show all, pour afficher tous les types de 
données.
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Réclamer le contenu de la mémoire des 
appareils
Sélectionnez Edit > Select all. Tous les emplacements de la 
fenêtre Device s’affichent en noir, ce qui indique qu’ils ont été 
sélectionnés. Sélectionnez à présent Edit > Request. Un dialo-
gue affiche “Receiving data from...” (“réception de données 
de...”) et une petite barre indique la progression du transfert. 
Vous allez voir la fenêtre Device se remplir d’entrées.

& Bien que la fenêtre Device contienne habituellement les sons d’un synthétiseur, ce 
manuel préfère utiliser systématiquement le terme “d’entrées” plutôt que celui de 
“sons”, dans la mesure où les entrées peuvent également être constituées de 
programmes d’effets appartenant à une réverb, etc. Une entrée de la fenêtre Device 
peut également représenter une configuration de système, de batterie ou un 
tampon d’édition, auxquels cas le terme “son” serait inadéquat.

Regardons la fenêtre Device plus en détail : sur la gauche, vous 
reconnaissez la case des paramètres d’appareil, déjà rencontrée 
dans la fenêtre Setup. La fenêtre Device affiche tous les empla-
cements mémoire de l’appareil. Utilisez les barres de défile-
ment ou l’outil de défilement x/y mentionné précédemment 
pour accéder aux articles actuellement hors champ.

Sauvegarder le contenu de la mémoire des 
appareils
Ainsi qu’il a été dit plus haut, la fenêtre Device est l’exacte 
description de la mémoire interne de votre appareil (ainsi, le cas 
échéant, que de sa carte mémoire). Cela signifie que lorsque 
vous travaillez dans la fenêtre Device, vous avez directement 
accès au contenu de la mémoire de votre appareil, ce qui rend 
possible l’effacement accidentel de données. Il vaut donc 
mieux jouer la sécurité et permettre à SoundDiver de recevoir 
tout le contenu de la mémoire de vos appareils pour les sauve-
garder sur disque. Nous reviendrons en détail sur chacune des 
étapes dans un moment mais, pour l’instant, commencez par 
suivre les instructions ci-dessous :

❏ sélectionnez tous les appareils installés dans la fenêtre
Setup 
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❏ sélectionnez New > Build library > All entries dans le menu
local de la fenêtre Setup [TG2]. SoundDiver va alors lancer
une requête des données des appareils - si cela n’a pas déjà
été fait dans la section précédente - et créer une bibliothè-
que mixte nommée “UNTITLED”

❏ sélectionnez à présent File > Save. Vous pouvez maintenant
sauvegarder cette nouvelle bibliothèque sur votre disque
dur.

Même si vous modifiez par accident le contenu de la mémoire 
de votre appareil au cours des exercices suivants - bien que 
SoundDiver vous en avertisse chaque fois que possible - vous 
disposez désormais d’une copie de sauvegarde grâce à laquelle 
vous pourrez rétablir toutes vos données d’origine.

Sélectionner des entrées
Il existe différents moyens de sélectionner des entrées ou des 
groupes d’entrées.

La fenêtre Device sépare clairement les différents types de 
données (dans le cas présent en setup, performances et 
patches). Chaque zone possède sa propre petite barre de titre 
grisée.

Cliquez sur l’une de ces barres de titre pour sélectionner la 
zone désirée. Cliquez sur la barre de titre d’une colonne de la 
banque de patches pour ne sélectionner que cette colonne.

Sélectionnez Edit > Toggle pour sélectionner toutes les entrées 
sauf celles qui étaient sélectionnées auparavant. Cliquez à 
présent n’importe où dans la zone grisée pour annuler la sélec-
tion.

Pour sélectionner une entrée unique, cliquez dessus. En main-
tenant ç ( : S) vous pourrez sélectionner également d’autres 
entrées.

Parvenus à ce point, nous allons essayer une autre fonction : 
activez Verr. Maj. (la touche située au-dessus de S), appuyez 
sur la lettre e et observez ce qui se passe. SoundDiver sélec-
tionne la première entrée dont le nom commence par un “E”. 
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Si aucune entrée ne commence par “E”, c’est l’entrée suivante 
dans alphabet qui est sélectionnée. Appuyez maintenant sur T 
et c’est l’entrée suivante dans l’ordre alphabétique qui est 
sélectionnée. Appuyer sur ST vous emmènera dans l’autre 
sens.

Écouter les entrées sélectionnées
Pour transférer une entrée de la fenêtre Device au tampon 
d’édition approprié du synthétiseur concerné, activez Options 
> AutoAudition (cet article de menu est alors coché) et cliquez 
sur l’entrée.

Le Patch est très rapidement disponible pour écoute sur votre 
clavier.

Chaque fois que vous cliquez sur une entrée, celle-ci est auto-
matiquement transmise à l’appareil, ce qui vous permet 
d’écouter vos sons très vite et très facilement. Pour désactiver 
cette fonction, resélectionnez Options > AutoAudition.

Si vous activez également Options > AutoPlay, SoundDiver 
transmettra en outre une note de test, pratique si votre synthé-
tiseur ne dispose pas de clavier ou s’il est hors de votre portée 
depuis l’ordinateur.

Déplacer et copier des entrées
Dans la fenêtre Device, vous pouvez copier, déplacer, initialiser 
ou supprimer les entrées si vous voulez classer votre banque de 
sons ou créer une nouvelle banque à partir de plusieurs autres. 
Vous pouvez aussi copier des entrées d’une fenêtre Device à 
une autre, du moment qu’elles proviennent d’appareils identi-
ques ou compatibles.

& Dans ce cas, SoundDiver peut savoir automatiquement si les données sont converti-
bles lorsqu’il s’agit d’appareils d’une même famille. Vous pourrez, par exemple, 
copier des entrées entre un D-50 et un D-550 ou même entre un M 1 et un T 1 ou 
encore entre un DX 7 et un SY 77. Vous pouvez aussi copier des entrées à la souris 
au sein d’une bibliothèque (nous y reviendrons).

Attention : l’exercice suivant modifie le contenu de la 
mémoire de votre appareil.
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X

Saisissez une entrée à la souris et déplacez-la à un autre empla-
cement. Assurez-vous que vous restez dans la même banque, 
autrement dit ne déplacez pas un programme de son vers une 
configuration système ou une performance vers un kit de batte-
rie. Si vous déplacez une entrée sur une autre entrée, elles 
échangeront leurs emplacements.

Vous pouvez annuler l’opération avec Edit > Undo.

Si vous voulez dupliquer une entrée, maintenez la touche A 
( : O) enfoncée pendant que vous faites glisser l’entrée sur sa 
position de destination. Cette opération peut aussi être annu-
lée.

Et pour initialiser un son ou une performance ? Pas de 
problème. Sélectionnez simplement la ou les entrées concer-
nées et sélectionnez Entry > Initialize dans le menu local de la 
fenêtre Device. SoundDiver ramènera alors tous les paramètres 
de cette entrée à leurs valeurs neutres. C’est l’équivalent de la 
fonction d’initialisation présente sur de nombreux synthéti-
seurs et autres appareils.

Passons maintenant à l’étape suivante : la bibliothèque.
101
Mode d’Emploi
Version 3.0



 – Visite guidée de SoundDiver
3.4 Étape 3 : la Bibliothèque

Une bibliothèque dans SoundDiver est une sorte de base de 
données de sons et autres données mémorisables de vos appa-
reils MIDI. Comme dans une base de données, vous pouvez 
retrouver, classer, supprimer et copier des entrées en fonction 
de critères donnés.

La particularité des bibliothèques de SoundDiver est de vous 
permettre de réunir des programmes provenant d’appareils 
différents : des patches de Roland JV-80, des voix de Yamaha 
SY 99, des programmes d’effets de Quadraverb Alesis - tous ces 
éléments peuvent être stockés en même temps dans une seule 
bibliothèque. On peut compiler les bibliothèques de diverses 
manières.

Dans le § Sauvegarder le contenu de la mémoire des appareils à la 
page 98 vous avez créé une bibliothèque et vous l’avez sauve-
gardée sur disque. Nous allons maintenant porter notre atten-
tion sur cette bibliothèque.
102
Emagic
SoundDiver 



Étape 3 : la Bibliothèque
Veuillez sélectionner Windows > Untitled.

Cliquez sur l’outil d’agrandissement maximum de la fenêtre 
dans le coin supérieur droit de la fenêtre de la Bibliothèque afin 
de l’afficher sur toute la surface de l’écran.

Configuration par l’utilisateur de la fenêtre 
de la Bibliothèque 

Comme vous pouvez le voir, la fenêtre Library affiche, outre le 
nom des entrées, une série de données importantes sur chaque 
entrée qui vous serviront à lancer des recherches, à trier ou 
simplement à identifier les entrées séparément les unes des 
autres.

Observons attentivement les détails de la fenêtre Library. Vous 
remarquez qu’elle comporte elle aussi une case des paramètres, 
qui affiche en seul tableau les paramètres de chaque entrée. Si 
la case des paramètres n’est pas visible, sélectionnez View > 
Parameters.

Modifions quelque peu l’affichage. Par exemple, pour l’instant 
nous n’avons pas besoin de voir la colonne des commentaires, 
alors autant nous en débarrasser. Sélectionnez l’article View > 
Comment qui jusqu’ici était coché. La colonne des commentai-
res disparaît et les colonnes qui étaient placées à sa droite sont 
déplacées vers la gauche. Faites à présent de même avec la date 
puisque pour l’instant la date de toutes les entrées de la biblio-
thèque est la même.
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Classer
Nous allons maintenant classer l’affichage de la bibliothèque 
par nom des entrées dans l’ordre alphabétique. Il y a deux 
façons de procéder. Vous pouvez soit double-cliquer sur le 
champ “Name” dans la barre de titre soit sélectionner Sort > 
Sort by Name (Classer par noms) dans le menu local.

Essayez ensuite de classer l’affichage de la bibliothèque avec 
Sort by Data type (Classer par types de données) et Sort by Size 
(Classer par taille).

Pour plus de détails, voir le § La Bibliothèque à partir de la page 
243 et suivantes

Déplacer les colonnes et modifier leur 
largeur
Vous préférez voir la colonne des modèles à gauche ? Pas de 
problème. Saisissez la légende “Model” dans la barre de titre et 
déplacez-la sur la légende “Name”. Les colonnes sont échan-
gées.

Vous jugez la colonne “Used by...” (Utilisé par...”) trop large ? Il 
suffit de cliquer-maintenir le bord droit du champ dans la barre 
de titre et de faire glisser la souris vers la gauche dès que son 
pointeur se transforme en une double flèche.

Si vous avez suivi ces instructions, la bibliothèque doit ressem-
bler à ceci :
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Vous pouvez à tout moment modifier l’affichage de la liste afin 
d’obtenir la meilleure vue d’ensemble possible.

Bibliothèques mixtes
Un des grands avantages des bibliothèques de SoundDiver est 
de vous permettre de gérer dans une même bibliothèque des 
entrées provenant d’appareils différents. Si vous possédez 
plusieurs appareils MIDI et que vous les avez installés dans la 
fenêtre Setup, votre bibliothèque sera déjà mixte puisqu’elle 
contiendra des données provenant des différents appareils. Si 
vous voulez rassembler toutes les entrées appartenant à un 
même appareil, il vous suffit de les classer avec Sort > Sort by 
Model (Classer par modèle).

Diviser une bibliothèque en zones
Vous pouvez aussi diviser une bibliothèque en zones portant 
chacune un titre approprié. Les fonctions de tri fonctionneront 
alors automatiquement à l’intérieur d’une zone. Faites-en 
l’expérience en essayant de classer votre bibliothèque mixte 
par modèle. Localisez à présent le point où commencent les 
entrées du prochain appareil, et sélectionnez la première 
entrée de cet appareil.

Sélectionnez Library > Insert title (Insérer titre) dans le menu 
local. Dans le champ texte qui s’ouvre alors, saisissez ceci : 
“Memory contents of <device name>” (Contenu de la mémoire 
de <nom de l’appareil>). A présent, classer les noms par ordre 
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alphabétique. Vous constaterez que SoundDiver effectue un 
classement alphabétique séparément dans les zones situées au-
dessus et au-dessous du titre.

Supprimez à nouveau le titre en le sélectionnant et en 
appuyant sur B.

Fonctions de recherche
Même la meilleure des bibliothèques ne vous servira à rien si 
vous ne pouvez pas retrouver rapidement tel ou tel son ou telle 
ou telle entrée. SoundDiver offre donc toute une palette de 
fonctions de recherche qui vous aideront à trouver tout de suite 
ce que vous cherchez, qu’il s’agisse du bon son de piano ou de 
toutes les performances d’EX5 - et cela jusque dans les biblio-
thèques les plus volumineuses.

Imaginons que vous vouliez savoir s’il existe des sons de basse 
dans votre bibliothèque. Nous allons devoir commencer par 
utiliser le nom dans notre recherche, autrement dit nous allons 
demander à SoundDiver de rechercher les entrées dont le nom 
contient la syllabe “bas”.

Sélectionnez Edit > Find (Rechercher). Une fenêtre de saisie 
s’ouvre. Tapez “bas” et cliquez sur Find. SoundDiver va rame-
ner la première entrée de la bibliothèque qui correspond au 
critère et la sélectionner. Fermez maintenant la fenêtre Find.

Activez Options > AutoPlay et AutoAudition.

Sélectionnez ensuite Edit > Find Again (Continuer la recher-
che).

S’il existe un autre son de basse, SoundDiver va le trouver, le 
transmettre à l’appareil et le faire jouer. Vous pouvez continuer 
à activer Find Again jusqu’à ce que vous ayez trouvé tous les 
sons de basse de la bibliothèque.

Et que se passe-t-il dans le cas d’une recherche sur des critères 
complètement différents ? Mettons que vous souhaitiez trans-
férer toutes les données d’EX5 d’une bibliothèque mixte à une 
nouvelle bibliothèque distincte.
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Ouvrez la fenêtre Find avec Edit > Find… et cliquez sur More 
Options (Options supplémentaires). Entrez le texte “EX 5”:

SoundDiver recherche alors les entrées provenant du modèle 
“EX 5” et sélectionne tous les résultats de la recherche à la fois. 
Vous pouvez utiliser les fonctions standard couper et coller pour 
transférer ces résultats vers une autre bibliothèque ou les 
copier par glisser-déposer.

Il est temps de plonger plus profond au cœur de SoundDiver, et 
d’explorer quelques-unes de ses exceptionnelles capacités 
d’édition.

3.5 Étape 4 : les Éditeurs
Le principe est simple : chaque module et la plupart des adap-
tations dans SoundDiver qui utilisent déjà les fenêtres Device, 
Setup et Library disposent également d’un éditeur complet 
pour l’appareil concerné.
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Autrefois, ce genre de programme était souvent écrit spéciale-
ment pour un appareil donné. Il y avait un éditeur de DX 7, un 
autre de Korg M1, etc. Si vous utilisiez plusieurs appareils, il 
vous fallait charger un programme différent pour chaque appa-
reil. Cela ne posait pas de gros problème il y a quelques années 
lorsque la moyenne des configurations ne comprenait qu’un 
faible nombre d’appareils.

Dans une configuration MIDI plus importante regroupant de 
nombreux petits synthétiseurs auxquels s’ajoutent des effets et 
des baies de raccordement MIDI, cette procédure est devenue 
trop encombrante. Imaginons qu’à la fin d’une séance, vous 
vouliez sauvegarder les sons de tous vos appareils dans l’ordina-
teur. Vous chargez le logiciel de gestion des sons du premier 
appareil, vous sauvegardez les sons, vous chargez le logiciel 
gérant l’appareil suivant et ainsi de suite...

Grâce à SoundDiver, vous pouvez organiser vos sons de façon 
universelle pour tous vos appareils. Au cours d’une séance de 
production, il faut souvent changer ou éditer les sons d’un 
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arrangement, si possible pendant que le séquenceur tourne et 
sans devoir lancer et quitter des programmes en permanence.

C’est justement ce que permet SoundDiver. Vous pouvez 
ouvrir plusieurs éditeurs à la fois, avec pour chacun d’entre eux 
plusieurs fenêtres offrant des vues différentes des paramètres 
de son. Vous pouvez zoomer sur l’enveloppe d’un EX5 à l’écran 
tandis qu’une autre fenêtre vous montre toute la section 
d’effets.

Grâce aux Screensets, vous pouvez exploiter à fond toutes ces 
options, même sur un écran de petite taille.

Allons-y...
Faisons un peu d’édition dans un EX 5. Par sécurité, assurez-
vous que vous avez bien créé une bibliothèque de sauvegarde 
de l’ensemble des éléments de la mémoire de l’EX 5, afin de ne 
rien changer par accident de façon irréversible. La procédure 
ressemble à celle décrite dans le § Sauvegarder le contenu de la 
mémoire des appareils à la page 98. Commencez par ouvrir la 
fenêtre Device de l’EX 5 (ou celle de votre appareil préféré).

... dans la bibliothèque
Sélectionnez Entry > Build Library (Construire bibliothèque) 
dans le menu local de la fenêtre Device. Celle-ci comporte un 
sous-menu dans lequel se sélectionnent des groupes d’entrées 
spécifiques :
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Comme nous voulons sélectionner toutes les entrées, il va 
falloir sélectionner All Entries (étonnant, non ?).

SoundDiver effectue automatiquement un certain nombre 
d’opérations : il reçoit les sons, crée et ouvre une nouvelle 
bibliothèque puis y copie les entrées reçues.

Bienvenue dans le monde de la program-
mation par plaisir...
Si vous cliquez sur une entrée, SoundDiver ouvre l’Éditeur 
(voir le diagramme ci-dessus) dans lequel vous pouvez immé-
diatement commencer à modifier le son. 

❏ activez tout d’abord Options > AutoAudition et AutoPlay

❏ double-cliquez sur un son pour ouvrir l’Éditeur. Faites des
essais de façon aléatoire sur les divers éléments - déplacez
les curseurs, redessinez les enveloppes et activez/désacti-
vez les fonctions. Vous pouvez entendre en temps réel les
résultats de vos manipulations 

❏ quittez l’Éditeur en cliquant sur la case de fermeture de la
fenêtre.

Si vous êtes satisfait des résultats de votre programmation aléa-
toire, cliquez sur Store (Mémoriser) dans le dialogue qui appa-
raît. Vous pouvez également choisir un emplacement différent 
pour le son édité dans le menu déroulant du dialogue. Pour 
cette fois, il vaudra probablement mieux cliquer sur Don’t Store 
(Ne pas mémoriser).
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Une poignée de fonctions d’édition...
Nous allons maintenant essayer l’Éditeur dans le détail. Avez-
vous connecté un appareil et ouvert l’Éditeur ? Si tel est le cas, 
vous devez avoir sous les yeux une fenêtre d’Éditeur.

Le diagramme montre une fenêtre d’Éditeur typique, ici celle 
d’un EX 5 :

Voici l’Overview (ou vue d’ensemble) qu’affichent au départ 
les appareils les plus complexes. Elle affiche d’un seul coup 
d’œil tous les éléments d’un son ou d’un programme.

On y trouve plusieurs macro paramètres (volume, pan, 
detune...) qui permettent d’éditer le son vite et aisément. Vous 
êtes sur “l’Easy Page”.

Utilisez ces fonctions pour éditer un son sans avoir à rentrer 
trop dans les détails. Dans l’exemple figurant sur ce 
diagramme, le point de fréquence de coupure a été augmenté, 
la résonance a été légèrement diminuée et l’attaque a été allon-
gée.

Imaginons que nous voulions éditer l’enveloppe du filtre du 
ton 1. Cliquez sur ce bouton dans l’Overview et SoundDiver 
passe en vue détaillée.

Essayez de vous représenter un éditeur de SoundDiver un peu 
comme un plan de ville. La fenêtre Éditeur affiche une certaine 
section de ce plan. L’Overview, au contraire, représente la carte 
tout entière à plus grande échelle.
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En vue détaillée, tous les paramètres de l’appareil sont affichés, 
et cela de façon nettement plus pratique et plus facile à gérer 
que sur l’appareil lui-même. On peut y éditer les enveloppes 
graphiquement et on dispose de boutons, de représentations de 
largeur de bande et de menus déroulants.

Le diagramme montre une section de la vue détaillée de 
l’éditeur de l’EX5, qui affiche d’un seul coup d’œil toutes les 
commandes principales.

Dans chaque éditeur, il est possible d’ouvrir plusieurs fenêtres 
qui peuvent montrer n’importe quelle section. Cette disposi-
tion trouve tout son intérêt, par exemple, lorsque vous voulez 
voir en même temps le bord gauche et le bord droit d’un 
éditeur détaillé. Au lieu de faire constamment défiler la vue 
d’une section à l’autre, ouvrez tout simplement une seconde 
fenêtre avec Windows > Open Editor. Placez-la contre la 
première et faites-la défiler jusqu’à la section voulue. Ou, autre 
exemple, supposons que vous vouliez voir en même temps la 
vue générale et une vue détaillée d’un son, comme sur le 
diagramme. Aucun problème, ouvrez deux fenêtres et réglez 
chacune d’entre elles en fonction de la vue dont vous avez 
besoin.
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Grâce aux Screensets, vous pouvez rappeler instantanément les 
différentes vues d’Éditeurs.
Si vous ignorez la signification d’un paramètre, cliquez dessus 
et appuyez sur @ ( : H).L’aide en ligne de SoundDiver affi-
che immédiatement l’information correspondante.
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Si vous laissez le pointeur de la souris immobile au-dessus d’un 
paramètre d’objet, une petite fenêtre s’ouvre avec une courte 
explication et la valeur actuelle du paramètre jusqu’à ce que 
vous déplaciez à nouveau le pointeur de la souris.

Ce n’est pas tout. Les fonctions du menu Edit sont également 
disponibles dans l’Éditeur. Vous pouvez ainsi copier à votre gré 
les composantes du son et les groupes de paramètres, même 
entre des entrées différentes. Cliquez sur un groupe de para-
mètres tout en maintenant la touche S pour le sélectionner. 
Cette fonction n’est accessible que dans les modules.

Le diagramme ci-dessus montre un groupe de paramètres 
sélectionnés (DFC). Vous pouvez utiliser Edit > Cut, Copy et 
Paste (couper, copier, coller) pour le copier via le tampon 
d’édition dans d’autres composantes du son (tons, éléments, 
voix) et bien entendu dans d’autres sons.
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Fonctions aléatoires
Si vous ne ressentez pas le besoin impératif de programmer 
vous-même, ou s’il vous faut une base de départ pour créer, 
essayez donc la fonction aléatoire de SoundDiver. Elle est non 
seulement capable de créer des sons entiers au hasard, mais 
également des groupes de paramètres individuels. Une enve-
loppe aléatoire dans un son d’effet, une nouvelle forme d’onde 
aléatoire dans un son de nappe - et voilà un son totalement 
renouvelé.

Le diagramme montre l’article de menu “Random value” 
(Valeur aléatoire) dans le menu Editor, avec, juste à côté, une 
enveloppe générée de façon aléatoire -pas mal, non, l’enve-
loppe ?
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3.6 Étape 5 : L’aide en ligne
SoundDiver dispose d’une fonction exhaustive d’aide en ligne 
intégrée. Cela revient à avoir un manuel individuel pour les 
modules et les adaptations, qui décrit les caractéristiques de 
chacun d’entre eux. L’aide en ligne est interactive et réagit au 
contexte. Cela a peut-être l’air un peu compliqué mais signifie 
en pratique que SoundDiver s’arrangera toujours pour vous 
fournir un texte d’aide adapté à la situation en cours. Faisons 
l’essai tout de suite.
Appelez la fenêtre Setup et placez-la de façon à occuper la 
gauche de l’écran. Puis sélectionnez Windows > Help.
Nous ne saurions trop vous conseiller de prendre l’habitude de 
faire appel à l’aide en ligne chaque fois que vous rencontrerez 
un problème. Sélectionnez un de vos appareils dans la fenêtre 
Setup et jetez un coup d’œil sur l’ensemble de ses messages 
d’aide. Familiarisez-vous avec les différents sujets abordés. De 
la sorte, en cas de difficultés, vous saurez immédiatement où 
trouver l’information pour résoudre votre problème.

3.7 Autres fonctions

Le Mini-Séquenceur
Parmi les éléments importants de SoundDiver se trouve le 
mini-séquenceur. Sa fonction ne consiste pas à enregistrer des 
morceaux MIDI entiers mais à vous permettre d’enregistrer 
une mélodie ou une phrase qui vous servira à tester les sons.
Le séquenceur s’ouvre avec Windows > Sequencer. La fenêtre 
du séquenceur est une fenêtre “flottante” par défaut qui reste 
en permanence au premier plan et ne se place jamais à l’arrière-
plan, même si vous activez une autre fenêtre.
Vérifiez en jouant quelques notes que votre clavier MIDI est 
correctement raccordé. Si le séquenceur reçoit des notes, une 
barre apparaîtra dans le champ jusque-là intitulé “NO IN” dans 
la fenêtre du séquenceur et des informations sur les notes s’affi-
cheront.
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La partie inférieure du séquenceur comporte des boutons de 
transport, semblables à ceux d’un magnétophone. Cliquez sur 
le bouton d’enregistrement (en haut à droite). Vous entendrez 
un signal de métronome provenant du haut-parleur de votre 
ordinateur ; le compteur du séquenceur reste coincé sur le 
premier temps - cela signifie que le séquenceur est en mode 
d’attente.
Jouez à présent une courte phrase d’environ quatre mesures. A 
la fin de cette phrase, cliquez sur le bouton stop (en bas à 
droite). La phrase a été enregistrée. Vous pouvez l’écouter en 
cliquant sur le bouton play (“lecture”, au-dessous, au milieu).
Appelez la fenêtre Library ou Device. Si vous avez activé 
Options > AutoPlay et AutoAudition, comme décrit plus haut, 
une entrée sera transmise à votre appareil MIDI dès que vous 
cliquerez dessus et le séquenceur jouera automatiquement la 
phrase de test.

Screensets
SoundDiver mémorise la disposition des fenêtres et divers 
autres réglages sous la forme de “Screensets”. Vous pouvez 
créer jusqu’à 90 Screensets différents et les rappeler à l’aide de 
raccourcis clavier. Votre Screenset actuel est le “1”, qui s’affiche 
dans la barre de menu principale. Si vous appuyez maintenant 
su 2 vous verrez apparaître un écran vide et “2” s’affichera 
dans la barre de menu principale.
Ouvrez ensuite quelques fenêtres ainsi que le séquenceur.
En appuyant alternativement sur 1 et 2 vous passez de l’un 
à l’autre de ces Screensets prédéfinis. Vous pouvez agencer les 
fenêtres avec précision puis verrouiller le Screenset avec 
Windows > Screenset > Locked (Verrouillé). Vous restez libre de 
modifier un Screenset verrouillé mais lorsque vous le rappelle-
rez plus tard, il reprendra son agencement de fenêtre d’origine. 
Pour déverrouiller le Screenset, sélectionnez à nouveau le 
même article de menu.
Grâce au rappel de ces Screensets, vous disposerez toujours 
d’une vue générale optimum, même sur un moniteur de petite 
taille.
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3.8 Introduction rapide aux 
SysEx

Rassurez-vous, vous n’aurez aucun besoin de vous occuper des 
données de SysEx - c’est justement à ça que sert SoundDiver. 
Cela dit, nous avons pensé qu’une brève présentation ne ferait 
de mal à personne. Donc, si la question vous intéresse, n’hési-
tez pas à lire ce qui suit.

Que représentent les données de Système 
Exclusif ?
SoundDiver contrôle des sons, des combinaisons, des program-
mes - bref, toutes les données mémorisables d’un appareil 
MIDI. Ces données diffèrent des commandes MIDI standardi-
sées comme Note On (début de note), Aftertouch (pression 
polyphonique) ou Program Change (changement de 
programme) dans la mesure où elles sont différentes pour 
chaque appareil. Un format spécial de données a été créé au 
sein de la norme MIDI pour gérer le transfert des paramètres 
spécifiques aux appareils : ce sont les données de Système 
Exclusif.

Il existe deux explications plausibles concernant l’expression 
“Système Exclusif”, sans que l’on puisse dire avec certitude 
laquelle est l’explication “officielle”. A vous de juger :

• Les données de Système Exclusif représentent l’exception 
parmi les formats de données MIDI parce que ce sont les 
seules à ne pas être identiques pour tous les appareils

• Les données de Système Exclusif sont conçues pour gérer 
exclusivement un système spécifique (appareil, modèle) et 
sont ignorées par tous les autres systèmes

SoundDiver communique avec les appareils MIDI presque 
uniquement sur la base des Systèmes Exclusifs. Vous ne vous 
en rentrez pratiquement pas compte puisque la façon de 
SoundDiver de communiquer avec les divers appareils reste 
interne au modules et adaptations. Vous aurez au contraire pres-
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que l’impression que SoundDiver s’adresse à tous les appareils 
de la même manière. C’est d’ailleurs exactement le but recher-
ché, afin que la manipulation des appareils soit aussi uniforme 
que possible et qu’elle fonctionne de manière rapide et effi-
cace. SoundDiver mettra quand même parfois un peu plus de 
temps à recevoir le contenu de la mémoire d’un appareil A que 
celui d’un appareil B.

Le format de données de Système Exclusif d’un appareil est 
établi par le constructeur à peu près librement. Voilà pourquoi 
tel appareil sera capable de transmettre tous ses sons un par un 
et tel autre en sera incapable. Même le volume des données 
utilisées pour un seul son varie considérablement d’un appareil 
à l’autre.

En travaillant avec SoundDiver, vous serez amené à rencontrer 
quelques caractéristiques particulières des données de 
Système Exclusif. Ce sont les suivantes.

Device ID
Normalement, on sépare les différents appareils d’un système 
MIDI en leur attribuant des canaux MIDI différents. Avec les 
données de Système Exclusif, cela n’est pas toujours approprié. 
Imaginons par exemple que vous vouliez faire jouer quatre 
synthétiseurs du même modèle tous sur le même canal mais 
chacun d’eux devant générer un son différent. Vous ne pourrez 
plus les séparer par canal, il vous faudra cette fois les séparer par 
appareil.

C’est pour ce type de raison que la plupart des appareils moder-
nes, ainsi qu’un bon nombre d’appareils plus anciens, possè-
dent un numéro distinct pour les données de Système Exclusif 
- le “Device ID” (en français, le numéro d’identification de 
l’appareil). Les appareils compatibles SysEx raccordés au 
système doivent avoir des ID différents pour pouvoir être 
adressés individuellement. Cela signifie que vous pouvez 
adresser individuellement bien plus que les seize appareils de 
base à la fois et que vous pouvez séparer des appareils pourtant 
identiques - par exemple plusieurs modules de DX 7 installés 
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dans un rack TX 816. Le Device ID est en général totalement 
indépendant du canal MIDI de l’appareil. Si un appareil est 
capable de gérer séparément le canal MIDI et le device ID, il 
vous suffit de communiquer son ID à SoundDiver et vous 
n’aurez même plus besoin de laisser cet appareil sur le même 
canal MIDI.

Dump Request (Requête de transfert)

La plupart des appareils MIDI peuvent transmettre leurs 
données sur demande. C’est vital si l’ordinateur doit être capa-
ble de communiquer avec un appareil. Par exemple, lorsque 
vous sélectionnez Edit > Request, SoundDiver transmet une 
requête de transfert à l’appareil en lui demandant de transmet-
tre ses données à l’ordinateur. En fonction de l’appareil, il 
existe différents types de requêtes de transfert selon qu’il s’agit 
de banques de sons, de sons eux-mêmes, de performances, de 
configurations système, de kits de batterie, etc. SoundDiver 
gère tous les types de requêtes de transfert utilisés par les 
divers appareils.

Dumps (Transferts)

Un dump (un transfert) est la réponse d’un appareil à une dump 
request (une requête de transfert) - il contient les données de 
son demandées. SoundDiver lui-même utilise les dumps, par 
exemple avec la fonction AutoAudition. De nombreux appa-
reils sont capables d’initier des “active dumps”. Il s’agit de 
dumps d’un appareil à un ordinateur initiés par l’appareil lui-
même, c-à-d. sans qu’aucune dump request n’ait été émise. 
SoundDiver peut gérer les active dumps en permanence.

Parameter Changes (Changements de paramètres)

Si vous modifiez un paramètre dans un éditeur, SoundDiver 
utilise un message de “Parameter Change” pour en informer 
l’appareil. Il pourrait bien sûr se contenter de transmettre un 
message de transfert (dump) du contenu du tampon d’édition 
mais cette procédure prendrait trop de temps et rendrait impos-
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sible toute édition en temps réel. Si vous utilisez SoundDiver 
conjointement à un séquenceur dans un système de gestion du 
MIDI, vous pouvez enregistrer les changements de paramètre 
de la même manière que les informations de contrôleur ou de 
molette de Pitch Bend.

Malheureusement, tous les appareils ne gèrent pas les change-
ments de paramètres. SoundDiver est alors obligé de transmet-
tre un dump. Afin d’éviter que cela se produise à la suite de 
chaque modification mineure (ce qui rendrait l’éditeur inutili-
sable), le dump est retardé jusqu’à environ une seconde après la 
dernière modification effectuée dans l’éditeur.

Nous espérons que ce chapitre aura fait plus que vous apporter 
quelques lumières et qu’il vous aura aussi donné envie d’en 
savoir davantage. Nous n’avons fait jusque-là qu’effleurer 
superficiellement les fonctions de SoundDiver. Dans les chapi-
tres suivants, vous entrerez dans le détail des fonctionnalités et 
des capacités de SoundDiver. 

Nous vous conseillons de prendre le temps de lire attentive-
ment les chapitres à venir. Cela ne vous prendra que quelques 
heures, mais cet investissement en temps devrait très rapide-
ment porter ses fruits. Bien entendu, il ne s’agit pas de tout 
retenir du premier coup. Si vous rencontrez un terme inconnu, 
recherchez sa signification dans l’index. Nous avons essayé de 
rendre cet index aussi complet que possible afin que vous y 
trouviez le moment venu toute l’aide dont vous aurez besoin. 
N’hésitez pas dans un premier temps à recourir à l’aide en ligne 
dont il a été question plus haut.

Dans le prochain chapitre, vous verrez comment SoundDiver 
fonctionne, et vous toucherez également à la barre de menu 
principale.
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L’interface utilisateur 
de SoundDiver

Dans ce chapitre, vous apprendrez à manipuler SoundDiver 
grâce à de nombreux exemples pratiques. Vous apprendrez 
entre autres à vous servir de la souris, des menus, des raccourcis 
claviers et des fenêtres, à optimiser l’affichage de votre configu-
ration MIDI, à classer vos sons dans la fenêtre Device et à créer 
une nouvelle bibliothèque. Après avoir lu ce chapitre, vous 
devriez être en bonne voie de maîtriser SoundDiver.

4.1 L’apparence de SoundDiver

Le look 3D 
Comme vous pouvez le constater d’après les illustrations de ce 
manuel, SoundDiver a désormais le même “look” Emagic que 
des programmes comme Logic ou MicroLogic.

Les cases et les boutons sont en 3D et le fond arbore un 
nouveau coloris gris en 3D. Ces caractéristiques améliorent 
indéniablement l’apparence de SoundDiver ; en revanche, 
elles accaparent un peu de la puissance de calcul de votre ordi-
nateur, ce qui peut devenir sensible sur des ordinateurs peu 
puissants.

Vous pouvez accélérer SoundDiver en désactivant 3-D 
Background dans le dialogue qui apparaît en sélectionnant 
Options > Settings > Display Preferences.

Chapitre 4
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Le look SoundDiver 2.0 
Si vous étiez habitué au look de SoundDiver 2.0 et que vous 
préférez le conserver, il vous suffit de modifier le réglage du 
dialogue mentionné ci-dessus pour y revenir.

Vous pouvez également désactiver complètement le look 3D. 

4.2 Fonctionnement : Généralités

La souris
Les fonctions de la souris sont traitées plus en détail dans des 
chapitres spécifiques, ces fonctions étant en effet différentes 
pour les fenêtres Device et Library. Cette section traite du 
maniement de la souris de façon plus générale. Nous vous 
conseillons de vous y essayer dès à présent dans SoundDiver 
afin de mieux les mémoriser :

• Cliquer sur un objet non sélectionné le sélectionne et désé-
lectionne tous les autres. Si l’objet était déjà sélectionné, 
rien ne se produit,

• Si vous maintenez ç ( : S) tout en cliquant sur un objet, la 
sélection de l’objet s’inverse.
Exemple: si vous cliquez sur une entrée de bibliothèque 
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sélectionnée, elle est alors désélectionnée. La sélection des 
autres appareils reste, elle, inchangée,

• Pour définir un bloc, cliquez sur la première entrée, main-
tenez S ( : ç) et cliquez sur la dernière entrée du bloc. 
Pour sélectionner plusieurs blocs, maintenez également ç 
( : S) après avoir sélectionné le premier bloc.
Exemple : dans une bibliothèque, vous voulez sélectionner 
deux blocs. Cliquez d’abord sur la première entrée du 
premier bloc. Sélectionnez la dernière entrée tout en main-
tenant S ( : ç) enfoncée. Cliquez à présent sur la 
première entrée du second bloc tout en appuyant sur ç ( : 
S). Cliquez sur la dernière entrée du second bloc tout en 
maintenant Sç ( : çS) enfoncé.

• Sous Windows, la souris fonctionne comme un “curseur” de 
données. Cliquez sur une valeur et gardez le bouton de la 
souris enfoncé. Vous pouvez alors changer la valeur en dépla-
çant la souris vers l’avant ou vers l’arrière.

•  : La manière de changer les valeurs à la souris dépend du 
réglage de Mouse as slider (Souris en mode curseur) dans la 
fenêtre Options >Settings > Global Preferences….
Si Mouse as slider est désactivé (se reporter au § Global Settings 
à la page 397), la souris fonctionne de la manière suivante : 
pour augmenter une valeur, cliquez dessus. Pour la dimi-
nuer, maintenez la touche C en même temps. Toutefois, en 
maintenant ç la souris se transforme en curseur et vous 
pouvez modifier la valeur en déplaçant la souris vers l’avant 
ou vers l’arrière.

• Un simple clic sur le fond (autrement dit, ailleurs que sur un 
objet) désélectionne tous les objets.

• Cliquez sur le fond puis faites glisser la souris (en mainte-
nant son bouton enfoncé) pour afficher un “élastique”. Tous 
les objets situés à l’intérieur du rectangle ainsi formé sont 
sélectionnés. Vous pouvez utiliser ç ( : S) ici aussi pour 
inverser la sélection ou sélectionner les objets à l’intérieur de 
plusieurs rectangles.
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• “Glisser-Déposer” : cliquez et maintenez un objet, puis 
déplacez la souris (sans relâcher son bouton). L’objet sera 
déplacé ou copié à l’emplacement indiqué par la flèche 
lorsque vous relâchez le bouton de la souris. Si cette action 
est accomplie au sein de la même unité d’organisation, 
l’objet est déplacé. (Si cela se produit dans la fenêtre Device, 
les deux éléments échangent leurs emplacements). Il est 
toutefois copié au lieu d’être déplacé si la destination appar-
tient à une unité d’organisation différente, par ex. en tirant 
un objet depuis une fenêtre Device vers une Library, ou 
depuis une Library vers une autre. Pendant le déplacement, 
la fenêtre défile automatiquement dès que la souris pointe 
vers un bord de fenêtre. Ce défilement s’interrompt lorsque 
la souris franchit le bord de la fenêtre.

•  : SoundDiver gère la fonction des “Menus figés” de Mac 
OS 8 : un clic rapide sur un titre de menu garde le menu 
ouvert sans que vous ayez besoin de garder le bouton de la 
souris enfoncé. Un clic sur un article de menu le sélectionne.

Microsoft IntelliMouse™ (Windows seulement)
SoundDiver Windows gère l’IntelliMouse(tm) de Microsoft 
conformément aux règles édictées par Microsoft. Veuillez 
installer le logiciel système IntelliPoint 2.0 pour un fonctionne-
ment correct.

• Défilement : actionnez la molette de l’IntelliMouse (sans 
cliquer sur un bouton) pour faire défiler la section actuelle-
ment visible dans la fenêtre. Le défilement s’effectue dans 
la direction (horizontale ou verticale) dont ne voit que la plus 
petite fraction. Le nombre de lignes qui défilent à chaque 
cran, ainsi que la direction, sont paramétrables dans le logi-
ciel IntelliPoint 2.0 (Menu “Démarrer > Paramètres > 
Panneau de configuration”, panneau de configuration 
“Souris”, onglet “Molette”, bouton “paramètres...”).

• Zoom : actionnez la molette de l’IntelliMouse tout en 
appuyant sur ç pour changer de facteur de zoom, autre-
ment dit la taille de la police (mais seulement dans les fenê-
tres qui offrent cette option).
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• Zoom sur les données : dans les fenêtres d’éditeur qui dispo-
sent d’une vue générale (“overview”), actionnez la molette 
de l’IntelliMouse tout en appuyant sur S pour alterner entre 
l’overview et la vue détaillée.

• Panneautage : cliquez n’importe où dans une fenêtre avec le 
bouton à molette, maintenez-le enfoncé et déplacez la souris. 
La section visible défilera dans la direction désirée. Cette 
fonction est identique à un S-clic sur l’outil de défilement x/
y (voir le § La commande de défilement x/y à la page 132).

• Défilement automatique : cliquez et relâchez le bouton de la 
molette. Vous pouvez désormais relâcher les boutons de la 
souris pour faire défiler la fenêtre (comme avec le panneau-
tage). Cliquez sur n’importe lequel des boutons de la souris 
ou appuyez sur une touche du clavier pour sortir de ce mode.

Menus contextuels (Windows seulement)
Dans la plupart des fenêtres, un clic effectué n’importe où avec 
le bouton droit de la souris ouvre un menu contextuel, comme 
dans Windows 95/98 et Windows NT4.0/2000. Ce menu 
contextuel contient un résumé des articles de menu capables 
d’agir sur les objets sélectionnés.
Si rien n’est encore sélectionné, l’objet sur lequel vous cliquez 
sera sélectionné avant l’apparition du menu contextuel. Si 
l’objet sur lequel vous cliquez est déjà sélectionné, la sélection 
restera inchangée.
Un article de menu sélectionné dans un menu contextuel 
s’applique toujours à l’ensemble des objets sélectionnés.
Les chapitres suivants contiennent des explications plus 
détaillées.

Le clavier de l’ordinateur
Les raccourcis clavier sont légèrement différents selon la 
version Macintosh ou Windows, en raison des différences 
d’agencement du clavier et des normes d’interface utilisateur 
entre ces systèmes d’exploitation. Ces différences sont décrites 
au § Différents raccourcis clavier à la page 415.
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Déplacer le curseur
Dans chaque fenêtre se trouve un curseur qui indique quel est 
l’objet actuellement en cours d’édition. Dans la fenêtre Setup, 
l’icône d’appareil sur laquelle est placé le curseur se distingue 
nettement à l’écran. 

Windows: les objets sélectionnés affichés sous forme de texte 
portent la couleur des objets sélectionnés telle qu’elle a été 
définie dans le panneau de configuration système “Affichage”.

 : les objets sélectionnés affichés sous forme de texte portent 
la couleur définie dans le tableau de bord “Apparence” (ancien-
nement intitulé : “Couleur”).

Vous pouvez déplacer le curseur soit à la souris, soit en cliquant 
sur l’emplacement voulu (icône d’appareil, entrée), ou à l’aide 
des flèches de défilement du clavier de l’ordinateur.

Outre la possibilité de se déplacer dans toutes les directions, un 
certain nombre d’autres options pratiques font des flèches de 
défilement la méthode la plus simple à utiliser. Toutes ces 
options sont listées dans le tableau ci-dessous :

Tableau 2  Se positionner à l’aide du clavier de l’ordinateur

Fenêtre Opération Windows Macintosh
Toutes 
fenêtres

sélectionner appareil/
entrée

M, I, J, K M, I, J, K

ajouter un objet à la 
sélection

çM, çI, 
çJ, çK

SM, SI, 
SJ, SK

page haut/bas N, U N, U

page gauche/droite çN, çU çN, çU

aller au coin supérieur 
gauche

Û ª 

aller au coin supérieur 
droit

˙ ¬

Fenêtres à 
listes

ajouter une page à la 
sélection

çN, çU SN, SU

étendre la sélection 
jusqu’en haut/en bas

çÛ, 
ç˘)

Sª,
S¬
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Saisir du texte
Le clavier de l’ordinateur ne sert pas qu’aux raccourcis clavier 
(voir le § Raccourcis clavier à la page 415) mais également à saisir 
du texte (noms d’entrées, commentaires, etc.) :

❏ Pour saisir du texte, cliquez sur le champ concerné. Vous
pouvez le supprimer totalement en sélectionnant Edit >
Select All puis en appuyant sur B. Saisissez le texte et vali-
dez avech R,

❏ Utiliser les flèches de défilement J ou K pour changer la
position du curseur,

❏ Vous pouvez sélectionner un bloc de texte en cliquant
devant la première lettre, en gardant le bouton de la souris
enfoncé et en faisant glisser le pointeur de la souris sur les
caractères désirés,

❏ Vous pouvez supprimer un objet sélectionné (par ex. un
bloc de texte) en appuyant sur B ou ∂ ( : L), mais si
rien n’est sélectionné, appuyer sur B supprimera le carac-
tère placé avant le curseur,

❏ Vous pouvez utiliser le menu Edit (voir le § Le menu Edit
(Édition) à la page 145) pour couper, copier et coller du
texte.

Définir la police utilisée (Windows seulement)
Sous Windows, vous pouvez sélectionner la police utilisée par 
SoundDiver dans tout le programme.

Dans le fichier WIN.INI de votre dossier Windows, ajoutez la 
ligne suivante à la section [SoundDiver] :
Police=Policename

et remplacez Policename par le nom de votre police préférée.

Cette fonction n’est pas disponible dans la version Macintosh.
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Menus 

Windows
SoundDiver pour Windows 95/98 et Windows NT 4.0/2000 est 
une application MDI (Multiple Document Interface). Cela 
signifie que toutes les fenêtres de documents sont contenues à 
l’intérieur d’une fenêtre principale (la “MDI frame window”). 
Celle-ci contient également la barre de menus. La barre de 
menus contient toujours les menu File, Edit, Options, Window 
et Help.

Selon la nature de la fenêtre de document active, on verra s’affi-
cher des menus supplémentaires spécifiques à la fenêtre (appe-
lés “menus locaux”). Ils sont toujours placés entre le menu 
Options et le menu Window.

Macintosh
Afin d’assurer une meilleure vue d’ensemble, les menus de 
SoundDiver sont répartis entre la barre de menu principale et 
les barres de menus locaux.

La barre de menu principale est située le long du bord supé-
rieur de l’écran et contient les fonctions qui s’appliquent à 
toutes les zones de SoundDiver. Elle comprend les menus File, 
Edit et Windows qui figurent dans tous les logiciels d’Emagic.

La plupart des fenêtres de SoundDiver contiennent également 
un ou plusieurs menus “locaux”, situés dans leur propre barre 
de menu en dessous de la barre de titre de la fenêtre. Elles 

Barre de menu principale Barres des menus locaux
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contiennent des fonctions spécifiques à chacune de ces fenê-
tres. Vous pouvez ainsi utiliser le menu Sort (Trier) dans la 
fenêtre Library pour classer les entrées d’une bibliothèque 
selon divers critères ou le menu New dans la fenêtre Setup pour 
installer de nouveaux appareils.

Les menus n’apparaissent donc que lorsque vous en avez 
besoin.

4.3 Gestion des fenêtres
Les fenêtres de SoundDiver s’utilisent strictement comme 
dans les autres applications. Elles disposent cependant de 
quelques fonctions supplémentaires destinées à offrir une vue 
d’ensemble du logiciel, même avec les configurations de fenê-
tres les plus complexes. Dans cette section, vous verrez 
comment utiliser les fenêtres de SoundDiver avec le maximum 
d’efficacité, afin de toujours conserver la meilleure vision 
d’ensemble de votre travail.

Les commandes habituelles

Macintosh
Vous êtes déjà habitué aux commandes standard de gestion des 
fenêtres dans d’autres programmes ou depuis le bureau de 
votre ordinateur :

❏ un clic sur la case de fermeture dans le coin supérieur gau-
che ferme la fenêtre,

❏ un clic sur la case de zoom dans le coin supérieur droit per-
met d’alterner entre deux tailles de fenêtre,

❏ en saisissant et en tirant l’outil de redimensionnement
situé au coin inférieur de la fenêtre, vous pouvez ajuster la
taille verticale et horizontale de cette fenêtre, y compris
lorsque celle-ci est placée à l’arrière-plan. Cela n’activera
pas la fenêtre. Pour activer une fenêtre, cliquez dessus rapi-
dement.
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Windows
Vous êtes déjà habitué aux commandes standard de gestion des 
fenêtres dans d’autres programmes ou depuis le bureau de 
votre ordinateur :

❏ un clic sur la case de fermeture dans le coin supérieur droit
ou un double-clic ferme la fenêtre,

❏ un clic sur la case de zoom à gauche de la case de fermeture
permet d’alterner entre deux tailles de fenêtre,

❏ en saisissant et en tirant les coins ou les bords de la fenêtre,
vous pouvez ajuster sa taille verticale et horizontale

Les barres de défilement 
Les barres de défilement 
situées le long des côtés 
droit et inférieur de chaque 
fenêtre peuvent changer 
non seulement de position, 
mais également de taille, 
laquelle est proportionnelle 
à la section de fenêtre visi-
ble. Cela signifie que vous 
pouvez visualiser en 
permanence la relation 

entre la section visible de la fenêtre et la totalité de son 
contenu. En cliquant sur la zone vide des barres de défilement, 
vous pouvez faire défiler la section de fenêtre d’une page à 
chaque fois dans la direction souhaitée. Si le contenu tout 
entier tient dans la section de la fenêtre, les cases occuperont la 
totalité des barres de défilement et les flèches disparaîtront.

La commande de défilement x/y
Outre les commandes de fenêtre standards, vous disposez 
également de l’outil de défilement x/y situé au coin inférieur 
gauche de la fenêtre. Cet outil permet de déplacer la section de 
la fenêtre à la fois horizontalement et verticalement.

Barres de défilement
132
Emagic
SoundDiver 



Gestion des fenêtres
En saisissant la petite case grisée, vous verrez le pointeur de la 
souris se transformer en croix. La vue dans la fenêtre se dépla-
cera alors directement en fonction des mouvements de votre 
souris. Si vous cliquez sur l’outil de défilement x/y tout en 
maintenant S ( : C) votre souris contrôlera la vitesse du défi-
lement au lieu de sa direction.

Avec une souris à 3 boutons ou avec l’ IntelliMouse™ de Micro-
soft sous Windows, vous pouvez cliquern’importe où dans la 
fenêtre avec le bouton du milieu (ou le bouton de la molette) et 
déplacer la souris avec le bouton enfoncé.

Zoom
Dans toutes les fenêtres (sauf les fenêtres Install, Edit et 
Sequencer) se trouve un petit bouton de zoom. Cet outil zoom 
permet d’agrandir ou de réduire le contenu de la fenêtre 
(lettres et icônes).

Un clic sur le haut de l’outil réduit le contenu de la fenêtre, un 
clic sur sa moitié inférieure l’agrandit.

Défilement automatique
Si vous agrandissez une fenêtre, SoundDiver modifie automa-
tiquement la section affichée pour afficher le plus possible du 
contenu de la fenêtre, y compris lorsque le contenu d’une fenê-
tre change et contient moins d’objets, ainsi qu’en zoomant.

Modifier la disposition des colonnes d’une 
fenêtre
Dans diverses fenêtres de SoundDiver, vous pouvez modifier à 
la souris la largeur de la partie gauche de la fenêtre. Cliquez/
maintenez le bord vertical de la colonne et déplacez-le vers la 
gauche ou vers la droite. En le déplaçant vers la gauche, vous 
agrandissez l’espace disponible pour le contenu de la fenêtre ; 
en le déplaçant vers la droite, vous agrandissez la case des para-
mètres, ce qui vous permet de lire une plus longue description 
des paramètres.
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Changer la largeur de la colonne des paramètres entraîne égale-
ment un changement de la taille de l’icône située au-dessus de 
cette colonne des paramètres.

Déplacer les fenêtres à l’arrière-plan
Il est possible de déplacer une fenêtre située à l’arrière-plan 
sans qu’elle passe au premier plan, simplement en appuyant 
sur C tout faisant glisser sa barre de titre.

Fermer des fenêtres
Pour fermer une fenêtre dans la version Windows, cliquez sur la 
case de fermeture située au coin supérieur droit ou double-
cliquez sur l’icône dans le coin supérieur gauche.

 : Pour fermer une fenêtre, cliquez sur la case de fermeture 
dans le coin supérieur gauche.

Vous pouvez aussi passer par les équivalents suivants :

❏ A ( : O)-clic sur la case de fermeture de la fenêtre Library 
ferme toutes les fenêtres Library sans refermer la Library 
elle-même. On retrouve la même fonction dans Logic.

❏ A ( : O)-clic sur la case de fermeture d’une fenêtre qui 
n’est pas une fenêtre de Library referme toutes les fenêtres 
qui n’appartiennent pas à une Library.

❏ AS ( : OS)-clic sur la case de fermeture d’une fenêtre 
quelconque referme toutes les fenêtres.

Agrandir la fenêtre à la taille de l’écran
En cliquant sur l’outil plein écran dans la version Windows, la 
fenêtre occupe tout l’espace client de la fenêtre principale. 
Avec çT vous pouvez facilement faire défiler alternative-
ment toutes les fenêtres du document.

 : Vous pouvez ajuster la taille de la fenêtre à son contenu en 
cliquant sur les boutons de zoom, ce qui sera pratique pour voir 
ou masquer la liste des paramètres, ou pour sélectionner un 
style de texte différente.
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Fenêtres flottantes
Toutes les fenêtres de SoundDiver peuvent s’ouvrir sous la 
forme de fenêtres flottantes. Une fenêtre flottante reste 
toujours au premier plan même lorsque l’on ouvre d’autres 
fenêtres qui la recouvrent. 

Pour ouvrir une fenêtre flottante, maintenez S ( : O) en 
ouvrant la fenêtre. Vous pouvez également utiliser la même 
touche morte en sélectionnant la commande équivalente dans 
le menu Windows.

Les raccourcis claviers pour ouvrir les fenêtres existent en 
version flottante et non flottante.

Sous Windows, les fenêtres flottantes peuvent être déplacées 
en dehors de la fenêtre principale.

Les fenêtres flottantes sont soumises à une limitation : les 
raccourcis clavier s’appliquent toujours à la fenêtre non-flot-
tante située sur le dessus. Sur Macintosh, il faut utiliser les 
menus locaux. Sous Windows, ce sont les menus contextuels 
qu’il faut utiliser (clic droit sur la barre de titre), le menu normal 
s’appliquant également toujours à la fenêtre non-flottante du 
dessus.

Screensets
Vous pouvez bénéficier d’une vue d’ensemble optimum de 
l’écran, instantanément et dans n’importe quelle situation, en 
rappelant à l’aide d’un raccourci clavier une des 90 combinai-
sons d’écran (ou Screensets) définies par l’utilisateur qu’offre 
SoundDiver.
Sélectionnez le Screenset désiré en appuyant sur un des chif-
fres du clavier principal de l’ordinateur. Ouvrez une fenêtre, 
ajustez-en la taille et la position des barres de défilement. Ces 
réglages seront automatiquement enregistrés et seront rétablis 
au prochain rappel de ce Screenset. Le numéro du Screenset en 
cours d’utilisation s’affiche dans la barre de menus à côté du 
menu Windows, par ex. “45”.
& La touche 0 ne peut pas être affectée à cet usage, il n’y a donc pas de Screensets 

pour 10, 20... 90.
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Paramétrer et rappeler des Screensets
Pour rappeler un Screenset :

❏ Appuyez sur la touche du chiffre qui correspond au numéro 
du Screenset. Par ex. la touche 7 rappelle le Screenset 7.

& Vous pouvez également utiliser les touches ! à ) du pavé numérique, à condition 
que le verrouillage numérique soit désactivé (voir la § Num Lock (Verr num.) à la page 
400).

❏ Pour saisir un numéro à deux chiffres, maintenez A (  :
ç) et saisissez les deux chiffres. Par exemple, la combinai-
son A78 (  : ç78) appelle le Screenset 78.

Exemple : supposons que vous vouliez enregistrer un Screen-
set correspondant à une fenêtre de Configuration MIDI qui 
occupe tout l’écran et qui vous donne une vue d’ensemble de 
votre système.

Nous allons utiliser le Screenset 99. Maintenez la touche A ( : 
ç) et appuyez deux fois sur 9. Le nombre 99 s’affiche à côté du 
menu Windows, mais l’écran est vide.

Ouvrez maintenant la fenêtre de Configuration MIDI et 
donnez-lui la taille maximale. Désormais, chaque fois que vous 
sélectionnerez ce Screenset 99, cette disposition d’écran sera 
rétablie. Essayez par vous-même.

Copier un Screenset
On peut facilement se servir d’un Screenset comme d’un point 
de départ pour effectuer des changements, en le copiant vers 
un autre numéro de Screenset. Tout d’abord, rappelez le 
Screenset que vous voulez copier. Ensuite appelez le numéro 
du Screenset de destination tout en maintenant la touche S. 
Vous pouvez également utiliser A (  : ç) pour copier un 
numéro de Screenset à deux chiffres.

Vous pouvez également utiliser les fonctions Windows > 
Screenset > Copy Screenset et Paste Screenset.
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Gérer plusieurs moniteurs
SoundDiver reconnaît la présence de plusieurs moniteurs. 
Cette configuration est hautement recommandée, si votre ordi-
nateur et votre système d’exploitation l’acceptent, surtout si 
SoundDiver est utilisé avec un logiciel de séquence comme 
Logic Audio.

&  : il est possible d’utiliser plusieurs moniteurs avec tous les ordinateurs équipés de 
ports PCI, quelle que soit la version de Mac OS.
Sous Windows, cela n’est possible qu’avec Windows 98 et 2000, pas avec Windows 
95 ou NT 4.0. Les pilotes de la carte graphique doivent également être compatibles 
avec le mode multi-moniteur.

4.4 Sélectionner des entrées
Il existe plusieurs façons différentes de sélectionner des 
entrées ou des groupes d’entrées dans une fenêtre Device ou 
une bibliothèque. Nous avons déjà décrit les fonctions généra-
les. Les options de sélection spécifiques aux fenêtres Device et 
Library sont traitées dans leur chapitre respectif.

Veuillez lire les sections suivantes attentivement et faites 
l’essai des fonctions dans une fenêtre Device ou Library.

Sélectionner des entrées individuelles 
Les entrées individuelles se sélectionnent d’un simple clic. 
Pour sélectionner plusieurs entrées non-contiguës, maintenez 
ç (  : S) et cliquez sur les entrées désirées. Cliquez une 
seconde fois sur une entrée pour la désélectionner.
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Pour sélectionner un bloc d’entrées contiguës, cliquez sur la 
première entrée, maintenez S (  : ç), puis cliquez sur la 
dernière entrée.
Vous pouvez aussi sélectionner plusieurs blocs en maintenant 
ç (  : S). En sélectionnant la première entrée du second 
bloc, maintenez S (  : ç) et utilisez les deux touches mortes 
pour la dernière entrée.

Sélection à l’élastique
Pour sélectionner toutes les entrées contenues à l’intérieur 
d’un rectangle, cliquez sur une zone vide (ou une colonne de 
numérotation verticale), maintenez le bouton de la souris 
enfoncé et faites glisser un élastique sur les entrées que vous 
souhaitez sélectionner.
Dès que cet élastique touche un bord de la fenêtre, la section 
visible de la fenêtre défile pour vous permettre de sélectionner 
des entrées qui vous étaient précédemment masquées.

Inverser la sélection dans une zone
Pour inverser la sélection dans une zone, cliquez sur une zone 
vide et - comme le décrit la section précédente - faites glisser 
un élastique sur les entrées tout en gardant la touche ç (  : 
S) enfoncée. La sélection s’inversera pour toutes les entrées 
contenues ou touchées par l’élastique.
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On peut également inverser la sélection en cours avec Edit > 
Toggle Sel.

4.5 Le Presse-papiers
SoundDiver dispose d’un presse-papiers dans lequel les 
données sont transférées avec Edit > Cut ET Copy pour être 
ensuite insérées ailleurs avec Edit > Paste. Ce presse-papiers 
fonctionne entre programmes différents. Par exemple, vous 
pouvez sélectionner toutes les entrées d’une bibliothèque et 
importer leurs noms dans un traitement de texte.

Vous pouvez également prendre dans le presse-papiers un texte 
provenant d’un autre programme et l’ajouter à une bibliothè-
que. Il y sera ajouté sous la forme d’une ou de plusieurs entrées 
de titre et les paragraphes de 75 caractères par ligne seront auto-
matiquement segmentés.

Le presse-papiers permet de copier quand même des entrées 
depuis une fenêtre Device vers un multi-instrument dans 
Logic Audio, au cas où AutoLink ne serait pas activé.

Le presse-papiers permet également d’imprimer facilement les 
raccourcis clavier. Après y avoir copié le contenu de la fenêtre 
Key Commands (article de menu local Options > Copy Key 
Commands to Clipboard), collez-le tout simplement dans votre 
traitement de texte préféré et éditez-le à votre convenance.
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4.6 Le menu File (Fichier)
Le menu File (“Fichier”) est l’endroit 
où vous pouvez créer de nouveaux 
fichiers de bibliothèque, ouvrir ou 
enregistrer des fichiers existants, 
imprimer le contenu d’une bibliothè-
que (ou de la fenêtre d’aide sur Macin-
tosh), importer et exporter des fichiers, 
définir des réglages par défaut ou quit-
ter SoundDiver.

New (Nouveau)

Crée une nouvelle bibliothèque pour-
vue d’une fenêtre vide Library et la 

nomme automatiquement “Untitled”. Chaque bibliothèque 
créée par la suite reçoit également un numéro.

Open... (Ouvrir)
Ouvre une bibliothèque existante depuis une disquette ou un 
disque dur. Un sélecteur de fichiers apparaît dans lequel vous 
sélectionnerez une bibliothèque SoundDiver.
Quand une bibliothèque s’ouvre, les fenêtres des documents 
de la bibliothèque s’ouvrent en obéissant aux paramétrages du 
Screenset en cours d’utilisation.
Si aucune fenêtre n’a été enregistrée pour le Screenset en cours 
d’utilisation, c’est une fenêtre par défaut qui s’ouvre.
& Les informations de Screenset appartenant aux fenêtres d’une bibliothèque sont 

mémorisées dans le fichier bibliothèque (et non dans les préférences de SoundDiver 
comme pour toutes les autres classes de fenêtres). De cette manière, lorsque vous 
ouvrez une bibliothèque, celle-ci s’ouvre automatiquement avec toutes les fenêtres 
telles qu’elles étaient configurées à la dernière ouverture, même si vous n’avez pas 
utilisé du tout cette bibliothèque lors de la séance précédente.

& “Open...” contient sensiblement les mêmes fonctions que “Import...”, qui n’existe 
que dans le menu pour des raisons de clarté.

&  :“Open...” ne permet de charger ou d’importer que des bibliothèques SoundDiver, 
des préférences SoundDiver, des MIDI Files standards et des fichiers SYX/MidiEx. Pour 
tous les autres types de fichiers, veuillez utiliser l’article de menu “Import...”.
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Close Library (Fermer la Bibliothèque)
Ferme la bibliothèque en cours d’utilisation, avec toutes ses 
fenêtres. Si vous avez effectué des modifications depuis 
l’ouverture de la bibliothèque, il vous sera automatiquement 
demandé si vous souhaitez les enregistrer. Contrairement à ce 
qui se passe pour toutes les autres fenêtres, la fermeture d’une 
fenêtre Library ne referme pas la bibliothèque.

& Si vous ne souhaitez fermer qu’une seule fenêtre de la bibliothèque en cours d’utili-
sation, sélectionnez plutôt Windows > Close window .

Save (Enregistrer)
Enregistre la bibliothèque en cours d’utilisation (celle qui est 
cochée dans le menu Windows) sur disquette ou disque dur. Si 
vous venez juste de créer la bibliothèque avec File > New, il 
vous sera demandé de nommer le fichier.

Save as… (Enregistrer sous)
Enregistre la bibliothèque en cours d’utilisation sous un autre 
nom ou selon un chemin d’accès différent. Utilisez cette fonc-
tion lorsque vous voulez préserver la bibliothèque existante.
& La règle suivante s’applique aux deux fonctions : si un fichier (quel que soit son type) 

ne peut pas être enregistré, par ex. si le support ne dispose pas d’assez de place, 
l’ancien fichier n’est pas écrasé et reste inchangé. Vous en serez informé par un 
message d’erreur.

Revert to Saved (Version précédente)
Si vous avez - par accident ou autre - effectué sur une bibliothè-
que des modifications que vous voudriez à présent annuler, 
vous pouvez utiliser cette fonction pour rappeler la dernière 
version enregistrée. Le contenu de la bibliothèque sera 
rechargé, mais les fenêtres resteront les mêmes.
& En suivant cette procédure, tous les changements effectués depuis la dernière sauve-

garde seront irrémédiablement perdus. Si vous n’êtes pas certain de vouloir annuler 
toutes vos modifications, il vaudra mieux commencer par sauvegarder la biblio-
thèque en cours d’utilisation sous un nom différent à l’aide de “Save as...” puis 
revenir à la version précédente avec “Open...”.
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Save Preferences (Sauvegarder Préférences)
Sauvegarde les réglages en cours dans le fichier correspondant. 
Veuillez vous reporter à la page 411.

Save Preferences as…
Veuillez vous reporter au § Save Preferences under a Different File 
Name (Sauver les Préférences sous un nom de fichier différent) à la 
page 412 pour plus de détails.

Page Setup… (Format d’impression)
Ouvre la fenêtre des paramètres de mise en page. La fenêtre de 
format d’impression de l’imprimante s’ouvre. Le format de 
papier et la taille de la page sont enregistrés au sein du fichier 
de bibliothèque, vous n’aurez donc pas à les redéfinir à la 
prochaine impression.

Print… (Imprimer)
Permet d’imprimer le contenu de la fenêtre active sur l’impri-
mante connectée. Vous pouvez imprimer :

• La fenêtre Library actuellement utilisée. La disposition des 
colonnes s’imprime exactement telle qu’elle apparaît à 
l’écran. Si la largeur d’impression est insuffisante, le reste 
des colonnes de la bibliothèque sera coupé.

•  : le document entier d’aide en ligne actuellement affiché 
dans la fenêtre d’aide active. La disposition du texte, dépen-
dant de la largeur de la fenêtre, sera également transmise à 
l’imprimante. Mais si la fenêtre est plus large que la zone 
d’impression du format de papier, la fin de chaque ligne sera 
coupée. Néanmoins, cet incident ne se produit pas en prin-
cipe avec la zone d’impression prédéfinie.
Pour imprimer un fichier d’aide de Windows, veuillez 
utiliser la fonction appropriée dans l’aide de Windows.

Le format d’impression dépend des réglages définis dans la 
fenêtre Page Setup (voir ci-dessus).
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Vous pouvez annuler l’impression avec R ou ™).

Chaque bibliothèque possède son propre format de page et 
peut donc être imprimée de façon optimale et personnalisée.

SoundDiver imprime les bibliothèques en “WYSIWYG” (What 
You See Is What You Get, ce qui signifie que le résultat de 
l’impression est identique à ce que vous voyez à l’écran). Il 
reconnaît les polices TrueType pour un résultat de haute 
qualité.

&  : L’agencement des lignes du texte d’aide n’est pas déterminé par la largeur de la 
fenêtre d’aide en ligne mais par la largeur de la page telle que vous l’avez définie en 
File > Page Setup.

Les marges sont exprimées en 1⁄72 de pouce et non en caractères 
ou en lignes. Le format de papier est intégré au dialogue de 
Format d’impression.

Import… (Importer)
Cette fonction permet de convertir en bibliothèques SoundDi-
ver des fichiers provenant de programmes C-LAB tel que Poly-
frame, X-alyzer, Explorer 32 et Explorer M1 ou d’autres 
éditeurs/bibliothécaires conçus par d’autres sociétés. Vous 
pouvez également importer des Standard MIDI Files (SMF) et 
des fichiers SYX (MidiEx).

Pour plus d’informations, veuillez vous reporter au § Importer 
des fichiers SYX à partir de la page 279 et suivantes.

Export MIDI File… (Exporter fichier MIDI)
Cet article de menu est identique à Edit > Transmit (voir le § 
Transmit (Transmettre) à la page 154), à cette différence près que 
les données ne sont pas transmises via MIDI, mais enregistrées 
au format Standard MIDI File.

Cela signifie que :

• Si la fenêtre active est une fenêtre Device, les entrées sélec-
tionnées sont sauvegardées
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• Si la fenêtre active est une fenêtre Setup, le contenu de la 
mémoire des appareils sélectionnés est sauvegardé 

• Si la fenêtre active est une fenêtre Library, les entrées sélec-
tionnées sont sauvegardées de telle sorte qu’à la relecture 
(par ex. dans un séquenceur), le fichier transmettra les 
entrées sauvegardées aux emplacements mémoire indiqués 
dans la colonne “Location” de la bibliothèque. Si vous le 
souhaitez, vous pouvez réassigner chaque emplacement 
mémoire manuellement dans le dialogue résultant, exacte-
ment comme dans “Transmit”.

Pour plus de détails sur les fonctions d’export, veuillez vous 
reporter au § Exportation de fichiers à la page 281.

Capture as MIDI-File…
Lorsqu’il est sélectionné, cet article de menu apparaît coché et 
toutes les données MIDI qui sont alors émises sont enregis-
trées dans une mémoire tampon temporaire. Quand l’article 
n’est pas coché, le contenu de cette mémoire tampon est sauve-
gardé au format Standard MIDI File. Comme d’habitude, vous 
devrez lui assigner un nom de fichier et un chemin d’accès.
& Seuls les événements MIDI émis (pas les événements MIDI reçus) sont sauvegardés, à 

l’exception de ceux présents en sortie du séquenceur interne ou en “MIDI Thru”.

& Contrairement à ce qui se passe pour les fonctions décrites au § Export MIDI File… 
(Exporter fichier MIDI) à la page 143 et au § Export … à la page 210, tes données 
MIDI continuent d’être émises aux ports MIDI, pour pouvoir par exemple recevoir les 
messages de confirmation des appareils qui nécessitent une communication en 
mode Handshake.

& Si vous sélectionnez l’une des fonctions “Export” mentionnées ci-dessus, “Capture 
MIDI File” est interrompu - toutes les données enregistrées seront perdues.

Quit (Quitter)
Sélectionnez cet article de menu pour quitter SoundDiver.

Si des bibliothèques sont encore ouvertes, vous pourrez 
commencer par les enregistrer.
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Quand vous quittez le programme, les préférences (voir ci-
dessous) sont toujours enregistrées elles aussi, de telle façon 
qu’au prochain lancement de SoundDiver, vous retrouviez 
exactement le même paramétrage que lors de la séance précé-
dente. Si ce n’est justement pas ce que vous souhaitez, alors 
quittez SoundDiver en sélectionnant l’article de menu tout en 
enfonçant la touche S (  : O) ou en utilisant le raccourci 
clavier Quit without saving Preferences.

4.7 Le menu Edit (Édition)
Le menu Edit contient les fonctions Find et Select ainsi que les 
fonctions standards servant à couper, copier, et coller les 
données comme dans tout logiciel Macintosh ou Windows. Ces 
fonctions étant variables selon des différents niveaux de Sound-
Diver, nous allons les traiter en profondeur. Vous trouverez 
également Request et Transmit dans ce menu, qui servent à 
transmettre toutes sortes d’entrées depuis et vers SoundDiver.

Undo… (Annuler)
Cette commande annule les dernières opérations si vous avez 
effacé ou modifié par erreur quelque chose d’important. Cette 
fonction agit sur presque toutes les opérations de SoundDiver, 
y compris :

• couper, copier, et coller dans toutes les fenêtres sauf la fenê-
tre Setup,

• déplacer et classer les entrées dans la bibliothèque et la fe-
nêtre Device,

• modifier les paramètres et les noms dans toutes les fenêtres. 
Des changements continus d’un même paramètre ne peu-
vent être annulés que tous ensemble.

Cet article de menu est toujours accompagné d’une description 
des dernières opérations ; vous savez ainsi toujours ce qu’il est 
possible d’annuler.

Naturellement, toutes les opérations annulées affectent égale-
ment la mémoire de vos appareils MIDI.
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Exemple : Supprimez une entrée A dans la fenêtre Device, 
puis échangez l’entrée B avec l’entrée C. En sélectionnant 
Undo la première fois (la fonction affiche pour l’instant “Undo 
Swap”), C sera à nouveau échangé avec B.

En sélectionnant Undo à nouveau (le menu affiche cette fois 
“Undo Clear”), l’entrée A est rétablie.

Si l’article de menu est grisé et affiche “Can’t undo” (Impossi-
ble d’annuler),

• la dernière opération ne peut pas être annulée (par ex. sup-
primer un appareil dans la fenêtre Setup),

• il n’y a pas d’opération à annuler,
• ou il n’y a pas assez de mémoire pour annuler (toutes les éta-

pes ont été effacées).

La fonction Undo possède un nombre illimité d’annulations : 
vous pouvez annuler toutes les opérations précédentes, à 
condition qu’il reste suffisamment de mémoire pour contenir 
les données nécessaires à l’annulation.

& Cette fonction d’annulation illimitée peut demander beaucoup de mémoire, en 
fonction des dernières opérations effectuées. C’est la raison pour laquelle, en cas de 
saturation de la mémoire, SoundDiver efface la première étape de la “chaîne d’annu-
lations” jusqu’à ce que suffisamment de mémoire soit libérée. Dans de telles circons-
tances, vous ne pourrez plus annuler que les opérations les plus récentes.

&  : Les étapes d’annulation ne sont effacées que lorsque les autres méthodes (par ex. 
l’abandon de fichiers de modules ou d’adaptations superflus) n’ont pas résolu le 
problème du manque de mémoire.

Redo… (Refaire)
Cette commande inverse l’Undo le plus récent et permet de 
rétablir la situation telle qu’elle était avant d’avoir eu recours à 
l’annulation. Comme Undo, Redo peut être utilisé un nombre 
illimité de fois.

Si l’article de menu est grisé et affiche “Can’t redo” (Impossi-
ble de rétablir), cela signifie que :

• vous n’avez pas encore appliqué la fonction Undo,
• toutes les étapes d’annulation ont déjà été rétablies,
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• ou qu’il reste si peu de mémoire que la “chaîne d’annula-
tions” a été entièrement effacée.

& Comme pour Undo, il existe une “chaîne de restauration”, qui est raccourcie étape 
par étape dans les situations où la mémoire est saturée ; pour être précis, c’est 
toujours la plus longue de ces deux chaînes (“chaîne d’annulations” et “chaîne de 
restauration”) qui sera raccourcie.

Le presse-papiers de texte
Quand les entrées sont stockées dans le presse-papiers sous 
forme de texte après une opération comme Cut (Couper) ou 
Copy (Copier) dans une fenêtre Library, chaque entrée est stoc-
kée sur une ligne et seules les colonnes actuellement affichées 
apparaissent. Celles-ci affichent leur contenu en entier et sont 
séparées par des symboles de tabulation.

Ce format est idéal pour construire des tableaux dans un logi-
ciel de traitement de texte ou pour être importé dans une base 
de données.

Cut (Couper)
Déplace vers le presse-papiers des objets sélectionnés dans une 
fenêtre ou un texte dans un texte champ. Le contenu du 
presse-papiers peut alors être ajouté ailleurs autant de fois que 
vous le souhaitez, à l’aide de la fonction coller.

Fenêtre Library/Device
Si vous “coupez” une entrée de bibliothèque ou de fenêtre 
Device qui utilise d’autres entrées (“entrée parent”, par exem-
ple une performance du EX 5), les “entrées filles” qui y sont 
reliées sont automatiquement copiées elles aussi dans le 
presse-papiers. Vous pouvez ainsi être sûr que l’entrée restera 
complète si vous l’ajoutez à une autre bibliothèque. Cette fonc-
tion opère sur tous les niveaux (par ex. tableau des change-
ments de programme → multis → voix → pans). Si vous souhai-
tez effacer les entrées associées en même temps que l’entrée 
que vous “coupez”, vous devrez les sélectionner elles aussi. La 
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bibliothèque dispose d’une fonction conçue à cet effet, appelée 
par : A-clic (  : O-clic).

& L’expression “entrée parent” utilisée ici comme ailleurs dans le présent manuel est 
un terme générique pour décrire une entrée constituée de plusieurs autres entrées 
qui la composent. Le terme exact utilisé par votre synthétiseur sera, lui, vraisembla-
blement quelque chose comme Combi, Performance ou Preset.

Si une entrée reliée est inconnue dans la fenêtre Device, un 
dialogue apparaît pour proposer les options suivantes :

Cancel
Les opérations de copie sont annulées.

Ignore
L’entrée est copiée sans les entrées associées, les données
seront donc incomplètes.

Ignore all
Comme “Ignore”, mais les entrées inconnues suivantes sont
ignorées sans nouvel avertissement.

Request
Les entrées inconnues sont réclamées à l’appareil via
MIDI puis copiées.

Request all
Comme “Request”, mais les entrées inconnues suivantes
sont réclamées sans nouvel avertissement.

& Si vous voulez juste supprimer un important volume de données (autrement dit si 
vous ne voulez pas le copier ailleurs à partir du presse-papiers), il vaudra mieux 
utiliser “Clear” (Effacer, voir ci-dessous), car “Cut” duplique temporairement les 
entrées à effacer, ce qui peut parfois saturer la mémoire. Il est plus rapide d’effacer 
que de couper.

Copy
Copie les objets ou le texte sélectionnés dans une fenêtre vers 
le presse-papiers, en laissant les éléments d’origine en place. 
Les explications concernant la fonction Cut s’appliquent égale-
ment ici pour la bibliothèque et la fenêtre Device.
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Paste
Insère le contenu du presse-papiers ailleurs, selon les règles 
suivantes :

Library (Bibliothèque)
Si vous avez sélectionné une entrée, le contenu du presse-
papiers est ajouté avant cette entrée. Si aucune entrée n’est 
sélectionnée, les données sont ajoutées à la fin de la bibliothè-
que. SoundDiver recherche automatiquement les éventuels 
doublons et les supprime.

Si vous ajoutez une entrée qui existe déjà, l’entrée existante 
continue à être utilisée. La référence (à l’emplacement 
mémoire de la fenêtre Device) n’est pas changée, mais une 
référence à l’entrée existante est créée à la place.

Attention : L’identité de deux entrées est établie sur la base 
des données, pas sur celle du nom. Cela signifie que si une 
entrée identique existe déjà dans la bibliothèque, mais sous un 
nom différent, l’entrée existante continue à être utilisée au lieu 
de l’entrée ajoutée.

Cette fonction automatique peut être désactivée dans la fenê-
tre Options > Settings > Library Preferences à l’aide de Check 
doubles (voir le § Check Doubles (Vérifier les Doublons) à la page 
408).

Fenêtre Device
Le contenu du presse-papiers se positionne sur les emplace-
ments mémoire à partir de la première entrée sélectionnée et 
remplace leur contenu. Si aucune entrée n’est sélectionnée, 
SoundDiver recherche un emplacement approprié. Le logiciel 
dispose d’un ensemble de routines visant à empêcher d’écraser 
accidentellement des données ou d’ajouter pour rien des 
entrées déjà présentes. Le fonctionnement est le suivant :

• Si l’emplacement mémoire cible contient déjà les données 
sur le point d’être ajoutées, rien ne se passe,
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• Si les entrées à coller existent déjà dans un autre emplace-
ment mémoire, elles ne seront pas ajoutées une deuxième 
fois,

• Si aucune entrée n’est déjà présente, SoundDiver recherche 
un nouvel emplacement cible pour commencer à partir de 
l’entrée sélectionnée. Il recherche pour cela en premier lieu 
des emplacements mémoire vides afin d’éviter autant que 
possible d’écraser des entrées. Si aucun emplacement n’est 
vide, un dialogue apparaît pour vous laisser choisir vous-
même les emplacements mémoire. Le programme commen-
ce par suggérer un emplacement où ne figure aucune réfé-
rence croisée.

Stratégies de collage
Si vous voulez savoir précisément comment SoundDiver asso-
cie les emplacements pour coller les entrées, les explications 
détaillées se trouvent dans cette section.

Les données reliées qui sont également copiées dans le presse-
papiers sont elles aussi collées. La procédure est la suivante :

• si l’entrée à ajouter est déjà présente dans un emplacement 
mémoire, celui-ci est “réutilisé”. La référence dans l’entrée 
parent est modifiée si l’emplacement mémoire trouvé est 
différent de celui figurant dans l’entrée parent,

• sinon, comme ci-dessus, le programme recherche l’emplace-
ment cible le plus approprié ayant le moins de répercussions 
possibles sur les données existantes.

Exemple : vous venez de copier dans la bibliothèque un multi 
qui utilise les voix “Piano” à l’emplacement mémoire I-05, 
“Slap Bass” en I-17 et “Choir” en I-23. Entre temps, vous avez 
regroupé les voix dans la fenêtre Device et “Slap Bass” est à 
présent à l’emplacement I-03 et “Choir” n’est plus là. Si vous 
copiez maintenant à nouveau le multi depuis la bibliothèque 
vers la fenêtre Device, il se passe les choses suivantes :

• la voix de piano ne changeant pas d’emplacement mémoire, 
rien ne se produit,

• SoundDiver se rend compte que “Slap Bass” n’est plus en I-
17 et qu’il y a été remplacé par une autre voix. Il entreprend 
150
Emagic
SoundDiver 



Le menu Edit (Édition)

X

donc de rechercher “Slap Bass” et le trouve en I-05. La réfé-
rence dans le multi passe alors de I-17 à I-03,

• en outre, “Choir” n’est plus en I-23. SoundDiver entreprend 
alors de le rechercher mais sans succès. Il cherche alors un 
emplacement mémoire vide. S’il n’en trouve pas, il cherche 
un emplacement auquel il n’est fait référence dans aucun 
autre multi (ou aucun tableau de changement de program-
me). L’emplacement mémoire trouvé est proposé comme 
emplacement cible dans un dialogue, mais vous pouvez tou-
jours en choisir un autre. Une fois ce choix confirmé avec 
OK, Choir est ajouté à la fenêtre Device et transmis à l’appa-
reil. La référence dans le multi passe de I-23 au nouvel em-
placement mémoire,

• pour finir, le multi modifié est collé et transmis.

Rappelez-vous que pour copier une entrée parent avec ses 
entrées filles associées depuis une bibliothèque vers une fenê-
tre Device, il suffit de copier l’entrée parent dans le presse-
papiers et de la coller dans la fenêtre Device. Les entrées filles 
associées seront automatiquement copiées elles aussi. En cas 
de doute, vous verrez apparaître un dialogue proposant diverses 
options. La même chose s’applique aussi pour l’opération 
inverse. Cela facilite la gestion des appareils dotés de plusieurs 
couches de données (par ex. Korg Wavestation, Roland D-70 ou 
Waldorf Microwave).

& Pour le collage vers la fenêtre Device, seules les données de son sont comparées, pas 
le nom.

Clear (Effacer)
Cette fonction supprime les objets ou le texte sélectionnés sans 
rien copier dans le presse-papiers. Elle s’annule à l’aide de Edit 
> Undo.

Library (Bibliothèque)
La fonction Entry Dependency Management (Système de gestion 
des relations des entrées) s’assure que vous n’êtes pas en train 
de supprimer une entrée utilisée par une autre entrée. Si c’est 
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justement le cas, un dialogue apparaît pour vous permettre de 
choisir entre :

Cancel
Annule toutes les opérations d’effacement.

No
Conserve l’entrée.

OK
Supprime l’entrée.

All
Toutes les entrées sélectionnées sont supprimées sans nou-
vel avertissement.

Dans le cas de “OK” et de “All”, l’information “uses” (utilise), 
figurant dans les entrées qui utilisent l’entrée supprimée, est 
également supprimée. Par exemple, cela peut rendre une 
entrée parent incomplète si vous supprimez une entrée fille 
que cette entrée parent utilisait. Il est évidemment important 
d’user de la fonction clear avec prudence.

Fenêtre Setup 
Ici, vous recevrez toujours un message d’alerte : en effet, toute 
opération de suppression d’un appareil est irréversible.

& L’icône de l’ordinateur ne peut pas être supprimée.

Select all (Tout sélectionner)
Sélectionne tous les objets sélectionnables dans une fenêtre 
active, ou tout le texte dans un champ texte. Il peut s’agir, par 
exemple, d’entrées de bibliothèque dans la bibliothèque, ou 
d’icônes d’appareils dans la fenêtre Setup.

Utiliser cette fonction avant d’éditer, de copier ou de déplacer 
le contenu entier d’une fenêtre.

Toggle Selection (Inverser la sélection)
Cette fonction inverse la sélection à l’intérieur d’une fenêtre 
active : tous les objets actuellement sélectionnés sont désélec-
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tionnés et inversement tous les objets précédemment non-
sélectionnés sont sélectionnés.

Exemple : Cette fonction peut servir à supprimer la plupart des 
entrées d’une bibliothèque. Vous pouvez sélectionner les quel-
ques entrées que vous souhaitez conserver, inverser la sélection 
et supprimer les entrées sélectionnées.

Request (Demander le transfert)
Quand vous sélectionnez cette commande, SoundDiver 
demande à l’appareil MIDI actif de transmettre ses données 
aux entrées sélectionnées. Selon la nature de la sélection, vous 
pouvez réclamer un son, une banque de sons, la totalité des 
tampons d’édition d’un appareil ou encore du contenu de sa 
mémoire.

Si vous avez sélectionné une icône d’appareil dans la fenêtre 
Setup, SoundDiver va réclamer à l’appareil la totalité du 
contenu de sa mémoire - une autre méthode consiste à activer 
Select all dans la fenêtre Device, puis à sélectionner Request.

Voici une explication détaillée des fonctions de la commande 
Request dans les différentes fenêtres :

Fenêtre Setup 
Dans la fenêtre Setup tous les emplacements mémoire de 
l’appareil sélectionné inconnus auparavant sont réclamés,

• “inconnu auparavant” signifie que si les entrées ont déjà fait 
l’objet d’une requête, elles ne seront pas réclamées à nou-
veau. La fonction Request se contente donc de compléter les 
données des fenêtres Device,

• “emplacements mémoire” signifie qu’aucun tampon d’édi-
tion n’est sollicité (puisqu’ils sont temporaires), pas plus que 
les entrées en ROM (qui, par définition, n’ont pas besoin 
d’être sauvegardées dans une bibliothèque),

• si aucune icône d’appareil n’est sélectionnée, un dialogue 
apparaît pour vous permettre de décider si les opérations 
doivent être appliquées à tous les appareils.
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Fenêtre Library 
Il se passe la même chose dans la fenêtre Library que dans la 
fenêtre Setup ; les emplacements mémoire des appareils sélec-
tionnés (ou de tous les appareils si aucun n’est sélectionné) sont 
copiés dans la bibliothèque.

Fenêtre Device
Dans la fenêtre Device, les entrées sélectionnées font l’objet 
d’une requête. Ici, cela peut également concerner les tampons 
d’édition et les entrées en ROM.
& Certains appareils n’autorisent pas la requête externe de certains types de données, 

ou même de tous les types. Dans ce cas, un dialogue vous permet d’annuler les 
opérations ou d’ignorer cette entrée spécifique.

& Si un appareil n’autorise pas la transmission d’entrées individuelles, le programme 
réclame automatiquement le bloc de données de taille immédiatement supérieure.

& Certains appareils n’autorisent pas la requête via MIDI du contenu entier de leur 
mémoire parce qu’il n’est pas possible de changer le mode de l’appareil via MIDI 
(c’est le cas par ex. des Roland JD-800, JD-990). Si cela se produit, vous en serez 
averti par l’alerte correspondante ou par le message “SysEx communication error”. 
Dans ce cas, cliquez sur le bouton “Help” pour savoir quoi faire.

Fenêtre Éditeur 
Dans les fenêtres d’éditeurs, l’entrée en cours d’édition est à 
nouveau réclamée. C’est indispensable si :

• vous sélectionnez un son différent depuis la façade de l’ap-
pareil 

• ou si vous éditez le son depuis la façade d’un appareil inca-
pable de transmettre des messages de changement de para-
mètres,

après avoir ouvert la fenêtre d’édition de cet appareil.

Transmit (Transmettre)
Cette commande est essentielle pour harmoniser le contenu de 
la mémoire de votre appareil avec SoundDiver - ce qui est 
toutefois rarement nécessaire, SoundDiver se chargeant lui-
même de cette synchronisation. Si vous sélectionnez cette 
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fonction, SoundDiver transmet aux appareils MIDI concernés 
les données se rapportant aux entrées sélectionnées.
& Contrairement aux fonctions Audition et AutoAudition, la fonction transmettre 

inscrit les données directement en mémoire et non dans le tampon d’édition de 
l’appareil.

Voici de façon détaillée ce qui se passe lorsque vous sélection-
nez la commande Transmit :

Fenêtre Setup 
Dans la fenêtre Setup, tous les emplacements mémoire des 
appareils sélectionnés sont transmis,

• “emplacements mémoire” signifie ici aussi qu’aucun tam-
pon d’édition ni aucune entrée en ROM n’est transmis. Na-
turellement, transmettre ces dernières n’aurait de toute 
façon pas de sens,

• si aucune icône d’appareil n’est sélectionnée, un dialogue 
apparaît pour vous permettre de décider si ces opérations 
doivent être appliquées à tous les appareils.

Fenêtre Library 
Dans la fenêtre Library, les entrées sélectionnées sont transmi-
ses aux emplacements mémoire des appareils concernés.

• Si aucune entrée n’est sélectionnée, SoundDiver demande 
s’il doit transmettre la bibliothèque tout entière.

• La sélection de “l’appareil concerné” est très élaborée, de 
nombreuses méthodes pouvant être employées. Pour plus 
d’informations, reportez-vous au § Stratégie de sélection d’ap-
pareils lors d’envois depuis une Bibliothèque à partir de la page 
212 et suivantes.

• Afin d’effectuer une présélection de l’emplacement mémoi-
re de destination, SoundDiver utilise l’information contenue 
par le champ Location de l’entrée de bibliothèque. Si ce 
champ est vide, SoundDiver tente automatiquement de 
trouver une destination appropriée.

Fenêtre Device
Dans la fenêtre Device, les entrées sélectionnées sont transmises.
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& Si certains de vos appareils ne sont pas capables de recevoir des entrées individuelles, 
SoundDiver demandera s’il doit transmettre la banque tout entière. Si certaines 
entrées de la banque ne sont pas reconnues, le logiciel vous demandera également 
si vous voulez initialiser les éléments non reconnus. Si vous ne le souhaitez pas, sélec-
tionnez “Cancel”, réceptionnez toute la banque, puis répétez la procédure de trans-
mission.

Fenêtre Éditeur 
Dans les fenêtres d’éditeurs, l’entrée en cours d’édition est 
transmise à l’appareil. C’est nécessaire notamment si l’appareil 
n’était pas prêt à recevoir au moment où la fenêtre d’éditeur a 
été ouverte (par ex. s’il était éteint).

Find…/Find again (Rechercher/encore)
Les fonctions Find servent à rechercher des entrées dans une 
ou plusieurs bibliothèques. SoundDiver permet d’entrer des 
critères de recherche de nombreuses façons différentes.

Pour une explication détaillée des fonctions de recherche, 
veuillez consulter le § La fonction Find (Recherche) à partir de la 
page 266 et suivantes.

4.8 Le Menu Options

Settings (Réglages)
Vous trouverez des explications 
détaillées au chapitre Les Préférences 
à partir de la page 385 et suivantes.

AutoAudition
Quand AutoAudition est activé, les entrées sélectionnées à la 
souris ou à l’aide des touches de curseur sont automatiquement 
transmises à un tampon d’édition de l’appareil, de façon à vous 
permettre d’écouter immédiatement les sons ou les program-
mes. Il n’est donc pas nécessaire de sélectionner la fonction 
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Transmit dans le Menu Edit chaque fois que vous sélectionnez 
une entrée.

•   : Vous pouvez temporairement inverser l’AutoAudition si 
vous sélectionnez les entrées avec C-clic. Vous pouvez ainsi 
sélectionner une entrée sans l’envoyer immédiatement à 
l’appareil, même si la fonction AutoAudition est active.

Cliquer avec S- ou ç enfoncé inhibe l’AutoAudition (à la fois 
dans les fenêtres Device et Library). Cela permet de faire une 
sélection multiple en évitant que chaque entrée cliquée soit 
transmise.

AutoPlay
Active/désactive la fonction AutoPlay. Lorsqu’elle est activée, 
le séquenceur intégré de SoundDiver joue la séquence chaque 
fois que l’Audition ou l’AutoAudition est déclenchée, ainsi 
qu’en cas de modification d’un paramètre dans un éditeur.

Vous pouvez donc auditionner automatiquement le nouveau 
son avec cette courte séquence.

L’enregistrement de la séquence de test est traité dans le § Le 
Mini Séquenceur à la page 180.
& Si vous utilisez SoundDiver couplé avec Logic Audio via Autolink, SoundDiver jouera 

automatiquement un court passage du morceau ouvert dans Logic Audio, à partir 
de la position du locator gauche.

MIDI Thru
Active/désactive la fonction MIDI Thru de SoundDiver. 
Lorsqu’elle est activée, SoundDiver détourne les événements 
en provenance du clavier maître vers l’appareil actif. Vous 
pouvez sélectionner le clavier maître dans la fenêtre MIDI 
Setup ; vous en saurez plus au § Master keyboard (Clavier maître) 
à la page 203.
& Pendant la requête ou la transmission d’entrées, MIDI Thru est temporairement 

désactivé, afin d’éviter de désorienter les appareils avec l’insertion d’événements de 
notes.

Pour plus d’informations sur les caractéristiques propres à la 
fonction MIDI Thru en relation avec la gestion du MIDI, 
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veuillez vous reporter au § SoundDiver et la gestion du MIDI à la 
page 66 du Chapitre 2 Installation.

Hold Transmission (Suspendre transmission)
Si cet article de menu est coché, toutes les transmissions en 
cours (autrement dit, les messages de dump) sont suspendues 
jusqu’à ce qu’il soit décoché. 

Ceci vaut de façon globale pour tous les appareils. Ainsi, si des 
données sont changées dans plusieurs appareils tant que Hold 
transmission est coché, aucune modification de données ne 
sera transmise aux appareils tant que l’article de menu restera 
coché.

Vous trouverez cette caractéristique utile si vous voulez réorga-
niser plusieurs entrées dans une banque, surtout si transmettre 
une entrée prend du temps (par ex. si vous ne disposez que 
d’un seul message de dump de banque).
Exemple : Vous voulez construire une banque à partir de 
plusieurs entrées de bibliothèque.
❏ vérifiez l’article de menu Hold transmission

❏ glissez/déposez toutes les entrées sur la banque (rien
n’étant transmis, cela ira vite,)

❏ cochez l’entrée de menu Hold transmission. Toutes les
entrées modifiées sont alors transmises.

Send MIDI (Émission MIDI)

All Notes Off
Utiliser cette fonction 
pour corriger les 
problèmes MIDI, 
comme par ex. les 
notes bloquées. 
Quand vous sélection-
nez All Notes Off, 
toutes les notes 
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encore en train de jouer sont désactivées à l’aide d’une 
commande MIDI All Notes Off, adressée à tous les appareils 
connectés. Si le séquenceur intégré est en train de jouer, il est 
arrêté lui aussi ; il en sera de même pour un séquenceur externe 
si vous utilisez un système de gestion du MIDI (AutoLink).

Reset Controllers
Cette fonction transmet la commande MIDI “Reset Control-
lers” qui ramène tous les contrôleurs MIDI (par ex. hauteur, 
modulation, aftertouch) à leur position “neutre”. Utilisez cette 
fonction si un synthétiseur réagit bizarrement à une erreur de 
traitement MIDI, comme un vibrato bloqué ou une hauteur de 
note fausse. Cette commande affecte tous les appareils connec-
tés.

Maximum Volume
Règle tous les appareils connectés sur le volume maximum. 
Cette commande transmet une valeur de 127 pour les contrô-
leurs 7 (volume) et 11 (expression) sur tous les canaux et toutes 
les sorties MIDI.

Loopback Test
Cet article de menu teste le fonctionnement des connexions 
MIDI. Pour cela, connectez temporairement une entrée MIDI 
donnée directement à une sortie MIDI donnée à l’aide d’un 
câble MIDI. SoundDiver envoie les données par paquets et les 
compare aux données reçues.
Cette fonction s’appelle avec Options > Loopback test.... Vous 
pouvez également la lancer à l’aide d’un bouton du message 
“SysEx communication error”.
Pour choisir le port, cliquez sur un appareil et sélectionnez 
votre port In et Out.
SoundDiver vous guide pas à pas.
Commencez par connecter le MIDI In avec le MIDI Out à 
l’aide d’un câble MIDI et cliquez sur Start tests.
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SoundDiver envoie des messages MIDI à la sortie et vérifie les 
données reçues.
SoundDiver transmet tous les messages sur 7*16 canaux (avec 
l’octet de données 0), puis des messages de SysEx portant l’ID 
de constructeur “Non-Commercial SysEx” (7Dh) de taille 
croissante.
Le dernier message vous donnera le détail des informations. 
Les tests continuent jusqu’à ce qu’un problème survienne ou 
jusqu’à ce que le message de SysEx testé atteigne 20 000 
octets.

4.9 Le Menu Windows 
(Fenêtres)

Le menu Windows est le seul 
menu variable de SoundDiver. 
Son contenu dépend de la nature 
des fenêtres ouvertes et de leur 
nombre. Les sections suivantes 
traitent des différentes classes de 
fenêtre : “Library”, “Setup” et 
“fenêtre Device”. Au sein d’une 
classe de fenêtres, il est possible 
d’ouvrir plusieurs fenêtres qui 
apparaîtront alors dans le menu 
Windows. Si vous avez ouvert un 
grand nombre de fenêtres qui se 
chevauchent, vous pouvez 
amener n’importe laquelle 
d’entre elles au premier plan à 
l’aide du menu Windows.
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Si vous sélectionnez un des articles du menu Open... et qu’une 
fenêtre de cette classe soit déjà ouverte sans être active (c’est-
à-dire au premier plan), la fenêtre est activée. Si aucune fenêtre 
de ce genre n’est ouverte, ou si elle est déjà active, alors c’est 
une nouvelle fenêtre de cette classe qui s’ouvrira (à condition 
qu’il soit possible d’ouvrir plusieurs fenêtres de cette classe).

Exemple : si vous sélectionnez l’article de menu Open Library, 
une nouvelle fenêtre Library s’ouvre. Mais si vous sélectionnez 
un des sous-articles de menu situés sous Library, la fenêtre sur 
laquelle vous cliquez passe au premier plan - aucune nouvelle 
fenêtre n’est ouverte.

Screensets

En principe, vous agencerez vos fenêtres à l’écran conformé-
ment à vos habitudes de travail. Cette disposition de diverses 
fenêtres ayant chacune des paramètres différents (affichage, 
zoom, position de chacune d’entre elles) s’appelle un Screenset 
et peut être enregistrée. Vous pouvez ainsi alterner entre diffé-
rents Screensets, un peu comme si vous alterniez entre diffé-
rents moniteurs d’ordinateur.

& Version Windows : la taille et la position de la fenêtre cadre (c’est celle qui contient 
la barre de menus) sont mémorisées elles aussi dans le Screenset.

Mémoriser des Screensets
Les Screensets sont numérotés de 1 à 99 en n’utilisant que les 
chiffres de 1 à 9 (la touche 0 n’est pas permise). Vous pouvez 
voir le numéro du Screenset en cours d’utilisation dans le menu 
principal à côté du mot Windows.

Il n’est pas nécessaire d’enregistrer les Screensets avec une 
commande explicite. L’enregistrement se fait automatique-
ment dès que vous passez à un autre Screenset. Ainsi, sans que 
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vous ayez à vous en soucier, votre espace de travail actuel est 
toujours stocké dans le Screenset en cours d’utilisation. vous en 
trouverez un exemple dans le § Screensets à partir de la page 117 
et suivantes.

Changer de Screenset
Tapez simplement le numéro du Screenset désiré (1 à 9). Pour 
les Screensets à deux chiffres, maintenez A (  : ç) en 
entrant le premier chiffre.

Protéger des Screensets
Utilisez l’option Windows > Screenset > Locked (Verrouiller) ou 
le raccourci clavier Lock/unlock current Screenset pour empêcher 
que le présent Screenset puisse être modifié. Un “•” (sur Macin-
tosh) ou un “#” (sous Windows) apparaît alors devant le numéro 
du Screenset. Sélectionnez à nouveau le raccourci clavier ou la 
commande de menu pour déverrouiller le Screenset.

Copier des Screensets
Pour copier le Screenset en cours d’utilisation sur un Screenset 
cible, maintenez S tout en appelant le Screenset de destina-
tion. Les Screensets à deux chiffres se copient avec SA (  : 
Sç). SoundDiver affiche un dialogue de sécurité lors de la 
copie de Screensets.

Vous pouvez également utiliser les fonctions de menu pour 
copier des Screensets via le presse-papiers : passez sur le 
Screenset que vous souhaitez copier et sélectionnez Windows 
> Screenset > Copy Screenset, puis appelez le Screenset qui 
doit recevoir la copie et sélectionnez Paste Screenset.

Revenir à un Screenset mémorisé
Le raccourci clavier Revert to current Screenset redonne à l’écran 
l’état qu’il avait avant que vous appeliez le Screenset actuel.
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Alterner à l’aide du séquenceur 
En mode AutoLink, les Screensets de Logic Audio et de 
SoundDiver sont synchronisés. Le Meta-événement n° 49 
permet d’alterner entre différents Screensets via Logic. Voir le 
chapitre 10 du manuel de Logic pour plus de détails.

Open Library
Cette commande de menu ouvre une nouvelle fenêtre dans la 
bibliothèque active. Vous pouvez ouvrir autant de fenêtres que 
vous voulez pour une même bibliothèque et organiser ainsi une 
bibliothèque en plusieurs sections de différentes tailles pour 
économiser de l’espace sur l’écran.

Si aucune bibliothèque n’est encore chargée, l’article de menu 
Open Library reste actif. Vous pouvez l’utiliser pour ouvrir une 
bibliothèque (c’est la même fonction que File > Open...).

Vous pouvez ouvrir plusieurs fenêtres de bibliothèque à la fois 
et disposer plusieurs sections de la même bibliothèque avec 
différentes échelles de représentation afin d’économiser de 
l’espace sur l’écran. Les fonctions des bibliothèques sont trai-
tées en détail à la page 243.
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Open Setup
Ouvre la fenêtre Setup (de Configuration) ou la fait passer au 
premier plan. On ne peut ouvrir qu’une seule fenêtre Setup.

Les fonctions de Setup sont décrites en détail page 189.

Open Device
Ouvre une nouvelle fenêtre Device (fenêtre d’Appareil) pour 
l’appareil sélectionné dans la fenêtre Setup. Si aucun appareil 
n’est encore sélectionné dans la fenêtre Setup, la fenêtre 
Device s’ouvre pour l’appareil qui était actif auparavant. Si la 
fenêtre Device de cet appareil était déjà ouverte, elle passe au 
premier plan.

Si la fenêtre Device n’affiche rien d’autre que la case des para--
mètres, vérifiez que tous les types de données apparaissent 
bien. Pour pouvoir voir tous les types de données l’écran, sélec-
tionnez View > Data types > Show All. Vous pouvez également 
cliquer sur le bouton All en haut à droite de l’icône de l’appa-
reil. Vous trouverez davantage d’informations au § La Fenêtre 
Device à la page 215.

Vous pouvez ouvrir plusieurs fenêtres Device à la fois pour un 
même appareil, ce qui permet de disposer à l’écran différentes 
sections d’une fenêtre Device et d’afficher simultanément des 
sections qui ne rentrent pas dans une seule fenêtre.
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X

Une fenêtre Device affichant deux sections de fenêtre 

Les fonctions de la fenêtre Device sont traitées en détail à la 
page 215.

Open Editor
Quand vous sélectionnez cette commande dans le menu, une 
nouvelle fenêtre d’éditeur s’ouvre pour l’entrée sélectionnée 
dans la fenêtre Device. Si aucune entrée n’est sélectionnée 
dans la fenêtre Device, cette commande ne sera pas accessible 
dans le menu. Si l’entrée sélectionnée ne peut pas être éditée, 
la fonction Audition se déclenche et la fenêtre Éditeur s’ouvre 
pour le tampon d’édition concerné. Si une fenêtre d’édition 
était déjà ouverte pour cette entrée, elle passe au premier plan.

Vous pouvez ouvrir plusieurs fenêtres d’édition pour le même 
tampon d’édition, ce qui permet de disposer à l’écran différen-
tes sections d’une fenêtre Device pour afficher simultanément 
des sections qui sinon ne rentreraient pas dans une seule fenê-
tre.

Les fonctions d’édition sont traitées en détail page 293.
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& La fonction “Link window” est désactivée dans toutes les fenêtres Editor si vous 
ouvrez une nouvelle fenêtre Éditeur alors qu’une fenêtre Éditeur était déjà ouverte. 
C’est en effet un cas où vous voudrez sans doute éditer plusieurs entrées différentes, 
ce que “Link window” vous empêcherait de faire.

Open Controller Assignments
Ouvre une fenêtre dans laquelle vous pouvez assigner 
n’importe quel message MIDI reçu à n’importe quel paramètre 
dans SoundDiver.

On ne peut ouvrir qu’une seule fenêtre Controller Assign-
ments, toutes les Assignations de Contrôleurs étant gérées dans 
le même tableau.

Vous trouverez tous les détails dans le § Les Assignations de 
contrôleurs à la page 327.

Open Install Window
Cette option ouvre la fenêtre Install (fenêtre d’installation).

On peut y installer de nouveaux appareils ou scanner l’installa-
tion MIDI pour y rechercher de nouveaux appareils connectés. 
Lisez le § Installer d’autres appareils à la page 58.

Open Sequencer
Cette commande de menu ouvre la fenêtre du séquenceur 
intégré. Cette fenêtre est (par défaut) une “fenêtre flottante”, 
par définition toujours au premier plan.

Pour l’ouvrir comme une fenêtre normale, utiliser le raccourci 
clavier Open Sequencer as normal.

Les fonctions détaillées du séquenceur sont traitées dans le § 
Le Mini Séquenceur à la page 180.

Open MIDI Monitor
Ce article de menu ouvre une fenêtre qui affiche les messages 
MIDI reçus et émis. Elle est particulièrement utile pour 
diagnostiquer les problèmes de communication.
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Les fonctions du MIDI Monitor sont traitées dans le § MIDI 
Monitor à la page 183.

Open Help
Sélectionnez cette option de menu ou appuyez sur @ (  : 
H) pour appeler l’aide en ligne (ou la faire passer au premier 
plan). La fonction d’aide est sensible au contexte, c à d. qu’elle 
fournit toujours la page d’aide relative à la situation en cours.

Exemple : si vous sélectionnez un appareil dans la fenêtre 
Setup et que vous choisissez “Help”, le texte d’aide concernant 
cet appareil viendra s’afficher à l’écran.

Les fonctions d’aide sont décrites de façon plus détaillée dans 
le § L’aide en ligne à la page 170.

Les commandes de fenêtre suivantes contribuent à vous 
donner une vue d’ensemble de l’écran en superposant les fenê-
tres et en les disposant sur toute la surface de l’écran. Elles sont 
à peu près identiques dans tous les logiciels d’Emagic.

Larger View (Vue agrandie)
Affiche le contenu de la fenêtre dans une taille de police supé-
rieure. 

Smaller View (Vue rétrécie)
Affiche le contenu de la fenêtre dans une taille de police infé-
rieure.

Next Window (Fenêtre suivante)
Cette option fait passer la fenêtre du dessous de la pile au 
premier plan et l’active si nécessaire.

Zoom Window
Cette option a la même fonction qu’un clic sur l’outil zoom 
situé au coin supérieur droit de la fenêtre active. Elle gère 
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l’alternance entre une utilisation maximale de l’écran et la taille 
définie pour la fenêtre. En même temps, elle place la fenêtre 
sous la barre de menus.
& Pour utilisateurs avertis : quand vous passez de la taille définie pour la fenêtre à la 

taille de fenêtre maximale, la position horizontale et verticale de la fenêtre n’est 
modifiée que si la fenêtre cesse de rentrer en entier dans l’écran.

Close Window (Fermer fenêtre)
Cette option ferme la fenêtre active. Vous pouvez également 
cliquer tout simplement sur la case de fermeture au coin supé-
rieur gauche de la fenêtre.
&   : dans des versions précédentes de SoundDiver, le raccourci clavier pour cette fonc-

tion était Cu. Pour des raisons de compatibilité avec les conventions Macintosh, 
il a été remplacé par Cw.

& Quand vous fermez une fenêtre de bibliothèque, la bibliothèque elle-même n’est pas 
refermée. Elle ne l’est qu’en sélectionnant File > Close Library (voir le § Close 
Library (Fermer la Bibliothèque) à la page 141). Cela s’avère pratique pour créer un 
Screenset qui ne possède pas de fenêtre de bibliothèque ouverte, tout en gardant 
ouverte la bibliothèque elle-même. Voir également le § Screensets à la page 135.

Tile Windows (Mosaïque)
Essaie de disposer toutes les fenêtres ouvertes sur l’écran de 
telle manière que vous puissiez les voir toutes à la fois. Bien 
entendu, la réussite de l’opération dépend du nombre de fenê-
tres ouvertes et de la taille l’écran.

Tile Windows Horizontally
Essaie de disposer toutes les fenêtres ouvertes sur l’écran de 
façon à leur donner la largeur maximale. S’il ne reste pas 
d’espace utile en hauteur pour une fenêtre, SoundDiver 
installe une nouvelle rangée. SoundDiver optimise la disposi-
tion des fenêtres.

Stack Windows (Empiler les fenêtres)
Place la première fenêtre au dessous de la barre de menus et 
empile les autres fenêtres en dessous de la première pour vous 
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permettre de déplacer ou d’activer facilement n’importe quelle 
fenêtre.

Liste des fenêtres
Sous les articles de menu spécifiques aux fenêtres figure une 
liste de toutes les fenêtres ouvertes. La fenêtre active est 
cochée. Sélectionner un de ces articles de menu active la fenê-
tre concernée.

Si plus de 10 fenêtres sont ouvertes, un article More windows... 
vient s’ajouter à la liste. Vous pouvez y sélectionner une des 
autres fenêtres ouvertes.

Liste des Bibliothèques
Au bas du menu Windows, vous pouvez voir les bibliothèques 
actuellement ouvertes. La bibliothèque active est cochée. Si 
vous sélectionnez une bibliothèque ici, elle est activée et sa 
fenêtre - si elle déjà ouverte - passe au premier plan. Si aucune 
fenêtre n’était encore ouverte pour la bibliothèque active, une 
nouvelle s’ouvre automatiquement.
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4.10 L’aide en ligne
Le système exhaustif d’aide en ligne constitue une part essen-
tielle de SoundDiver. Il offre une assistance à l’utilisateur 
confronté à divers problèmes, questions et dysfonctionne-
ments. L’aide en ligne est sensible au contexte - ce qui signifie 
que lorsque vous appelez l’aide, c’est toujours le texte d’aide 
relatif à la situation présente qui apparaît à l’écran. Vous pouvez 
en parcourir les pages ou utiliser l’index pour appeler l’aide 
directement par thèmes.

 La version Windows utilise le système d’aide de Windows.

 : L’aide utilise une fenêtre ordinaire qui peut rester ouverte 
pendant que SoundDiver travaille. 

Nous vous conseillons de laisser cette fenêtre d’aide ouverte en 
permanence les premiers temps - par exemple sur la droite de 
l’écran - et de lire le texte d’aide très attentivement.

L’aide en ligne complète le présent manuel avec des informa-
tions concernant des appareils spécifiques. Par exemple, dans la 
fenêtre Setup, vous pouvez obtenir une aide à propos de l’appa-
reil MIDI sélectionné. En dehors des messages à caractère 
général concernant SoundDiver, il existe des messages d’aide 
spécifiques à chaque module, installés avec chaque nouveau 
module.

L’aide en ligne s’appelle soit en sélectionnant Windows > Help 
ou en appuyant sur @ (  : H).

& Windows seulement : en sélectionnant l’article de menu Options > Help always 
in foreground, la fenêtre d’aide demeure au premier plan, même lorsque vous 
cliquez ailleurs dans SoundDiver.

&  : La fenêtre d’aide s’ouvre par défaut sous la forme d’une “fenêtre flottante”. Les 
raccourcis claviers pour la fenêtre d’aide cessent d’être actifs. Si vous voulez 
conserver l’usage des raccourcis claviers avec la fenêtre d’aide, ouvrez-la tout en 
appuyant sur O.

Menu Aide sous Windows
Le menu d’aide se trouve à droite du menu Windows. Vous 
pouvez y ouvrir l’aide en ligne de plusieurs manières :
170
Emagic
SoundDiver 



L’aide en ligne
Help…
Ouvre l’aide en ligne avec des contenus différents selon la 
situation en cours. Cet article de menu est identique à celui qui 
figure dans le menu Windows (voir le § Open Help à la page 167).

Search Help…
Ouvre le dialogue d’index de la fenêtre d’aide relative à la 
situation en cours. Vous pouvez y sélectionner directement une 
page d’aide ou rechercher des passages de texte dans le fichier 
d’aide.

How to Use Help…
Vous montre comment utiliser le système d’aide de Windows.

Menus communs
Sur le Macintosh dans le menu  , et sur Windows dans le menu 
Aide se trouvent les articles suivants :

About SoundDiver…
Ouvre la fenêtre d’info “A propos de”. Vous y trouverez, entre 
autres, le numéro de version exact de SoundDiver. Vous en 
aurez besoin en cas d’appel au service technique.

Les articles de menu suivants ne figurent que dans les versions 
OEM et démo de SoundDiver.

License Agreement… (Accord de licence)
Ouvre un fichier d’aide comportant l’accord sur les conditions 
d’utilisation. Pour les versions commerciales de SoundDiver, 
cet accord figure dans le § Accord de licence à la page 2.

SoundDiver Features…
Ouvre un fichier d’aide comportant la liste de toutes les carac-
téristiques de SoundDiver.
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Emagic Distributors…
Ouvre un fichier d’aide comportant la liste de tous les distribu-
teurs des produits Emagic.

Disposition de la fenêtre d’aide

La fenêtre d’aide

Comme les autres fenêtres, la fenêtre d’aide contient les 
éléments de fenêtre standards (barres de défilement, case de 
fermeture, etc.). Vous pouvez donc la placer où vous voulez sur 
l’écran ou déplacer l’affichage de la fenêtre.
La barre de titre affiche toujours le chemin d’accès sur le disque 
du message d’aide du moment.

La barre de contrôle sous Windows

Vous pouvez utiliser la barre de contrôle locale pour vous dépla-
cer dans les messages d’aide de la façon suivante :

• Ce nouveau bouton vous conduit à la première page 
du fichier d’aide sélectionné. C’est normalement là que vous 
trouverez la description du module ou de l’adaptation.

•  Voir ci-dessous.

• Vous ramène à la précédente page sélectionnée. Vous 
pouvez ainsi remonter le cours des messages d’aide jusqu’à 
votre point de départ.

Barre TitreBarre de commandes

Message d’aide

Barres de

Références croissées

défilement
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X
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 : la fenêtre d’aide se ferme dès que vous revenez au début.

• recule d’une page

• avance d’une page

Index
Si vous cliquez sur Index, l’index apparaît à l’écran. Sélection-
nez le terme sur lequel vous souhaitez obtenir plus d’informa-
tions et cliquez dessus. Si vous changez d’avis et que vous 
renoncez à ouvrir une autre page de l’index, appuyez sur ™.

Utiliser l’aide en ligne
L’aide en ligne elle-même comporte des instructions expli-
quant comment naviguer à travers le système d’aide. Pour faire 
apparaître ces instructions, cliquez sur le bouton Help dans la 
barre de contrôle de la fenêtre Help (Windows: @).

Zoom
La taille de l’affichage au sein de la fenêtre Help peut être 
modifiée à l’aide de l’outil Zoom sur Macintosh (Windows : 
sous-menu “Options” article “Font size”, trois tailles de police 
disponibles).

Références croisées

Les messages d’aide contiennent toujours des références croi-
sées à des sujets voisins ou associés par extension. Les mots 
clés concernés apparaissent soulignés et en caractères gras sur 
Macintosh (Windows : en couleur et soulignés). Un clic sur l’un 
de ces mots fait apparaître à l’écran la page correspondante.

Icônes
Vous rencontrerez souvent des icônes qui mettent en avant des 
sections particulièrement importantes, des alertes ou des infor-
mations détaillées.
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 veuillez lire le texte suivant très attentivement afin 
d’éviter une fausse manœuvre ou la perte de données

 explique comment utiliser un objet avec la souris

 un exemple explicatif du message d’aide

Pages standards 
La plupart des fichiers d’aide comportent au minimum une 
série de pages d’aide standards. Toutes ces pages peuvent être 
appelées depuis l’index (voir le § Index à la page 173).

“Module” Module (par ex. module JV1080) 
Cette page se trouve au tout début des fichiers d’aide des 
modules de SoundDiver. Elle contient des descriptions d’intro-
duction au module.

“Model” (par ex. XP-80) 
Dans un Module de SoundDiver, cette page décrit les particu-
larités d’un modèle donné, notamment par rapport aux autres 
modèles gérés par le module.

Dans une Adaptation, cette page trouve au tout début du 
fichier d’aide et contient des notes sur l’Adaptation ainsi que 
sur les modèles qu’elle prend en charge.

Cette page s’appelle depuis la fenêtre Install pour le premier 
appareil sélectionné.

Installation
Décrit les étapes nécessaires à l’installation de l’appareil dans 
SoundDiver, par ex. au cas où des paramétrages seraient requis 
pour que l’appareil puisse traiter les messages de SysEx.

Scan…
Décrit les particularités de la fonction Scan. Certains appareils 
ne peuvent pas être scannés, ce qui sera dans ce cas indiqué ici.
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MIDI…
Ici sont indiqués en détail quels messages MIDI le Module ou 
l’Adaptation est en mesure de traiter. Certains modules ne 
reconnaissent pas les “bulk dump” (transferts complets) et/ou 
les messages de changement de paramètre.

Vous y trouverez également des notes à caractère général sur les 
spécificités de la communication MIDI avec l’appareil.

AutoLink
Cette page contient toutes les informations relatives à l’affi-
chage des noms de Changements de Programmes (Name 
Provider, voir le § Noms des sons dans les Instruments Logic à la 
page 360) : l’éventuelle nécessité de réclamer certaines entrées 
ou de configurer certains paramètres, ainsi que tous les messa-
ges Bank Select reconnus. Si vous rencontrez des problèmes 
avec le Name Provider d’AutoLink, veuillez commencer par 
consulter cette page.

SysEx Communication Error
Cette page énumère toutes les raisons susceptibles d’expliquer 
les problèmes de communication, ainsi que les façons de les 
résoudre ou de les éviter.

Cette page d’aide s’affiche en cliquant sur le bouton Help dans 
le message d’erreur “xxx didn’t answer...” (xxx ne répond 
pas...).

Memory Manager (Gestionnaire de mémoire)
Le Memory Manager dresse la liste de toutes les banques de 
l’appareil, ainsi que celle des configurations possibles (par ex. 
cartes, extensions mémoire).

Cette page s’appelle en ouvrant la fenêtre d’aide depuis la 
fenêtre Device si aucune entrée n’est sélectionnée, ou s’il 
n’existe pas d’aide en ligne pour la banque de l’entrée sélec-
tionnée.
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“Data type” (par ex. Patch)

Définit le type de données.

“Bank” (par ex. patches temporaires en mode 
Performance)

Décrit les particularités de la banque et comporte un lien avec 
le type de données de la banque.

Cette page s’affiche en ouvrant la fenêtre d’aide alors qu’une 
entrée est sélectionnée dans la fenêtre Device, ou en sélection-
nant une entrée dans une autre banque alors que la fenêtre 
d’aide est déjà ouverte.

Case des Paramètres d’Appareil
Les particularités de la case des paramètres d’appareil (voir le § 
La Case des Paramètres d’Appareil à la page 196) ainsi que les 
paramètres spéciaux (voir le § Paramètres d’Appareil Spéciaux à la 
page 206) s’affichent ici.

Cette page s’obtient en cliquant sur le bouton Help dans la case 
des paramètres spéciaux.

Conversion
Indique si le Module ou l’Adaptation est capable de convertir 
un type de données en un autre type (ou même entre différents 
modèles d’appareils).

Import
Indique si le Module est capable d’importer des formats de 
fichiers exotiques.

Credits
Indique qui a créé le Module ou l’Adaptation ainsi que le 
fichier d’aide en ligne.
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“Data type” Editor (par ex. Patch Editor)

Décrit la conception générale et la structure de l’éditeur de 
SoundDiver pour un certain type de données.
Cette page s’obtient en ouvrant la fenêtre d’aide alors une 
fenêtre d’édition est active mais qu’aucun curseur ne clignote 
ou qu’il n’existe pas d’aide spécifique pour le paramètre sur 
lequel pointe le curseur.

“Parameter group” (par ex. TVA Envelope)…

Décrit la fonction du groupe de paramètres, ainsi qu’une liste 
des groupes de paramètres secondaires qui peuvent également 
être copiés à part.

Cette page s’ouvre s’il n’existe aucune aide spécifique concer-
nant les paramètres individuels dans le groupe de paramètres.

“Parameter” (par ex. Cutoff Frequency)…

Décrit l’effet d’un paramètre et, le cas échéant, les valeurs indi-
viduelles du paramètre. Vous y trouverez souvent également un 
lien vers le groupe de paramètres portant le numéro immédia-
tement supérieur.

Si le paramètre peut être édité avec “Listen to MIDI” (voir le 
§ Entrée de valeurs via MIDI à la page 309), vous trouverez 
l’icône appropriée associée à un commentaire indiquant quels 
messages MIDI peuvent être utilisés pour saisir une valeur.

Ce page s’affiche en ouvrant la fenêtre d’aide alors que le 
curseur clignote sur un paramètre, ou quand le curseur est 
déplacé sur un autre paramètre tandis que la fenêtre d’aide est 
déjà ouverte.

4.11 Les Bulles d’Aide
Les Bulles d’Aide (ToolTips) sont de petites fenêtres locales 
qui s’ouvrent lorsque le pointeur de la souris passe au dessus 
d’un objet et y reste au-delà d’une demi seconde. Les Bulles 
d’Aide donnent des informations sur les entrées ou décrivent la 
fonction d’un bouton.
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La Bulle d’Aide se referme si

• le pointeur de la souris se déplace sur un autre objet, 

• une touche ou un bouton est enfoncé

• vous cliquez sur une entrée de la fenêtre Device

• ou au bout de 10 secondes maximum.

Les Bulles d’Aide dans la fenêtre Éditeur 
Dans une fenêtre d’édition, les Bulles d’Aide affichent en 
entier le nom et la valeur du paramètre actuel. Une Bulle 
d’Aide s’ouvre si vous éditez un paramètre dans une fenêtre 
Éditeur 

• à la souris (fonction “Mouse as slider”). La Bulle d’Aide se 
referme lorsque vous relâchez le bouton de la souris.

• au clavier. La Bulle d’Aide se referme au bout de 2 secondes.

Les Bulles d’Aide dans la fenêtre Device
Dans la fenêtre Device, les Bulles d’Aide contiennent le type 
de données, l’emplacement mémoire et le nom complet de 
chaque entrée. Cette information figure également dans la 
barre d’état au bas de votre fenêtre, mais seulement pour 
l’entrée sélectionnée.

Réglage des Bulles d’Aide
Les réglages des Bulles d’Aide se trouvent en Options > 
Settings > Display Preferences.
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Si When pointing on objects (“en pointant sur un objet”) n’est pas 
coché, aucune Bulle d’Aide ne s’affiche quand le pointeur de la 
souris passe au dessus d’un objet.
Désactiver While editing (“en cours d’édition”) ne supprime les 
Bulles d’Aide que lorsque des paramètres sont en train d’être 
édités.

Particularités
& Aucune Bulle d’Aide ne s’affiche lorsque des groupes de paramètres sont copiés, 

initialisés ou soumis à des opérations aléatoires. Si des paramètres sont modifiés par 
traitement de messages MIDI dans la liste des assignations de contrôleurs, les Bulles 
d’Aide sont omise là encore (voir le § Les Assignations de contrôleurs à partir de la 
page 327 et suivantes).

 : Si l’option Aide > Afficher les bulles d’aide est activée, les 
fenêtres de Bulle d’Aide s’ouvrent immédiatement et ne se 
referment que lorsque le pointeur de la souris se déplace sur un 
endroit dépourvu d’objets capables de faire apparaître une 
Bulle d’Aide.
Sur la plate-forme Windows, on peut choisir le fond des Bulles 
d’Aide dans le panneau de configuration “Affichage”, onglet 
“Apparence”. On peut aussi choisir la couleur dans le menu 
déroulant “Couleur” après avoir sélectionné “Info-bulle” dans 
le menu déroulant “Élément”.
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Voir le § ToolTips (Bulles d’aide) à la page 403 pour plus de 
détails.

4.12 Le Mini Séquenceur
SoundDiver dispose d’un petit séquenceur pour enregistrer 
des phrases ou des mélodies, qui peut servir à écouter vos sons. 
Ce séquenceur sera particulièrement pratique si vous devez 
travailler sans clavier MIDI. Vous pouvez intégrer des séquen-
ces de test à chaque bibliothèque et les faire jouer automati-
quement grâce à la fonction Options > AutoPlay.

&  : Le séquenceur interne est désactivé chaque fois que vous utilisez AutoLink. Pour 
plus de détails, veuillez vous reporter au § SoundDiver et la gestion du MIDI à partir 
de la page 66 et suivantes.

Pour ouvrir la fenêtre du séquenceur, sélectionnez Windows > 
Sequencer. La fenêtre du séquenceur est une “fenêtre flot-
tante” elle reste toujours active et au premier plan. Comme elle 
prend assez peu de place, vous pouvez, si vous voulez, la laisser 
ouverte en permanence. Si vous voulez ouvrir le séquenceur 
sous la forme d’une fenêtre ordinaire, utilisez le raccourci 
clavier Open Sequencer as normal.

Le mini-séquenceur ne dispose que d’une seule piste et 
contient les fonctions principales qui vous sont probablement 
déjà familières dans d’autres séquenceurs.

1 Affichage des mesures : mesure, temps, 

double-croche, tic.

2 Champ Tempo

3 Affichage MIDI In/Out : entrée/sortie des 
événements MIDI sous forme de texte 

4 Bouton Enregistrement

5 Bouton Pause

6 Bouton Lecture (Play)

7 Bouton Stop

1

2

3 4

5

6 7
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Sous Autolink, le curseur de tempo est remplacé par un curseur 
“AutoPlay Duration”. Ce curseur règle la durée de jeu (en 
secondes) du séquenceur externe en mode AutoPlay.

& Si le séquenceur externe tourne déjà en mode “cycle”, SoundDiver ne l’arrêtera pas. 
Vous pouvez ainsi essayer des sons différents pendant qu’il tourne en boucle.

Enregistrement
Pour enregistrer une séquence, commencez par vous assurer, 
en observant l’affichage des données de MIDI In, que le 
séquenceur reçoit correctement les données émises par le 
clavier,
❏ cliquez sur le bouton d’enregistrement (record) ; vous allez

entendre un métronome et la position des doubles-croches
et des tics va s’afficher en boucle,

❏ réglez le tempo en modifiant la valeur de bpm à la souris,
❏ jouez la séquence sur le clavier MIDI. Dès que vous com-

mencez à jouer, l’affichage de l’horloge démarre. Vous pou-
vez interrompre l’enregistrement à l’aide du bouton pause.
Lorsque vous avez fini de jouer, cliquez sur le bouton stop.

Paramètres de sortie 
Comme pour le MIDI Thru, le séquenceur joue toujours sur la 
sortie MIDI assignée à l’appareil actif et sur le canal MIDI défini 
par le paramètre Thru Ch (voir le § Thru Channel (Canal Thru) à la 
page 200).

Play
Cliquez sur le bouton Play pour écouter la séquence. Le 
séquenceur joue la phrase une fois. Vous pouvez automatiser le 
jeu de la séquence de test de la façon suivante :
Si vous avez activé Options > AutoPlay, la séquence de test est 
transmise chaque fois que vous sélectionnez une entrée.
Dans ce cas, il vaudra mieux utiliser des séquences d’une 
mesure au maximum.
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Drum Autoplay
Définit la durée d’une note (en millisecondes). Ce paramètre 
n’est utilisé que si un éditeur ne change qu’une seule note, car 
sinon une séquence complète n’aurait pas de sens. Lorsque 
vous éditez des sons de batterie, la note concernée est jouée 
pour la durée définie en Drum AutoPlay.
& Cette fonction n’est pas disponible pour les Adaptations.

Free Memory
La mémoire disponible est visible au bas de la fenêtre Séquen-
ceur. Elle sert de vue d’ensemble de la consommation de 
mémoire de SoundDiver.
Les valeurs affichées donnent la taille du bloc disponible le 
plus important, pas la taille cumulée de tous les blocs libres - 
cette dernière information étant inutile lorsqu’il s’agit d’allouer 
un gros bloc de mémoire.
En cliquant sur l’affichage, vous pouvez tenter d’augmenter la 
mémoire disponible :

• Un seul clic “comprime” la mémoire, autrement dit déplace 
les blocs qui peuvent l’être de façon à combiner ensemble 
les blocs disponibles fragmentés. Cette fonction est compa-
rable à celle des outils de défragmentation comme Norton 
SpeedDisk.

• Un clic droit (  : C-clic) purge les blocs qui peuvent l’être, 
autrement dit retire les blocs qui ne sont pas nécessaires à ce 
moment-là.

• Un double-clic libère autant de mémoire que possible, 
autrement dit procède aux deux opérations ci-dessus.

Mémoriser la séquence
Dans la fenêtre Library se trouve l’article de menu Library > 
Store sequence. Cette commande permet d’intégrer la 
séquence actuellement dans le mini-séquenceur à toutes les 
entrées sélectionnées. Par exemple, vous pouvez sélectionner 
tous les sons de basse et leur attribuer un plan de basse slap 
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caractéristique, puis attribuer à tous les sons de cordes une 
progression d’accords lente, etc.
Enregistrez simplement la séquence que désirez, sélectionnez 
les entrées concernées dans la bibliothèque et sélectionnez 
cette commande de menu.
& Cette fonction n’est pas disponible en mode AutoLink ou lorsque SoundDiver est 

utilisé avec un autre système de gestion du MIDI. Dans de tels cas, le séquenceur 
interne est désactivé.

Le séquences sont mémorisées sur le disque avec la bibliothè-
que et sont disponibles dès que vous redémarrez SoundDiver.

4.13 MIDI Monitor
Abb. MIDI-In-Fenster

La fenêtre MIDI Monitor affiche le flux de données MIDI et 
sert principalement à vérifier les connexions MIDI. Pour 
l’ouvrir, cliquez sur In ou Out dans la fenêtre Sequencer.

L’autre méthode consiste à sélectionner Windows > Open MIDI 
Monitor. Si vous maintenez ‚ (  : O) en même temps, la 
fenêtre s’ouvre sous la forme d’une “fenêtre flottante”.

La fenêtre affiche toutes les données MIDI reçues ou transmi-
ses par l’ordinateur, sur toutes les sorties et toutes les entrées.
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Les données MIDI sont au format hexadécimal à gauche et en 
ASCII à droite. Les octets de statut sont en caractères gras 
(dans l’illustration, comparez les octets de statut SysEx F0 et 
F7).

On peut zoomer sur la fenêtre (outil zoom en bas à droite) et 
SoundDiver sélectionne automatiquement la taille de police 
appropriée. Le contenu des fenêtres défile également.

La fenêtre peut afficher jusqu’à 256 Koctets de données. Pour 
effacer le contenu du tampon et par conséquent celui de la 
fenêtre, sélectionnez Edit > Clear.

& Note aux utilisateurs avertis : pour les messages de SysEx, la colonne verticale à côté 
de la fenêtre de données donne l’offset du premier octet de chaque ligne au format 
hexadécimal. Ainsi, avec la ligne de titre, vous pouvez facilement déterminer l’offset 
d’un octet de données dans un message de SysEx.

Il se produit un saut de ligne pour tous les octets de statut sauf 
pour F7 (End of Exclusive), si bien que chaque nouveau 
message débute toujours sur une nouvelle ligne. De même, à 
chaque changement entre données reçues et émises ou à 
chaque changement de sortie, une ligne horizontale vient 
s’inscrire, ainsi que le texte “Input :” ou “Output :” accompa-
gné du nom de sortie approprié. Pour une meilleure identifica-
tion, les données reçues sont affichées en rouge et les données 
émises en vert. 

Cette fenêtre s’avère pratique pour diagnostiquer les échecs de 
requêtes ou de scan. Vous pouvez également y comprendre 
comment opère la fonction scan de SoundDiver.

Le menu Edit

Copy
Vous pouvez copier le contenu de la fenêtre tout entière sous 
forme de texte dans le presse-papiers et le coller dans un 
éditeur de texte avec l’article de menu Edit > Copy. Cette 
opération peut servir à donner des détails sur un problème de 
communication. Voir également Dépannage à la page 421, 
Annexe C Dépannage.
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Clear
L’article de menu Edit > Clear permet d’effacer le contenu de la 
fenêtre ; pratique si la fenêtre affiche déjà 256 Ko ou si vous 
voulez analyser un problème de communication spécifique et 
que vous ne souhaitez afficher que les données pertinentes.

Show Menu
Le menu local View > ... permet de montrer ou de masquer 
certaines informations et donc de personnaliser l’affichage au 
plus près de vos besoins.

MIDI In
Les données MIDI reçues ne sont affichées que si cet article de 
menu est coché.

MIDI Out
Les données MIDI émises ne sont affichées que si cet article 
de menu est coché.

Menu View 
Le menu local View permet d’activer et de désactiver l’affi-
chage de diverses données et par conséquent de privilégier soit 
le nombre de détails soit la lisibilité en fonction de vos besoins.

Time Stamps
Quand cet article de menu est coché, les Time Stamps (ou 
“marquages temporels”) deviennent visibles.
Les lignes de Time Stamp affichent le temps exact auquel les 
octets MIDI ont été transmis ou reçus. L’information affichée 
représente :

• Le temps auquel les données MIDI ont été transmises ou re-
çues, sous la forme HH:MM.SS.mmm (heures, minutes, se-
condes, millisecondes). Le temps affiché se réfère au 
moment où l’ordinateur a été démarré pour la dernière fois.
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• L’écart de temps par rapport à la dernière ligne de Time 
Stamp en millisecondes. Cette information ne s’affiche que 
si sa valeur est supérieure à 0.

• “Input” ou “Output” accompagné du nom de l’entrée ou de 
la sortie. Cette information ne s’affiche que si elle est diffé-
rente de celle de la dernière ligne de time stamp.

& Les Time Stamps des octets MIDI reçus se réfèrent au moment où SoundDiver, ou le 
Module, les a lus dans le tampon d’entrée et non au moment où ils sont réellement 
parvenus à l’ordinateur. La différence peut être notable si SoundDiver est alors acca-
paré par d’autres tâches gourmandes en temps de calcul, par ex. les rafraîchisse-
ments d’écran.

& L’information de Time Stamp peut vous aider à trouver une valeur utile pour le para-
mètre de time-out (temps de réaction) dans la case des paramètres d’appareil : faites 
simplement une demande de transfert d’entrée puis vérifiez la valeur entre crochets 
dans la première ligne de Time Stamp des données reçues.

…pour les octets de statut seulement
Quand l’article of Status Byte Only est coché, l’information de 
Time Stamp ne s’affiche que pour les octets de statut. Dans le 
cas contraire, elle s’affiche également pour tous les messages 
MIDI, autrement dit pour les octets de données.

Au dessous d’une ligne de Time Stamp pour les données, 
l’octet de données suivant s’affiche dans la colonne qui suit le 
dernier octet de données affiché (et pas dans la première 
colonne), de façon à conserver le décompte par 16 au sein des 
messages de SysEx.

& Les lignes de Time Stamp pour les octets de données sont importantes pour les appa-
reils qui insèrent de longues pauses dans les messages de SysEx (par ex. les Lexicon 
LXP-1/5 pour les transferts de banques ou le Kawai K5000 ADD pour les transferts 
de sons). Cela peut provoquer des erreurs de réception si l’Adaptation ou le Module 
ne le prend pas en compte.

Note Off, …, messages Système
Ces huit articles de menu servent à filtrer des types de messa-
ges spécifiques, en fonction de l’octet de statut :
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Cocher un de ces articles de menu provoque l’affichage des 
Messages MIDI correspondants.

& Les messages en temps réel reçus (F8h... FFh) sont filtrés par définition, ils ne s’affi-
chent donc pas.

Limitations
• La fenêtre MIDI Monitor est limitée à 256 Koctets de 

données. Si cette limite est atteinte, aucune donnée supplé-
mentaire ne pourra s’afficher. Vous pouvez effacer le contenu 
de la fenêtre avec B ou avec l’article de menu Edit > Clear 
(sauf si la fenêtre a été ouverte sous la forme d’une fenêtre 
flottante).

• Le fait d’ouvrir une fenêtre MIDI Monitor ralentit le traite-
ment du MIDI et peut causer des problèmes de communi-
cation. Il vaut donc mieux la fermer lorsque vous ne l’utilisez 
pas.

• La résolution de l’information de Time Stamp est basée sur 
l’horloge système de 1 ms (1⁄1000 s) sous les deux systèmes 
d’exploitation. Cette résolution suffit largement à gérer le 
time-out, qui se situe en général entre 20 et 500 ms.

Tableau 3 Filtre de statut

Note Off 80 … 8F

Note On 90 … 9F

Poly Pressure A0 … AF

Control Change B0 … BF

Program Change C0 … CF

Channel Pressure D0 … DF

Pitch Bend E0 … EF

Messages Système F0 … FF
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Installation des appareils
La fenêtre Setup

Ce chapitre vous explique comment régler votre configuration 
de SoundDiver. Vous apprendrez entre autre comment faire 
pour que SoundDiver recherche automatiquement les appa-
reils connectés à votre système, comment installer manuelle-
ment des appareils, comment régler individuellement chaque 
appareil, et comment créer automatiquement une bibliothèque 
pour un ou plusieurs appareils.

5.1 Installation des appareils
La section Installer d’autres appareils à la page 58 du Chapitre 2 
Installation traite de la fenêtre d’installation et de ses fonctions 
en détail. C’est ici que vous pouvez installer vos appareils, soit 
manuellement, soit en utilisant la fonction Scan automatique. 
Si vous n’avez pas encore lu cette section, vous devriez le faire 
maintenant.

5.2 Installation manuelle de 
nouveaux appareils

Chaque appareil doit être installé avant que SoundDiver ne 
puisse communiquer avec lui. De nouveaux appareils peuvent 
être installés à tout moment en utilisant l’écran d’installation.

Si vous désirez installer manuellement des appareils- c.à.d sans 
utiliser la fonction Scan- sélectionner New>Install... Une fois la 
fenêtre d’installation ouverte, vous pouvez sélectionner l’appa-
reil que vous voulez, et l’installer. Pour plus de détails, veuillez 
vous référer au § La fenêtre Install à la page 58 du Chapitre 2 
Installation.

Chapitre 5
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& S’il y a déjà un appareil compatible dans la configuration, un dialogue vous informe 
que le nouvel appareil s’est vu automatiquement attribuer une nouvelle ID et qu’un 
numéro a été ajouté au nom. L’écran de configuration sera aussi activé afin que vous 
puissiez faire immédiatement toute correction nécessaire (au cas où l’ID automatique 
ne serait pas correcte). Nous vous conseillons de donner tout de suite un nom distinct 
à l’appareil.

5.3 Aide en ligne interactive
Si vous sélectionnez un appareil dans la liste et que vous 
cliquez sur le bouton Help, ou que vous appuyez sur @ ( : 
H), un message d’aide s’affiche pour l’appareil sélectionné, 
avec des astuces sur les fonctions spéciales ou les limitations. Si 
vous choisissez un autre appareil alors que la fonction Aide est 
ouverte, le message d’aide est automatiquement actualisé.

Si vous désirez de l’aide sur l’installation des appareils, cliquez 
sur Index dans la fenêtre d’aide et choisissez Installation.
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5.4 Aperçu graphique de la 
configuration

La fenêtre de Configuration se compose d’un affichage graphi-
que de la configuration actuelle, avec la case des paramètres 
d’appareil à gauche. Normalement, l’affichage graphique de la 
configuration occupe la plus grande place de la fenêtre de 
Configuration. Il y a une icône pour l’ordinateur et une icône 
par appareil reconnu par SoundDiver.

Icônes et Listes
La fenêtre de Configuration peut s’afficher sous forme d’icônes 
ou sous forme. 

Vous choisissez entre les deux vues dans le menu View > As 
Icons et As List.

Case des

Paramètres

Confi
d’Appareil

Paramètres

spéciaux

gurat
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Abb. links Setup-Icons, rechts Setup-Liste 

Comme vous pouvez le constater, l’affichage sous forme de liste 
n’est pas aussi détaillé que la représentation graphique de la 
configuration, mais vous pouvez voir un nombre d’appareils 
bien plus grand dans le même espace.

Les appareils sont affichés par ordre alphabétique. Chaque 
appareil de la liste possède un nom, un port MIDI, et un 
numéro d’identification (ID). A droite, la quantité de mémoire 
allouée à l’appareil est indiquée (en octets). Cela peut être utile 
pour déterminer quel appareil utilise le plus de mémoire, selon 
les connections connues.

Les options de menu Windows > Larger view et Windows > 
Smaller view servent à modifier la taille du texte, et donc le 
nombre d’appareils que vous pouvez voir.

En mode d’affichage texte, il y a un petit espace à gauche où 
vous pouvez cliquer pour désélectionner tous les appareils ou 
bien pour en sélectionner plusieurs grâce à l’élastique.
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Activer un appareil
Vous pouvez activer un appareil dans la fenêtre de Configura--
tion de toutes les manières suivantes :

• En cliquant sur son icône.
• En tapant la première lettre de son nom (n’oubliez pas d’ac-

tiver les majuscules).
• En plaçant le curseur (représenté par un affichage plus som-

bre de l’icône sélectionnée) en utilisant les touches du cur-
seur (MIJK).

Le contenu de la case des paramètres d’appareil et la case des 
paramètres spéciaux (voir ci-dessous) affichent automatique-
ment les paramètres de l’appareil actif.

Pour sélectionner plusieurs appareils en même temps, vous 
pouvez soit cliquer dessus en maintenant ç ( : S) soit passer 
l’élastique au-dessus de leurs icônes.

& Une fois qu’un appareil a été activé, SoundDiver transmet parfois un message de 
Changement de Programme ou des données SysEx pour fixer correctement les 
connections du Patchbay.

Déplacer des icônes avec la souris
Dans la fenêtre de Configuration, vous pourrez voir une icône 
pour l’ordinateur, et une icône pour chaque appareil installé ; il 
y a aussi des lignes de connexion qui représentent les branche-
ments MIDI mais ne correspond pas au câblage en terme 
d’entrée et de sortie MIDI.

SoundDiver affiche les icônes les unes en dessous des autres 
dans leur ordre d’installation. Si un appareil a été localisé via un 
Patchbay, l’icône de l’appareil s’affiche en relief.

Vous pouvez modifier la disposition de la fenêtre de Configura-
tion à tout moment, par exemple si vous désirez faire de la place 
sur l’écran ou si vous souhaitez que l’agencement des icônes 
corresponde à celui de vos appareils.

Déplacer des icônes dans SoundDiver se fait exactement de la 
même manière que dans le bureau de votre ordinateur. Vous 
pouvez sélectionner et déplacer plusieurs icônes à la fois.
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Il vous suffit de cliquer une fois sur l’icône et de la déplacer 
jusqu’à l’endroit désiré. Elle sera automatiquement placé en 
position suivante sur une “grille magnétique” et les câbles de 
connexion seront ajustés en conséquence. La taille des icônes 
est prise en compte pour éviter tout chevauchement.

Pour déplacer plusieurs icônes en même temps, il faut d’abord 
maintenir le bouton de la souris et étirer l’élastique autour des 
icônes pour les sélectionner.

Importer de nouvelles icônes
Il arrive que des modules soient livrés avec des icônes.

SoundDiver peut mettre à jour les icônes actuelles pendant le 
chargement des Préférences. Appuyez sur ç ( : C) pendant 
le chargement des Préférences.

Ouvrir une fenêtre Device (Appareil)
Vous pouvez ouvrir une fenêtre Device depuis la fenêtre de 
Configuration en sélectionnant tout d’abord l’icône désirée 
(voir ci-dessus) puis : 

• En double cliquant sur l’icône.
• En sélectionnant Windows > Open Device our

• En appuyant sur R.

& Vous pouvez ouvrir des fenêtres appareil pour plusieurs appareils en même temps en 
sélectionnant les icônes désirées et en tapant sur R. Dans ce cas l’option de lien de 
fenêtre entre toutes les Fenêtres Appareil sera désactivée, car dans le cas contraire, 
toutes les fenêtres ouvertes finiraient par afficher le contenu de la fenêtre la plus 
récente.

Désinstaller un appareil
Pour supprimer un ou plusieurs appareils de la configuration, 
cliquez dessus avec la souris et pressez B ou sélectionnez 
Edit>Clear.
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Boutons de Requête/Transmission
Vous pouvez utiliser ces deux boutons pour demander ou trans-
mettre le contenu de la mémoire du (ou des) appareil(s) sélec-
tionné(s). Ces fonctions sont également présentes dans le 
menu Edit. Il suffit d’appuyer sur le bouton concerné pour 
effectuer la fonction correspondante.

Request est représentée par un point d’interrogation et une 
flèche qui part de l’appareil, Transmit par un point d’exclama-
tion et une flèche qui pointe vers l’appareil.

& Les fonctions Request et Transmit de l’écran de configuration agissent sur tous les 
emplacements mémoire des appareils sélectionnés, à l’exception du tampon Edit et 
des données en ROM.

5.5 Menu contextuel sous 
Windows

Lorsque vous effectuez un clic droit sur l’icône d’un appareil, 
celui-ci sera sélectionné s’il ne l’était pas auparavant, et un 
menu contextuel apparaîtra. Le menu propose les choix 
suivants:

• Open Device: voir le § Ouvrir une fenêtre Device (Appareil) à la 
page 194.

• Request: voir le § Request (Demander le transfert) à la page 153 
et le § Boutons de Requête/Transmission à la page 195.

• Transmit: voir le § Transmit (Transmettre) à la page 154 et le § 
Boutons de Requête/Transmission à la page 195.

• Hold Transmission: voir le § Hold Transmission (Suspendre 
transmission) à la page 158.

• Clear: voir le § Désinstaller un appareil à la page 194.

• Open Install: voir le§ La fenêtre Install à la page 58 et le § 
Install… à la page 209.

• Scan all models: voir le § Scan All à la page 61 et le § Scan All 
Models à la page 209.

• Store all edits: voir le § Store All Edits à la page 210.
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• Parameters: voir le § Parameters à la page 210.

• as Icons: voir le § Icônes et Listes à la page 191 du Chapitre 5 La 
fenêtre Setup.

• as List: voir le § Icônes et Listes à la page 191 du Chapitre 5 La 
fenêtre Setup.

Si vous cliquez sur une zone vide, un menu contextuel plus 
court apparaîtra, qui contient des fonctions sans rapport avec les 
appareils.

5.6 La Case des Paramètres 
d’Appareil

La case des paramètres de la fenêtre de Configuration contient 
les paramètres spécifiques des appareils qui contrôlent la trajec-
toire et le transfert des informations SysEx. Vous pouvez modi-
fier la plupart de ces paramètres si nécessaire.

& Certains paramètres sont automatiquement fixés par SoundDiver s’ils ont été préa-
lablement définis dans les modules ou les adaptations, par exemple le nom de 
l’appareil ou le temps de pause entre deux envois. D’autres paramètres, (par exemple 
le port de sortie) sont automatiquement fixés uniquement si SoundDiver a installé les 
appareils en utilisant la fonction Scan.

Masquer et afficher la Case des Paramètres
Vous pouvez masquer la case des paramètres pour libérer de 
l’espace à l’écran. Vous pouvez faire cela pour voir la case des 
paramètres spéciaux, ou pour laisser plus d’espace à la fenêtre 
de Configuration, sur des ordinateurs avec de petits moniteurs : 
❏ Si vous cliquez sur le petit triangle dans le coin supérieur

gauche de la case des paramètres (à gauche du nom de
l’appareil), elle sera verticalement réduite, ce qui vous per-
mettra de voir les paramètres spéciaux, 

❏ si vous souhaitez masquer ou afficher la case des paramè-
tres toute entière, sélectionner View > Parameters dans le
menu local de la fenêtre de Configuration. Dans ce cas la
largeur de la fenêtre de Configuration sera ajustée en con-
séquence.
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Nom
Le nom de l’appareil est affichée en entête de la case des para-
mètres. SoundDiver affiche automatiquement le nom de 
l’appareil, du module, ou de l’adaptation, mais vous pouvez le 
modifier, par exemple si vous voulez distinguer deux appareils 
identiques. Pour cela, cliquez simplement sur le nom et un 
champ d’entrée de texte apparaîtra dans lequel vous pourrez 
entrer le nouveau nom. Confirmez votre choix avec R.

Ports de Sortie et d’Entrée
Ceci indique les ports d’entrée et sortie MIDI par lesquels 
l’ordinateur est connecté à l’appareil. Lorsque vous cliquez ces 
lignes, un menu local apparaît dans lequel vous sélectionnez 
l’entrée ou la sortie à partir des options disponibles. Ces options 
varient selon l’interface MIDI que vous utilisez.

& Le port d’entrée et le port de sortie sont fixés par la fonction Scan.

Avec la version 3.0 de SoundDiver, les entrées peuvent être 
assignées séparément. Cela permet à SoundDiver d’assigner 
correctement les messages reçus provenant d’appareils identi-
ques, même si elles utilisent la même identification (ID).
Si vous ne voulez pas d’une entrée assignée (les messages sont 
toujours traités, peu importe l’entrée par laquelle ils sont 
reçus), sélectionnez Any dans le menu local. C’est aussi la confi-
guration par défaut des fichiers préférences des anciennes 
versions de SoundDiver.
La liste de sélection est différente si un Patchbay est utilisé. 
Voir le § Entrées et sorties utilisant des baies de raccordement à partir 
de la page 198 et suivantes.

Problèmes particuliers à Windows
• La sortie “MIDI Mapper” n’est pas disponible- c’est géné-

ralement une simple copie d’une sortie effective, elle est 
donc superflue.

• Bien que les sorties aux noms en gris puissent être sélection-
nées, elles ne peuvent pas être utilisées, puisqu’elles sont 
déjà utilisées par une autre application et ne peuvent pas 
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être ouvertes par SoundDiver. Si vous voulez utiliser une de 
ces sorties avec SoundDiver, vous avez besoin d’activer la 
sortie multi-client. Pour plus de détails, veuillez vous référer 
au § Pilotes MIDI multi-clients à la page 72.

Problèmes particuliers au Macintosh
• En mode OMS, l’instrument OMS est affiché et peut être 

édité ici.

Entrées et sorties utilisant des baies de 
raccordement
Si au moins une baie de raccordement reconnue par SoundDi-
ver est installée (voir le § Baies de raccordement MIDI (Patchbays) 
à la page 46), deux paramètres additionnels, Connected to et 
Return to, apparaissent.

Connected to
Ce paramètre vous permet de déterminer comment l’appareil 
est connecté à SoundDiver - soit par une baie de raccordement 
(Patchbay), soit directement à l’ordinateur.

Cliquez et maintenez la ligne Connected to dans la case des para-
mètres pour faire apparaître un menu local vous permettant de 
sélectionner l’appareil désiré.
& Ce paramètre est automatiquement réglé par la fonction Scan.

Out Port (Port de sortie du Patchbay)
Si Connected to est assigné à une baie de raccordement, ce para-
mètre vous permet de sélectionner la sortie sur le Patchbay, 
mais ni sur l’ordinateur, ni sur l’interface MIDI.
& Ce paramètre est automatiquement réglé par la fonction Scan.

Return to
Ce paramètre vous indique si la sortie MIDI de l’appareil est 
reliée directement à l’ordinateur ou à une baie de raccorde-
ment.
& Ce paramètre est automatiquement réglé par la fonction Scan.
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Input (Entrée du Patchbay)
Si Return To est assigné à une baie de raccordement, ce paramè-
tre vous montre l’entrée MIDI du Patchbay. Si vous cliquez sur 
la ligne, un menu local apparaît dans lequel vous pouvez sélec-
tionner une des entrées. Le nombre d’entrées disponibles 
dépend du type de Patchbay.

& Ce paramètre est automatiquement fixé par la fonction Scan.

& N’oubliez pas : SoundDiver permet d’avoir plusieurs Patchbays connectés en série. Il 
est cependant impossible d’avoir la sortie d’une baie de raccordement directement 
ou indirectement connectée à l’entrée du premier Patchbay. Un message d’alerte 
apparaîtra si un tel cas de figure est détecté.

Voici deux exemples de câblage : Dans le premier exemple, 
l’EX5 est directement connecté à l’ordinateur, dans les deux 
sens par l’interface Unitor8 d’Emagic :
Abb. Beispiel Anschluss & Beispiel Ausgang 2

L’entrée MIDI de l’EX5 dans le second exemple est connectée 
à la sortie 2 d’un Synapse J.L Cooper, et la sortie MIDI de 
l’EX5 retourne directement vers l’entrée de l’interface de 
l’ordinateur (Unitor8, port 01).
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& La fonction Scan peut reconnaître un appareil si son entrée est reliée à une baie de 
raccordement et sa sortie est connectée directement à l’ordinateur, mais pas 
l’inverse. Dans ce cas vous devrez installer manuellement l’appareil.

Device ID (Identification Appareil)
C’est là que vous sélectionnez le numéro d’identification 
SysEx de l’appareil au sein du système MIDI. Il est utilisé pour 
communiquer avec chaque appareil unique, et aussi pour 
distinguer deux appareils du même modèle. Nous recomman-
dons de toujours utiliser des numéros d’identification différents 
pour des appareils similaires. Référez-vous à l’aide en ligne 
pour des informations sur la manière de trouver les paramètres 
appropriés à l’intérieur d’un appareil en particulier.

L’échelle de valeur des ID disponibles dépend du modèle. 
Certains appareils ne peuvent avoir un ID qui soit différent du 
canal MIDI. Dans ce cas, le canal Thru ne sera pas disponible 
dans la case des paramètres mais sera toujours identique au 
Device ID.

Certains appareils n’utilisent même pas d’ID, dans ce cas, ce 
paramètre ne sera pas disponible. Si vous souhaitez communi-
quer avec deux tels appareils identiques, vous devez les 
connecter à des sorties différentes (de l’ordinateur, ou du 
Patchbay).

& Ce paramètre est automatiquement réglé par la fonction Scan.

Thru Channel (Canal Thru)
Si vous avez activé Options > MIDI Thru, les évènements MIDI 
reçus- exceptés les changements de programmes et les données 
SysEx sont redirigés vers l’appareil par ce canal. Si le champ du 
canal Thru est vide, les données sont acheminées sans change-
ment, c.à.d qu’elles ne sont pas redistribuées sur les différents 
canaux.

& Ce paramètre est vérifié automatiquement par la fonction Scan uniquement pour les 
modules. Pour des Adaptations ou des Appareils dont l’ID serait différent du canal 
Thru (principalement ceux qui disposent d’un mode MIDI multi) vous devrez régler le 
canal Thru manuellement.
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Preserve Thru-Port/Channel
Cette option laisse le port et le canal MIDI inchangés en cas de 
changement d’appareil actif.

Utilisez cette fonction pour les processeurs d’effets.

Exemple: 

❏ Dans la fenêtre de Configuration, cliquez d’abord sur un
générateur de sons dont la sortie audio est reliée au proces-
seur d’effets, 

❏ cliquez ensuite sur le processeur d’effets. Comme la pré-
servation du Port/Canal THRU est activée pour le proces-
seur d’effets, le MIDI Thru et la sortie du séquenceur iront
toujours vers le générateur de sons. 

❏ éditez le processeur d’effets, vous entendrez le son du
générateur.

Velocity (Vélocité)
La valeur est ajoutée (ou soustraite) à la vélocité des notes 
provenant d’un MIDI Thru ou d’un séquenceur. De -127 à 
+127.

Cela permet d’ajuster facilement le volume d’un appareil.

& Cette fonction n’est pas disponible en mode Autolink. Dans ce cas, vous devez 
ajuster les paramètres de vélocité de l’Instrument Logic correspondant.

Timeout
C’est ici que vous déterminez le temps que SoundDiver donne 
à un appareil pour réagir. Au-delà de cette durée (en millisecon-
des), SoundDiver répète la requête plusieurs fois (le nombre 
d’essais est ajustable, voyez le § Request Retries (Réessayer les 
Requêtes) à partir de la page 396 et suivantes). S’il n’y a toujours 
aucune réaction de l’appareil, un message d’erreur apparaît 
“SysEx communication error : XY didn’t respond”.

& SoundDiver fixe ce paramètre à une valeur moyenne lorsque vous installez l’appareil. 
Toutefois, si vous recevez constamment ce message d’erreur, vous pouvez essayer 
d’augmenter la durée et vérifiez si cela améliore la communication.
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Send Pause
Beaucoup d’appareils envoient leurs données en bloc, même 
pour transférer le contenu entier d’une fenêtre Device. Ce 
paramètre détermine le temps d’attente de SoundDiver entre 
deux transferts afin que l’appareil ait assez de temps pour trai-
ter le premier.
Certains appareils ont même besoin de temps pour traiter les 
messages simples. Dans ce cas, SoundDiver fait une pause de 
cette durée afin de ne pas perturber l’appareil.
& Ce paramètre aussi est fixé à une valeur moyenne lorsque vous installez l’appareil. Toute-

fois, si vous installez un nouveau système d’exploitation pour l’appareil qui permet un 
transfert MIDI plus rapide, vous aurez la possibilité de réduire le temps de pause.

Play Delay
Si l’Autoplay est activé, SoundDiver attend un peu entre la 
transmission d’instructions et le déclenchement de la note test. 
Ceci afin de s’assurer que l’appareil est prêt à jouer de nouveau 
après avoir reçu les données, et ne produira pas de grésille-
ments ou de notes tronquées, parce qu’il n’aurait pas terminé 
d’initialiser la section d’effets. C’est ici que vous fixez le temps 
voulu, en millisecondes comme d’habitude.

Programmation du Patchbay
Si vous avez connecté votre appareil à une baie de raccorde-
ment dont le module n’est pas reconnu par SoundDiver, vous 
pouvez toujours vous assurer que SoundDiver s’adresse au bon 
appareil.
Pour cela, il faut prédéfinir un programme dans votre Patchbay 
qui sera automatiquement ouvert par SoundDiver à chaque fois 
que l’appareil sera sélectionné. Vous devez :
❏ Ajouter manuellement l’appareil, car la fonction Scan ne

l’aura probablement pas détecté.

❏ Assigner les ports d’entrée et sortie aux ports MIDI de la baie
de raccordement connectée à l’ordinateur.

❏ Activer le Program Change du Patchbay en cochant la case.
D’autres paramètres apparaîtront.
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❏ Sélectionnez un programme sur votre baie de raccorde-
ment et réglez-la de manière à ce que l’ordinateur et
l’appareil soient correctement reliés via MIDI dans les
deux sens. La sortie du clavier maître devrait être “fusion-
née” avec l’entrée de l’ordinateur si le Patchbay possède
une option “merge”. Vous pouvez ensuite vous assurer que
le MIDI Thru fonctionne correctement. Si le Patchbay ne
possède pas de fonction fusion, vous devrez connecter le
clavier maître à une autre entrée de l’ordinateur, 

❏ fixez le nombre de programmes de la baie de raccordement
à coté de la case à cocher active. Faites attention à la numé-
rotation du Patchbay. SoundDiver numérote les program-
mes du Patchbay 1...128, 

❏ sous…Out/Ch sélectionnez la sortie de l’ordinateur à
laquelle la baie de raccordement est connectée. A la droite
de ceci, entrez le canal MIDI par lequel les messages de
changement de programme sont envoyés au Patchbay.

❏ Si votre baie de raccordement prend un certain temps à
reprogrammer les entrées et les sorties, vous pouvez régler
le temps de pause en millisecondes sous …Delay. Après
avoir envoyé le changement de programme, SoundDiver
attendra aussi longtemps avant de transmettre des données
ou des notes test.

Master keyboard (Clavier maître)
Si vous utilisez un Patchbay MIDI combiné avec la fonction 
MIDI Thru de SoundDiver, il est utile de désigner un des 
claviers connectés au Patchbay comme clavier maître. Sound-
Diver déviera les notes MIDI de ce clavier vers le synthétiseur 
que vous êtes en train d’éditer. Le Patchbay sera éventuelle-
ment reprogrammé si nécessaire. SoundDiver s’occupe de tout!

Bien entendu le contrôle par clavier maître fonctionne seule-
ment via les Patchbays acceptés par SoundDiver. Avec tout 
autre Patchbay, la fonction Clavier Maître est inutile, et vous 
devez programmer le Patchbay manuellement pour que la 
sortie du clavier maître fusionne avec l’ordinateur.
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Pour définir un appareil comme clavier maître, sélectionnez cet 
appareil dans la fenêtre de Configuration en cliquant dessus 
avec votre souris et activez le bouton Master keyboard dans sa 
case des paramètres. Le clavier maître actuel est indiqué par les 
“mains au-dessus du clavier”. SoundDiver s’assure tout seul 
que vous ne choisissiez pas accidentellement un appareil sans 
clavier comme clavier maître. Les seules exceptions à cela étant 
les Adaptations qui sont conçues à la fois pour des claviers et 
des expandeurs (ex : Matrix 6 et 6R).

Si vous désirez contrôler votre configuration MIDI à partir du 
clavier maître, activez Options > MIDI Thru.

& La fonction “clavier maître” est uniquement nécessaire si votre clavier maître est 
connecté à une baie de raccordement. S’il est directement relié à l’ordinateur, MIDI 
Thru dirigera toujours les données MIDI reçues du clavier maître vers l’appareil actif.

Auto Request
Si vous avez activé cette fonction, SoundDiver demande auto-
matiquement les données de l’appareil à chaque fois que vous 
lancez le programme. Vous pouvez fixer le nombre de deman-
des en utilisant les options suivantes : 

None
Aucune requête ;

I
Requêtes uniquement sur la mémoire interne (ni cartes ni
ROM);

I+C
Requêtes uniquement sur la mémoire internes et les cartes
RAM;

I+C+R
Requêtes sur tout excepté les tampons d’édition;

All
Requête sur tout.

La fonction Auto Request est utile car elle permet de toujours 
voir le contenu de la mémoire de l’appareil dans la fenêtre 
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Device immédiatement après le début du programme ; cepen-
dant la durée peut varier selon l’appareil.

Veuillez vous reporter au § Save Device Entries in Preferences File 
(Sauvegarder les Entrées d’Appareils dans le Fichier Préférences) à la 
page 397. 

Module
C’est ici que vous pouvez voir le nom du module en charge de 
l’appareil sélectionné. Pour des informations plus détaillées sur 
le module, cliquez sur le nom du module.

Pour les Adaptations, ce paramètre affiche Uni pour “module 
Universel”.

Model
C’est ici que le nom du modèle est affiché. Comme vous le 
savez, un module peut contrôler plusieurs modèles (ex : SY 77 
module : SY 77, TG 77, SY 99).

Pour les Adaptations, ce paramètre indique le nom de l’Adap-
tation.

Version
Est indiqué ici la version logicielle du fabricant de l’appareil. 
Ces informations sont disponibles uniquement si vous avez 
installé l’appareil en utilisant la fonction Scan (et si l’appareil 
offre un moyen de transmettre un numéro de série via MIDI).

Aussi nous vous recommandons fortement de toujours utiliser 
la fonction Scan. De nombreux modules de SoundDiver 
peuvent distinguer les caractéristiques des différentes versions 
de logiciels et adapter la communication SysEx en consé-
quence. Si d’un autre coté vous installez un appareil manuelle-
ment, SoundDiver utilise toujours la première version du logi-
ciel. Cela peut vouloir dire que certaines fonctions qui ont été 
ajoutées ultérieurement, ou certaines améliorations du système 
d’exploitation ne seront pas reconnues par SoundDiver. Cela 
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peut se traduire par une réduction considérable de l’efficacité 
des transmissions MIDI.

5.7 Paramètres d’Appareil 
Spéciaux

Vous trouverez des réglages supplé-
mentaires pour de nombreux appareils 
sous la cas de paramètres appareil. Les 
boutons correspondant changent avec 
chaque appareil actif.

Aide sur les Paramètres Spéciaux
Cliquez sur le bouton d’aide pour obtenir des renseignements 
plus détaillés sur les paramètres spéciaux de chaque appareil.

Paramètres Spéciaux pour les Patchbays
La case des paramètres spéciaux de la 
fenêtre de Configuration montre les 
entrées et les sorties du Patchbay qui 
sont directement ou indirectement 
connectées à l’ordinateur. Ces paramè-
tres sont fixés automatiquement par la 
fonction Scan.

Les premières entrées et sorties actives du Patchbay sont utili-
sées par l’ordinateur lorsqu’un appareil essaye de communi-
quer via le Patchbay. Chaque entrée et chaque sortie active est 
évidemment ignorée par la fonction Scan.
Vous pouvez utiliser ces boutons pour installer manuellement 
une baie de raccordement ou si vous avez changer le câblage 
entre le Patchbay et l’ordinateur.

Souvenez-vous : 
• Assurez-vous qu’au moins une entrée et une sortie soient ac-

tives, sinon les appareils reliés au Patchbay ne seront pas pris 
en compte.
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• Il va de soi que ces réglages doivent correspondre au câblage 
réel.

• Les changements du bouton de réglage ne peuvent être an-
nulés en utilisant “annuler changement de paramètre”.

• Lorsque SoundDiver établit une connexion avec un appareil 
connecté à une baie de raccordement, elle doit toujours être 
faite en utilisant la première entrée et la première sortie con-
nectés à l’ordinateur. Il est pour l’instant impossible de con-
trôler un appareil via une entrée ou une sortie spécifique du 
Patchbay.

Programmes Patchbay et Standard
Dans la case des paramètres de la fenêtre de Configuration, 
chaque appareil possède le paramètre Patchbay Program. Cela 
permet à SoundDiver de toujours pouvoir communiquer avec 
l’appareil en utilisant le bon programme de Patchbay (voir le § 
Programmation du Patchbay à partir de la page 202 et suivantes).

Si l’appareil est lui-même une baie de 
raccordement, le paramètre se nomme 
Standard Prg.

Vous pouvez entrer un programme de 
Patchbay, qui sera activé après chaque 
transmission avec un appareil. Norma-
lement, une baie de raccordement 
possède un programme standard qui est 
utilisé par le séquenceur. Sa structure 
est en général :

• Clavier maître → Ordinateur
• Ordinateur → appareils divers (selon 

les cas, plusieurs sorties de l’ordina-
teur peuvent être connectées au Patchbay, chacune d’elles 
étant internement patchée avec plusieurs sorties).

Fixez le numéro de programme MIDI de ce programme de 
Patchbay dans la case du paramètre Standard Prg. SoundDiver 
vérifie alors automatiquement que ce programme de Patchbay 
soit normalement actif. Pendant la communication avec un 
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appareil différent (ex : données demandées ou envoyées) le 
Patchbay est reprogrammé ou modifié (en utilisant le Patchbay 
Prg de l’appareil). Le Standard Prg est alors automatiquement 
relancé pour que le séquenceur puisse être de nouveau actif.

& Assurez-vous aussi de fixer correctement les paramètres “Out/Ch” et “Delay” (voir 
le § Programmation du Patchbay à la page 202).

& Ce changement automatique est possible même pendant que le séquenceur fonc-
tionne. Cela signifie par exemple que vous pouvez essayer différents sons d’une 
bibliothèque en utilisant AutoAudition. Si une note se bloque, cela veut malheureu-
sement dire que le Patchbay n’envoie aucun message “all notes off” avant le chan-
gement, ou que l’appareil ne comprend pas “all notes off”. Dans ce cas, utilisez 
l’appareil uniquement si le séquenceur est arrêté. 

& Lorsqu’un appareil est édité, le programme par défaut du Patchbay demeure actif. 
Pour s’assurer que les changements de paramètres parviennent à l’appareil, ce 
programme doit être réglé de manière à fournir une connexion entre l’ordinateur et 
l’appareil édité.

5.8 Aide en Ligne Interactive
Si vous avez sélectionné l’icône d’un appareil, vous pouvez 
obtenir de l’aide sur ce modèle en sélectionnant Windows > 
Help. Comme la fonction d’aide est interactive, l’affichage de 
l’aide changera si vous sélectionnez une icône différente dans 
la fenêtre de Configuration.

 : Si aucune icône n’est sélectionnée, sélectionner la fonction 
d’aide affichera d’abord une liste de tous les modules et adap-
tations. Si vous cliquez sur l’un des mots-clés, vous serez 
emmené à la page d’aide concernée.
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5.9 Menus locaux de la fenêtre 
Setup

New

Install…
Utilisez ce menu pour installer manuellement un appareil. 
Pour des informations plus détaillées, référez-vous au § Instal-
lation manuelle de nouveaux appareils à la page 189. Cet article du 
menu est identique à Windows > Open Install.

Scan All Models
Cette fonction lance l’opération de Scan pour l’installation 
d’appareils. Pour des explications plus détaillées référez-vous 
au § Scanner à partir de la page 60 et suivantes.

Load and Transmit File …
Cette option est aussi disponible dans la fenêtre Device. Elle 
agit uniquement sur les entrées de l’appareil en cours d’utilisa-
tion. Voir le § Load and transmit File… à la page 230

Build Library
Cette fonction permet de créer automatiquement une Biblio-
thèque à partir du contenu de la mémoire de tous les appareils 
sélectionnés. Pour plus de détails, référez-vous au § Sauvegar-
der une banque comme Bibliothèque à la page 285.

Save as…
Cette option de menu fonctionne comme Create Library, mais 
sauvegarde la Bibliothèque directement sur le disque une fois 
que vous avez entré son le nom et le chemin dans le sélecteur 
de fichiers.
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Export …
Cette fonction est identique à Save As..., cependant le fichier 
est enregistré comme un fichier MIDI standard, ou comme un 
fichier SYX/MidiEx.

Save Library for Logic Song
Cette fonction est uniquement disponible en mode AutoLink 
utilisant Logic (Macintosh Version 2.5 et plus, Windows 
Version 4.0 et plus). Cela vous permet de créer automatique-
ment une bibliothèque qui contienne toutes les données 
(incluant tous les liens) demandées par la Logic song en cours, 
via les changements de programmes de l’instrument.

Si l’AutoLink n’est pas actif, ou que la version de Logic ne 
reconnaît pas cette fonction, vous obtiendrez un message 
d’erreur.

Pour plus de détails, référez-vous au § Sauvegarder les données de 
morceau dans une Bibliothèque à la page 368.

Store All Edits
Cette option de menu lance la fonction “Store” pour tous les 
tampons d’édition utilisés et non sauvegardés de tous les appa-
reils. Les données seront sauvegardées dans la source appro-
priée (emplacement mémoire de la fenêtre Device, ou Biblio-
thèque). S’il n’y a rien à stocker, l’option de menu ne peut être 
sélectionnée.

Voir aussi le § Store (Mémoriser) à la page 318.

View

Parameters
Sélectionner cette option de menu permet de masquer ou 
d’afficher la case des paramètres d’appareil. Masquer la case 
des paramètres laisse tout l’espace de la fenêtre de Configura-
tion libre pour afficher les icônes.
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As Icons/As List
Le contenu de la fenêtre de Configuration peut être affiché en 
icônes ou en liste.

La vue en icônes ne peut être agrandie.

& Windows uniquement : La molette de la souris permet de modifier la taille des carac-
tères en pressant ç.

5.10 Créer automatiquement une 
Bibliothèque

SoundDiver vous permet de rappeler automatiquement le 
contenu de la mémoire d’un ou plusieurs appareils, et de l’utili-
ser pour créer une bibliothèque. Vous pouvez utiliser cette 
fonction pour créer une bibliothèque à partir de la mémoire 
interne d’un EX5, un Access Virus, ou même votre configura-
tion toute entière :

❏ Sélectionnez le ou les appareils dont les contenus de
mémoire doivent être stockés dans la bibliothèque en cli-
quant dessus dans la fenêtre de Configuration.

❏ Sélectionnez un des choix du sous-menu New>Build
Library dans le menu local de la fenêtre de Configuration.

& Si vous n’avez sélectionné aucun appareil lorsque vous choisissez cette fonction du 
menu, un dialogue apparaît vous demandant si vous souhaitez que l’opération porte 
sur tous les appareils connectés.

SoundDiver créera alors automatiquement une nouvelle biblio-
thèque et copiera les données désirées dedans. Selon l’option 
du sous-menu choisie, certaines informations sont requises si 
elles n’ont pas encore été reçues. Toutes les informations qui 
sont déjà disponibles ne sont pas redemandées. Pour la signifi-
cation des options du sous-menu, consultez le § Sous-menu à la 
page 285.

& Vous pouvez utiliser cette fonction pour faire une copie de sauvegarde de votre 
entière configuration d’un simple clic. N’oubliez pas de sauvegarder la bibliothèque !
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5.11 Stratégie de sélection 
d’appareils lors d’envois 
depuis une Bibliothèque

En sélectionnant des appareils dans la fenêtre de Configuration 
MIDI, vous pouvez définir vers quel appareil SoundDiver 
devra envoyer des données s’il y a plusieurs possibilités :

En sélectionnant des appareils dans la fenêtre de Configuration 
MIDI, vous pouvez définir vers quel appareil SoundDiver 
devra envoyer des données s’il y a plusieurs possibilités :

• SoundDiver donne la priorité au transfert vers les appareils 
sélectionnés dans la configuration-mais uniquement si la 
fonction Prefer selected devices as target est sélectionnée dans 
Options > Settings > Library Preferences … (voir le § Prefer 
Selected Devices as Target (Préférer les Appareils sélectionnés 
comme Destination) à la page 408). Par exemple si vous voulez 
transmettre la voix d’un DX7 vers un SY77, même si vous 
avez un DX7 dans le Setup, sélectionnez le SY77. La voix 
sera automatiquement convertie et envoyée vers le SY77 ;

• Si aucun appareil n’est sélectionné dans la fenêtre de Confi-
guration MIDI, la voix sera envoyée vers l’appareil qui peut 
la traiter sans la convertir, en l’occurrence le DX7 ;

• Si ces appareils sont plusieurs, la voix sera envoyée vers 
l’appareil dont l’ID est la plus proche ;

• Si un appareil qui ne correspond pas (ex : un DX7 pour un D-
50) est sélectionné dans la fenêtre de Configuration MIDI, 
l’appareil le plus approprié parmi ceux qui restent est auto-
matiquement sélectionné.

• Dans les trois derniers cas, l’appareil en cours d’utilisation 
(celui qui est affiché dans la case des paramètres d’appareil) 
est préféré aux autres.

Exemple : dans la configuration, il y a un DX7 II, un SY77 et un 
D-50. Ce dernier est sélectionné. Un son du TX802 sera alors 
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il 

e.

hé
envoyé vers le DX7, même si le SY77 peut aussi convertir les 
données.

Le tableau suivant illustre cette stratégie:

Tableau 4 Stratégie de choix d’appareil

N°
Appareil 
sélectionné

Module Modèle Device ID Module / 
Adapta-
tion chargé

Appare
actifcorrespond

1a

a. Passé si l’option “Prefer selected Devices as target” est désactivé

√

2 √ √ √ √ √

3 √ √ √ √

4 √ √ √

5 √ √ √ √

6 √ √ √

7 √ √

8 √ √ √ √

9 √ √ √

10 √ √

11 √ √ √

12 √ √

13 √

14 √ √

15 √

16 Aucune condition, un tampon d’édition est simplement recherc
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La Fenêtre Device

Dans ce chapitre est décrite la fenêtre Device (Appareil). Elle 
affiche le contenu de la mémoire interne d’un appareil MIDI à 
l’écran. C’est dans la fenêtre Device que vous pouvez éditer les 
différents types de données pour votre appareil. 

& Le terme “entrée” est utilisé ici et ailleurs dans ce manuel comme terme générique 
pour désigner un ensemble de données. Selon l’appareil et le type de données, il 
peut aussi être appelé “Son”, “Programme”, “Patch”, “Performance”, “Combi”, 
“Multi”, “Global Data”, “Wavetable”, etc.

Afin de s’assurer que tout fonctionne au mieux, SoundDiver 
possède deux fonctions importantes :

Chapitre 6
215
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6.1 Cohérence des données 
entre l’appareil et la fenêtre 
Device

De nombreux programmes d’archivage de sons utilisent des 
banques dans lesquelles les sons sauvegardés peuvent être 
complètement différents de ceux contenus dans la mémoire de 
l’appareil lui-même. A l’opposé, avec SoundDiver le contenu 
de la fenêtre Device correspond aux données de l’appareil 
connecté. La fenêtre Device n’est donc pas une fonction indé-
pendante de l’appareil, mais plutôt le reflet du contenu de la 
mémoire de votre appareil.

Important : Ce principe est uniquement valable si vous éditez 
les données de votre appareil dans SoundDiver et non pas sur 
l’appareil. Les fonctions Copy et Delete ne sont pas transmises 
via MIDI par l’appareil, SoundDiver ne peut donc pas les 
reconnaître. Il y a donc un risque d’altérer accidentellement 
certains sons importants. Si vous changez quelque chose dans 
l’appareil lui-même - exemple : pendant un concert ou une 
répétition- lorsque vous rallumerez votre appareil, vous devrez 
immédiatement rappeler la version altérée, afin que vous puis-
siez toujours voir la situation actuelle de votre appareil à l’écran. 
SoundDiver ne peut faire cela automatiquement, comme indi-
qué dans le § Auto Request à la page 204.

6.2 Gestion de la Dépendance 
des Entrées

La plupart des synthétiseurs modernes proposent des “entrées 
parents” (souvent appelées Multis, Combinaison ou Perfor-
mances”) combinant plusieurs sons. Ces entrées parents rési-
dent dans les emplacements de mémoire de l’appareil.

& Le terme “entrée parent” (appelés dans d’autres programmes “patch parent”) est 
utilisé ici et ailleurs dans ce manuel comme terme générique pour désigner une 
entrée constituée de multiples autres entrées. Le terme effectivement utilisé par 
216
Emagic
SoundDiver 



Gestion de la Dépendance des Entrées
votre synthétiseur diffère probablement, Multis, Combi, Performance ou Preset. Une 
entrée référencée par une entrée parent est appelée “entrée fille” (ou “patch fille”)

Par exemple, une performance d’EX5 appelée “Drum&Bass” 
pourra utiliser les programmes A24 “Drum”, et B36 “Bass”. 
Dès que vous modifiez les deux sons dans la mémoire, la 
combinaison devient en général inutile, puisqu’elle utilise les 
mauvais sons.

Ce n’est pas le cas de SoundDiver, grâce à une fonctionnalité 
appelée “Gestion de la dépendance des entrées”. Cette fonc-
tionnalité garde automatiquement un œil sur les entrées qui 
sont utilisées par d’autres. Pour illustrer, reprenons cet 
exemple : Si vous déplacez “Drums” depuis A24 vers B65, 
SoundDiver modifie automatiquement l’entrée parent afin que 
dans le futur, il utilise B65. La Gestion de la dépendance des 
entrées peut aussi couvrir plusieurs niveaux de l’appareil -par 
exemple la table de Program Change d’un Waldorf Microwave 
→ Multi → Voice → Wavetable → Wave.

Bien sur, en pratique, vous n’avez pas besoin de vous inquiéter 
de ces interactions, puisque SoundDiver contrôle tout cela 
automatiquement.

Souvenez-vous que ces dépendances doivent être définies dans 
les Adaptations. Cela se fait avec les objets spéciaux dans les 
éditeurs.

Appareils possédant des tampons 
d’édition individuels
Certains appareils MultiMode tels que le Roland JV-1080/2080 
ou le Waldorf microWave XT, disposent de tampons d’édition 
séparés pour toutes les entrées filles effectivement utilisées par 
une entrée parent. Ces tampons d’édition sont appelés “Parts” 
ou “Instruments”. Lorsque vous écoutez une entrée parent 
dans la fenêtre Device, les modules de SoundDiver qui gèrent 
ces appareils mettent à jour le contenu des Parts. L’appareil 
effectue cette tâche lui-même chaque fois qu’il reçoit un 
message de changement de programme ou de Dump concer-
nant une Performance ou un Multi.
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En revanche, si vous éditez de tels Parts ou Instruments, le lien 
de l’entrée parent pointe toujours vers l’emplacement de 
mémoire d’où provient l’entrée fille (bien que vous ayez modi-
fié l’entrée fille entre temps). Dans ce cas, SoundDiver 
détourne la dépendance concernée- vers la Partie et non pas 
vers l’emplacement mémoire d’origine de l’entrée fille, afin 
que vous puissiez facilement sauvegarder l’entrée parent dans 
une bibliothèque sans avoir besoin de stocker les Parties 
éditées dans l’appareil vers les emplacements d’origine des 
entrées filles.

Voir aussi le § Les tampons d’édition à la page 290 et le § Appareils 
possédant des tampons d’édition individuels à la page 217.

6.3 La Fenêtre Device (Appareil)
La fenêtre Device de l’appareil actif s’ouvre :

•  en sélectionnant Windows > Open Device,

• en pressant R dans la fenêtre de Configuration ou en double 
cliquant sur l’icône de l’appareil.

SoundDiver ouvrira alors une fenêtre Device pour l’appareil 
actif. Si plusieurs appareils ont été sélectionnés, une fenêtre 
s’ouvrira pour chacun d’entre eux.

& Si une fenêtre Device est déjà ouverte dans le Background, elle apparaîtra au premier 
plan. Si elle est déjà au premier plan, une autre s’ouvrira.

Vous pouvez ouvrir plusieurs fenêtres Appareil pour le même 
appareil -pour plus d’informations veuillez vous référer au § 
Aspect de la fenêtre Device à la page 220.

La fonction Lien
Au-dessus de la case des paramètres de la fenêtre Device, 
il y a une autre case contenant trois chaînes stylisées. C’est 

là que vous pouvez activer et désactiver la fonction Lien. Lors-
que la fonction Lien est active, les contenus des fenêtres 
Device reposent toujours sur l’appareil actif dont le nom appa-
raît dans la barre de titre.
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Exemple : Si vous ouvrez la fenêtre Device pour l’EX5 lorsque 
la fonction est activée et qu’ensuite vous sélectionnez le Virus 
dans la fenêtre Setup, SoundDiver affiche le Virus dans la 
même fenêtre Device. Vous n’avez donc besoin que d’une 
seule fenêtre Device pour tous les appareils.

S’il y a plusieurs fenêtres Device ouvertes en même temps, la 
fonction Lien est automatiquement désactivée.

Boutons pour la requête et la transmission
La fenêtre Device dispose aussi des boutons Request/Transmit 
qui ont été décrits dans le § Boutons de Requête/Transmission à la 
page 195 du Chapitre 5 La fenêtre Setup.

& Les fonctions Request et Transmit de la fenêtre Device agissent uniquement sur les 
entrées effectivement sélectionnées des appareils correspondants.

Fonctions Zoom
Il est possible de zoomer sur l’affi-
chage de la fenêtre Device.

Sur un Macintosh, cliquez sur le 
bouton Zoom dans le coin supé-
rieur droit de la fenêtre Device 
pour avoir une vue grossie de la 
section ou pour afficher les 
entrées en caractères plus gros.

Sélectionnez l’option Windows > 
Larger view ou Windows > Smal-
ler view pour parvenir au même 
résultat.

Sous Windows, avec une souris Microsoft IntelliMouse™ vous 
pouvez aussi zoomer en utilisant la roue de la souris et en pres-
sant ç.

& Note: Si les banques dépassent ou sont trop éloignées dans l’Adaptation, celle ci doit 
être adaptée au nouveau format. Pour cela, ouvrez l’éditeur d’Adaptation. Pour plus 
de détails, veuillez consulter le manuel de programmation de module universelle.
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Aspect de la fenêtre Device
La fenêtre Device contient plusieurs objets standard, une case 
des paramètres et des menus contextuels.
Pour la plupart des appareils, le contenu de la fenêtre Device 
ne pourra pas tenir sur un écran normal. Cependant, comme 
d’habitude vous pouvez faire défiler le contenu de la fenêtre en 
utilisant la barre de défilement ou en utilisant l’élément x/y.
Un autre solution est d’ouvrir plusieurs fenêtres Appareil pour 
le même appareil et de les disposer à l’écran. Vous pouvez utili-
ser cette méthode pour faire de l’espace, si par exemple vous 
désiriez voir les parties gauche et droite de la fenêtre Device, 
mais pas sa partie centrale. Voici un exemple :

De plus, tous les types de données peuvent être affichés ou 
masqués individuellement.
Il existe deux façons de procéder :
• Les boutons en haut de la fenêtre font disparaître les types 

en un clic.
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• Vous pouvez aussi utiliser le menu View>Data Types >.... Co-
chez ou non les différents types selon vos besoins. Voir Data 
Types à la page 233 du Chapitre 6 La Fenêtre Device pour les 
détails.

Vous pouvez utiliser les Screensets (voir le § Screensets à partir 
de la page 135 et suivantes) pour préprogrammer le bon affi-
chage pour chaque situation.

Contenu de la fenêtre Device
La fenêtre Device affiche la totalité du contenu de la mémoire 
de l’appareil - si un appareil contient des sons prédéfinis 
(ROM), ils sont aussi affichés à l’écran afin qu’ils puissent être 
copiés dans la mémoire interne. Cependant cela n’est pas 
toujours possible, selon les capacités SysEx de la machine.

Banques
L’affichage de la mémoire interne varie d’appareil en appareil 
et est basée sur le type et le nombre d’emplacements mémoire. 
Par exemple, le Yamaha EX5 possède 128 performances inter-
nes et quatre banques de 128 voix. Bien sur SoundDiver gère 
aussi les données globales ou du Kit de batterie de cet appareil 
et les tampons d’édition. Dans un Access Virus, vous trouverez 
128 Multis, et deux banques de 128 Singles. Dans la plupart des 
cas SoundDiver peut contrôler n’importe quelle donnée depuis 
l’appareil reconnu par son implémentation SysEx.
& Certains appareils ne permettent pas le transfert de banques, le SY77 par exemple 

ne peut envoyer ni recevoir les sons de sa carte. Malheureusement dans ce cas, vous 
ne pourrez pas afficher la banque.

Entrées dépendantes
Les entrées en caractères gras sont appelées “entrées filles”, 
utilisées par au moins une “entrée parent”, c’est à dire que les 
entrées en caractères gras ont une dépendance. Vous feriez 
mieux de ne pas modifier de telles entrées, car autrement les 
entrées parents auront un son différent.
& Si la gestion des dépendances est désactivée, l’affichage en est également désactivé. 

Voir le § Dependency Management (Gestion des Dépendances)  à la page 399.
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Entrées en gris
SoundDiver affiche les entrées en gris au lieu de noir seule-
ment si leur nom est connu, mais pas leurs données de patch.

Ce sont soit des entrées ROM ou des entrées qui ont été reçues 
mais supprimées de nouveau entre-temps.
& Lorsque SoundDiver efface une entrée dans la fenêtre Device, il se rappelle son nom. 

Cela vous permet d’économiser de la mémoire si vous avez juste besoin des noms 
pour la fonction d’attribution de noms de l’Autolink (voir le § Noms des sons dans 
les Instruments Logic à partir de la page 360 et suivantes).

Nom des entrées ROM
SoundDiver reçoit aussi les données ROM d’un appareil, les 
affiche dans la fenêtre Device et vous permet de les copier dans 
la bibliothèque.
Abb. ROM-Einträge

Les données ROM peuvent être éditées (à condition qu’il y ait 
un tampon d’édition pour le même type de données), bien 
qu’elles ne puissent pas être stockées dans leur emplacement 
d’origine, puisque ceux ci ne peuvent être modifiés. Les noms 
sont indiqués même lorsque SoundDiver ignore leurs contenus 
effectifs. Cependant s’ils sont demandés, les noms réels sont 
affichés. Il peut différer du nom grisé, si le fabricant a stocké 
des sons ROM différents dans une nouvelle version. Naturelle-
ment, vous pouvez utiliser un son ROM comme point de départ 
pour une de vos propres créations. Pour cela, il vous suffit de 
l’ouvrir et de le stocker dans un emplacement RAM disponible. 
Pour plus de détails, voir le § Store (Mémoriser) à la page 318.
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& Si vous n’avez besoin que des noms d’une banque ROM (par exemple pour les utiliser 
dans un multi-instrument Logic), vous n’avez pas besoin de les demander. La fonc-
tion “Copy” dans le menu Edit copie les noms dans le presse-papiers, même s’ils sont 
affichés en gris. Mais essayez la fonction Autolink d’abord, car elle offre beaucoup 
plus de possibilités (voir le § Noms des sons dans les Instruments Logic à la page 360).

6.4 Fonctions dans la fenêtre 
Device

Dans la fenêtre Device, les données de même type peuvent 
être échangées, copiées, supprimées, etc. Veuillez noter que 
SoundDiver transmet immédiatement ces changements à 
l’appareil, car le contenu de l’appareil doit toujours correspon-
dre au contenu affiché dans la fenêtre Device.

Avant de commencer à déplacer ou copier des entrées, assurez-
vous que la fenêtre Device reflète l’exact contenu de la 
mémoire de l’appareil. Si vous voulez être entièrement sûr, 
sélectionnez l’appareil dans la fenêtre Device et sélectionnez 
Edit > Request. SoundDiver recevra alors la totalité du contenu 
de la mémoire de l’appareil, et la fenêtre Device sera totale-
ment à jour.

Sélectionner des entrées dans la fenêtre 
Device
Dans Sélectionner des entrées à la page 137 du Chapitre 4 
L’interface utilisateur de SoundDiver vous trouvez des informa-
tions sur les fonctions de sélection. Voici un bref rappel :

• Pour sélectionner une entrée, cliquez dessus. En cliquant 
sur la zone grise dans la fenêtre Device, vous annulez la 
sélection.

• Pour sélectionner plusieurs entrées dans un rectangle, 
utilisez l’élastique : Cliquez et maintenez à l’arrière plan ou 
sur la colonne de numérotage à gauche d’une banque, et 
étirez le rectangle.
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• Pour sélectionner plusieurs entrées, cliquez dessus les unes 
après les autres en maintenant ç ( : S). Vous pouvez pas-
ser à la sélection en cliquant tout en pressant ç ( : S) ou 
en maintenant ç ( : S) et en étirant un élastique au-des-
sus des entrées,

• Pour sélectionner un bloc entier, cliquez sur la première en-
trée, puis cliquez sur la dernière en maintenant S ( : ç). 
Vous pouvez sélectionner plusieurs blocs en répétant cette 
opération tout en appuyant sur ç ( : S). Cette opération 
est possible même si les blocs contiennent des données de 
types différents;

• Pour sélectionner une colonne, cliquez sur son titre (dans 
l’exemple ci-dessus, affiché “1” à “4”. Vous pouvez sélec-
tionner plusieurs colonnes si vous pressez aussi ç ( : S),

• Pour sélectionner une banque entière, cliquez sur le titre 
noir de la banque (dans l’exemple ci-dessus intitulé 
“Patches internes”. Vous pouvez sélectionner plusieurs 
banques si vous pressez aussi ç ( : S) ;

• La fonction Elastique de la fenêtre de Configuration est 
aussi disponible dans la fenêtre Device,

• Vous pouvez utiliser le menu Edit pour sélectionner toutes 
les entrées à la fois, ou pour inverser la sélection ;

• Pour désélectionner toutes les entrées, cliquez dans une 
zone grise de la fenêtre Device, ou bien cliquez dans une co-
lonne de numéros.

& Cliquer sur la barre de sélection d’une banque comportant une seule entrée équivaut 
à cliquer sur l’entrée elle-même. Double-cliquer sur la barre de sélection ouvre 
l’entrée, déplacer la barre de sélection déplace l’entrée.
224
Emagic
SoundDiver 



Fonctions dans la fenêtre Device
Sélectionner des entrées en utilisant les noms
Vous pouvez rechercher des entrées dans la fenêtre Device en 
utilisant le nom des entrées ou en parcourant la liste alphabéti-
que des entrées.

Activez d’abord les majuscules avec la touche Y, (située au-
dessus de la touche S).

Ensuite tapez simplement les premières lettres du nom de 
l’entrée. La première entrée dont le nom commence par les 
mêmes caractères sera sélectionnée.

Pour sélectionner l’entrée suivante dans l’ordre alphabétique, 
pressez T ; pour passer à la suivante, pressez ST.

Ces options vous aident à atteindre les entrées en utilisant leurs 
noms.

SoundDiver continue de gérer des entrées qui ne contiennent 
pas de données, mais qui sont toujours présentes en tant que 
nom (ex : entrées effacées, visibles dans la fenêtre Device.)

Échanger, déplacer et copier des entrées 
avec la souris

Échanger
Pour échanger les emplacements de deux 
entrées dans la fenêtre Device, déplacer 
une entrée avec la souris sur une autre. Les 
emplacements seront automatiquement 
échangés. Bien sur vous pouvez aussi 
sélectionner plusieurs entrées et les déplacer vers un autre 
emplacement. SoundDiver échangera alors les emplacements 
des entrées en accord avec leur ordre dans la fenêtre Device.

Exemple: si vous déplacez les entrées 12,15,18, et 32 sur 
l’entrée 56, elles seront déplacées dans l’ordre vers les entrées 
56 à 59, qui remplaceront en retour les entrées déplacées.

Si vous déplacez des entrées sur des emplacements vides, elles 
seront simplement copiées.
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Copier
Si vous maintenez A ( : O) enfoncé durant cette opération, 
l’entrée cible est remplacée. C’est ainsi que l’on duplique des 
entrées dans la fenêtre Device.

Exemple : Si vous pressez A ( : O) et déplacez les entrées 
12,15,18, et 32 sur les entrées 56, elles seront copiées sur les 
emplacements 56 à 59.Et donc, l’entrée 56 contient une copie 
de l’entrée 12, 57 une copie de l’entrée 15, 58 de 18, et 59 de 32. 

A chaque fois que vous déplacez des entrées depuis la fenêtre 
Device vers une autre fenêtre, ces entrées sont automatique-
ment copiées.

& Essayez de ne pas choisir des entrées affichées en gras comme destination. Ce sont 
des entrées filles qui sont déjà utilisées par une autre entrée. Voir aussi le § Entrées 
dépendantes à la page 221.

Utiliser le menu Edit pour couper, copier, 
coller et supprimer des entrées
Vous pouvez sélectionner des entrées dans la fenêtre Device et 
utiliser les fonctions du menu Edit pour les couper, les copier, 
les coller ou les effacer . Cela s’applique aussi aux entrées d’une 
bibliothèque. Les fonctions du menu Edit sont expliquées en 
détail au § Le menu Edit (Édition) à partir de la page 145 et 
suivantes.

& SoundDiver garde tous les noms des entrées effacées, même si les données ont été 
effacées. Les entrées en question sont affichées en gris au lieu de noir (comme les 
entrées ROM), c’est particulièrement utile lorsque vous utilisez l’Autolink.

Édition d’entrées
Si vous double-cliquez sur une entrée dans SoundDiver, c’est 
l’éditeur qui s’ouvre à la place. Pour plus de détails, veuillez 
vous référer au chapitre L’édition dans SoundDiver à partir de la 
page 293 et suivantes.
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6.5 Menu contextuel
Lorsque vous cliquez sur une entrée avec le bouton droit, elle 
est sélectionnée (si elle ne l’était pas déjà) et un menu contex-
tuel apparaît. Les options de menu suivantes sont disponibles :

• Edit: voir Edit à la page 231 du Chapitre 6 La Fenêtre Device.

• Audition: voir le § Audition à la page 231.

• Cut, Copy, Paste: voir le § Utiliser le menu Edit pour couper, 
copier, coller et supprimer des entrées à la page 226.

• Request: voir le § Demande d’Entrées à la page 234

• Transmit: voir le § Transmettre des Entrées à la page 235.

• Hold Transmission: voir le § Hold Transmission (Suspendre 
transmission) à la page 158.

• Rename: voir le § Rename à la page 230.

• Export MIDI File…: voir le § Export MIDI File… (Exporter 
fichier MIDI) à la page 143.

• Parameters: voir le § Parameters à la page 232.

Lorsque vous cliquez sur une zone vide avec le bouton de la 
souris, un menu contextuel plus court apparaît, qui contient 
seulement les options Parameters et Hold Transmission.

6.6 La Case des Paramètres 
d’Appareil

La case des paramètres d’Appareil dans la fenêtre Device est 
identique celle de la fenêtre Setup excepté les lignes “use”, ou 
“used by”. Les paramètres spécifiques sont détaillés au § La 
Case des Paramètres d’Appareil à partir de la page 196 et suivan-
tes.

La fonction View > Parameters permet d’afficher et de masquer 
la case des paramètres.
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6.7 Fonctions spéciales
Sous la case des paramètres se trouvent 
quelques fonctions spéciales supplé-
mentaires. Si vous ne pouvez pas bien 
les voir, cliquez sur le petit triangle 
dans le coin supérieur gauche de la case 
des paramètres pour la réduire.

Avec les appareils possédant un port pour carte RAM ou ROM, 
vous pouvez utiliser le bouton Card pour déterminer si les 
données de la carte doivent être affichées dans la fenêtre 
Device.

La plupart des modules peuvent reconnaître une carte insérée, 
soit pendant la fonction Scan, ou à tout moment (ex : Korg M1), 
suivant les capacités MIDI individuelles de l’appareil.

Le Module Universel affiche jusqu’à quatre cartes différentes. 
Cependant, la fonction dépend des adaptations particulières.

6.8 Aide en Ligne Interactive
Vous pouvez interroger l’aide interactive en cliquant le bouton 
d’aide qui délivre des messages d’aide relatifs à la case des para-
mètres d’Appareil et aux fonctions spéciales. Vous pouvez 
ouvrir la totalité de l’aide en ligne en sélectionnant 
Windows>Help. Le contenu de cette fenêtre d’aide dépendra 
alors de la position du curseur. Les messages d’aide contien-
nent des informations sur les différents types de données ou les 
fonctions spéciales.

S’il n’y a pas de message d’aide particulier pour la zone sélec-
tionnée, des informations générales seront affichées.

Exemple : Ouvrez l’aide interactive et positionnez-la sur 
l’écran de manière à ce que vous puissiez voir les entrées de la 
fenêtre Device. Cliquez sur les différentes zones de la fenêtre 
Device pour vous familiariser avec le système d’aide interac-
tive. Si vous voulez l’ouvrir dans une fenêtre flottante, voir le § 
L’aide en ligne à la page 170.
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6.9 Liste des Dépendances
Au-dessous des fonctions 
spéciales, vous trouverez la 
liste des dépendances. Elle 
vous indique quelles autres 
entrées sont utilisées par l’entrée sélectionnée. Si aucune 
entrée ou plusieurs entrées sont sélectionnées, la liste des 
dépendances sera vide.

uses… Ce champ regroupe les noms des entrées qui sont 
utilisées par l’entrée sélectionnée. Si vous sélectionnez une 
entrée parent (ex : performance, multi ou combinaison) les 
noms des entrées filles lui appartenant seront affichées ici.

used by… Ce champ 
regroupe les noms des entrées 
parents qui utilisent l’entrée 
sélectionnée. Si vous sélection-
nez un son (patch, voix, 
programme) vous pourrez voir 
quelles entrées parents (multi, performance, combis), s’il y en 
a, les utilisent.

Si vous cliquez sur un nom dans la liste de dépendance, cette 
entrée sera alors sélectionnée.

& Si le type de données de l’entrée que vous avec cliquée est masqué, SoundDiver affi-
chera automatiquement ce type de données.

Le numéro de l’emplacement mémoire est affiché dans la 
marge gauche de chaque entrée. Si une entrée n’a pas de nom, 
le nom de son type de données est affiché à la place (ex : 
“Program Change Map”). Vous pouvez avoir à ajuster la largeur 
de la liste de paramètres pour rendre ce numéro visible.

& Lorsque le gestionnaire de dépendances est désactivé, la liste des dépendances n’est 
pas affichée. Voir aussi le § Dependency Management (Gestion des Dépendances)  à 
la page 399.
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6.10 Menus locaux de la fenêtre 
Device

Entry

Load and transmit File…
Pour une description de cet fonc-
tion, référez-vous au § Loading for 
a Single Device à la page 288 et au § 
Load and Transmit File… à la page 
287.

Initialize
Vous pouvez initialiser des sons, performances ou tout autre 
emplacement mémoire dans la fenêtre Device. Cette fonction 
est équivalente à celles “Initialiser”, “Défaut”, ou “Voice Init” 
offertes par d’autres appareils.
❏ Sélectionnez les entrées que vous voulez initialiser en cli-

quant dessus.
❏ Sélectionnez Entry> Initialize les entrées correspondantes

seront initialisées et envoyées à l’appareil.
& L’entrée initialisée sera directement inscrite dans l’emplacement mémoire correspon-

dant. Vous pouvez annuler l’initialisation en sélectionnant Edit > Undo.

Rename
Vous pouvez renommer une entrée en la sélectionnant et en 
choisissant Entry>Rename. Tapez le nouveau nom dans le 
champ d’entrée de texte et pressez ensuite R ou cliquez à 
l’extérieur du champ d’entrée de texte. Le nouveau nom sera 
alors affiché et l’entrée sera envoyée à l’appareil.
& Si vous voulez renommer un groupe d’entrées en une seule fois, au lieu de presser 

R après avoir entré le nom, pressez simplement une des touches du curseur, I ou 
M, qui vous feront passer à l’entrée suivante en gardant le champ de texte ouvert. 

& L’attribution d’un nouveau nom peut être interrompue à tout moment en pressant 
™.

& Le nombre de caractères disponibles pour l’entrée d’un nom dépend de l’appareil.
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Audition
Si vous avez sélectionné une entrée que vous désirez écouter, 
sélectionnez Entry>Audition. Les données de l’entrées seront 
envoyées vers le tampon d’édition approprié, et à condition que 
la fonction Autoplay soit activée, le son sera joué par la note test.
Lorsque vous utilisez la fonction Audition, notez qu’aucun 
emplacement de mémoire n’est modifié. Les seules exceptions 
sont les entrées ROM qui n’ont pas de tampon d’édition (ex : 
Micro-Waves Waves). Dans ce cas la fonction Audition modifie 
un emplacement de mémoire RAM du même type, mais seule-
ment après vous avoir demandé si vous acceptiez. 
Veuillez vous référer au § AutoAudition à la page 156.

Edit
Cette option de menu copie l’entrée dans un tampon d’édition 
et ouvre la fenêtre de l’éditeur. Pour les détails, consultez le 
chapitre L’édition dans SoundDiver à partir de la page 293 et 
suivantes.

Build Library
Cette option de menu est identique à celle de la fenêtre de 
Configuration, bien qu’ici elle s’applique seulement à l’appa-
reil actif. Elle crée une nouvelle bibliothèque à partir des 
entrées de la fenêtre Device.
Voir aussi le § Build Library à partir de la page 209 et suivantes.

Save as…
Cette option de menu fonctionne comme Build Library mais 
sauvegarde la bibliothèque créée directement sur le disque une 
fois que vous avez entré son nom et son chemin d’accès dans 
l’écran de sélection de fichiers.

Export…
Cette option de menu fonctionne comme Save As..., mais le 
fichier est sauvegardé soit comme un fichier MIDI standard, ou 
comme un fichier SYX/MidiEX. Pour plus de détails, consultez 
le § Exportation de fichiers à la page 281.
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Append to Library
Cette option de menu ajoute les entrées sélectionnées à la 
bibliothèque active (la plus récemment sélectionnée.)

& Cette fonction est particulièrement utile lorsque vous recevez diverses banques d’un 
appareil (ex : Lorsque vous souhaitez convertir le contenu de plusieurs cartes ROM 
en Bibliothèque SoundDiver.)

View

Parameters
Cette fonction détermine si la case 
des paramètres de la fenêtre Device 
doit être affichée. Si elle est désacti-

vée, l’intégralité de la zone de la fenêtre Device sera disponible 
pour afficher les entrées.

Link Windows
Cette fonction active le mode Lien. Dans ce mode, le contenu 
de la fenêtre Device est déterminé par l’appareil actif dans la 
fenêtre Device.

Cette fonction équivaut à utiliser le symbole Lien, les réglages 
sont synchronisés.

Vous trouverez un exemple au § La fonction Lien à la page 218

Next Device/Previous Device
Ces fonctions vous permettent de sélectionner rapidement les 
appareils sans ouvrir la fenêtre de Configuration ni créer 
plusieurs Screensets. L’ordre de sélection est le même que 
celui que vous avez établi dans la liste de la fenêtre de Confi-
guration.

Notez qu’aussi longtemps que vous maintenez ç ( : C), 
seule la barre de titre de l’appareil nouvellement sélectionné 
est mise à jour. Dès que vous relâchez la touche, le contenu tout 
entier de la fenêtre est actualisé. Cela vous permet une sélec-
tion rapide dans les configurations importantes.
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Data Types
Pour les appareils 
disposant d’un grand 
nombre de données 
(Multi, Voices, Effects, 
Pans...) vous pouvez 
rapidement vous 
perdre en les parcou-
rant. Pour éviter cela, 
vous pouvez masquer 
certains ou tous les 
groupes de paramètres.
Le contenu de cette 
option de menu 
reflète la structure de l’appareil. L’image montre le menu d’un 
Yamaha SY99.
Sélectionnez les types que vous voulez voir et auxquels vous 
désirez avoir accès.
En haut du sous-menu, tous les types de données sont affichés 
séparément. En bas, vous pouvez sélectionner Show All ou 
Show None pour afficher tout, ou masquer tout. 
& Si une fenêtre Device est complètement vide ou qu’il y manque quelque chose, véri-

fiez cette option en premier, et sélectionnez Show All.

Sélectionner le type de données avec les boutons
L’affichage des types de données peuvent aussi être contrôlé 
grâce aux boutons situés en haut de la fenêtre. Vous trouverez 
cette fonction uniquement pour les appareisl disposant de 
plusieurs types de données.

Les boutons sont triés de gauche à droite, en commençant par All, 
puis un bouton par type de données. Pour sélectionner plusieurs 
types à la fois, cliquez sur les boutons tout en pressant S.
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Spécial
Avec certains appareils, la barre de menu de la fenêtre Device 
contient un autre menu spécial comportant des fonctions rela-
tives à l’appareil. Par exemple, avec un Korg Wavestation, vous 
aurez un autre menu spécial dont les fonctions sont expliquées 
dans l’aide en ligne.

Adaptation
Dans le menu local de la fenêtre Device intitulé Adaptations, 
vous pouvez éditer et sauvegarder les Adaptations. Tout ceci 
est détaillé au chapitre Le Module Universel à partir de la page 
379 et suivantes.

6.11 Fonctions MIDI de la fenêtre 
Device

Demande d’Entrées
Vous pouvez ordonner à SoundDiver de mettre à jour les 
entrées sélectionnées dans la fenêtre Device en demandant les 
données concernées à l’appareil.

Sélectionnez une ou plusieurs entrées et choisissez Edit > 
Request. Vous pouvez aussi cliquer sur l’icône en forme de 
point d’interrogation au-dessus de la case des paramètres 
d’Appareil. SoundDiver demande les données de l’appareil et 
met à jour les entrées correspondantes dans la fenêtre.

Cette fonction est particulièrement utile si vous avez modifié le 
contenu de la mémoire d’un appareil et que SoundDiver n’est 
plus complètement à jour.
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& Si vous voulez recevoir le contenu entier de la fenêtre Device d’un seul coup, vous 
devrez d’abord sélectionner Edit > Select all.

Transmettre des Entrées
Vous pouvez transmettre les entrées sélectionnées à l’appareil 
via MIDI. Normalement, cela se fait automatiquement, car 
SoundDiver travaille à l’arrière plan pour s’assurer de la cons-
tante synchronisation entre le contenu des appareils et le 
contenu de la fenêtre. Si un appareil n’est pas informé d’un 
changement survenu dans SoundDiver (ex : car il n’a pas été 
activé), vous pouvez transmettre les entrées manuellement : 
sélectionnez Edit > Transmit, ou cliquez sur le bouton avec le 
point d’exclamation au-dessus de la case des paramètres 
d’Appareil.

Si vous commencez en sélectionnant Edit > Select All, cette 
option transmettra la totalité du contenu de la fenêtre Device 
d’un coup.

Ces entrées sont demandées
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Attention : Contrairement à la fonction Audition, les entrées 
sont directement écrites dans les emplacements mémoire, et 
non dans un tampon d’édition.

Demander le Contenu de la fenêtre Device 
au démarrage
Vous pouvez ordonner à SoundDiver de demander automati-
quement le contenu des mémoires des appareils installés au 
démarrage du programme.

Cliquez et maintenez à la droite d’AutoRequest dans la case des 
paramètres d’Appareil. Un menu local s’ouvre, dans lequel 
vous pouvez déterminer quelles données vous souhaitez que 
SoundDiver demande :

none
Aucune entrée

I
Interne

I+C
Interne + Carte

I+C+R
Interne + Carte + ROM

all
La totalité du contenu de la mémoire (tampons d’édition
inclus)

SoundDiver requerra alors automatiquement les contenus 
mémoire des appareils à chaque démarrage du programme.

& Souvenez-vous que cela peut prendre quelques minutes, selon l’appareil, et donc 
que cela peut allonger le délai de démarrage de SoundDiver de manière significative, 
spécialement avec d’importantes configurations MIDI.

Vous pouvez vous dispenser de cette procédure de requête 
automatique en sauvegardant le contenu de la fenêtre Device 
avant de quitter le programme. Pour plus de détails référez-
vous au § Save Device Entries in Preferences File (Sauvegarder les 
Entrées d’Appareils dans le Fichier Préférences) à partir de la page 
397 et suivantes.
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6.12 Sauvegarder la fenêtre 
Device sur disque

Si vous désirez sauvegarder le contenu de la fenêtre Device sur 
votre disque dur, vous avez deux possibilités :

• Vous pouvez indiquer à SoundDiver de créer une biblio-
thèque contenant toute ou une partie de la fenêtre Device, 
et de l’enregistrer sur le disque

• Vous pouvez faire en sorte que les contenus des fenêtres 
Appareil de tous les appareils installés soient automatique-
ment sauvegardés lorsque vous quittez le programme 
(consultez le § Save Device Entries in Preferences File (Sauve-
garder les Entrées d’Appareils dans le Fichier Préférences) à partir 
de la page 397 et suivantes).
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Sauvegarder la fenêtre Device sous la 
forme d’une Bibliothèque

Une banque de sons dans la fenêtre Device (droite) et dans la 
bibliothèque

• Sélectionner Entry>Build Library>Memory Location dans le 
menu local de la fenêtre Device, ou bien

• Sélectionner l’appareil dans la fenêtre de Configuration et 
sélectionner Entry>Build Library>Memory Location dans le 
menu local.

SoundDiver créera alors une nouvelle Bibliothèque contenant 
la totalité du contenu de la mémoire de l’appareil. Seuls les 
tampons d’édition et les entrées ROM seront exclues. Vous 
pouvez enregistrer la nouvelle bibliothèque en sélectionnant 
File > Save. Vous pouvez aussi choisir dès le départ Save As... au 
lieu de Build Library.
Si vous voulez enregistrer des entrées en particulier, sélection-
nez-les dans la fenêtre Device puis sélectionnez Entry>Build 
Library>Selected entries ou Entry>Save as...>Selected Entries 
dans la fenêtre Device.
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Recharger la fenêtre Device
Si vous désirez recharger le contenu de la fenêtre Device qui a 
été sauvegardé sur le disque :

• Chargez la bibliothèque soit en sélectionnant New > Load 
and transmit File… Dans la fenêtre de Configuration ou 
Entry>Load and transmit File dans la fenêtre Device, et 
sélectionnez la bibliothèque désirée dans la case de sélec-
tion de fichier.

• Après que les entrées aient été transférées   à la fenêtre 
Device, vous recevrez un message d’alerte vous demandant 
si vous désirez réellement les transmettre à l’appareil.

Recharger une partie de la fenêtre Device
Si vous désirez recharger une partie d’une bibliothèque dans la 
fenêtre Device, 

❏ Ouvrez la bibliothèque en sélectionnant File > Open…t
sélectionnez la bibliothèque désirée dans le sélecteur de
fichiers,

❏ Désactivez Options > AutoAudition, 

❏ Sélectionnez les entrées désirées,

❏ Sélectionnez Edit > Transmit.

Vous pouvez rectifier l’emplacement de mémoire cible pour 
chaque entrée dans le dialogue qui apparaît. Si vous souhaitez 
que toutes les entrées aillent vers leurs emplacements mémoire 
d’origine, cliquez simplement All. Les entrées sont alors auto-
matiquement envoyées à l’appareil.

Pour plus de détails sur les fonctions de la bibliothèque, réfé-
rez-vous au § La Bibliothèque à partir de la page 243 et suivantes.
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Sauvegarde automatique de la fenêtre 
Device

En activant la fonction Save Device Entries dans Preferences file 
dans les préférences (ouvertes par Options > Settings > Global 
Preferences), le contenu de tous les appareils installés sont 
automatiquement sauvegardés sur le disque. En utilisant le 
menu local, vous pouvez en plus sélectionner quelles entrées 
doivent être sauvegardées automatiquement. Pour plus de 
détails, référez-vous § Save Device Entries in Preferences File 
(Sauvegarder les Entrées d’Appareils dans le Fichier Préférences) à la 
page 397.

& Si seul le nom d’une entrée est connu, il est enregistré dans les préférences, indépen-
damment des réglages ci-dessus. De cette manière ; vous voyez les noms des entrées 
récentes dans la session suivante.

6.13 Adaptations de 
Télécommande

Certaines Adaptations ne contiennent qu’un seul éditeur qui 
ne correspond pas à un tampon d’édition spécifique d’un appa-
reil particulier, mais à la place permet le contrôle à distance ou 
l’affichage de certains contrôles. Nous appelons ces Adapta-
tions “Adaptations de Télécommande”. 

Puisqu’il n’y a pas de transfert (dump) possible dans les Adap-
tations de Télécommande qui pourraient être requis ou trans-
mis, l’affichage d’une fenêtre Device n’est pas nécessaire. 
Donc, ouvrir l’Adaptation à partir de la fenêtre de Configura-
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tion n’ouvre pas la fenêtre Device, mais directement la fenêtre 
d’Edition, avec des valeurs initialisées. Exemples incluant les 
Adaptations fournies “Mixer”, “Monitor” et “Roland Addres-
ses”.

Cependant il existe aussi des Adaptations “normales” conte-
nant un tel éditeur de télécommandes (ex :Dynacord DRP15) 
en plus de leurs autres éditeurs. Dans ce cas, la fenêtre Device 
est ouverte normalement. En ouvrant l’entrée “remote control” 
depuis la fenêtre Device, elle est initialisée et ouverte automa-
tiquement. La télécommande de SoundDiver n’a aucun 
rapport avec ces Adaptations. Pour plus de détails, consultez le 
chapitre Les Assignations de contrôleurs à partir de la page 327 et 
suivantes.
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La Bibliothèque

Dans ce chapitre, vous apprendrez comment utiliser la Biblio-
thèque dans SoundDiver pour compiler des banques de 
données de sons. Ces banques de données vous permettent de 
trouver et de trier les sons et les données dans votre système 
MIDI, de manière rapide et efficace.

7.1 Qu’est-ce qu’une 
Bibliothèque SoundDiver ?

Une bibliothèque SoundDiver est un fichier dans lequel toutes 
les données SysEx (programmes, sons, combis, multis, effets, et 
autres) de votre système MIDI peuvent être sauvegardées, 
classées et affichées selon différents points de vue.

Le but d’une telle bibliothèque est de vous permettre de 
compiler une importante collection de sons et d’autres 
données, de trouver les bons immédiatement en les triant selon 
les critères appropriés. Vous pouvez alors les afficher à l’écran et 
les transmettre aux appareils MIDI.

De ce point de vue, une bibliothèque est identique à une base 
de données que vous utilisez peut-être pour vos adresses ou vos 
listes de livres. De même qu’un fichier d’adresses va vous 
permettre de rechercher parmi des milliers d’adresses et de 
trouver celles dont le code postal commence par 4, vous pouvez 
parcourir une bibliothèque SoundDiver, sélectionner instanta-
nément les sons dont les noms contiennent “piano” et les 
envoyer aux appareils concernés.

Mis à part les fonctions habituelles de gestion, les bibliothè-
ques SoundDiver offrent certaines fonctions très appréciables :

• La taille de votre bibliothèque est uniquement limitée par la 
capacité RAM de votre ordinateur. Vous pouvez décider 

Chapitre 7
243
Mode d’Emploi
Version 3.0



 – La Bibliothèque
d’utiliser peu de grosses bibliothèques ou plusieurs petites. 
Par exemple, une bibliothèque peut contenir des milliers de 
sons provenant de différents synthétiseurs ou bien unique-
ment le contenu d’une seule fenêtre Device. Comme vous 
pouvez échanger, copier, et importer le contenu de diffé-
rentes bibliothèques, votre collection de données peut être 
compilée comme vous le souhaitez. 

• SoundDiver vous permet de compiler plusieurs bibliothè-
ques mixtes. Les “Performances” d’un Yamaha EX5, les 
“Multis” d’un Yamaha SY99, et les “Singles” d’un Access 
Virus pourront tous être gérés dans la même bibliothèque.

7.2 La Fenêtre Library 
(Bibliothèque)

La fenêtre Bibliothèque contient trois éléments importants :

• La bibliothèque
• La case des paramètres des entrées
• La liste des liens
•  : et la barre de menu local
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Dans la barre de menu local, vous trouverez des fonctions qui 
vous aideront dans des tâches telles qu’afficher et classer la 
bibliothèque. La liste de la bibliothèque est elle-même divisée 
en une barre de titre pouvant être reconfigurée, et bien 
entendu la table des entrées. Pour chaque entrée il y a une liste 
de paramètres pouvant être affichés dans la case des paramè-
tres.

Ouvrir et fermer un fichier Bibliothèque
Vous pouvez ouvrir un fichier bibliothèque en sélectionnant 
File > Open… et en sélectionnant une bibliothèque dans le 
dialogue qui apparaît. Vous pouvez ouvrir plusieurs documents 
à la fois, et les copier dans les bibliothèques.

Pour fermer la bibliothèque, sélectionnez File > Close Library. 
Si vous avez modifié la bibliothèque, une boite de dialogue 
vous demande si vous souhaitez enregistrer ces modifications.

Référez-vous au § Le menu File (Fichier) à partir de la page 140 et 
suivantes pour plus de détails sur la gestion de ces fichiers.

& Fermer une fenêtre bibliothèque ne ferme pas le fichier en lui-même.

& Presser A ( : O) en cliquant la case de fermeture de fenêtre ferme toutes les 
bibliothèques des fenêtres sans fermer la bibliothèque en elle-même.

Ouvrir une Fenêtre de Bibliothèque
Vous pouvez ouvrir une fenêtre bibliothèque en sélectionnant 
Windows > Library. Vous pouvez ouvrir plusieurs fenêtres pour 
la même bibliothèque.

La barre de titre de chaque fenê-
tre Bibliothèque contient le nom 
de la bibliothèque et, à partir de 
la seconde fenêtre, un numéro 
de série.

Par exemple : Vous pouvez appe-
ler plusieurs fonctions d’une 
bibliothèque à l’écran ou afficher la bibliothèque en différentes 
tailles.
245
Mode d’Emploi
Version 3.0



 – La Bibliothèque

X

Sélection d’entrées dans la Bibliothèque
Dans le § Sélectionner des entrées à partir de la page 137 et suivan-
tes vous avez appris à utiliser les fonctions de sélection. Elles 
s’appliquent aussi à la bibliothèque. Voici un bref rappel :

• Sélectionnez une entrée en cliquant dessus ; si vous cliquez 
de nouveau dessus en maintenant ç ( : S) la sélection 
sera inversée ; 

• Pour sélectionner plusieurs entrées, cliquez dessus, les unes 
après les autres en maintenant ç ( : S).

• Pour sélectionner un bloc, cliquez sur la première entrée, 
puis en maintenant S ( : ç) cliquez sur la dernière.

• Vous pouvez sélec-
tionner des blocs 
d’entrées dans la bi-
bliothèque en cli-
quant dans la colonne 
étroite sur le bord 
gauche de la biblio-
thèque et en étirant 
un élastique au-des-
sus des entrées tout 
en maintenant le 
bouton de la souris 
enfoncé. Les entrées 
adjacentes ou à l’inté-
rieur de l’élastique 
seront sélectionnées. 
Vous pouvez sélectionner plusieurs blocs en maintenant ç 
( : S) enfoncé sitôt après avoir sélectionné le premier bloc.

• En cliquant sur le titre d’une entrée (voir le § Insert Title (In-
sérer Titre) à partir de la page 263 et suivantes) dans la biblio-
thèque en maintenant A ( : O) enfoncé, toutes les entrées 
jusqu’au prochain titre sont sélectionnées. Cela vous permet 
de sélectionner très facilement des blocs dans une bibliothè-
que.

• Utilisez le menu Edit pour sélectionner toutes les entrées à la 
fois ou inverser la sélection.

Cliquer ici
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Opérations avec la souris dans la Bibliothèque
• Dans la bibliothèque, vous pouvez désélectionner toutes les 
entrées d’un seul coup en cliquant sur la fine bande le long 
de la zone vide de la table de bibliothèque (si cette dernière 
est visible.

Sélectionner aussi des entrées filles
En pratique vous aurez assez souvent à couper ou supprimer 
des entrées parents de la bibliothèque ainsi que les entrées 
filles qui les constituent. Pour vous éviter l’effort de devoir 
chercher dans toute la librairie les entrées filles, il y a un 
raccourci clavier que vous pouvez utiliser : lorsque vous sélec-
tionnez une entrée parent, les entrées filles utilisées sont sélec-
tionnées aussi. 

Il vous suffit de cliquer sur l’entrée parent en maintenant A 
( : O). Les entrées filles associées seront sélectionnées aussi, 
et prises en compte lorsque vous couperez, déplacerez ou 
supprimerez l’entrée parent.

& A chaque fois que vous coupez ou effacez une entrée parent ainsi que ses entrées 
filles, SoundDiver vérifie si parmi les entrées files aucune n’est utilisée par d’autres 
entrées parents.Si c’est le cas, il vous sera demandé de confirmer la suppression de 
ces entrées filles. Vous pouvez ainsi éviter de détruire l’intégrité d’autres entrées 
parents.

& Si vous voulez copier une entrée parent avec ses composantes entrées filles, il vous 
suffit de sélectionner l’entrée parent. Lorsque vous copiez une entrée parent ses 
composantes entrées filles sont toujours “prises en compte”, que vous les ayez sélec-
tionnées ou pas. Vous pouvez désactiver cette option (voir le § Dependency Mana-
gement (Gestion des Dépendances) à la page 399).

7.3 Opérations avec la souris 
dans la Bibliothèque

Mis à part les opérations générales avec la souris (voir le § La souris 
à la page 124 du Chapitre 4 L’interface utilisateur de SoundDiver) la 
bibliothèque contient les fonctions spéciales suivantes:

• Pour déplacer une ou plusieurs entrées dans la bibliothèque, 
sélectionnez les entrées désirées et déplacez-les avec la 
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souris vers un autre endroit de la même fenêtre. Cependant, 
si vous désirez déplacer les entrées dans la fenêtre d’une 
autre bibliothèque, maintenez A ( : O) enfoncé tout en 
déplaçant, autrement les entrées seront copiées.

•  : Si vous cliquez sur une entrée en maintenant C, les 
réglages de l’AutoAudition sont inversés, ce qui est utile si 
vous avez activé l’AutoAudition mais que vous désiriez 
ensuite sélectionner une entrée sans la transmettre via 
MIDI, sélectionnez-la avec le bouton droit.

7.4 Menu contextuel sous 
Windows

Lorsque vous cliquez sur une entrée avec le bouton droit, ce 
menu contextuel apparaît. Les options de menu suivantes sont 
disponibles :

• Audition: voir le § Audition à la page 261.

• Edit: voir le § Edit à la page 262.

• Cut: voir le § Cut (Couper) à la page 147.

• Copy: voir le § Copy à la page 148.

• Paste: voir le § Paste à la page 149.

• Request: voir le § Demander des entrées de Bibliothèque à la page 
264.

• Transmit: voir lee § Transmettre des entrées de Bibliothèque à la 
page 265.

• Hold Transmission: voir le § Hold Transmission (Suspendre 
transmission) à la page 158.

• Store sequence: voir le § Store Sequence (Mémoriser la séquence) 
à la page 262.

• Insert title: voir le § Insert Title (Insérer Titre) à la page 263.

• Insert file…: voir le § Insert File (Insérer Fichier) à la page 264.

• Parameters: voir le § Ajuster et masquer la Case des Paramètres à 
la page 258.
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Lorsque vous cliquez dans une zone vide avec le bouton droit 
de la souris, un menu contextuel plus court apparaît, qui 
contient seulement les options Paste, Hold Transmission et les 
trois dernières.

7.5 Gestion des bibliothèques 
sur disque

Vous gérez les bibliothèques du disque dur en utilisant les fonc-
tions du menu Fichier, qui sont expliquées en détail au § Le 
menu File (Fichier) à partir de la page 140 et suivantes.

7.6 Création de Bibliothèques
Il existe plusieurs façons de créer une bibliothèque dans 
SoundDiver :

• Sélectionnez File > New pour ouvrir une nouvelle fenêtre 
vide de bibliothèque dans laquelle copier des entrées.

• Sélectionnez un ou plusieurs appareils dans la fenêtre de 
Configuration puis sélectionnez New>Build Library dans le 
menu local pour générer automatiquement une biblio-
thèque utilisant le contenus mémoire des appareils sélec-
tionnés.

• Créer une nouvelle Bibliothèque et importer des Bibliothè-
ques ou des banques d’autres programmes (voir le § Insert 
File (Insérer Fichier) à la page 264).

& Les bibliothèques Polyframe C-LAB peuvent être chargées dans une bibliothèque 
SoundDiver en utilisant File > Open…  Cela vous permet de continuer à utiliser vos 
bibliothèques Polyframe dans SoundDiver. La conversion est automatique et Sound-
Diver conserve le nom de l’ancienne bibliothèque. Les fichiers Setup Polyframe (avec 
l’extension .ps) ne peuvent pas être directement chargés dans SoundDiver. Vous 
devez charger le Setup Polyframe dans la fenêtre de l’appareil correspondant et 
sauvegarder toute la fenêtre Device comme une bibliothèque Polyframe. SoundDiver 
peut alors lire cette bibliothèque.

& Pour importer une bibliothèque Polyframe, renommez-la d’abord, de manière à 
changer son extension de .PL en.LIB.
 : Le type de fichier doit être réglé sur EM9F et son créateur sur EMA6 . Voir le § 
Compatibilité des versions Windows, Macintosh et Atari  à la page 76 pour les détails.
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Toutes les fonctions de gestion des bibliothèques sont décrites 
dans le § Le menu File (Fichier) à partir de la page 140 et suivan-
tes. Veuillez consulter cette section pour en savoir plus.

7.7 Chargement automatique 
d’une Bibliothèque au 
démarrage

Si vous travaillez dans SoundDiver avec une ou plusieurs 
bibliothèques standard, vous n’avez pas besoin de définir des 
bibliothèques spéciales Autoload. Lorsque vous quittez le 
programme, SoundDiver se souvient quelles bibliothèques 
étaient ouvertes, et les ouvre de nouveau lorsque vous démar-
rez le programme la fois suivante. SoundDiver sera dans le 
même mode exactement, que la dernière fois où vous avez 
travaillé avec.
Si vous démarrez toujours de la même bibliothèque, vous 
pouvez en changer le nom pour Autoload (Macintosh)ou AUTO-
LOAD.LIB (Windows) et, si nécessaire, la déplacer dans le dossier 
Libraries. Elle sera alors lancée automatiquement au démarrage.

7.8 Apparence du tableau de 
Bibliothèque

Vous êtes libre de définir vous-même l’aspect de la fenêtre 
Bibliothèque. En utilisant la souris, vous pouvez déterminer la 
largeur de la case des paramètres, les largeurs respectives des 
colonnes de la bibliothèque et la taille de l’affichage.
& En optimisant l’utilisation des Screensets, vous pouvez prédéfinir les différents 

aspects d’une fenêtre bibliothèque et passer de l’un à l’autre selon vos désirs. Pour 
plus de détails sur les réglages des Screensets, veuillez vous référer au § Screensets 
à partir de la page 135 et suivantes.

La bibliothèque est affichée sous forme d’un tableau. Les 
entrées sont ordonnées verticalement, et peuvent être triées 
comme vous le désirez (voir le § Fonctions de classement à la page 
253 pour plus de détails).
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Apparence du tableau de Bibliothèque
La barre de titre contient toute sorte de fonctions pour définir 
l’aspect de la fenêtre Bibliothèque. Vous pouvez modifier 
l’ordre des colonnes, afficher des colonnes individuelles ou 
modifier leur largeur.

Numéro
Chaque entrée a une position numérotée dans la bibliothèque. 
Ce numéro n’a rien à voir avec la position de l’entrée dans la 
mémoire de la fenêtre Device, mais détermine simplement 
l’endroit de la bibliothèque où se trouve l’entrée. C’est la raison 
pour laquelle vous ne pouvez pas trier les entrées par ordre 
numérique dans la Bibliothèque.

Modifier l’ordre des colonnes
Pour changer la position d’une colonne dans la liste, cliquez et 
maintenez l’entête de la colonne désirée dans la barre de titre : 
La flèche de la souris devient une main. Déplacez le champ de 
titre vers la position désirée de la colonne et relâchez le bouton 
de la souris. La colonne sera insérée à cet endroit et toutes les 
autres colonnes seront déplacées en conséquence vers la droite.

Modifier la largeur des colonnes
Pour modifier la 
largeur d’une 
colonne, dépla-
cez le curseur de 
la souris à l’extrémité droite du titre de la colonne : le curseur 
de la souris devient une double-flèche. Etirez le bord de la 
colonne selon vos désirs et relâchez le bouton de la souris. 

Si vous maintenez S pendant cette opération, la largeur de la 
colonne suivante sera modifiée en conséquence, de sorte que 
ce que vous modifiez est en fait la largeur de l’espace entre les 
deux. Cette fonction n’affecte aucune autre colonne.

Pour faire disparaître une colonne, étirer son bord droit aussi 
loin que possible vers la gauche.
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Le menu View
Le menu local View est celui dans lequel vous pouvez afficher/
masquer les colonnes. Désactiver une colonne dans ce menu 
revient à fixer sa largeur à une valeur minimum. Activer une 
colonne fixe sa largeur à 100 pixels : Vous êtes libre de changer 
cette valeur en utilisant la méthode d’étirement décrite ci-
dessus.

Pour activer et désactiver des colonnes, sélectionnez-les 
simplement dans le menu : La marque indique leur statut.

Il est aussi possible d’utiliser les options de menu Show All 
(Afficher tout) et Show None (Rien n’afficher) afin de définir 
l’apparence du tableau tout entier.

Exemple : Il y a toutes sortes de colonnes visibles, mais vous 
voulez uniquement voir les noms et les dates. Le meilleur 
moyen est d’utiliser Show None suivi de Show Name et Show 
Date, plutôt que de désactiver chaque colonne individuelle-
ment.

Taille du texte
L’accessoire Zoom peut augmenter (de moitié) ou 
réduire (de moitié) la taille des caractères.

Avec Windows > Larger view et Smaller view vous 
pouvez sélectionner la taille de police de la fenêtre 
bibliothèque.

Sous Windows, avec une souris Microsoft IntelliMouse™ cela 
peut également être fait en tournant la molette tout en pressant 
ç.

 : Vous utilisez le petit symbole en forme de 
télescope dans le coin supérieur droit de la 
fenêtre Bibliothèque pour choisir la taille du 
texte dans la fenêtre. Cliquez sur la moitié 

gauche de la case de Zoom pour choisir une taille plus petite, et 
la moitié droite pour une taille plus grande.

Zoom box
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Choisissez un texte de petite taille si vous désirez voir autant 
d’entrées que possible en une seule fois. Gardez à l’esprit que 
cela les rend plus difficiles à lire.

& Vous pouvez aussi utiliser les Screensets (voir le § Screensets à la page 135) pour 
mémoriser vos affichages favoris et pouvoir passer de l’un à l’autre.

7.9 Fonctions de classement
Les entrées d’une bibliothèque peuvent être organisées à tout 
moment en utilisant l’éventail simple et complet des fonctions 
de classement de SoundDiver. Il est possible d’organiser les 
entrées en fonction de la plupart de leurs paramètres, que ces 
paramètres soient alors affichés ou non.
Un modèle de classement peut être annulé par Edit > Undo 
pour autant que cela soit fait juste après le classement.
SoundDiver peut gérer jusqu’à trois niveaux de classement, qui 
sont aussi archivés dans le fichier bibliothèque. Si vous classez 
une bibliothèque, les trois classements précédents sont mémo-
risés. Vous trouverez une description avec des exemples au § 
Niveaux de classement à la page 256. 
Les fonctions de classement sont uniquement disponibles pour 
la bibliothèque entière, bien qu’une bibliothèque puisse être 
divisée en zones. Cela veut dire que si vous effectuez un clas-
sement dans une fenêtre Bibliothèque, cela affectera toutes les 
autres fenêtres ouvertes pour cette même bibliothèque.

Classement dans la barre de titre

Il existe une manière rapide de reclasser une bibliothèque : 
double-cliquez dans la barre de titre le paramètre correspon-
dant à la manière dont vous voulez qu’elle soit classée. Cela 
organise automatiquement l’affichage, et si AutoSort (voir le § 
Le menu Sort (Trier) à la page 254) est activé, les paramètres 
appropriés apparaîtront aussi soulignés dans la barre de titre.
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Le menu Sort (Trier)
Le menu local Sort de la fenêtre Bibliothèque vous permet de 
sélectionner un critère de classement : La bibliothèque est 
organisée selon l’option de menu que vous sélectionnez. Le 
Menu Sort a un avantage sur la méthode de classement de la 
barre de titre, qui est que vous pouvez trier selon des paramè-
tres qui ne sont pas visibles dans la barre de titre.

Sort by Name (Trier par nom)
Les entrées sont classées par ordre alphabétique. Cela vous 
permet de trouver rapidement tous les sons dont les noms 
commencent par “strings” par exemple, peu importe leur appa-
reil d’origine.

Sort by Module (Trier par Module)
Les entrées sont classées par ordre alphabétique en fonction de 
leur module. Cela vous permet d’avoir un affichage de biblio-
thèque dans lequel les entrées sont séparées en blocs selon 
leurs appareils d’origine respectifs.

Sort by Model (Trier par Modèle)
Les entrées sont classées alphabétiquement selon leur modèle. 
Le résultat de ce classement est indépendant du critère 
“module” (ex : “SD-1”, “SY77”, “VFX”)

Sort by Device ID (Trier par Device ID)
Les entrées sont classées selon leur Device ID. Si vous n’êtes 
pas familiarisé avec cela, consultez le § Device ID (Identification 
Appareil) à la page 200.

Si vous avez plusieurs appareils du même type dans votre confi-
guration, il est facile de trouver des entrées dans un appareil en 
particulier. Classez d’abord par ID, puis par nom d’entrée.

Sort by Data Type (Trier par type de donnée)
Les entrées sont classées alphabétiquement en fonction de leur 
type de données.
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Exemple : Dans le tableau, Les performances de l’EX5 appa-
raissent en premier, puis les Preset Voices de l’EX5, et finale-
ment les Voix du SY99.

Sort by Location (Trier par emplacement)
Les entrées sont classées par ordre ascendant en fonction de 
leur emplacement de stockage dans l’appareil.

Sort by Size (Trier par taille)
Les entrées sont classées par ordre ascendant en fonction de 
leur taille en octets.

Sort by Date (Trier par date)
Les entrées sont classées dans l’ordre chronologique de leur 
création. Les plus anciennes au début et les plus récentes à la 
fin du tableau.

La date et l’heure de création de la bibliothèque sont affichées 
dans le format choisi. Cela peut être réglé dans le Tableau de 
Bord “Date & Heure” (Macintosh) et dans le panneau de confi-
guration “International” (Windows).

Sort by Comment (Trier par commentaire)
Les entrées sont classées par ordre alphabétique en fonction de 
leurs commentaires. En attribuant des commentaires tels 
“Cordes”, “Piano”, “Studio” ou “Live 07.07.2001” vous 
permettra de les trouver immédiatement sur simple demande.

Auto (AutoSort)
Les entrées sont classées selon le dernier critère de classement 
sélectionné, si quelque chose a été modifié. Le classement 
automatique facilite la répétition du même type de classement 
après des opérations de coupe ou d’insertion.

Pour activer l’AutoSort, sélectionnez Sort>Auto.

& Lorsque l’AutosSort est activé, les positions des curseurs d’insertion ou de la cible 
pour les opérations de la souris sont sans effet. La seule exception étant si la biblio-
thèque est divisée en zone selon les entrées titres.
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Annuler les classements
Edit > Undo annule les effets du dernier classement, et vous 
permet d’alterner entre le classement d’origine et le dernier en 
date.

Trier une Bibliothèque divisée en zones
Insérer une entrée titre permet aux bibliothèques d’être subdi-
visées en zones ; ceci peut être utilisé pour regrouper des 
banques de sons, des sons pour des sessions live spécifiques, 
etc. C’est plus intéressant que de créer une nouvelle bibliothè-
que pour chaque groupement puisque le classement et la 
recherche se font en une seule fois.

Voir le § Insert Title (Insérer Titre) à la page 263 pour savoir 
comment insérer une entrée titre.

SoundDiver prend en compte les zones lors du classement, et 
les classe individuellement. Ceci afin de préserver la relation 
des entrées avec leurs zones.

Le classement est effectué à chaque nouvelle entrée titre

Niveaux de classement
SoundDiver mémorise les trois dernières opérations de classe-
ment, et conserve les résultats. Cette fonction vous permet de 
trier au sein d’un groupe d’entrées ayant un critère identique.

Exemple : Votre bibliothèque est classée par date et vous 
recherchez une Performance particulière sur l’EX5.
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Triez d’abord par nom, puis par module et enfin par type de 
données. Consultez la section des Performances de l’EX5 qui 
sont maintenant classées par ordre alphabétique.

Après le tri par nom, SoundDiver a listé les entrées par module. 
Nous avons maintenant classé par type de données, afin qu’il 
soit facile de trouver la section des Performances et la Perfor-
mance désirée grâce à son nom.

7.10 La Case des Paramètres 
d’Entrée

Chaque entrée, que ce soient des sons, des programmes d’effet, 
ou des Multis, est sauvegardée avec un certain nombre de para-
mètres qui facilitent le classement et l’organisation. Certains 
d’entre eux peuvent être édités, comme le nom d’une entrée.

Chaque fois que vous sélectionnez une entrée, vous voyez ses 
paramètres dans la case.

Le contenu de la case des paramètres est toujours relatif aux 
entrées sélectionnées. Si un paramètre particulier a des valeurs 
différentes pour les entrées sélectionnées, un astérisque (*) 
sera affiché au lieu d’une valeur.

Vous pouvez éditer certains des paramètres dans la case. 
L’édition affectera toujours toutes les entrées sélectionnées.

Ajouter du texte à plusieurs entrées
Avec cette fonction, un texte identique peut être ajouté aux 
noms, commentaires ou emplacements de plusieurs entrées à la 
fois, sans effacer le texte actuel.

❏ Sélectionnez d’abord les entrées que vous voulez modifier

❏ Cliquez sur le paramètre (ex : Le nom)

❏ Entrez un astérisque (*) d’abord, suivi du texte voulu.

❏ Fermez le champ de texte avec R.
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Ajuster et masquer la Case des Paramètres
La case des paramètres peut être réduite en taille en cliquant le 
triangle dans la partie supérieure gauche de la case des paramè-
tres. Sélectionner View > Parameters permet d’activer ou 
désactiver la case des paramètres.

Nom
Cette ligne indique “pas de sélection” si aucune entrée n’est 
sélectionnée. Si une seule entrée est sélectionnée, son nom est 
indiqué ici. Si plusieurs entrées sont sélectionnées, le nombre 
total de sélections est affiché, ex : “35 selected”

Cliquer sur la ligne du nom ouvre un champ de texte pour 
renommer l’entrée. Si plusieurs entrées sont sélectionnées, 
toute saisie alphanumérique les affectera toutes. Le nom de la 
première entrée apparaît par défaut dans le champ de texte. 
Pour pouvoir éditer les noms de plusieurs entrées les uns après 
les autres, sélectionnez la première entrée, ouvrez le champ de 
texte, tapez le nom, puis parcourez la liste en utilisant les 
touches du curseur M et I pour aller jusqu’à l’entrée suivante. 
Le champ de texte restera ouvert et n’a pas besoin d’être 
rouvert à chaque fois.

& Vous pouvez utiliser ces deux fonctions pour donner à toutes les entrées sélection-
nées une identité supplémentaire. Vous pouvez terminer en donnant à chaque 
entrée un nom propre.

& Si vous désirez ajouter des lettres ou des mots aux entrées, consultez le § Ajouter du 
texte à plusieurs entrées à la page 257.

& Si vous voulez quitter le champ de texte sans faire de changement, pressez ™.

Module
Cette ligne indique le module qui a créé cette entrée. Cliquer 
sur cette ligne ouvre une fenêtre d’information qui donne plus 
de détails sur ce module précis.
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Model
Cette ligne indique quel modèle a créé cette entrée. Elle ne 
peut pas être éditée. 
& Un module peut inclure plusieurs modèles différents. Pour cette raison, l’affichage 

du modèle sert à différencier plus précisément les différents appareils utilisés par un 
module.

Device ID
Cette ligne indique l’identité (ID) MIDI de l’appareil qui a 
créé cette entrée. En gros, c’est un numéro d’identification 
pour les données SysEx, permettant aux appareils de même 
type de modèle d’être identifiés séparément dans un système 
MIDI. Ainsi, si vous écoutez une sélection d’entrées de 
plusieurs appareils identiques (ex : un TX816 contenant huit 
modules de DX7) le Device ID vous permet de voir vers quel 
appareil l’entrée actuelle est envoyée.
Exemple : s’il y a deux EX5R dans votre système MIDI, le 
Device ID permet de les différencier.

Data Type (Type de données)
Cette ligne indique le type de données de l’entrée de la biblio-
thèque. Elle vous indique si l’entrée est un son, un Multi, ou un 
programme d’effets.
Exemple : Le Yamaha EX5 contient des “Voix” et des “Perfor-
mances” ; le Yamaha SY99 a des “Sons”, “Multi”, “Synth 
Setup”, “Pan”, “Microtuning”, et “Seq Setup”.
Ce paramètre n’est pas éditable.

Emplacement
SoundDiver note 
immédiatement 
l’emplacement d’une 
entrée dans la fenêtre 
Device lorsqu’il a été 
copié dans la biblio-
thèque. Cet emplace-
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ment apparaît dans la bibliothèque et est toujours inclus dans 
toutes les opérations de SoundDiver.
& Lorsqu’une entrée de la bibliothèque doit être transmise et qu’elle n’a pas d’empla-

cement défini, SoundDiver utilise une stratégie spéciale afin de deviner la destination 
désirée. Voir le § Emplacement de destination par défaut à la page 265.

& Si vous désirez ajouter des lettres ou des mots à l’emplacement, consultez le § 
Ajouter du texte à plusieurs entrées à la page 257.

Date
Indique la date de création de l’entrée. Si vous double cliquez sur 
la ligne, vous pouvez entrer la date avec le clavier de l’ordinateur. 
& Lorsque vous saisissez les valeurs, utilisez des caractères non-numériques pour 

séparer l’année, le mois, et le jour.

Time (Heure)
Indique l’heure de création de l’entrée. L’édition s’effectue 
comme pour la date. Les nombres impairs de secondes ne sont 
pas valides.

Size (Taille)
Cette ligne indique la taille de l’entrée en octets. Cette taille 
n’est pas identique à la taille du message SysEx puisque les 
modules optimisent la quantité de données en laissant de côté 
tout groupe de paramètres qui n’est pas utilisé.

Commentaire
Chaque entrée peut se voir attribuer sa propre ligne de 
commentaires. Comme vous pouvez classer en fonction des 
commentaires, des groupes peuvent être créés si leurs entrées 
respectives ont un commentaire identique. Pour attribuer le 
même commentaire à plusieurs entrées, sélectionnez-les 
toutes, et cliquez sur la ligne de commentaires, un champ de 
texte s’ouvre dans lequel vous pouvez saisir le texte.
& Donner le même commentaire à des entrées (ex : Piano, Cordes, Solo) permet de les 

retrouver facilement et de les classer dans la bibliothèque.

& Si vous souhaitez ajouter des lettres ou des mots à l’emplacement, consultez le § 
Ajouter du texte à plusieurs entrées à la page 257.
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La Liste des Dépendances
La liste de dépendances est décrite au § Gestion de la Dépendance 
des Entrées à la page 216. Elle fonctionne de la même manière 
que la fenêtre Bibliothèque, hormis le numéro de l’emplace-
ment mémoire qui n’est pas affiché.

7.11 Le menu local de la 
Bibliothèque

Le menu local de la bibliothèque permet 
d’envoyer les entrées sélectionnées vers 
les tampons d’édition pour vérifier, jouer 
une séquence test, insérer des sous-titres 
dans la bibliothèque ou charger des 
bibliothèques du disque vers la biblio-
thèque en cours d’utilisation.

Audition
Sélectionner cette option de menu envoie les entrées sélection-
nées vers les tampons d’édition de l’appareil approprié pour 
l’audition.
Comme les entrées sont uniquement envoyées vers les 
tampons d’édition, il n’y a aucun risque que l’AutoAudition 
modifie le contenu de la mémoire. La seule exception concerne 
l’envoi de données pour lesquelles un appareil ne possède pas 
de tampon d’édition.Toutefois, dans ce cas, il y aura toujours un 
message d’alerte.
Si une entrée est une entrée parent, c’est à dire qu’elle possède 
des entrées filles, tels plusieurs sons appartenant à un Multi- 
SoundDiver vous demande via un dialogue si elles doivent être 
envoyées aussi. Si vous sélectionnez “All” (tout), l’entrée 
parent et les entrées filles sont transmises.
& Pour mémoriser de manière permanente les entrées sélectionnées dans l’appareil, 

copiez-les simplement dans la fenêtre Device en les déplaçant jusqu’à l’emplacement 
cible d’une fenêtre Device ou bien sélectionnez Edit > Transmit.
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Appareils avec tampons d’édition individuels
Certains appareils, comme ceux disposant d’un mode multi 
fabriqués par Roland (D-70, JV80/90/100, JV-1080, U-20/220, 
XP50/80) ainsi que le Waldorf Microwave, proposent des 
tampons d’édition séparés pour les entrées filles utilisées par 
une entrée parent. SoundDiver peut utiliser avantageusement 
cela : Lorsque vous auditionnez une entrée parent (ex : Perfor-
mance ou Multi) et que certaines entrées filles liées (ex : 
Patches ou Sons) n’existent pas encore dans l’appareil, elles ne 
sont pas transférées vers un emplacement mémoire, comme 
c’est habituellement le cas lors d’une transmission, mais vers le 
tampon d’édition représentant la “Partie” correspondante. 
L’appareil utilise alors les données trouvées dans la partie, 
même si le lien de l’entrée parent pointe vers une entrée fille 
totalement différente dans la mémoire de l’appareil. Ainsi vous 
pouvez facilement écouter une entrée parent se trouvant dans 
une bibliothèque, sans avoir besoin de remplacer les emplace-
ments mémoire de l’appareil.
Voir aussi le § Appareils possédant des tampons d’édition individuels 
à la page 217 et le § Plusieurs tampons d’édition à la page 312.

Edit
Library > Edit ouvre la fenêtre d’édition de l’entrée.
Si une fenêtre Device était déjà ouverte à l’arrière plan, elle 
sera affichée au premier plan. Si la fenêtre était déjà au premier 
plan, une autre est ouverte.
& La fenêtre d’Edition peut être ouverte en double cliquant une entrée ou en pressant 

R.

Store Sequence (Mémoriser la séquence)
La séquence test enregistrée dans le mini-séquenceur de 
SoundDiver est assignée aux entrées sélectionnées, permettant 
à chaque entrée d’avoir sa propre séquence d’audition, tel 
qu’un accord pour des sons de cordes et une mélodie pour des 
sons solo. Pour jouer cette séquence, activez les fonctions Auto-
Play et AutoAudition.
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Les entrées contenant une séquence ont un astérisque (*) dans 
la colonne Séquence.

Cette opération n’est pas disponible si vous utilisez SoundDi-
ver avec l’AutoLink puisque cela désactive automatiquement 
le séquenceur interne.

& Cette opération réécrit une séquence existante ayant déjà été assignée à une entrée 
sans avertissement.

Delete Sequence (Effacer une séquence)
La séquence archivée est effacée pour toutes les entrées sélec-
tionnées. Tous les astérisques (*) sont effacés.

Insert Title (Insérer Titre)

Cette fonction vous permet d’insérer un titre à n’importe quel 
endroit de la bibliothèque. Sélectionnez l’entrée au-dessus de 
laquelle le texte doit être inséré et sélectionnez Library>Insert 
Title. Cela ouvre un champ de saisie de texte. Si vous avez 
besoin de plusieurs lignes de texte, vous pouvez sélectionner 
cette option de menu autant de fois que vous le désirez. Le 
texte peut être édité par la suite, en cliquant d’abord dessus 
dans la fenêtre Bibliothèque, puis en cliquant sur la ligne de 
texte dans la case des paramètres, ou simplement en double-
cliquant sur le titre.

Important : Ces titres séparent une bibliothèque en zones-ex : 
“Sons de Scène”, “Sons Studio”, “Sons SY99” et ainsi de suite.

Pour vous débarrasser d’un titre, sélectionnez-le et choisissez 
Edit > Delete.
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& Vous pouvez sélectionner toutes les entrées titres dans une bibliothèque à l’aide de 
la fonction Find. Activez “More Options”, et utilisez “The Data Type” “is” “Title” et 
“Select All”. Si vous avez besoin de savoir comment opère la fonction Find, veuillez 
vous référer au § La fonction Find (Recherche) à la page 266.

Les zones sont reconnues par les opérations de classement, de 
sorte que les relations entre le titre et les entrées demeurent 
inchangées. SoundDiver classera toujours les entrées indivi-
duellement par zone.

Insert File (Insérer Fichier)
Vous pouvez insérer une bibliothèque ou un fichier importé 
d’une disquette ou du disque dur dans une bibliothèque 
SoundDiver. Cela vous permettra de faire une grosse bibliothè-
que à partir de plusieurs petites. Insert File... est identique à 
Import...dans le menu Fichier, sauf que cela ne crée pas de 
nouveau document Bibliothèque.
Sélectionnez l’entrée avant laquelle la bibliothèque doit être 
insérée et sélectionnez Insert File... Sélectionnez ensuite la 
bibliothèque désirée dans la case de sélection qui apparaît. Si 
cette bibliothèque est “étrangère” (Polyframe, X-alyzer, 
Synthworks ;etc) elle est automatiquement convertie. Vous 
trouverez plus d’informations au § Importer des Bibliothèques 
Polyframe à la page 273.
& Cette opération insère automatiquement un sous titre avant la nouvelle biblio-

thèque, indiquant le nom du fichier. Vous serez libre de supprimer ce titre par la suite.

& Il est possible d’utiliser une fonction Find pour chercher des entrées titres, en sélec-
tionnant “more options”, et les critères “data type”, “is”, “Title”. Les fonctions de 
recherche sont expliquées au § La fonction Find (Recherche) à partir de la page 266 
et suivantes.

7.12 Demander des entrées de 
Bibliothèque

Si vous sélectionnez Edit > Request, les contenus des mémoires 
internes de tous les appareils sélectionnés dans la fenêtre de 
Configuration feront l’objet d’une requête et seront insérés 
dans la bibliothèque. (Voir le § Request (Demander le transfert) à 
partir de la page 153 et suivantes)
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7.13 Transmettre des entrées de 
Bibliothèque

Si vous sélectionnez d’abord les entrées souhaitées, puis Edit > 
Transmit, les données seront envoyées vers les appareils dont 
les ID sont compatibles avec celles des entrées envoyées. Donc 
si vous désirez envoyer huit voix d’un DX7 vers les huit modu-
les d’un TX816, vous pouvez utiliser les ID des appareils pour 
déterminer quelle voix va vers quel expandeur.

Pour des détails concernant la conversion de données entre des 
appareils proches (comme le DX7 et le SY77), veuillez consul-
ter le § Stratégie de sélection d’appareils lors d’envois depuis une 
Bibliothèque à partir de la page 212 et suivantes.

Emplacement de destination par défaut
Lorsque vous transmettez une entrée de bibliothèque vers un 
appareil avec l’option de menu Transmit, SoundDiver utilise le 
réglage d’Emplacement (Location) comme valeur de destina-
tion par défaut. Lorsque le message d’alerte “Overwriting 
memory entries” est activé (voir le § Overwriting Memory Entries 
(Remplacer des Entrées Mémoire) à la page 405), un dialogue appa-
raît, vous permettant de modifier cette destination par défaut. 
En général, vous devez juste confirmer en pressant R.

S’il n’y a pas de mention d’emplacement dans la bibliothèque, 
SoundDiver vous suggère l’emplacement qui vous convient le 
mieux :

• Si une entrée équivalente existe déjà dans la fenêtre Device 
(identiques en ce qui concerne les données, les noms ne sont 
pas comparés), cette entrée est utilisée comme cible. Dans 
ce cas, aucun message de sécurité n’apparaît. Autrement 
l’entrée suivante vous est suggérée selon les propriétés sui-
vantes, énoncées par ordre descendant de priorité :

• Inconnue et non utilisée par d’autres entrées (pas une entrée 
fille)

• Connue et non utilisée par d’autres entrées (pas une entrée 
fille)
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• Inconnue
• Connue

Cela signifie que vous pouvez transmettre une bibliothèque 
entière sans avoir besoin d’ajuster manuellement les positions 
de destination, même si la bibliothèque contient des dépen-
dances, mais aucune mention d’emplacement.

Vous pouvez aussi facilement remplir des banques avec des 
sons sans remplacer les emplacements déjà utilisés. Sélection-
nez simplement les entrées désirées dans la bibliothèque et 
sélectionnez Edit>Transmit. SoundDiver les écrit alors automa-
tiquement dans des emplacements qui ne sont pas déjà utilisés 
par d’autres entrées.

7.14 La fonction Find (Recherche)
Une des fonctions les plus puissantes de SoundDiver est la 
fonction Find ; elle vous permet de mener une recherche ciblée 
sur une entrée dans une zone d’une bibliothèque, une biblio-
thèque entière, ou tout votre système MIDI. Cette fonction est 
d’une grande utilité dans le studio, où vous aurez souvent 
besoin de trouver un son spécifique ou un éventail de sons 
convenables dans une large collection. Voici quelques exem-
ples pratiques :

• Rechercher tous les sons d’instrument à cordes au sein d’une 
quantité d’entrées sélectionnées.

• Rechercher un son appelé “SuperBass” parmi toutes les 
bibliothèques ouvertes.

• Rechercher tous les sons ayant été créés avant le 07.07.2001.

• Rechercher tous les sons d’un EX5 dans une bibliothèque.

Une recherche n’a de sens uniquement s’il y a une bibliothè-
que présente -puisque les options de menu Edit>Find... et 
Edit>Find again sont uniquement disponibles lorsqu’une librai-
rie est chargée.
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SoundDiver peut mener des recherches simples portant sur les 
noms ou les syllabes, mais peut aussi utiliser des critères plus 
complexes.

La fenêtre Find est différente selon la version, Macintosh ou 
Windows. Vous trouverez donc des photos des deux versions 
dans la section suivante.

Ouverture de la fenêtre Find
Sélectionnez Edit > Find….

Macintosh

Windows

Important : La fenêtre Find est une vraie fenêtre, pas un 
dialogue. L’avantage est qu’elle reste ouverte durant les opéra-
tions de recherche, afin de vous permettre d’améliorer ou de 
modifier le critère de recherche. Vous pouvez même position-
ner les fenêtres Bibliothèque et Find à l’écran de manière à les 
voir toutes les deux en même temps. Les positions des fenêtres 
et les critères de recherche sont mémorisés lorsque vous quit-
tez SoundDiver.
267
Mode d’Emploi
Version 3.0



 – La Bibliothèque

X

X

Une opération de recherche simple
Lorsque vous ouvrez pour la première fois une fenêtre Find, 
tout ce qu’elle contient est un champ de texte et les boutons 
More options et Find. Dans ce mode vous pouvez trouver les 
entrées par nom ou partie du nom. Le casse des caractères n’est 
pas prise en compte.
Si vous recherchez une suite de caractères au début d’un nom 
dans une bibliothèque, vous n’avez même pas besoin d’ouvrir 
la fenêtre Find : La fenêtre Bibliothèque vous offre une 
méthode rapide semblable à celle que vous avez déjà rencon-
trée dans la fenêtre Device, comme suit :
❏ Activez d’abord les majuscules en pressant la touche Y (au

dessus de la touche S de gauche).
❏ Tapez simplement les premières lettres du nom de l’entrée

désirée. SoundDiver trouve immédiatement la première
entrée dont le nom commence par les lettres que vous avez
tapées.

❏ Utiliser T vous permet de passer à l’entrée suivante dans
l’ordre alphabétique ; utiliser TS passe à la précédente.

Lancer l’opération de recherche
Entrez le texte désiré et cliquez sur Find.
La recherche de noms qui contiennent ces caractères débute 
alors dans la bibliothèque active, débutant à partir de l’entrée 
sélectionnée.
La première entrée trouvée est sélectionnée. Si l’AutoAudition 
et /ou l’AutoPlay sont activés, l’entrée est immédiatement 
transmise, et/ou jouée.
Si aucun nom n’est trouvé, un dialogue apparaît.

Répéter la recherche
Après la première recherche, le bouton Find devient Find 
again. Cliquer dessus continue l’opération pour le nom suivant. 
Vous pouvez aussi sélectionner Edit > Find again.
& Que vous utilisiez les raccourcis clavier ou les commandes de menu, vous pouvez 

fermer la fenêtre Find pour gagner de la place à l’écran.
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Plus d’options
Si vous avez besoin de critères de recherches plus sophistiqués, 
cliquez sur le bouton More options dans la fenêtre Find. La fenê-
tre grandit pour afficher un nombre de menus basculants qui 
sont utilisés pour définir des critères de recherche plus comple-
xes.

 :

Windows:

Quoi
Ce menu vous permet de définir le principal paramètre qui sera 
utilisé comme critère de recherche. Vous pouvez définir le nom 
de l’entrée, son modèle, type de donnée, commentaire, empla-
cement, et “data” (voir la section suivante).

Quoi Comment Valeur à rechercher

Sélection des entrées trouvées

Quoi Comment Valeur à rechercher

Sélection des entrées trouvées
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Problèmes particuliers avec le critère “Data”
Cette option n’apparaît nulle part ailleurs que dans la fenêtre 
Find : Elle indique à SoundDiver de comparer les données 
SysEx de l’entrée. Cela vous permet de trouver des sons 
sonnant de manière similaire si une recherche par nom n’a rien 
donné d’utile.
& Cette fonction ne peut garantir que les sons qu’elle trouve seront similaires. Si vous 

modifiez la forme d’onde de base d’un son de synthé, il sonnera totalement différem-
ment, bien que les paramètres SysEx correspondants puissent rester presque 
inchangés.

Il est recommandé d’utiliser “Data” pour des situations où vous 
avez créé plusieurs variations (enveloppes, filtre) d’un même 
son et que vous vouliez effacer ces variations.

Attention : n’utilisez jamais “Data” avec “Keep first, delete 
rest” car cela pourrait supprimer des entrées que vous vouliez 
conserver.

Comment
Ce menu local contient la condition que le critère de recherche 
“Quoi” doit remplir pour que l’entrée soit trouvée. Le contenu 
du menu fait référence au critère sélectionné par “Quoi”.

Tableau 5 Conditions “Comment”

Condition Description
contains contient le texte saisi

does not contain ne contient pas le texte saisi

begins with commence par le texte saisi

ends with (not date, size, 
contents)

finit par le texte saisi

is correspond exactement au texte saisi

is not ne correspond pas au texte saisi

is before (date only) a été créé avant la date saisie

is after (date only) a été créé après la date saisie

is less than (size only) a une taille inférieure à la valeur saisie

is greater than (size only) a une taille supérieure à la valeur saisie
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xemples 
ass, BasicPad

X Rhodes, DX 
ass, DX7Pno

ongas

électionnées

s sélectionnées
Critères de comparaison
Les quatre critères suivants ne recherchent pas d’exemple 
précis, mais chacun compare deux entrées prises comme une 
paire. Cela vous permet de trouver, par exemple, tous les sons 
qui ont des noms similaires.

La valeur de recherche
Selon le contenu des deux premiers champs, un champ de texte 
apparaît (pour les noms ou les commentaires), ou un champ 
numérique (pour saisir les dates ou les tailles).

Sélection des entrées trouvées
Ce menu local supplémentaire vous permet de définir ce que 
SoundDiver fait avec les entrées qu’il trouve :

Tableau 6 Exemples

Quoi Comment Valeur Recherche E
The name contains bas toutes les entrées dont le 

nom contient la syllabe “bas“ 
B

The name begins with DX toutes les entrées dont le 
nom commence par DX

D
B

The name is Congas toutes les entrées dont le nom 
est exactement “Congas”

C

The model is not 01/W toutes les entrées qui ne 
viennent pas d’un 01/W

The size is greater than 345 toutes les entrées dont la 
taille est supérieure à 345 
octets

Tableau 7 Critère de comparaison

Condition Description
is equal to selection sélectionne une entrée égale à une des entrées s

is similar to selection sélectionne une entrée similaire à une des entrée

is equal in pairs sélectionne deux entrées identiques

is similar in pairs sélectionne deux entrées similaires
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Select One
Désélectionne toutes les entrées précédentes, sélectionne la 
première entrée trouvée et déplace la section correspondante 
de la fenêtre pour la rendre visible. Si l’AutoAudition est activé, 
l’entrée est aussi envoyée à l’appareil.

Si aucune fenêtre n’est ouverte pour la bibliothèque en cours, il 
s’en ouvrira automatiquement une. Find again est utile unique-
ment si vous ne modifiez pas les conditions de recherche.

Select All
Sélectionne toutes les entrées trouvées et désélectionne toutes 
les entrées précédentes.

Add to Selection
Les entrées trouvées sont sélectionnées en plus des entrées 
déjà sélectionnées (“OU logique”)

Select in Selection
La recherche est menée uniquement dans la sélection. Seules 
les entrées trouvées demeurent sélectionnées ; toutes les autres 
sont dé-sélectionnées (“ET logique”)

Keep First, Delete Rest
Cette option existe seulement en conjonction avec les critères 
de comparaison (voir le § Critères de comparaison à la page 271). 
Si une entrée est identique, ou similaire à une ou plusieurs 
autres entrées, la première trouvée est conservée et les suivan-
tes sont affichées comme étant prêtes à être supprimées (en 
gris).

La suppression effective a lieu après la fin de l’opération de 
recherche, et uniquement après avoir répondu au message 
d’alerte.

& Cette fonction est particulièrement utile lorsqu’elle est combinée à “Search in all 
documents” et “The Data” “is equal in pairs”. Le résultat correspond alors à la 
suppression des doublons qui pourraient s’étendre sur plusieurs bibliothèque.
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Search in All Documents (Recherche dans 
tous les documents)
Activer cette option conduit la recherche parmi toutes les 
bibliothèques ouvertes. Lorsqu’elle est utilisée avec les critères 
de comparaison (voir le § Critères de comparaison à la page 271) 
chaque entrée dans chaque bibliothèque est comparée avec 
chaque entrée dans chacune des autres bibliothèques ouvertes.

Less Options (Moins d’options)
Cliquez ce bouton si vous désirez simplement rechercher par 
nom et n’avez pas besoin des autres options.

Find (Rechercher)
Cliquez ce bouton pour lancer la recherche. Après avoir trouvé la 
première entrée, l’intitulé du bouton devient Find again. Cliquez 
dessus ou pressez R pour débuter la recherche suivante.
& L’option de menu Edit > Find again …permet une nouvelle recherche même si la 

fenêtre Find est fermée.

7.15 Importer depuis d’autres 
programmes

SoundDiver est capable de charger des fichiers d’autres 
programmes et de les convertir en bibliothèques SoundDiver. 
Cette fonction d’importation offre une quantité d’options qui 
facilitent l’importation de fichiers.

Sélectionner File > Import… ouvre une fenêtre de sélection. 
Confirmez votre sélection et SoundDiver essaiera de la charger.

Importer des Bibliothèques Polyframe
Lorsque vous importez des bibliothèques Polyframe, toutes les 
données sont converties au format SoundDiver. La seule chose 
qui manque est l’information de lien car celle-ci n’est pas 
disponible dans la bibliothèque Polyframe. Vous pouvez géné-
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rer des liens en copiant les entrées désirées dans une fenêtre 
Device et en les copiant depuis celle-ci dans une nouvelle 
bibliothèque (Voir l’option de menu New).

Pour que SoundDiver sous Windows reconnaisse les bibliothè-
ques Polyframe, remplacer l’extension du nom de fichier PL par 
LIB.

 : Pour que SoundDiver reconnaisse les bibliothèques Poly-
frame, donnez-leur le même type de fichier que les bibliothè-
ques SoundDiver. Vous pouvez faire cela en ajoutant le suffixe 
PL au fichier EM9F dans le Tableau de Bord “Échange de 
Fichiers” qui fait partie du Mac OS, vous pouvez toutefois utili-
ser un autre produit similaire.

Ouvrez le tableau de bord “Échange de fichiers”, cliquez sur le 
bouton “Ajouter”, sélectionnez le fichier d’application Sound-
Diver, entrez PL dans le champ de texte en haut et sélectionnez 
l’icône de bibliothèque SoundDiver en bas. Vous pouvez main-
tenant insérer une disquette Atari contenant une bibliothèque 
Polyframe, et elle peut être immédiatement chargée par 
SoundDiver.

Importer des Fichiers MIDI Standard (SMF)
Les fichiers MIDI standard (SMF) peuvent être inscrits par la 
plupart des programmes MIDI. SoundDiver peut importer des 
SMF, qui contiennent des Dumps SysEx, et soit les envoyer 
aux appareils concernés, soit les convertir en une bibliothèque.

Conditions pour le fichier
SoundDiver est capable de lire tous les formats de fichiers 
MIDI (0,1,2) et donc est compatible avec n’importe quel 
séquenceur, éditeur, ou autre logiciel MIDI pouvant créer des 
fichiers MIDI. Toutes les séquences d’un fichier MIDI sont 
examinées.

Les fichiers MIDI standard (SMF) utilisent l’extension .MID.

 : Normalement, vous trouverez aussi cette extension sur 
Macintosh, bien que les Adaptations de nom de fichiers ne 
soient pas communément rencontrées. Le fichier doit être de 
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type “Midi”, ou bien de type “????”, “BINA”, “MDOS”, “mdos”, 
“pBIN” ou “TEXT”, et le fichier doit avoir l’extension .MID. Le 
“Creator” est inopérant.(“MDOS” et “mdos” sont les types de 
fichiers utilisés par défaut par PC Exchange). Voir aussi le § 
Convertir des fichiers entre les trois plate-formes à la page 76.
Vous pouvez importer des fichiers SMF soit en sélectionnant 
File > Open… ou File > Import… ou en sélectionnant Load & 
Transmit File dans la fenêtre Device ou de Configuration. 

 : Vous pouvez déplacer l’icône de fichier SMF sur l’icône de 
SoundDiver. 

Fonctionnement de la fonction Import
Les fichiers SMF importés simulent des messages MIDI reçus, 
de sorte que les données chargées arrivent dans la fenêtre 
Device concernée. Il est donc impératif qu’un appareil soit 
présent dans la configuration de SoundDiver pour lequel le 
module d’accompagnement ou l’Adaptation puisse traiter des 
dumps au format SMF (Fichier MIDI Standard).
Le Device ID est toutefois inopérant, il n’est pas pris en 
compte lors de l’importation de fichiers. C’est très utile lorsque 
vous avez un fichier dont vous ne connaissez pas le Device ID 
qui a été utilisé lors de la création de ce fichier.

& Si vous avez plusieurs appareils dans votre configuration qui peuvent traiter des 
messages dans le fichier, vous devez d’abord sélectionner l’appareil de destination 
désiré. SoundDiver essaie toujours d’assigner les données MIDI reçues d’abord à 
l’appareil actif puis à tous les autres. Comme les fichiers importés SMF/SYX sont 
traités en interne comme du MIDI reçu, cette technique fonctionne aussi pour cela.

Les fichiers MIDI standard qui contiennent des données 
provenant de plusieurs appareils différents peuvent être impor-
tés par SoundDiver en une seule opération.

Lorsque des données ont été trouvées pour un appareil en 
particulier durant l’importation, la fenêtre Device de l’appareil 
est ouverte de manière à ce que vous puissiez contrôler immé-
diatement les données importées.

Après qu’un SMF ait été importé, vous aurez soit un message 
vous informant qu’aucune donnée n’a été trouvée, ou alors le 
message suivant :
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Abort (Abandonner)
Les entrées importées demeurent dans la fenêtre Device
mais rien d’autre ne se produit. 
Attention : cela provoquera certainement des disparités
dans les données de vos appareils MIDI

Library (Bibliothèque)
Les entrées importées sont placées dans une nouvelle
Bibliothèque. Vous pouvez alors les sauvegarder.

Transmit (Transmettre)
Les entrées importées sont envoyées aux appareils.

& Après avoir déplacé des entrées importées dans une bibliothèque, les anciennes 
entrées réapparaissent dans la fenêtre Device. Vous n’avez pas besoin de faire une 
nouvelle requête du contenu de la fenêtre Device après une telle opération d’Import. 
Cependant si vous avez sélectionné “Abort” ou “Transmit”, vous pouvez annuler 
l’importation : l’option de menu Edit>Undo est alors renommé Undo Import .

Importer des fichiers avec plusieurs Dumps pour les 
mêmes entrées
Si un fichier SMF contient plusieurs dumps pour les mêmes 
banques ou les mêmes entrées, le dialogue suivant apparaît :

Abort (Abandonner)
Les entrées déjà importées demeurent dans la fenêtre
Device, le reste des fichiers importés est ignoré.
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Skip (Passer)
Toutes les entrées reconnues comme des doubles sont pas-
sées. Le fichier restant est importé, hormis les duplicata.

New version (Nouvelle version)
Toutes les entrées reconnues comme des duplicata sont
chargées et seront inscrites par dessus les entrées précé-
demment chargées.

Library (Bibliothèque)
Toutes les entrées précédemment importées, ainsi que les
entrées restant à importer sont déplacées dans une nouvel-
le bibliothèque, ou y sont ajoutées. Ensuite, vous pouvez
sauvegarder la bibliothèque. Le message “Voulez-vous
transmettre les entrées chargées ou les déplacer dans une
bibliothèque ?” est omis.

La dernière option vous permet d’importer d’énormes quanti-
tés de données provenant de différents programmes, s’ils 
peuvent enregistrer leurs données au format SMF. Opcode 
Galaxy™ utilise la fonction “capture de fichier MIDI” pour 
faire cela :

❏ Sélectionnez l’option de menu “Start MIDI File Capture”
dans le menu Play.

❏ Ouvrez la bibliothèque, le groupe ou la banque de fichiers
et transmettez leur contenu.

❏ Sélectionnez l’option de menu “Save MIDI File…” dans
le menu Play.

❏ Quittez Galaxy TM
❏ Démarrez SoundDiver et sélectionnez les appareils désirés

dans la fenêtre de Configuration.
❏ Importer le fichier MIDI Standard dans SoundDiver. Lors-

que le dialogue ci-dessus apparaît, sélectionnez “Library”.

Importer depuis un fichier Song
Vous pouvez même extraire des sons du morceau (song) d’un 
séquenceur sauvegardé comme un Fichier MIDI Standard. Par 
exemple : Vous travaillez sur une production créée par 
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quelqu’un d’autre. Le créateur du fichier vous a envoyé le 
morceau sous forme d’une disquette MIDI File. Le morceau 
contient aussi les sons des instruments utilisés. Vous pouvez 
vous servir de la fonction Import pour charger le fichier song 
dans SoundDiver et envoyer directement les sons aux claviers 
concernés. Les données restantes sont ignorées.

Dumps non reconnus
Si le fichier qui doit être importé contient des dumps SysEx qui 
ne peuvent être traités par aucun des appareils installés dans la 
configuation, vous obtiendrez le message suivant : 

Abort (Abandonner)
Annule l’importation du fichier.

Install (Installer)
Ouvre la fenêtre d’Installation. Vous pouvez maintenant
installer l’appareil approprié. Réessayez ensuite d’importer
le fichier.

Generic SysEx
Installe l’Adaptation “Generic SysEx” et recommence
l’importation du fichier. Cette Adaptation peut traiter tout
type de message SysEx.

& Certains appareils proposent un “Bulk-Dump” ou “All Dump” qui est en fait le 
contenu de plusieurs banques de différents types de données dans un seul message 
SysEx. Ce type de message n’est souvent pas reconnu par les modules SoundDiver. 
Si vous importez un fichier contenant un tel message, vous obtiendrez le message ci-
dessus, bien que l’appareil approprié soit déjà installé dans votre Configuration. Dans 
ce cas, vous devez d’abord importer le fichier avec “Generic SysEx”, transmettre les 
données depuis là vers l’appareil, puis demander les banques avec le module ou 
l’Adaptation prévue directement depuis cet appareil. Utiliser ce détour, le “bulk-
dump” est converti en un simple message ou un message de “bank dump” qui 
pourra être traité par le module ou l’adaptation.
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Importer des fichiers SYX
Les fichiers SYX (ou fichiers MidiEx ou SysEx) contiennent les 
données brutes, non encodées. SoundDiver peut importer ces 
fichiers et soit les envoyer aux appareils concernés, soit les 
convertir en une bibliothèque.

Conditions pour le fichier
Les fichiers SYX utilisent les extensions .SYX, .MQX, .DMP.

 : Les fichiers SYX ont généralement le type de fichier 
“BULK”. Les fichiers de ce type peuvent être ouverts directe-
ment avec File>Open... Si un fichier SYX est de type 
“????”,”BINA”, “mdos”, “pBIN”, ou “TEXT” et que le nom du 
fichier comporte une des extensions ci-dessus, ils sont détectés 
par SoundDiver, toutefois vous devrez les charger en utilisant 
File > Import ….

Fonctionnement de la fonction Import
Les fichiers importés SYX simulent des messages MIDI reçus 
(comme les fichiers SMF). Souvenez-vous des conditions 
spéciales qui s’appliquent ; voir le § Importer des Fichiers MIDI 
Standard (SMF) à la page 274.

& Si vous désirez importer un fichier mais que vous ne connaissez pas son format, ce 
sera certainement un fichier SYX. Modifiez l’extension du nom de fichier en .SYX 
puis essayez d’importer le fichier.

&  : Les fichiers SYX peuvent aussi être importés simplement en déplaçant l’icône du 
fichier sur l’icône de programme SoundDiver.

Fonction Import pour les modules spécifi-
ques
Certains modules SoundDiver permettent d’importer certains 
formats de fichier. Vous pouvez convertir ces fichiers grâce à 
l’option de menu File >Import… en une bibliothèque Sound-
Diver.
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Reconnaissance du format
Comme certains modules contiennent des fonctions d’importa-
tion spéciales qui peuvent identifier le format du fichier sélec-
tionné, il peut arriver que SoundDiver charge plusieurs modu-
les à la suite jusqu’à ce que le format soit reconnu. Cette 
opération est automatique et prend peu de temps.

Dès que SoundDiver reconnaît le format des données, il crée 
une nouvelle bibliothèque dont le titre est emprunté au nom 
de fichier, et charge les données converties. Le nombre 
d’entrées qu’elle contient dépend, bien entendu, du nombre 
d’entrées dans le fichier d’origine.

Format des données pour l’importation
Pour trouver quel format chaque module est capable de recon-
naître, utilisez l’aide en ligne.

Sélectionnez l’ appareil désiré dans la fenêtre de Configuration 
et sélectionne Windows > Help. L’aide en ligne de cet appareil 
s’affiche alors. Cliquez sur Index et sélectionnez Import dans la 
liste qui apparaît.

Vous pouvez aussi trouver ces informations dans le fichier 
“SoundDiver 3.0 Model List.pdf”.

Informations supplémentaires
• Si un fichier ne peut être importé, un dialogue s’ouvrira, vous 

permettant d’ignorer ce fichier ou d’annuler toute l’opéra-
tion.

• Pendant l’importation, SoundDiver supprimera automati-
quement toutes les entrées dupliquées qu’il trouvera.

• SoundDiver vous permet d’agir sur l’ordre dans lequel les 
modules sont sélectionnés : Choisissez simplement l’appa-
reil de la fenêtre de Configuration qui est le plus à même 
d’être compatible avec le fichier à importer.
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7.16 Exportation de fichiers
SoundDiver offre plusieurs options pour exporter des fichiers. 
C’est utile si vous travaillez avec des programmes d’autres 
fabricants qui ne proposent pas de moyens souples d’échange 
de données, ou si vous voulez donner des sons à vos amis qui 
n’ont pas SoundDiver.

& Vous ne devez utiliser les fonctions d’exportation que s’il n’y a pas d’autre moyen. Il 
existe des restrictions en comparaison de l’utilisation des bibliothèques SoundDiver 
(voir ci-dessous)

Exportation de Fichiers MIDI Standard (SMF)
Pour les diverses opérations d’exportation, voir

• le § Export MIDI File… (Exporter fichier MIDI) à la page 143
• le § Capture as MIDI-File… à la page 144
• le § Export … à la page 210
• le § Export… à la page 231

SoundDiver écrit un Fichier MIDI Standard au format 0 (qui 
ne contient qu’une seule piste). Le fichier ne contient pas 
d’informations de tempo, ce qui implique un tempo par défaut 
de 120 bpm, et une résolution de 96 ppq. C’est le format le plus 
communément utilisé et il devrait être compatible avec tous les 
programmes qui peuvent lire les SMF.

La durée de transmission de tous les messages MIDI est prise 
en compte, ce qui provoque une modification des positions de 
l’horloge. L’écart d’horloge entre deux évènements est toujours 
au moins d’un Tic, même s’il devrait être 0 en raison de la basse 
résolution. Cela évite que l’ordre des évènements MIDI ne soit 
modifié par des séquenceurs qui ont une sorte d’optimisation 
“intelligente” des priorités.

Les délais nécessaires pour la transmission correcte des dumps 
sont enregistrés aussi (convertis en méta-évènements qui 
correspondent au délai à 120bpm).

 : Les fichiers sont enregistrés sous le type “Midi”.
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& Lorsque vous chargez un fichier MIDI créé par SoundDiver et fixez un tempo supé-
rieur à 120bpm, cela peut provoquer des problèmes lors de l’envoi de données, 
puisque les délais nécessaires pour un transfert correct sont raccourcis.

& Lorsque SoundDiver crée un fichier MIDI qui contient les dumps pour plusieurs appa-
reils, qui sont connectés à différentes sorties MIDI de l’ordinateur ; tous les dumps 
sont contenus dans la même piste. Pour permettre à un séquenceur d’envoyer les 
fichiers chargés correctement, vous devrez “démixer” les évènements chargés pour 
séparer les pistes de manière à ce qu’ils puissent être envoyés vers les sorties 
correctes.

Exportation de fichiers SYX
Pour plus de détails voir

• le § Export … à la page 210
• le § Export… à la page 231

De tels fichiers contiennent des données MIDI sans aucun 
formatage. Il n’y a aucune information de temps, aussi cela peut 
créer des problèmes si le fichier est transmis avec un utilitaire 
générique tel que “MidiEx”. Si des délais sont nécessaires pour 
une transmission correcte, vous obtiendrez un message d’alerte 
lorsque vous essayerez d’exporter un fichier au format SYX.
 : Le fichier est enregistré sous le type “BULK”. Ce type de 
fichier est reconnus pars les outils Freeware tels que “Bulk 
SysEx Utility” ou “MIDI Pack’en”.
Si SoundDiver a besoin d’une communication certifiée afin 
d’envoyer certaines entrées, vous obtiendrez un message 
d’erreur. La raison est que l’appareil ne répond pas par le 
message de reconnaissance (“Acknowledge”) requis (puisque 
SoundDiver est redirigé vers le fichier Export) et le module 
SoundDiver pense conséquemment que les données ne sont 
pas arrivées à l’appareil.
Dans ce cas vous devriez vérifier si vous pouvez envoyer les 
données sans communication certifiée (soit dans la case des 
paramètres spéciaux ou dans la case de dialogue).
Autrement, utilisez la fonction Capture MIDI File… (voir le § 
Capture as MIDI-File… à la page 144).
Finalement vous devez saisir le dossier et le nom du fichier qui 
doit être exporté.
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 : Il est conseillé (mais pas impératif) pour corriger une exten-
sion .mid ou .syx pour être capable de reconnaître le format à 
partir du nom de fichier.

Sous Windows il est nécessaire d’utiliser les noms exacts des 
fichiers, sinon le fichier ne peut pas être lu par d’autre program-
mes.

Limitations à l’exportation de fichiers
Les données qui doivent être exportées sont d’abord stockées 
dans une mémoire temporaire de l’ordinateur, et non réelle-
ment envoyés comme des messages MIDI.

Limitation connue : il doit y avoir assez de mémoire. Si vous 
recevez un message “Out of Memory”, vous devez sauvegarder 
plusieurs petits fichiers au lieu d’un seul gros fichier.

 : Vous pouvez aussi allouer plus de mémoire à SoundDiver.

Questions-réponses sur l’exportation de 
fichiers
? Lorsque je sauvegarde un seul Multi A-01 d’un Microwave 
comme un fichier MIDI Standard, et que j’essaye de réimpor-
ter ce fichier, le Multi apparaît dans le tampon d’édition mais 
pas à l’emplacement mémoire A-01. Pourquoi ?

! Car le Microwave ne fournit pas de message SysEx pour 
transmettre un Multi ou un son directement vers un emplace-
ment de mémoire précis. SoundDiver transmet d’abord le 
Multi ou le son au tampon d’édition puis une commande “stoc-
ker le tampon d’édition à l’emplacement de mémoire xxx”. En 
important cette séquence de commandes SysEx, le module 
MW ignore cette commande “stocker” (puisque le Microwave 
n’envoie jamais cette commande)

Cependant, si vous envoyez le fichier MIDI directement au 
MicroWave, l’effet escompté est obtenu. Ce problème se 
produit avec tous les appareils qui ne reconnaissent pas les 
messages de dump directs ou si vous ne sauvegardez pas une 
banque entière.
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Si vous devez importer un fichier MIDI dans SoundDiver, pour 
quelque raison que ce soit, ce devrait toujours être des banques 
entières.

? Lorsque je sauvegarde une entrée parent dans un fichier 
MIDI ou dans en fichier SYX avec Export>Selected Entries, les 
entrées filles dépendantes ne sont pas sauvegardées si je ne les 
sélectionne pas de manière explicite. Pourquoi ?

! Car la fonction Transmit n’a pas cet effet. En raison du 
concept “WYSIWYH” de SoundDiver, la fonction manuelle 
Transmit n’est utilisée que dans les cas exceptionnels. Ainsi 
vous devez ajouter manuellement les données désirées au 
fichier. Une alternative est d’activer File>Capture MIDI File... et 
de transmettre l’entrée parent à partir d’une bibliothèque vers 
une fenêtre Device vide. Il est important que la fenêtre Device 
soit vide, car sinon les dumps pourront être manquants si 
SoundDiver a déjà passé les entrées filles existantes dans un 
souci d’optimisation.

7.17 Conversion des sons 
d’appareils relatifs

Certains modules de SoundDiver sont capables de convertir 
des sons provenant de différents synthétiseurs. Dans la plupart 
des cas ce sont des appareils relatifs ou plus anciens. Par exem-
ple le module JV-80 peut charger les sons d’un Roland D-70 et 
les convertir en sons JV-80. Le module SY77 fera de même avec 
les sons d’un DX7.

L’aide en ligne vous indiquera quelles conversions sont dispo-
nibles pour vos appareils, et vous donnera plus d’informations 
sur le processus de conversion, comme suit :

Sélectionnez l’appareil voulu dans la fenêtre de Configuration 
et sélectionnez Windows > Help. Cette aide en ligne d’appareil 
apparaîtra alors. Cliquez sur Index et choisissez Conversion dans 
la liste. C’est ici que vous pourrez tout apprendre sur ce que la 
conversion peut faire pour cet appareil précis.
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7.18 Sauvegarder une banque 
comme Bibliothèque

Vous pouvez gérer les sons de vos appareils dans les bibliothè-
ques sans perdre leurs emplacements de mémoire.

❏ Sélectionnez les appareils voulus dans la fenêtre de Confi-
guration. Vous pouvez aussi sélectionner plusieurs appa-
reils si vous voulez sauvegarder leurs contenus dans une
seule bibliothèque.

❏ Sélectionnez New > Build Library dans le menu local de la
fenêtre de Configuration et une des sous-options. Sound-
Diver les copie alors dans une nouvelle bibliothèque. Si
besoin est, les entrées sont automatiquement requises dans
ce but. Voir le § Créer automatiquement une Bibliothèque à par-
tir de la page 211 et suivantes pour plus d’informations.

& Build Library (Créer une bibliothèque) se trouve aussi dans la fenêtre Device dans 
le menu local Entry. La différence étant que ce menu agit uniquement sur les entrées 
de l’appareil en cours et pas sur tous les appareils sélectionnés.

Sous-menu
Utilisez le sous-menu Build Library pour sélectionner les 
entrées que doit utiliser SoundDiver pour la bibliothèque.

Entrées éditables
La bibliothèque est créée à partir de toutes les entrées directe-
ment éditables des appareils. Cela inclut les tampons d’édition, 
ainsi que les entrées dans les emplacements mémoire qui sont 
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éditables directement, tels que les réglages de Pan d’un 
Yamaha SY99, les Multi-Setup du Virus ou la configuration 
globale d’un Alesis DM Pro. En gros, cette option stocke l’état 
actuel de l’appareil vous permettant ainsi de le recharger plus 
tard.
& Gardez à l’esprit que toutes les entrées de certaines Adaptations sont dans cette 

catégorie, comme les Tampons d’édition qui ne peuvent communiquer directement 
via MIDI.

La gestion des entrées dépendantes est active ici aussi. Si vous 
écrivez une entrée parent qui s’adresse à des entrées filles dans 
la bibliothèque, ces entrées filles seront incluses aussi.

Memory (Emplacements mémoire)
Cette option agit sur tous les emplacements mémoire, y 
compris ceux des cartes, mais pas des entrées ROM. Cette 
option est particulièrement utile si vous adressez tous vos sons 
via un message de changement de programme dans le séquen-
ceur et que vous ne vouliez pas transférer les tampons d’édition 
dans une bibliothèque.

All Entries
Cette option crée une bibliothèque à partir de toutes les 
entrées (hormis les entrées ROM). Sélectionnez All Entries 
lorsque vous désirez une sauvegarde de tous vos appareils y 
compris les tampons d’édition.

Selected Entries
Seules les entrées sélectionnées (hormis les entrées ROM) sont 
mises dans la bibliothèque. Cela vous permet de déterminer 
manuellement ce que la bibliothèque doit contenir.

Known Entries
Crée la bibliothèque à partir des entrées ayant déjà été requises 
dans la fenêtre Device. Utilisez cette option lorsque vous 
souhaitez créer une copie de sauvegarde à partir d’un nombre 
d’entrées spécifique (ex : uniquement les emplacements, 1 à 
30, uniquement les Multis...)
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“Save as…”
Cette option de menu dans le menu local New de la fenêtre de 
Configuration fonctionne de la même manière que Build 
Library, mais enregistre la bibliothèque créée directement sur 
le disque une fois que vous avez entré un nom de fichier et un 
chemin d’accès dans le sélecteur de fichiers.

Cette option est aussi disponible dans la fenêtre Device ; elle 
agit seulement sur les entrées des appareils en cours d’utilisa-
tion.

Load and Transmit File…
Vous trouverez cette option de menu dans le menu local New de 
la fenêtre de Configuration et dans le menu local Entry de la fenê-
tre Device. Il permet à une bibliothèque d’être chargée depuis le 
disque et envoyée directement aux appareils appropriés. Si vous 
avez utilisé “Create Library” pour faire une copie d’une partie ou 
de tout le contenue de la mémoire de votre configuration, “Load 
and Transmit File” les recherche à nouveau.

Si vous avez sélectionné un certain nombre d’appareils, seules 
les entrées de ces appareils seront acceptées. 

& Au sens strict, Load and Transmit File est une macro-instruction qui charge une 
bibliothèque sans ouvrir de fenêtre, sélectionne tout, en envoie la totalité vers les 
appareils puis referme la bibliothèque.

Les entrées de la bibliothèque qui ont un champ d’emplace-
ment vierge sont copiées comme d’habitude vers le prochain 
emplacement disponible. Si le message de Preference Safety 
concernant la réinscription des emplacements mémoire est 
activé, un dialogue apparaît afin que vous puissiez sélectionner 
une autre cible.

Si une bibliothèque contient plusieurs entrées pour le même 
emplacement mémoire, seul le dernier est traité.

La sélection dans la fenêtre Device est étendue par toutes les 
entrées chargées. Si vous désélectionnez tout, vous pourrez 
immédiatement voir n’importe quel changement.
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Le processus peut être abandonné en utilisant ™ ( : ou C.). 
Edit > Undo annule le chargement.

Après avoir chargé une bibliothèque, on vous demande si vous 
souhaitez transmettre les données chargées aux appareils 
correspondants (excepté avec les fichiers MIDI ; voir ci-
dessous). Cela vous évite de remplacer les mémoires des appa-
reils en chargeant accidentellement le mauvais fichier.

& Si vous cliquez “Cancel”, les données dans l’appareil ne correspondront pas à celles 
dans l’ordinateur, alors faites attention !

Pour les fichiers MIDI, SoundDiver vérifie d’abord pour voir si 
ils contiennent des données qui conviennent à un des appareils 
installés. Si ce n’est pas le cas, un message d’alerte apparaît.

Loading for a Single Device
Load and transmit File… est aussi présent dans la fenêtre 
Device du menu local Entry. Si vous utilisez cette commande 
de menu, le processus est limité uniquement à l’appareil en 
cours.

Exemple : Après avoir terminé une production, vous avez fait 
une copie de sauvegarde de l’intégralité de votre palette de 
sons sous forme d’une bibliothèque SoundDiver, et mainte-
nant vous voulez charger uniquement les sons de l’Xpander 
Oberheim pour une nouvelle production ? Dans cette situation, 
sélectionnez Load and Transmit File... dans la fenêtre Device de 
l’Xpander. Les données des autres appareils seront ignorées.

Importer différents formats
Vous pouvez aussi utiliser la fonction Load and Transmit File 
pour importer des fichiers d’un format étranger tels que les 
Fichiers MIDI Standard (SMF). Les contenus des fichiers 
chargés sont de même envoyés aux appareils concernés.

Pour plus de détails sur l’importation des fichiers SMF, veuillez 
vous référer au § Importer des Fichiers MIDI Standard (SMF) à la 
page 274.

& De plus, la fonction Load and Transmit File limite son action à l’appareil en cours 
lors du chargement d’un format différent dans la fenêtre Device.
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Envoyer des entrées depuis la Bibliothèque
Si vous sélectionnez une entrée dans la bibliothèque et sélec-
tionnez Edit > Transmit, les données seront envoyées à l’empla-
cement mémoire affiché sous memory location.

Modifier l’emplacement
Si vous désirez copier une entrée de la bibliothèque vers un 
emplacement mémoire différent de celui indiqué dans le 
champ d’emplacement, déplacez-la simplement avec la souris 
vers cet endroit. En utilisant cette méthode, vous pouvez expli-
citement spécifier la nouvelle cible de sorte que le champ 
d’emplacement dans la bibliothèque soit ignoré. Si plusieurs 
entrées sont copiées de cette manière, les entrées qui viennent 
ensuite sont copiées en conséquence vers d’autres endroits.

Effacer l’assignation d’emplacement 
mémoire
Il n’est parfois pas souhaitable pour SoundDiver de prendre en 
compte le champ d’emplacement d’une entrée lorsqu’il utilise 
la fonction Transmit. C’est le cas par exemple lorsque vous 
générez une bibliothèque universelle importante à partir de 
nombreuses banques de sons différentes. Dans ce cas vous 
pouvez effacer le champ d’emplacement :

❏ Sélectionnez les entrées de la bibliothèque que vous vou-
lez supprimer

❏ Cliquez sur le paramètre Location dans la case des paramè-
tres et effacez-le avec B. Cela efface les numéros d’empla-
cement des entrées sélectionnées dans la bibliothèque.

Si vous finissez par envoyer les entrées de la bibliothèque vers 
les appareils, SoundDiver distribue les entrées selon leur posi-
tion dans la bibliothèque.

Exemple : disons que vous vouliez envoyer cinq sons de la 
bibliothèque vers un synthétiseur, où ils devront occuper les 
emplacements 24 à 28.
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Vous devez sélectionner les entrées dans la bibliothèque puis 
sélectionner Edit > Transmit. Dans le dialogue résultant, sélec-
tionnez l’emplacement 24 puis cliquez sur le bouton All. 
SoundDiver envoie les cinq sons et les place les uns après les 
autres dans l’appareil, en commençant par l’emplacement 24.

Les tampons d’édition
Les entrées qui n’ont pas de numéro d’emplacement se voient 
attribuer un “E” dans la bibliothèque et sont renvoyées vers le 
Tampon d’Edition approprié dans l’appareil. Cela signifie que 
vous pouvez faire une sauvegarde complète de la totalité des 
contenus mémoire, incluant tous les Tampons d’Edition, dans 
SoundDiver.

Vous devez insérer manuellement le “E” dans les bibliothè-
ques plus anciennes. Pour cela, il est recommandé d’utiliser la 
fonction Find : 

❏ Sélectionnez More Options.

❏ Entrez la condition “The location” “is” (laisser vide)

❏ Sélectionnez l’option Show All

❏ A ce stade, toutes les entrées sans numéro d’emplacement
sont sélectionnées. Cliquez sur le paramètre d’emplace-
ment dans la case des paramètres et entrez “E”.

7.19 Exemples pratiques pour les 
Bibliothèques

Voici deux exemples destinés à vous montrer à quel point les 
bibliothèques peuvent être utiles dans votre travail au jour le 
jour.
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Sauvegarder instantanément les sons pour 
une production
Imaginons que vous soyez en train de travailler sur une produc-
tion et que vous désiriez sauvegarder les contenus mémoire de 
tous vos appareils pour les recharger ultérieurement car vous 
devez alors débuter une nouvelle production :

❏ Dans la fenêtre de Configuration, sélectionnez tous les
appareils que vous utilisez, 

❏ sélectionnez New>Save as...>Memory locations, 

❏ sauvegardez la bibliothèque qui apparaît en utilisant le
nom de la production, 

❏ vous pouvez alors commencer votre production suivante ;
en d’autres mots, vous êtes maintenant libre de modifier les
contenus mémoire de vos appareils.

Une fois que vous êtes prêt à travailler sur votre production 
d’origine, 

❏ envoyez la bibliothèque dans la fenêtre de Configuration
avec New > Load and transmit file….

❏ Après avoir répondu au message de sécurité, vous revenez
au point où vous en étiez précédemment.

Archivage de sons superposés
Si vous avez créé un son composé de plusieurs couches en 
combinant divers appareils et que vous désiriez le sauvegarder :

❏ Créer une nouvelle bibliothèque avech File > New ou
ouvrez une bibliothèque existante,

❏ copiez toutes les entrées de vos divers appareils qui for-
ment le son composé dans votre bibliothèque, 

❏ si nécessaire, séparez ce groupe d’entrées des autres en uti-
lisant une entrée-titre.

❏ Pour stocker ces entrées dans les appareils, sélectionnez-
les, cela se fait très facilement en pressant A ( : O) et en
cliquant sur l’entrée titre, puis envoyez-les en utilisant Edit
291
Mode d’Emploi
Version 3.0



 – La Bibliothèque

X

> Transmit. Pour écouter les sons sans avoir besoin de tou-
jours les stocker dans les appareils, sélectionnez dans le
menu local Library > Audition.

❏ Vous pouvez aussi sélectionner les entrées dans différents
modèles du même type d’appareil.
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L’édition dans 
SoundDiver

SoundDiver, en plus du simple arrangement de vos sons, vous 
donne également la possibilité de les éditer directement sur 
l’écran de votre ordinateur.

8.1 Généralités
Depuis que SoundDiver contient des modules et des adapta-
tions pour plus de 500 appareils, la plupart d’entre eux compor-
tent au moins un éditeur. Toutes leurs fonctions spécifiques ne 
peuvent pas être décrites dans un seul manuel d’utilisation. 
C’est pour celà que ce manuel nous décrit les fonctions généra-
les de SoundDiver communes à tous ses éditeurs.

La forme générale, les options opérationnelles et basiques sont 
identiques à tous les éditeurs SoundDiver. Vous avez donc 
seulement besoin d’apprendre comment utiliser un des 
éditeurs SoundDiver pour savoir les utiliser tous.

S’il vous reste encore des questions relatives à des fonctions 
spécifiques à un appareil ou si vous souhaitez obtenir plus de 
détails sur les options disponibles dans un éditeur, vous pouvez 
profiter des informations fournies par l’aide en ligne.

Les fonctions spécifiques, les options et caractéristiques des 
différents éditeurs sont particulièrement décrites dans la fenê-
tre d’aide. Ce qui vous garantit que lors d’une édition, une 
amélioration ou une expansion des modules et des adaptations, 
les instructions restent pertinentes par le biais du texte d’aide 
réactualisé.

Chapitre 8
293
Mode d’Emploi
Version 3.0



 – L’édition dans SoundDiver

X

X

X

Abb. Editor-Hilfe

Par exemple, voici une page de l’aide en ligne pour le Yamaha 
EX5. Comme vous pouvez le constater, cette aide contient des 
informations détaillées sur les appareils spécifiques.

8.2 Ouverture de l’éditeur
Pour sélectionner une entrée pour l’édition, vous pouvez :

• double-cliquer dans la fenêtre Device ou la bibliothèque.

• sélectionner une entrée dans la fenêtre Device ou la biblio-
thèque puis sélectionner Windows > Open Editor;

• sélectionner une entrée dans la fenêtre Device puis sélec-
tionner Entry > Edit dans le menu local;

• sélectionner une entrée dans une bibliothèque puis sélec-
tionne Library > Edit dans le menu local.

Si le contenu de l’entrée à éditer 
n’est pas encore connu, une fenêtre 
apparaît vous donnant quelques ou 
toutes les options suivantes qui 
dépendent de la situation rencontrée
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• annuler l’opération ;

• initialiser l’entrée. L’initialisation des données est alors 
envoyée à l’appareil, et l’éditeur est ouvert avec ces données ;

• demander d’abord l’entrée de l’appareil.

& Il arrive quelque fois qu’aucune donnée ne soit disponible pour une fenêtre Éditeur 
ouverte. Vous recevez alors un message “donnée inconnue”. Vous pouvez recevoir 
les données de l’éditeur en sélectionnant Edit > Request  ou en l’initialisant avec 
Edit > Initialize par le menu local.

La Vue d’ensemble (Overview)

Si un éditeur dispose de plusieurs vues, SoundDiver ouvre une 
nouvelle fenêtre éditeur dans le mode de vue d’ensemble. Il 
vous permet de voir immédiatement tous les domaines de fonc-
tion de votre appareil. Avec des synthétiseurs, ceux-ci vous 
donnent une meilleure indication de la structure de la généra-
tion sonore, tel que le plus important des paramètres : le 
volume ou le panorama et ainsi de suite. Cependant avec la 
plupart des appareils, il n’est pas possible de voir tous les para-
mètres en une seule fois, la vue d’ensemble vous procure un 
moyen très simple de sélectionner le domaine que vous voulez 
éditer.

Supposons que vous vouliez éditer les paramètres AWM du son 
de l’EX5 montré dans l’illustration. Cliquez sur la case AWM 
dans la vue d’ensemble et un affichage détaillé de l’AWM appa-
raît.
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Abb. Editor Detail

Pour revenir à la vue d’ensemble :

• sélectionnez View > Overview dans le menu local ;

•  :cliquez sur le bouton adéquat dans la fenêtre d’édition.

La vue d’ensemble et l’affichage détaillé sont représentés par 
une fonction zoom à deux niveaux. Vous pouvez passer de la 
vue d’ensemble à l’affichage détaillé et pointer rapidement les 
paramètres que vous souhaitez. Lorsque vous passez de l’un à 
l’autre, votre position dans la vue d’ensemble reste la même.

& Si l’entrée que vous éditez contient peu de paramètres, il n’y aura plus de vue 
d’ensemble. On rencontre souvent ce cas avec des programmes d’effets simples ou 
des Multipatches. Par contre, d’autres éditeurs sont si complexes qu’ils sont répartis 
en trois niveaux (par exemple : Roland D-70 Drums).

8.3 “Easy Page”
Une partie de la vue d’ensemble contient des macros-paramè-
tres pour élaborer des altérations approximatives au son sans 
devoir entrer dans les détails. Ces altérations, qui sont connues 
sous le nom de “Easy Page”, influencent toujours le son globa-
lement. Supposons que vous vouliez utiliser l’Easy Page pour 
changer la fréquence du filtre dans un Morpheus EMU, tous les 
éléments y sont disponibles. Si vous souhaitez modifier la 
fréquence du filtre d’une composante d’un son particulier, vous 
pouvez le faire dans l’affichage détaillé.
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Si vous changez un paramètre dans l’affichage détaillé, tous les 
paramètres de l’Easy Page sont remis à zéro.

Double-cliquez sur un paramètre pour revenir directement à la 
section correspondante de l’affichage détaillé.

Dans certains modules, il existe davantage de boutons disponi-
bles pour ouvrir plus de fenêtres Éditeurs.

Exemple: Sur la vue détaillée du Roland VM-7100/7200, les 
petits boutons de la section d’égalisation ouvrent une autre 
fenêtre.

8.4 Naviguer dans la fenêtre 
Éditeur

Vous pouvez représenter un Éditeur comme un grand plan 
routier, sur lequel tous les paramètres sont exposés. La fenêtre 
Éditeur vous montre une section de cette carte, que vous sélec-
tionnez en utilisant les différentes fonctions de navigation. 

Le passage de la vue d’ensemble à l’affichage détaillé a été 
exposée dans le paragraphe précédent.

Vous accédez aux domaines extérieurs à la fenêtre Éditeur au 
moyen des barres de défilement. Les paramètres d’une compo-
sante d’un programme (qui compose un son) sont habituelle-
ment arrangés de manière horizontale.
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Au moyen de la barre de défilement du bas pour se déplacer de 
gauche à droite, vous pouvez suivre le cheminement du signal 
de l’appareil ou la structure d’une combinaison, d’une perfor-
mance ou d’un multi-programme.
Abb. Tone horizontal

Ces illustrations montrent les paramètres d’un élément d’un 
Yamaha EX5 et en dessous les paramètres d’une performance 
dans un Yamaha SY99.

SoundDiver arrange d’autres éléments verticalement. L’outil 
de défilement x/y en bas dans le coin gauche de la fenêtre vous 
permet de vous déplacer rapidement dans n’importe quelle 
direction du plan.

Sous Windows vous pouvez aussi ç-cliquer avec le bouton 
central de votre souris dans n’importe quel endroit de la fenê-
tre.
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8.5 Sélection du paramètre à 
éditer

Lorsqu’un paramètre comporte un curseur clignotant, cela 
signifie qu’il peut être édité.

Vous pouvez soit cliquer directement sur le paramètre avec la 
souris soit déplacer le curseur dans n’importe quelle direction 
en utilisant les touches fléchées, auquel cas la section de la 
fenêtre se déplace aussi automatiquement.

Cliquer sur un objet déplace la vue de la fenêtre afin de 
permettre de voir l’objet. Si l’objet est déjà totalement visible 
ou trop grand pour elle, la vue de la fenêtre ne sera pas dépla-
cée, comme c’est le cas pour de très gros objets comme le 
clavier vertical dans les éditeurs rythmiques.

La description du paramètre est visible :

• lorsque vous maintenez le pointeur de la souris sur un objet 
sans le faire bouger pendant un instant. Une petite fenêtre 
(Bulle d’Aide) indique le nom du paramètre et sa valeur 
actuelle. Pour les paramètres dont les valeurs sont des noms 
(comme les formes d’onde), le nom de la valeur est affiché.

& Cette fonction peut être désactivée. Voir le § ToolTips (Bulles d’aide) à la page 403.

• Sur la ligne d’information de la fenêtre Éditeur (Macintosh) 
et sur la ligne de statut (en bas de la fenêtre principale de 
SoundDiver) sur Windows.

L’aide Paramètre
Si vous voulez connaître la fonction précise d’un paramètre 
spécifique, cliquez dessus et sélectionner Windows > Help, 
puis la fenêtre d’Aide apparaîtra avec une description du para-
mètre.
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Abb. Parameter-Erklärung

Vous pouvez laisser la fenêtre d’Aide ouverte et lorsque vous 
cliquez sur les différents paramètres, le message d’Aide change 
alors automatiquement en conséquence. Il vaut mieux ouvrir la 
fenêtre d’Aide en tant que fenêtre flottante en :

• sélectionnant toujours l’option de menu Options > Help 
always in foreground > in foreground dans la fenêtre d’aide 
sous Windows ou

•  : en maintenant O tout en ouvrant simultanément la 
fenêtre d’aide.

Position du curseur
SoundDiver mémorise toujours la position curseur, même si 
vous déplacez la fenêtre au second plan et rappelez un Screen-
set différent.

Canal MIDI Thru
Il y a des modules qui mettent à jour automatiquement le canal 
MIDI Thru dans certains éditeurs lorsque vous sélectionnez un 
paramètre. Cette fonction est disponible dans la plupart des 
multi-éditeurs pour vous permettre de lire la partie édité.

& Cette fonction n’est actuellement pas disponible dans les Adaptations. Pour écouter 
le paramètre édité, modifiez manuellement le canal MIDI Thru.
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8.6 Édition des paramètres à la 
souris

L’édition des paramètres a été exposé dans le § Fonctionnement 
: Généralités à partir de la page 124 et suivantes, mais les éditeurs 
contiennent des fonctions supplémentaires. Vous pouvez par 
exemple, éditer des paramètres au moyen de potentiomètres. 
En ce qui concerne la vue d’ensemble, une autre description 
des différentes méthodes est disponible ici pour l’édition des 
paramètres.

Utiliser la souris comme un curseur
Pour régler directement les valeurs des paramètres avec la 
souris, cliquez et maintenez sur le nombre de la valeur. Vous 
pouvez alors la modifier en déplaçant la souris dans n’importe 
quelle direction verticalement.

 : Cette fonction est appelée “Mouse-as-slider” (souris comme 
curseur) et peut être désactivée dans les Préférences.

Utiliser la souris pour la diminution ou 
l’augmentation des valeurs
Si vous avez désactivé l’option Mouse-as-slider dans les Préfé-
rences, la souris fonctionnera comme une touche de diminution 
ou d’augmentation sur un synthétiseur.

Cliquer augmente la valeur, C-cliquer la diminue. Si vous 
maintenez vers le bas S, Sounddiver modifiera la valeur de dix 
en dix. 

Cliquer-presser changera la valeur en continu.
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Menus locaux
A l’aide des menus 
locaux, vous pouvez 
sélectionner des préré-
glages ou des valeurs 
exprimées par des 
noms, tels que le nom 
des formes d’onde ou 

des réglages de commutation. Ils sont repérables à leur surface 
“biseautée” et (si la place le permet) par une flèche pointant 
vers le bas sur le côté droit.

Le fonctionnement de la souris
C’est en cliquant sur un objet menu local que vous l’ouvrez. Il 
existe cependant deux possibilités pour l’ouvrir :

• lorsqu’il a été ouvert par un clic court, le menu se ferme par 
un autre clic.

• s’il a été ouvert par un clic prolongé sur le bouton de la 
souris, le menu local se ferme en relâchant le bouton.

 : Si vous maintenez S après avoir ouvert le menu local 
avec cette option, le menu reste ouvert après avoir relâché le 
bouton de la souris. Le menu se ferme lorsque vous relâcher 
à la fois la touche S et le bouton de la souris.

& Attention : ne maintenez pas S après avoir cliqué (un S-clic sélectionne le niveau 
suivant des groupes de paramètres, voir ci-dessous).

En déplaçant le pointeur de la souris sur le menu, vous sélec-
tionnez une valeur. Si le pointeur de la souris est situé dans une 
valeur lorsque le menu se ferme, cette valeur est choisie pour 
l’objet menu local.

Affichage
Si le menu local contient plus de valeurs qu’il ne peut y en avoir 
dans une colonne, il en comprendra plusieurs. Si l’écran n’est 
pas assez large pour représenter toutes les colonnes, une barre 
de défilement apparaît au bas de la vue d’ensemble. Dans le cas 
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contraire, un nombre de lignes est choisi afin qu’il y ait aussi 
peu que possible de lignes vides dans la dernière colonne. Effet 
corollaire, il en résulte un nombre de lignes qui correspond au 
système de numérotation par exemple lors de la sélection 
d’une entrée dans une banque.

Windows : Fonctionnement du clavier
Sous Windows, il existe des options supplémentaires

• Au lieu de cliquer dans un objet menu local, vous pouvez 
aussi déplacer le curseur lumineux sur le menu local et pres-
sez R.

• Dans des menus locaux ouverts, vous pouvez sélectionner 
les valeurs souhaitées avec les touches curseur. Si nécessaire 
le menu défile automatiquement.

• Aussitôt que la valeur désirée est sélectionnée, valider la sé-
lection avec R.

• Si vous cliquez par erreur dans un menu local, pressez la tou-
che ™ afin de le fermer sans changer de valeur.

Éditer un objet menu local sans menu local
Si vous cliquez sur un objet menu local tout en maintenant ç, 
il ne s’ouvrira pas. Mais vous pourrez entrer la valeur en utili-
sant la souris comme curseur. Avec un ç double-clic, vous 
pouvez entrer une valeur avec le clavier.

Édition avec des objets graphiques
Pour modifier un para-
mètre, utiliser son affi-
chage graphique, 
cliquez-maintenez. Cela 
dépend du paramètre…

• ...vous pouvez entrer la valeur en utilisant un potentiomètre 
dont la position change en faisant bouger la souris verticale-
ment.

& Maintenir ç vous apporte une résolution plus fine : déplacer le pointeur de la souris 
de deux crans modifie la valeur d’une unité. Important à savoir pour des petits poten-
tiomètres ayant une plage de valeurs étendue.
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• Le Fader fonctionne 
d’une façon similaire au 
potentiomètre, vous 
changez la valeur en 
poussant ou en tirant la 
souris.

• Les Faders horizontaux fonctionnent exactement de la 
même manière sauf qu’il faut déplacer la souris horizontale-
ment.

& Avec des Faders, vous pouvez aussi effectuer des réglages fins en maintenant simul-
tanément la touche ç.

& La valeur numérique d’un objet graphique fonctionne simplement comme un objet 
de valeur numérique.  : Ceci s’applique plus particulièrement à la méthode “souris 
comme curseur”.

Enveloppes
Elles peuvent être éditées graphi-
quement en faisant glisser les 
points dans la direction souhaitée. 
Toutes les modifications sont alors 
représentées dans l’affichage 
numérique. 

Selon la structure de l’enveloppe, 
le point peut être déplacé dans une ou dans les deux directions. 
Dans certaines enveloppes, il existe des limitations pour le 
positionnement du point (par exemple avec le Yamaha EX5). 

Les points se situant à l’extérieur du rectangle du graphique de 
l’enveloppe sont indiqués par une petite flèche. De tels points 
peuvent être édités en cliquant sur cette flèche.
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La fenêtre Clavier

Pour la plupart des synthétiseurs, les tessitures de clavier 
peuvent être définies. Celles-ci ont souvent affichées graphi-
quement à coté de la représentation numérique.

Vous pouvez modifier simplement les limites des tessitures 
définies en faisant glisser la souris. Pour certains appareils, 
seule une partie des 128 sons possibles est représentée, afin de 
gagner de la place.

Dans ce cas, cliquez simplement la côté gauche ou droit pour 
définir la limite convenable. 

Si l’appareil ne permet pas que la touche la plus aiguë (High 
Key) soit inférieure à plus la grave (Low Key), cette dernière 
est automatiquement déplacée en conséquence lorsque la 
touche aiguë est éditée, et inversement.

Cependant, il y a aussi des appareils qui autorisent cette situa-
tion, par exemple le Yamaha EX5. C’est ce qui le plus souvent 
définit un filtre, cela signifie que deux tessitures sont détermi-
nées : de la touche C-2 à la plus aiguë et de la plus grave à la G8. 
Ceci est affiché en toute logique dans SoundDiver.

Fenêtres Keyboard Velocity (Vélocité du clavier)
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Cette variante de la fenêtre clavier va vous apporter des infor-
mations supplémentaires relatives à l’étendue de la vélocité. 
SoundDiver présente une telle fenêtre sous la forme d’un 
clavier surmonté d’un rectangle. Les dimensions du rectangle 
représentent la tessiture du clavier dans l’axe y et sa vélocité 
dans l’axe x. Les lignes guides horizontales et verticales 
rendent l’orientation plus pratique.

Mis à part les procédures habituellement disponibles dans les 
fenêtres clavier, vous pouvez à l’aide de la souris déplacer les 
quatre coins du rectangle afin de changer les limites du clavier 
et de sa vélocité.

Comme pour les tessitures, certains appareils ne permettent 
pas que la vélocité la plus élevée soit inférieure à la vélocité la 
plus basse. De nouveau, SoundDiver définie la limite automa-
tiquement. La remarque mentionnée ci-dessus concernant les 
“filtres de tessiture de clavier” s’applique aussi aux fenêtres de 
vélocité du clavier.

8.7 Entrée de valeurs au clavier

Mode de saisie des nombres
Les valeurs de paramètres peuvent être aussi entrées directe-
ment par l’intermédiaire du pavé numérique. Les touches 1 à 
9 servent habituellement à passer d’un Screenset SoundDiver 
à un autre, alors que = déclenche le séquenceur. Vous pouvez 
modifiez cela en :

• activant le raccourci clavier “Num Lock” ; normalement c’est 
la touche “ ( : touche ~) — cette touche est aussi symbo-
lisé par “Num.”;

• activant “Num Lock” dans les Préférences.

Cette fonction est aussi connu sous le nom des “NumLock”.

Si le mode de saisie des nombres est activé, c’est signalé dans la 
ligne d’informations de SoundDiver sur Macintosh (Windows : 
ligne de statut) :
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 : Ce message apparaît dans toutes les fenêtres ayant une ligne 
d’informations.

Notez que si vous faites une pause entre les chiffres, elle doit 
restée inférieure à une seconde. Les valeurs négatives doivent 
être précédés du signe _. Dans ce cas aussi la pause ne doit pas 
dépasser la seconde.

Appuyer à nouveau sur “ ( : ~) permet de quitter le mode 
de saisie des nombres. Vous pouvez sauvegarder le réglage du 
mode de saisie des nombres dans les Préférences.

Case de saisie de texte
Si vous ne voulez pas utiliser le mode de saisie des nombres, si 
par exemple vous utilisez souvent les différents Screensets, il 
suffit de double cliquer sur le paramètre. Une petite fenêtre 
apparaît alors dans laquelle vous tapez la valeur désirée, pressez 
ensuite R pour valider.

Si le curseur est déjà placé sur l’objet à modifier, la case de 
saisie peut être ouverte avec R.

Dans la case de saisie texte, il existe différentes façons d’entrer 
une valeur. Si le paramètre n’a que des valeurs entières consé-
cutives ou des noms de note, les possibilités sont identiques à 
celles de Logic Audio d’Emagic :

• entrée décimale : 0, 1, 2, 123
• entrée hexadécimale: $1, $2, $0A, $7F
• une note de valeur “C3”, “C#3”, “Cb3”, “C##2” (corres-

pond à D3), “Dbb2” (correspond à C2)
• ajouter une valeur à la précédente: “+5”, “+$10”
• soustraire une valeur de la précédente: “−5”

& Pour entrer une valeur absolue négative −x, entrer “0−x”

• ajouter deux nombres: “38+17”
• soustraire deux nombres: “38−17”
• multiplier deux nombres: “7∗ 8”
• diviser deux nombres: “80/5”
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Pour tous les autres paramètres, vous pouvez entrer n’importe 
quel texte. SoundDiver sélectionnera la valeur qui est la plus 
proche du texte entré.

Exemple: Les valeurs des paramètres disponibles sont
Hall 1
Hall 2
Delay
Pan-Dly

Entrer “2” sélectionnera Hall 2; “del” sélectionnera Delay, et 
“dl” sélectionnera Pan-Dly.

Augmentation et diminution de valeurs
Pour augmenter ou diminuer une valeur en une seule étape, 
pressez  ou _. Maintenir S modifie la valeur de dix en dix.

Pour entrer une valeur négative, presser tout d’abord _ (initia-
lement, la valeur diminue de un) puis entrer le nombre.

Noms
Dans de nombreux types de données, un nom que l’on peut 
éditer appartient aux paramètres. Il est souvent affiché du côté 
gauche de la fenêtre Éditeur. Cliquez sur un des caractères et le 
curseur sera représenté sous la forme d’un rectangle clignotant 
(au lieu d’un cadre). Mis à part les touches curseur, les 
commandes suivantes rendent leur entrée plus facile :

entrer un caractère fait avancer le curseur au suivant

™ efface le nom entier

B efface le caractère situé à gauche du curseur et déplace le 
reste d’un cran vers la gauche 

∂ ( : L) efface le caractère situé sous le curseur et déplace le 
reste d’un cran vers la gauche 

⁄ insère un espace (sous Windows).

& Les commandes d’insertion et d’effacement fonctionnent seulement dans les 
éditeurs de modules, pas dans les adaptations.
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8.8 Entrée de valeurs via MIDI
De nombreux paramètres reflètent des valeurs MIDI spécifi-
ques comme les notes, les vélocités, les numéros de contrô-
leurs, etc... Dans la plupart des éditeurs vous pouvez directe-
ment entrer ces valeurs (pas dans les adaptations). Cette 
fonction est appelée “Écoute MIDI” (Listen to MIDI).
Placer le curseur sur le paramètre, maintenir S et jouer 
l’événement MIDI sur le clavier. Par exemple, dans un multi-
éditeur vous pouvez définir la tessiture d’une partie en jouant la 
note la plus haute ou la plus grave, ou programmer le contrôleur 
de souffle en tant que source de modulation en maintenant S 
tout en soufflant.
Les paramètres qui permettent une telle entrée sont repérés 
par ce symbole:

8.9 AutoPlay
Si l’AutoPlay est activé, le séquenceur intégré met automati-
quement en lecture la séquence de test en mode Cycle avec 
chaque changement de valeur, (que ce soit avec la souris, le 
clavier ou l’entrée MIDI). Avec l’Autolink (Lien automatique), 
le séquenceur lit depuis le Locator gauche le laps de temps 
indiqué par le paramètre AutoPlay Duration.

Avec les éditeurs rythmiques, c’est la note éditée qui est jouée 
pendant la durée indiquée par Drum AutoPlay Duration (ceci 
n’est pas applicable aux adaptations).

8.10 Le bouton d’Edition (Edit)
Certains menus locaux affiche le 
nom d’autres entrées (référence 
croisée). Par exemple, des menus 
locaux dans une entrée parent 
afficheront les sons des appareils. 
Si le nom d’une entrée reste encore inconnu, seul le numéro de 
l’emplacement mémoire est affiché.
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Il y aura souvent un commutateur Edit à côté. Si vous cliquez 
dessus, l’éditeur correspondant s’ouvrira. Cela désactive simul-
tanément la fonction Lien dans les anciennes et les nouvelles 
fenêtres. Avec certaines valeurs de paramètre, le commutateur 
Edit se désactive (en gris). Dans ce cas, sélectionner tout 
d’abord un emplacement RAM utilisateur.

8.11 Menu contextuel sous 
Windows

Lorsque vous cliquez sur un groupe de paramètres avec le 
bouton droit de la souris, il est alors sélectionné (s’il ne l’était 
pas déjà), et un menu contextuel apparaît. Les informations 
disponibles dans ce menu sont les suivantes :

• New window: voir le § Plusieurs fenêtres Éditeur à la page 311.

• Cut: voir le § Couper un groupe de paramètres à la page 316.

• Copy: voir le § Copier un groupe de paramètres à la page 316.

• Paste: voir le § Coller un groupe de paramètres à la page 316.

• Initialize: voir le § Initialize à la page 324.

• Randomize: voir le § Randomize à la page 321.

• Link Window: voir le § Link Window (Lier les fenêtres) à la page 
322.

• Overview: voir le § “Easy Page” à la page 296.

• Request: voir le§ Request (Demander le transfert) à la page 153

• Transmit: voir le § Transmit (Transmettre) à la page 154.

• Hold Transmission: voir le § Hold Transmission (Suspendre 
transmission) à la page 158.

• Compare: voir le § La Fonction Comparer à la page 318

• Store: voir le § Store (Mémoriser) à la page 318.

• Store in…: voir le § Store in… (Mémoriser dans) à la page 319.

• Snapshot: voir le § Snapshot (Instantané) à la page 319.

• Parameters: voir le § Paramètres à la page 322.
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Lorsque vous cliquez sur une zone vide avec le bouton de la 
souris, un menu contextuel plus court apparaît, qui ne contient 
pas d’options mais qui est seulement destiné aux groupes de 
paramètres.

8.12 Plusieurs fenêtres Éditeur
Vous pouvez ouvrir plusieurs fenêtres Éditeur pour une simple 
entrée, une d’entre elle pourrait vous exposer la vue d’ensem-
ble, une autre l’enveloppe du filtre.
Abb. Mehrere Editorfenster

Si plusieurs fenêtres sont ouvertes pour une seule entrée, 
toutes les fenêtres vous montreront les paramètres de cette 
entrée, mais dans différents affichages. Toutes les modifica-
tions sont toujours reflétées dans toutes les fenêtres où le para-
mètre concerné est visible.
& Veuillez noter qu’afficher des modifications dans plusieurs fenêtres prend du temps 

et que le programme doit réagir à toutes ces entrées.
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8.13 Le tampon d’édition
L’éditeur SoundDiver a besoin de copier des données dans un 
tampon d’édition qui correspond à celui de l’appareil lui-
même. C’est pour cela que vous pouvez voir le tampon 
d’édition dans la fenêtre Device. L’entrée que vous écoutez ou 
modifiez à ce moment-là est marquée d’un petit “E”. Ce E 
détermine donc le mode actuel (par exemple le mode Perfor-
mance, Patch, Multi, Solo) de l’appareil.
Ce petit E, qui est assigné à une seule entrée par appareil, nous 
indique si l’une d’entre elle peut être directement éditée ou 
pas, cela veut dire que c’est un tampon d’édition : il n’apparaî-
tra que lorsque vous cliquez sur une entrée. Certains emplace-
ments mémoire peuvent être aussi directement édités.

Plusieurs tampons d’édition
Lorsque vous double-cliquez sur une entrée, SoundDiver cher-
che un tampon d’édition adéquat puis y copie le son. Dans 
certains appareils, il existe plusieurs tampons d’édition pour 
certains types de données, par exemple les huit “Performance 
Temp.Patches” du Roland JV-1080. Vous pouvez choisir quel 
tampon d’édition SoundDiver doit être utilisé, soit en copiant 
l’entrée dans le tampon d’édition souhaité et en double-
cliquant sur celui-ci, soit en cliquant sur le tampon d’édition 
souhaité avant d’ouvrir le tampon d’édition par un double-clic 
sur l’entrée à éditer.
Voir aussi le § Appareils possédant des tampons d’édition individuels à la 
page 217 et le § Appareils avec tampons d’édition individuels à la page 
262.

MIDI Thru
N’oubliez pas que la fonction MIDI Thru du tampon d’édition 
peut être traitée intelligemment par les modules (mais pas par 
les adaptations) : à chaque fois que vous changez de tampons 
d’édition, il est automatiquement configuré à cette valeur de 
manière à ce que vous puissiez écouter ce tampon. Ceci fonc-
tionne seulement si les données de configuration multi ou 
312
Emagic
SoundDiver 



Télécommande et Moniteurs
globales conviennent, parce que c’est de là que provient l’infor-
mation du canal demandé.

8.14 Télécommande et Moniteurs
Les adaptations qui représentent des télécommandes, les 
moniteurs pour les appareils ou les fonctions MIDI, initialisent 
la fenêtre Éditeur aussitôt que vous l’ouvrez (Moniteur MIDI, 
Console MIDI). Ceci parce que ces éditeurs ne peuvent pas 
démarrer dans l’appareil à partir des réglages connus. 
Abb. -Mixer

C’est la même chose pour les appareils sans tampon d’édition, 
ou ceux dont le contenu ne peut pas être envoyé via un trans-
fert MIDI, ici aussi SoundDiver n’a pas de point de départ, 
c’est pourquoi il est préférable de commencer par un réglage 
neutre.

Les éditeurs de télécommandes sont très semblables à ceux de 
l’Environnement Logic ou du Mixer Map de Cubase.

L’assignation des contrôleurs SoundDiver 3.0 est un très bon 
moyen pour télécommander tous les paramètres. Vous en 
saurez plus en lisant le § Les Assignations de contrôleurs à la page 
327
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8.15 Annulation des éditions
Comme partout dans SoundDiver, vous pouvez annuler les 
dernières modifications apportées dans un éditeur (fonction 
Undo). 

Sélectionnez l’option de menu Edit > Undo Parameter Change. 
en la sélectionnant une seconde fois le changement du paramè-
tre précédent est annulé.

Si vous utilisez accidentellement la fonction Undo vous pouvez 
rétablir l’édition en sélectionnant Edit > Redo Parameter 
Change.

& Les fonctions “Undo” and “Redo” sont presque illimitées. Leur nombre est simple-
ment limité par la mémoire du système. Cela dépend de la dernière opération effec-
tuée, qui pourrait utiliser beaucoup de mémoire. C’est pour cela que la dernière 
étape est parfois effacée lorsqu’il n y a plus de mémoire disponible. Dans ce cas, 
seule l’étape la plus récente de l’enchaînement peut être reproduite.
 : S’il n’y a pas assez de mémoire dans SoundDiver pour procéder à une opération 
et que d’autres mesures ne fonctionnent pas (par exemple effacer des modules ou 
des adaptations dont on a plus besoin) SoundDiver effacera des étapes jusqu’à ce 
qu’il y ait suffisamment de mémoire disponible.

8.16 Fonctions Presse-papiers 
dans l’Éditeur

Si l’éditeur est approvisionné par un module (pas par une adap-
tation ni par le module universel), vous pouvez sélectionner des 
groupes de paramètre à l’intérieur de l’éditeur puis les copier 
ou les initialiser, ainsi que beaucoup d’autres fonctions.

Sélectionner un groupe de paramètre 
Pour sélectionner un groupe de paramètre, cliquez sur la zone 
grise à l’intérieur du groupe de paramètres ou maintenez S et 
cliquez sur un paramètre à partir de ce groupe. Utilisez la 
dernière méthode, si vous ne pouvez par voir cette zone grise à 
l’intérieur du groupe de paramètre.
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Les groupes de paramètre dans SoundDiver sont structurés 
hiérarchiquement. Vous pouvez par exemple, sélectionner en 
tant que groupe un son entier (élément ou voix) ; une seule 
enveloppe, un LFO, un effet ou n’importe quel composant de 
sons collectifs.

Pour sélectionner un groupe de paramètres situé plus haut dans 
la hiérarchie, cliquez sur un point appartenant au groupe de 
paramètre situé plus haut. Par exemple, dans un oscillateur ou 
une hiérarchie de partiels, cliquez entre les groupes de fonction 
séparés (enveloppes, filtres, etc...)

& Il y a habituellement une liste de groupe de paramètres dans le Fichier d’Aide.

Le groupe sélectionné sera affiché en inversé. Le diagramme 
ci-dessus représente un groupe sélectionné de paramètres 
complet pour le “Pitch Envelope Generator” sur la gauche et 
sur la droite les paramètres sélectionnés “Time” d’un synthéti-
seur EX5.

Pour effacer une sélection de groupe de paramètres, vous 
n’avez besoin que de cliquer sur un seul paramètre ou dans 
l’arrière-plan.

Fonctions Presse-papiers pour les Groupes 
sélectionnés
Les trois opérations suivantes s’appliquent au presse-papiers. 
Ces fonctions (Couper, Copier et Coller) sont aussi communé-
ment applicables aux différentes fenêtres et entrées. Par exem-
ple, vous pouvez copier l’enveloppe du filtre du son EX5 
“Piano” sur l’enveloppe du filtre du son “Strings” de l’EX5.
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Couper un groupe de paramètres
Sélectionnez un groupe de paramètres et choisissez Edit > Cut.

Le groupe de paramètre est copié dans le presse-papiers puis 
initialisé.

Si vous voulez simplement initialiser les paramètres sans les 
copier dans le presse-papiers, sélectionnez Edit > Initialize.

Copier un groupe de paramètres
Sélectionnez un groupe de paramètres et choisissez Edit > 
Copy.

Les valeurs du groupe de paramètres sont copiés dans le 
presse-papiers et peuvent ensuite être collés dans un autre 
endroit.

Coller un groupe de paramètres
Sélectionnez un groupe de paramètres et choisissez Edit > 
Paste.

Le contenu du presse-papiers est collé sur le groupe de para-
mètres sélectionnés, ce qui les rend compatibles. Vous ne pour-
riez pas par exemple copier l’enveloppe du filtre d’un Virus 
dans des réglages d’effets de l’EX5.

Glisser-Déposer
Plutôt que copier un groupe de paramètres en utilisant le 
copier-coller, il est plus pratique d’utiliser le Glisser-Déposer.

Pendant que vous maintenez S, saisissez un groupe de para-
mètres avec la souris et glissez-le vers un autre endroit qui peut 
se trouver dans une fenêtre différente.

Lorsque vous relâchez le bouton de la souris, les valeurs du 
groupe de paramètres sont copiées sur la position visée. Si le 
pointeur de la souris sort des limites de la fenêtre, la section de 
la fenêtre se déplacera automatiquement avec celui-ci de 
manière à ce que vous puissiez glisser même le groupe de para-
mètres en dehors de la section de la fenêtre vers une position 
visée.
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Effacer un groupe de paramètres
Sélectionner l’option de menu Edit > Clear réinitialise le groupe 
de paramètres, ce qui habituellement remet les paramètres à 
zéro ou à leur valeur par défaut.

8.17 Fenêtres locales dans le 
Menu Editor

La fenêtre Éditeur contient des menus locaux comportant 
différentes options permettant de travailler dans l’éditeur.

Le Menu Edit

Undo
voir le § Annulation des éditions à la page 314.

Redo
voir le § Annulation des éditions à la page 314.

Cut
voir le § Couper un groupe de paramètres à la page 316.

Copy
voir le § Copier un groupe de paramètres à la page 316.

Paste
voir le § Coller un groupe de paramètres à la page 316.

Clear
voir le § Effacer un groupe de paramètres à la page 317.

Request
voir le § Request (Demander le transfert) à la page 153.
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Transmit
voir le § Transmit (Transmettre) à la page 154.

La Fonction Comparer
Il arrive souvent lorsque vous éditez un son, de revenir au 
début d’une phase où vous vous demandez si le son obtenu est 
mieux que l’original.
Pour cela, SoundDiver comporte une fonction qui est similaire 
à la fonction de comparaison d’un synthétiseur.
Sélectionner Edit > Compare dans le menu local de la fenêtre 
Éditeur, le message “Original version” apparaît dans la Ligne 
d’Info. Si l’option du menu est cochée, vous entendez la version 
d’origine. En sélectionnant de nouveau Compare, vous entendez 
alors la version éditée. La ligne d’information sur le Macintosh 
(Windows : ligne de statut) indique alors “Edited version”.
Un message d’alerte apparaît, si vous essayez d’éditer la version 
originale. 

Si vous cliquez sur OK, vous détruisez la version éditée et conti-
nuez de travailler sur l’original. Si vous essayez d’éditer par 
erreur la version originale, pressez sur Cancel pour quitter la 
fonction.

Store (Mémoriser)
Sélectionnez cette option de menu lorsque vous voulez sauve-
garder le résultat de votre édition. La version éditée remplace 
alors l’original, qui est de ce fait perdu. Cette fonction corres-
pond à la fonction “Write” ou “Store” d’un synthétiseur.
& L’emplacement mémoire de l’entrée source est indiquée à la fin de la barre titre de 

la fenêtre éditeur. Si l’entrée source provient d’une bibliothèque, la barre titre 
indique “←Library”.

Cette option est la manière la plus rapide de réactualiser votre 
travail. 
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Si vous voulez juste garder une copie de la version éditée, il est 
préférable d’utiliser la fonction Snapshot (voir ci-dessous), qui 
permet de créer plusieurs versions sans avoir à remplacer 
l’entrée d’origine.

Store in… (Mémoriser dans)
Si vous souhaitez sauvegarder la version éditée dans un autre 
endroit sans fermer la fenêtre éditeur, sélectionnez alors Store 
in... Cette fonction est la même que la fonction Store sauf 
qu’un dialogue s’ouvre, où vous pouvez choisir un emplace-
ment différent.

Pour cela, ouvrez le menu local dans le dialogue par un clic 
maintenu puis sélectionnez un autre emplacement.

Si des entrées sont utilisés par une entrée parent (par exemple 
Performance ou Multi) vous serez averti par un signe figurant à 
droite.

Snapshot (Instantané)
SoundDiver permet de sauvegarder la phase actuelle de vos 
éditions à chaque fois que vous le souhaitez. Lorsque vous 
créez un instantané, le contenu du tampon d’édition sur lequel 
vous travaillez est ajouté à la Bibliothèque appelée Snapshots. 
Si elle n’est pas disponible, SoundDiver :

• la créera automatiquement ;

• si elle est disponible sur disque, elle sera chargée.

Cette fonction est extrêmement pratique dans les situations :

• vous aimez tellement le résultat de votre édition que vous 
voulez le garder.

• vous disposez de plusieurs variations d’un son édité et vous 
souhaitez trouver la meilleure d’entre elles.

• vous utilisez la fonction Randomize (création aléatoire) et 
vous souhaitez sauvegarder autant de versions que possibles.
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Lorsque vous quitter SoundDiver, la Bibliothèque de Snaps-
hots est automatiquement sauvegardée dans le dossier “Librai-
ries”. S’il n’est pas disponible, vous trouver ces instantanés 
dans le dossier “Librairies”.

Créer automatiquement des Snapshots 
Vous trouverez l’option Automatic Snapshots every x s dans les 
Préférences (Options > Settings > Global Preferences). C’est ici 
que vous déterminez le nombre de secondes. A ces intervalles 
réguliers, SoundDiver créera un instantané et l’ajoutera à sa 
Bibliothèque. Pour plus de détails, référez-vous au § Auto 
Snapshot Every x s (Instantané automatique toutes les x secondes) à la 
page 398.

Le Dialogue Autostore (Mémorisation 
automatique)
SoundDiver essaie de vous prévenir des perte accidentelles de 
vos éditions. Cette avertissement s’effectué à l’aide du dialo-
gue Autostore.

Il apparaît à chaque fois que :

• vous ouvrez un Éditeur après avoir édité un son ;

• vous êtes en train réécrire un emplacement mémoire et que 
l’option Overwrite memory Entries (Réécrire les entrées mémoires) 
est activée (dans Options > Settings > Safety Messages);

• vous êtes en train de réécrire un tampon d’édition qui n’a pas 
encore été sauvegardé et que l’option Overwrite edited Entries 
(Réécrire les entrées éditées) est activée (dans Options > Settings 
> Safety Messages);

• la position cible (lors d’un déplacement ou d’une copie) ne 
correspond pas au type d’entrée que vous êtes en train 
d’ajouter.

Vous alors les options suivantes :

Don’t store (Ne pas mémoriser)
ferme la fenêtre de l’éditeur sans mémoriser les éditions.
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Cancel (Annuler)
vous renvoie à l’éditeur.

Store (Mémoriser)
mémorise les éditions.

Si l’entrée éditée provient à l’origine d’une Bibliothèque, il y a 
d’autres options :

Entry in Library “library name”
remplace l’entrée d’origine

Add to the Library “library name”
ajoute l’entrée éditée à la fin de la Bibliothèque et garde
l’original intact.

Si vous avez déjà fermé la Bibliothèque la première option 
n’est plus disponible. SoundDiver vous donne alors la possibi-
lité d’ajouter l’édition dans la Bibliothèque active.

Initialize (Initialisation)
Cette fonction initialise soit un groupe de paramètres, soit une 
entrée entière. Vous devez tout d’abord sélectionner le groupe 
de paramètres pour qu’il soit ensuite initialisé. Pour plus de 
détails, référez-vous au § Fonctions Presse-papiers dans l’Éditeur à 
la page 314. S’il n’y a rien de sélectionner dans l’éditeur, 
l’entrée complète est initialisée, ce qui signifie que SoundDi-
ver réinitialise tous les paramètres à leur valeur d’origine.

Randomize
SoundDiver peut créer des valeurs aléatoires pour des groupes 
de paramètres sélectionnés, ce qui procure alors de l’inspiration 
en sons nouveaux ou pour introduire des variations encore 
inconnues.
Cela signifie que chaque paramètre d’un groupe est assigné à 
une valeur aléatoire.
Si rien n’est sélectionné, certains éditeurs vous permettent de 
sélectionner l’entrée entière, tous les paramètres de l’entrée 
complète sont programmés par des valeurs aléatoires.
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Cela produit des résultats qui sont, bien que toujours originaux, 
pas forcément utilisables.
Vous vous souvenez de la structure hiérarchique des groupes de 
paramètres ? Vous pouvez éditer n’importe quelle partie d’un 
son jusqu’à une simple enveloppe avec la fonction Randomize.

Find Controller Assignments
Si un paramètre est marqué (autrement dit si le curseur le fait 
clignoter), cette fonction ouvre la fenêtre Controller Assign-
ment et sélectionne toutes les assignations de contrôleurs qui 
ont ce paramètre pour destination. Voir le § Rechercher des Assi-
gnations de Contrôleurs à la page 336.

Learn New Controller Assignment
Cette fonction attribue une assignation de contrôleur au para-
mètre actif.

Cliquez tout d’abord sur le paramètre puis sélectionnez Edit > 
Learn new Controller Assignment.

Si vous appelez cette fonction par son raccourci clavier et que 
vous gardez la ou les touches mortes enfoncées, vous faites 
apparaître une Bulle d’Aide qui vous indique la marche à 
suivre. Voir le § Le Mode Learn à la page 344 pour les détails.

Le menu local View

Paramètres
La case des paramètres est masquée lorsque cette option est 
active. Voir le § La Case des Paramètres d’Appareil à la page 196 
pour plus de détails.

Link Window (Lier les fenêtres)
Lorsque cette option est active, SoundDiver modifie automati-
quement le contenu de la fenêtre Éditeur de façon à l’adapter 
au changement d’appareil actif ou du tampon d’édition actif.
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Vous pouvez ainsi alterner rapidement entre les différents 
tampons d’édition (Edit Buffers) d’un appareil en cliquant 
simplement dessus dans la fenêtre Device.

Si AutoAudition est activé, toute entrée sur laquelle vous 
cliquez s’affiche immédiatement dans la fenêtre Éditeur en 
même temps qu’elle est transmise à l’appareil. Cette fonction 
est particulièrement pratique pour des recherches au sein 
d’une bibliothèque mixte.

& Pour afficher plusieurs éditeurs à la fois, désactivez cette option avant d’ouvrir la 
fenêtre suivante.

Cette option existe également sous forme de bouton si les para-
mètres sont affichés.

Overview
Sert à désactiver l’affichage de l’Overview (vue d’ensemble) 
décrit ci-dessus. Naturellement, vous pouvez aussi revenir de 
l’Overview à la vue détaillée.

New Window
Voici une fonction extrêmement pratique : sélectionnez un 
groupe de paramètres puis sélectionnez View > New Window 
ans le menu local Editor. Ceci ouvre une nouvelle fenêtre 
d’édition comportant le groupe de paramètres dans sa section 
visible. Par exemple, vous pouvez “récupérer” l’enveloppe 
d’amplitude de l’éditeur en cours d’utilisation pour pouvoir 
continuer à l’éditer dans sa propre fenêtre. Vous pouvez alors, 
bien entendu, ajuster la taille de cette fenêtre et la position de 
sa section visible.

& La fonction “Lier les fenêtres” est automatiquement désactivée à la fois dans 
l’ancienne et dans la nouvelle fenêtre d’édition.

En sélectionnant New Window avec S (  : O), la nouvelle 
fenêtre s’ouvre sous la forme d’une fenêtre flottante.

Autres menus locaux
Certains éditeurs possèdent d’autres menus locaux.
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Adaptation
Ce menu apparaît dans les adaptations. Elles servent à définir 
et à modifier les objets d’un éditeur. La place manque dans le 
présent manuel pour une description détaillée des fonctions 
existantes mais vous trouverez cette description dans le manuel 
de programmation du module universel de SoundDiver 
(SoundDiver Universal Module Programming Manual). Ce manuel 
est disponible en téléchargement gratuit sur notre site web à 
l’adresse http://www.emagic.de.

Bien sûr, rien ne vous empêche d’expérimenter tous azimuts 
mais vous obtiendrez de meilleurs résultats en vous aidant de 
ce manuel de programmation. Une info utile : le mode 
“Layout” joue un rôle essentiel...

Range
Certains éditeurs disposent d’un menu local Range doté de 
sous-fonctions permettant de modifier l’accord ou d’éditer des 
tables de vélocité. Les voici.

Full Range

L’éditeur possède deux paramètres permettant de définir la 
limite inférieure et la limite supérieure du champ d’action à 
éditer, qu’il s’agisse par exemple de notes ou de vélocités.

La fonction Full range donne à ce champ d’action l’étendue 
totale des valeurs de la table.

Initialize

Initialise les valeurs comprises dans le champ d’action.

Mirror Vertically

Les valeurs comprises dans le champ d’action sont inversées : 
nouvelle valeur = maximum - ancienne valeur.

Mirror Horizontally

Les valeurs comprises dans le champ d’action pivotent autour 
du milieu de son étendue : la première valeur est échangée 
avec la dernière, la deuxième avec l’avant-dernière, etc.
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Interpolate

Provoque une interpolation linéaire entre les premières et les 
dernières valeurs comprises dans le champ d’action, ce qui 
donne une ligne droite.

Cela permet de créer facilement des accords de 1⁄4 ou de 1⁄8 de 
ton : par exemple, réglez la tessiture sur deux octaves (mettons 
de C2 à C4). Donnez à C2 la valeur C2 et la valeur C3 à C4. A 
présent, sélectionnez Interpolate et vous obtenez un accord 
d’un quart de tons.

Extrapolate

Les valeurs comprises dans le champ d’action sont poursuivies 
en dessous et au-dessus du champ d’action.

Autrement dit, il vous suffit de régler l’accord sur une seule 
octave pour pouvoir le transférer instantanément à toutes les 
autres octaves.

Autres menus
Vous trouverez d’autres menus, variables d’un module à l’autre. 
Consultez le fichier d’aide du module pour connaître leur signi-
fication 

8.18 Fermer la fenêtre Éditeur
Si vous fermez la fenêtre d’édition sans avoir enregistré votre 
travail auparavant, un dialogue apparaît. Vous pouvez y choisir 
d’enregistrer vos éditions, ainsi que l’emplacement de la sauve-
garde, ou décider de les abandonner.

Les options sont les suivantes :

Don’t Store (Ne pas mémoriser)
La fenêtre Éditeur se referme sans que les changements
soient enregistrés auparavant. Le tampon d’édition (Edit
Buffer) reste intact et vous pouvez le copier manuellement
dans la fenêtre Device vers l’emplacement désiré
(n’oubliez pas de maintenir S (  : O) sinon l’Edit Buffer
sera échangé avec l’emplacement de sauvegarde : voir le §
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Échanger, déplacer et copier des entrées avec la souris à la page
225).

Cancel (Annuler)
la fenêtre Éditeur reste ouverte

Store (Mémoriser)
Le tampon d’édition est sauvegardé à l’emplacement indi-
qué et la fenêtre Éditeur se referme.

Lorsque vous refermez un éditeur précédemment ouvert 
depuis une bibliothèque, les options sont les suivantes :

• Entry in Library xxx remplace l’entrée d’origine 

• Append to Library xxx rajoute l’entrée à la fin de la biblio-
thèque désignée, tout en conservant l’entrée d’origine.

& Si la bibliothèque d’origine a été refermée entre-temps, la première option n’est plus 
accessible.

& L’option “Append to library” s’applique toujours à la bibliothèque actuellement 
active, même si l’entrée éditée provient d’une autre bibliothèque.

8.19 Rappeler le contenu de la 
fenêtre Éditeur à la séance 
suivante

Si vous quittez SoundDiver alors qu’une fenêtre d’édition est 
ouverte, celle-ci apparaîtra vide à l’ouverture de la séance de 
travail suivante sur SoundDiver et le message “No data” s’affi-
chera jusqu’à ce que vous ayez sélectionné une entrée en 
faisant une requête, en initialisant l’entrée ou en copiant une 
entrée dans l’éditeur.

Si vous préférez que SoundDiver rétablisse automatiquement 
le contenu de la fenêtre, sélectionnez all pour l’option de Préfé-
rences Save Device entries in preferences file. Voir également le § 
Save Device Entries in Preferences File (Sauvegarder les Entrées 
d’Appareils dans le Fichier Préférences) à la page 397.
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Les Assignations de 
contrôleurs

Grâce aux Assignations de Contrôleur, SoundDiver peut asso-
cier les messages reçus à n’importe quel objet de paramètre, à 
l’intérieur d’une fenêtre d’édition.

Ceci vous permet de contrôler totalement les paramètres à 
distance et de modeler les sons très facilement.

La connexion entre les messages MIDI reçus et un objet 
SoundDiver s’effectue dans la fenêtre d’Assignations de 
Contrôleurs.

9.1 Qu’est-ce qu’une 
assignation de contrôleur ?

Le flux des messages MIDI ainsi que le traitement interne sont 
décrits dans le schéma suivant. 

Chapitre 9
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Premier exemple d’Assignation d’un 
Contrôleur
Supposons que vous ayez un pupitre Motor Mix connecté à 
l’ordinateur, que vous ayez configuré SoundDiver en rapport et 
défini quelques assignations de contrôleurs dont un contrôle la 
vitesse du LFO dans l’EX5.

Si vous bougez maintenant un fader sur le pupitre Motor Mix, 
cela envoie un message de contrôleur 1. SoundDiver recher-
che alors l’assignation de contrôleur correspondante 2 et loca-
lise le paramètre qu’elle contrôle. Le message de contrôleur est 
converti en événement de changement de paramètre 3 qui 
change la valeur de la vitesse du LFO 4. Le message de chan-
gement de paramètre correspondant est maintenant transmis à 
l’appareil (ici un EX5) via un message de changement de para-
mètre MIDI 5. Au même instant, l’écran LCD du pupitre 
Motor Mix affiche le nom et la valeur actuelle du paramètre 
contrôlé, ce qui s’effectue par les commandes SysEx 6. Donc, 
vous n’avez même pas à regarder l’écran de l’ordinateur.

1

2

3

4
5

6
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Cependant si vous changez un paramètre dans la fenêtre 
d’édition 1, SoundDiver recherche également l’assignation de 
contrôleur correspondant 2 et transmet la mise à jour de l’affi-
chage ainsi que les messages de retransmission de faders moto-
risés vers le pupitre Motor Mix 3 en même temps que le 
message de changement de paramètre vers l’EX5 4.

Comme vous le voyez, il y a toujours deux parties fixes dans la 
fenêtre d’Assignation de Contrôleur:

• Le message MIDI reçu, contrôlant et

• L’Assignation de Contrôleur créée pour un appareil et ses 
paramètres.

Les changements effectués sur un appareil ou à l’intérieur 
d’une fenêtre d’édition sont renvoyés vers le pupitre de 
commande MIDI, de façon à ce que la valeur et le fader moto-
risé de le pupitre de commande MIDI soient synchronisés. 
SoundDiver prend lui-même cet aspect en charge.

1

2

3

4
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Caractéristiques des Assignations de 
Contrôleurs
Une Assignation de Contrôleur est une connexion entre 
n’importe quel message MIDI reçu et un objet d’éditeur. Deux 
actions sont donc requises pour définir une Assignation de 
Contrôleur:

• Définir le message de contrôleur reçu sur lequel SoundDiver 
doit réagir et

• Définir le paramètre contrôlé.

SoundDiver offre une grande souplesse dans le processus 
d’assignation, car différents messages d’assignation de contrô-
leur peuvent être affectés à un seul paramètre. Par exemple, un 
paramètre ayant de nombreuses valeurs possibles peut être 
piloté par un fader pour un contrôle grossier, par un encodeur 
pour un contrôle fin et par deux boutons pour de simples 
augmentations et diminutions.

D’ autre part, le même message MIDI peut contrôler de multi-
ples paramètres. Par exemple, vous pouvez utilisez un fader 
pour contrôler le filtre VCF de tous les Tones ou Partiels.

Il n’existe aucune limite au nombre de création des assigna-
tions de contrôleur. Créez-les par un glisser-déposer, manuelle-
ment ou en utilisant la fonction Learn (voir le § Le Mode Learn 
à la page 344). Les assignations de contrôleur peuvent être 
créées pour les paramètres de l’Easy Page, mais aussi depuis 
l’affichage détaillé dans une fenêtre d’édition.

Les messages d’assignation de contrôleur sont traités même si 
l’appareil n’est pas l’appareil actif ou qu’aucune fenêtre 
d’édition contenant le paramètre contrôlé n’est ouverte, sauf si 
vous avez activé l’option Requires Editor window (voir le § Requi-
res Editor Window à la page 342). 
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Modules pour “Fader Box”
Pour certains pupitres de faders, il existe des modules Sound-
Diver dédiés qui offrent des fonctions avancées pour les assi-
gnations de contrôleur:

• Inscription automatique des assignations de contrôleur 
actives dans l’affichage à cristaux liquides de le pupitre de 
commande MIDI 

• Retransmission de faders motorisés : Les changements 
effectués à l’intérieur d’une fenêtre d’édition (qui peuvent 
aussi provenir de la réception d’un message de changement 
de paramètre) sont renvoyés vers le pupitre de commande 
MIDI, de façon à ce que la valeur du paramètre soit synchro-
nisée avec la position du fader motorisé du pupitre.
Ceci fonctionne également pour les encodeurs avec une ring 
de LED, les potentiomètres rotatifs motorisés, les boutons 
rétro-éclairés etc...

• Pendant que vous contrôlez un paramètre à distance, l’écran 
du pupitre de commande MIDI affiche le nom et/ou la 
valeur de ce dernier. Vous n’avez donc pas besoin de 
consulter l’écran de l’ordinateur lorsque vous utilisez le 
pupitre de commande MIDI.

• Définition simple de l’assignation de contrôleur grâce au 
glisser-déposer (voir l’exemple ci-après).

• Recherche facile des assignations de contrôleurs définies 
pour un certain contrôleur.

Pour plus de détails, voir le § Modules “Fader Box” à partir de la 
page 346 et suivantes.

Si vous disposez d’un pupitre de commande MIDI qui n’est 
pas reconnu par un module SoundDiver, vous pouvez toujours 
utiliser les assignations de contrôleurs. Voir le § Le Mode Learn à 
la page 344.
331
Mode d’Emploi
Version 3.0



 – Les Assignations de contrôleurs
Exemple de création d’une Assignation de Contrôleur
Cet exemple va vous expliquer comment utiliser les assigna-
tions de contrôleur, et plus particulièrement les avantages de la 
création par glisser-déposer, possible seulement avec les modu-
les Fader Box. Vous n’avez pas besoin d’avoir un des pupitres 
de faders reconnus, mais vous avez par contre besoin d’un appa-
reil avec un contrôleur (molette de modulation, fader, bouton 
etc.), c.a.d. qui envoie des messages MIDI. 
❏ Ouvrez la fenêtre d’édition de votre appareil avec vue

détaillée (un EX5 dans cet exemple)
❏ Installez “manuellement” l’appareil “Motor Mix” dans la

fenêtre Install (fabriquant “CM Automation”).
❏ Ouvrez la fenêtre Setup. Vous devez maintenant définir

manuellement les ports d’entrées et sorties MIDI (ceci doit
être fait manuellement, car les pupitres Motor Mix ne peu-
vent être identifiés par la fonction Scan). Si vous n’avez pas
de console de pupitre Motor Mix, réglez les ports MIDI de
l’appareil mentionné ci-dessus.
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❏ Ouvrez la fenêtre d’édition de cet appareil en double-cli-
quant sur l’icône “Motor Mix” dans la fenêtre Setup.

❏ Ouvrez la fenêtre d’assignation de contrôleur en choisissant
Window > Open Controller Assigns.

❏ Disposez les trois fenêtres à l’écran comme dans l’illustra-
tion ci-dessus.

❏ Puis, cliquez-maintenez un fader du pupitre Motor Mix (le
pointeur de la souris devient une prise), déplacez-le vers le
paramètre de votre choix à l’intérieur de la fenêtre d’édi-
tion. Un câble de connexion apparaîtra tant que vous main-
tenez le bouton de la souris. Les objets “connectables”
apparaîtront inversés quand le curseur passera dessus.
Relâchez le bouton de la souris lorsque le pointeur est au-
dessus d’un objet.

❏ Dans la fenêtre d’assignation de contrôleur, vous verrez
une première zone qui affiche le nom du fader à gauche,
avec le nom du paramètre assigné au milieu et le message
MIDI correspondant à droite.

Si vous avez un pupitre Motor Mix, vous obtenez satisfaction 
immédiatement : bougez le fader et le paramètre change. 
Changez le paramètre avec la souris, et le fader bouge.

Dans le cas contraire, vous devez changer le message (MIDI 
In), pour que le message de notre appareil soit reconnu.

❏ Cliquez sur le bouton Learn Message sous la case de paramè-
tre, et quand il devient bleu, bougez le contrôleur de votre
appareil.

❏ Finissez en cliquant sur le bouton Learn Message à nou-
veau. Le bouton redevient gris.

❏ Actionnez ensuite le potentiomètre ou le fader de votre
appareil et il contrôlera le paramètre choisi.
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9.2 Terminologie
Pour faciliter la compréhension des Assignations de Contrôleur 
dans SoundDiver, nous utilisons les termes suivants:
Assignation de contrôleur

Comme déjà décrit c’est un réglage qui définit le contrôle
à distance d’un paramètre.

Pupitre de commande MIDI (Fader Box)
Appareil qui transmet des messages MIDI et donc justifie
une assignation de contrôleur. Un pupitre de commande MIDI
peut également être n’importe quel type de clavier MIDI,
car la molette de modulation ou même le clavier peuvent
également être utilisés pour des assignations de contrôleur. 

Contrôleur
Commande d’un pupitre de commande MIDI qui génère un
message MIDI donné. Ce peut être un curseur, un poten-
tiomètre rotatif, un bouton, un encodeur, une molette de
Jog, un contrôleur à ruban, etc.

Message de contrôleur
Message MIDI généré par un contrôleur. Souvent un messa-
ge de contrôleur contient un ou plusieurs octets variables.
SoundDiver reconnaît non seulement les messages Control
Change (Bxxx xx), mais également n’importe quel type de
message MIDI, y compris les SysEx. Un message de contrô-
leur peut consister en de multiples messages MIDI (ex: des
messages Control Change MSB et LSB successifs).

Valeur entrante
Valeur transmise à l’intérieur même du message de contrôleur
reçu.

Valeur résultante
Valeur calculée à partir d’une valeur entrante, utilisant divers
calculs, basés sur les propriétés de l’assignation du contrôleur
et du paramètre contrôlé. La valeur résultante deviendra la
nouvelle valeur du paramètre contrôlé.

Paramètre contrôlé
Paramètre d’un éditeur SoundDiver qui peut être contrôlé
via une assignation de contrôleur.
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9.3 Fenêtre d’assignation de 
contrôleurs

La fenêtre d’assignation des contrôleurs ressemble quelque 
peut à la fenêtre Bibliothèque et comporte deux parties :

• La section des données avec toutes les assignations de con-
trôleur et

• La case des paramètres

Les données à l’intérieur de la fenêtre 
d’Assignation de contrôleurs
La fenêtre d’Assignation de Contrôleur s’ouvre par Windows > 
Open Controller Assigns.
Comme il n’y a qu’un tableau, il n’y a également qu’une seule 
fenêtre d’assignation de contrôleur.

Maniement des assignations de contrôleurs
Les assignations de contrôleurs sont traitées comme tous les 
autres objets “éditables” de SoundDiver. Elles se sélection-
nent via les opérations habituelles. Reportez-vous au § Sélec-
tionner des entrées à la page 137 si vous avez besoin d’aide.
Double-cliquer sur une assignation de contrôleur ouvre la fenê-
tre d’édition et indique le paramètre contrôlé par l’assignation 
de contrôleur.
Chaque étape peut être annulée grâce à la fonction Undo (voir le 
§ Undo… (Annuler) à la page 145) et vous pouvez couper, copier, 
coller et effacer toutes les assignations de contrôleurs selon les 
méthodes habituelles (voir le § Le menu Edit (Édition) à la page 
145).

Le Menu Local d’Assignation
Le menu local Assignment a trois sous-menus.
New

Ce sous-menu offre plusieurs options pour créer de nouvelles 
assignations de contrôleurs.
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• Empty Assignment
Permet d’insérer une nouvelle assignation de contrôleur 
vierge au-dessus de la première sélectionnée.

• Tous les autres sous-menus servent à créer des assignations de 
contrôleurs pour commander à distance la configuration 
d’assignations de contrôleurs. Pour les détails, voir le § Assi-
gnations de Contrôleurs prédéfinies à partir de la page 352 et 
suivantes.

Show controlled parameter

SoundDiver ouvre la fenêtre d’édition correspondante et indi-
que le paramètre. Double-cliquer aura le même effet.
Learn Message

Ce sous-menu offre la même fonction que le bouton intégré à la 
fenêtre d’Assignations de Contrôleurs (§ Le Mode Learn dans la 
Fenêtre d’Assignation de Contrôleurs à partir de la page 344 et 
suivantes).

Rechercher des Assignations de Contrôleurs
Comme vous pouvez créer autant d’Assignations de Contrô-
leurs que vous le désirez, il risque d’en exister un grand 
nombre. Nous vous offrons donc une solution pour les repérer.

Vous pouvez rechercher les Assignations de contrôleurs en 
partant des “deux cotés”, et à l’intérieur même de la fenêtre 
d’Assignations de Contrôleurs.

• Double-cliquer sur un contrôleur dans la fenêtre d’édition 
Fader Box ouvre la fenêtre d’Assignation de Contrôleurs, et 
sélectionne toutes les Assignations de Contrôleurs associées 
au contrôle choisi.

• Dans une fenêtre d’édition, cliquez sur un paramètre contrôlé 
par l’Assignation de Contrôleur désirée, et sélectionnez Edit > 
Find Controller Assignments. La fenêtre d’Assignation de 
Contrôleurs s’ouvrira et toutes les Assignations de Contrô-
leurs associées au paramètre seront sélectionnées.

• Dans la fenêtre d’Assignations de Contrôleurs, cliquez sur 
une assignation de Contrôleur, et vous pourrez visualiser 
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tous les paramètres qui la constitue, y compris l’appareil 
contrôlé et ses paramètres, aussi bien que le message d’Assi-
gnation de contrôleur et l’entrée MIDI ou il doit être reçu.

Paramètres d’une Assignation de Contrô-
leur
La case des Paramètres peut être masquée/affichée avec View > 
Parameters.

Nom
Le nom figurant tout en haut est celui du paramètre contrôlé. 
Ce n’est que pour information, et c’est celui affiché dans la 
liste. Quand une nouvelle Assignation de Contrôleur est créée, 
SoundDiver affiche le nom du paramètre contrôlé par défaut.
Le nom peut être édité comme du texte en l’ouvrant par un 
double-clic. Toutes les fonctions d’édition de texte sont dispo-
nibles (reportez-vous au § Saisir du texte à la page 129).
Vous pouvez ajouter du texte à plusieurs Assignations de 
Contrôleurs en tapant d’abord un astérisque (*), puis le texte 
même (voir le § Ajouter du texte à plusieurs entrées à la page 257).

Input
Le message de contrôleur doit arriver sur le port MIDI in spéci-
fié, à moins de l’avoir configuré sur “any”.

SoundDiver assigne automatiquement le port, quand le 
message de contrôleur est défini par la fonction Learn.

Pour définir le port manuellement, cliquez sur le paramètre et 
sélectionnez le port désiré à partir du menu local (voir le § Ports 
de Sortie et d’Entrée à la page 197).

Message
C’est une option du message de contrôleur MIDI, reconnu par 
l’Assignation de Contrôleur. Toutes les valeurs sont affichées 
en hexadécimal.
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Deux octets spéciaux peuvent être contenus dans cette chaîne : 
Hi7 (pour “les 7 bits de poids fort ou MSB”) et Lo7 (pour “les 7 
bits de poids faible ou LSB”).

La façon dont sont calculées la valeur entrante et la plage de 
valeurs dépend de l’octet spécial présent dans le message :

• Si à la fois Hi7 et Lo7 sont présents, la valeur entrante sera Hi7 
x128 + Lo7, et la plage de valeurs sera de 14 octets (0 à 16383 
ou -8192 à 8191, selon que le format est avec ou sans signe).

• Si seulement Lo7 est contenu dans la chaîne du message de 
contrôleur, la valeur entrante égalera Lo7, et la plage de 
valeurs sera de 7 octets (0 à 255 ou -128 à 127, selon que le 
format est avec ou sans signe).

• Si la chaîne du message reçu ne contient ni Hi7 ni Lo7, la 
valeur entrante devient 1 par défaut, et la plage de valeurs 1 
octet.

& Vous pouvez utiliser cette option si le message reçu généré par l’appui d’un bouton 
n’envoie pas la valeur 1.

En utilisant le mode Learn (voir le § Le Mode Learn à la page 344), 
SoundDiver inscrit la chaîne du message reçu alors même qu’il 
s’enregistre.

& Vous pouvez copier un message MIDI entre Assignations de Contrôleurs grâce au 
presse-papiers.

Le format du message utilise les termes “Hi7” pour les parties 
MSB et “Lo7” pour les parties LSB de ce dernier. Ceci empêche 
le mélange des événements de Contrôleur MSB et LSB.

& Si un contrôleur n’envoie que la portion MSB d’un message de Control Change, il 
est préférable d’utiliser l’octet Lo7, pour qu’une série de 7 octets puisse être créée.

Lo7 min/Lo7 max
Ces deux paramètres limitent l’étendue des valeurs possibles 
de l’octet Lo7. Le message n’est reconnu pour l’Assignation de 
Contrôleur, qu’a condition d’être dans ces limites. Servez-vous 
de cette possibilité si un pupitre de commande MIDI utilise le 
même message pour deux contrôleurs, mais avec des valeurs de 
paramètres différentes. 
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& Si la valeur du message reçu est constante (ex: pour les boutons), vous pouvez 
simplement inscrire la valeur du message à la place de Lo7. Dans ce cas, il est inutile 
d’ajuster Lo7 min et Lo7 max.

Format
Ce paramètre définit la façon dont la valeur entrante est 
extraite à partir des octets du message reçu représenté par Lo7 
et Hi7 :

Unsigned
La valeur est toujours traitée comme positive.

2’s complement
Si l’octet de poids fort est fixé (à Lo7 c’est l’octet 6, à Hi7/
Lo7 c’est l’octet 13), la valeur est considérée comme valeur
négative avec un format de second complément (2’s com-
plement).

1’s complement
Si l’octet de poids fort est fixé (à Lo7 c’est l’octet 6, à Hi7/
Lo7 c’est l’octet 13), la valeur est considérée comme valeur
négative avec un format de premier complément (1’s com-
plement).

Sign Magnitude
Si l’octet de poids fort est fixé (à Lo7 c’est l’octet 6, à Hi7/
Lo7 c’est l’octet 13), la valeur est considérée comme valeur
négative. Les octets restants contiennent la valeur absolue.

Factor
Le facteur définit une valeur par laquelle est multipliée la 
valeur entrante avant que ne soit calculée la valeur résultante, 
selon le mode choisi (voir ci-dessous).

Quand le mode direct est utilisé, le facteur peut définir une 
valeur résultante constante. Avec le mode relatif, le facteur peut 
modifier l’échelle et la polarité.

Il est également possible de spécifier un facteur négatif. Avec 
l’aide du mode relatif, vous pouvez définir des Assignations de 
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Contrôleurs qui diminuent la valeur d’un paramètre d’un cran à 
la fois, en inscrivant -1.00 à cet endroit.

La résolution est de 1⁄100. Ceci vous permet d’ajuster la résolu-
tion des encodeurs. Si un encodeur “travaille” trop rapidement, 
réglez simplement le facteur sur 0.5.

Mode
Le paramètre “mode” détermine la façon dont la valeur 
entrante est convertie en valeur résultante.

Direct
La valeur entrante détermine directement la valeur résul-
tante.

& Utilisez cette option si le message est généré par des boutons (le message ne 
contient donc pas de variables), et que le paramètre contrôlé a des valeurs discrètes 
et non-linéaires (ex : les formes d’ondes du LFO). La valeur réellement choisie peut 
être déterminée par le paramètre Factor (voir le § Factor à la page 339).

Scaled
La valeur entrante est étalonnée d’après sa plage de valeurs
pour donner celle du paramètre sélectionné.

& En bougeant ou en tournant le contrôleur sur sa position maximale, le paramètre 
contrôlé atteindra également sa valeur maximale, et vice-versa pour les valeurs mini-
males. Utilisez cette option seulement pour les contrôleurs disposant de valeurs mini-
males et maximales. Ex : les faders et potentiomètres rotatifs.

Relative
La valeur entrante est ajoutée à la valeur actuelle du para-
mètre (ou soustraite, voir le § Factor à la page 339).

& Essayez ce réglage pour les encodeurs rotatifs et pour les boutons destinés à 
augmenter ou diminuer la valeur d’une certaine quantité.

Device
Ce champ définit l’appareil pour lequel l’assignation de contrô-
leur est valable.

Si la valeur est any, le message d’assignation de contrôleur est 
toujours envoyé au paramètre “pointé” de l’appareil actif (si 
une fenêtre d’édition est ouverte et qu’un curseur clignote).
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La valeur Controller Assignement Set signifie que l’Assignation de 
Contrôleur ne contrôle pas un paramètre dans un appareil, mais 
la Configuration d’Assignation de Contrôleur. Pour plus de 
détails, voir le § Contrôle à Distance de la Configuration d’Assigna-
tion de Contrôleur en cours à partir de la page 351 et suivantes.

Data Type
Sélectionne le type de donnée pour lequel l’Assignation de 
Contrôleur est valable.

Si Device est sur any, le type de donnée est toujours any, et ne 
peut être changé.

Quand Device est sur Controller Assignement Set, ce paramètre n’a 
aucune signification.

Entry
Ceci définit l’entrée pour laquelle l’Assignation de Contrôleur 
est valable.

Vous pouvez la fixer sur any pour permettre à l’Assignation de 
Contrôleur de toujours s’appliquer à l’entrée actuellement 
éditée. Si Device ou Data Type sont réglés sur any, Entry est 
également réglé sur any.
& La valeur any vous permet de définir une Assignation de Contrôleur qui dépend du 

tampon d’édition actif. C’est utile pour les appareils multitimbraux dotés de tampons 
d’édition “adressables” séparément, comme le Roland JV-2080 : Vous pouvez créer 
une Assignation de Contrôleur qui modifie le filtre VCF du premier “Tone” dans un 
Patch. C’est le tampon d’édition actif qui déterminera lequel des 16 Patches de 
“Performance Mode Temp Patches” sera concerné. 

Quand Device est sur Controller Assignement Set, ce paramètre n’a 
aucune signification.

Memory Offset/LS Bit
Ces deux paramètres définissent le paramètre contrôlé au sein 
d’un tampon d’édition. Les chiffres sont peu parlants, car ils 
dépendent de la structure interne des données du tampon 
d’édition. Comme ils sont automatiquement déterminés par un 
glisser-déposer ou par la fonction Learn, cela ne devrait poser 
aucun problème.
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La raison de leur présence à cet endroit est que vous pouvez 
régler l’offset-mémoire (Memory Offset) sur any (réglez sur la 
plus basse valeur possible pour cela), pour permettre à l’Assi-
gnation de Contrôleur de toujours s’appliquer au paramètre de 
curseur actuel (tant qu’une fenêtre d’édition est active et que le 
curseur clignote).

Si le paramètre Device est réglé sur Controller Assignment Set, ces 
paramètres (Memory Offset et LS Bit) prennent un sens totale-
ment différent. Voir le § Contrôle à Distance de la Configuration 
d’Assignation de Contrôleur en cours à partir de la page 351 et 
suivantes.

Controller name
C’est le nom du fader ou du contrôle, affiché dans la liste, pour 
repérer plus facilement une Assignation de Contrôleur.

Short name
C’est une forme abrégée du nom de paramètre, utilisée par les 
modules “Fader Box”, pour être affichée dans l’écran du pupi-
tre de commande MIDI (voir le § Modules “Fader Box” à la page 
346).

Lorsqu’une Assignation de Contrôleur est créée par le biais du 
Glisser-déposer ou de la fonction Learn, l’abréviation du nom 
est automatiquement créée à partir du nom du paramètre, le 
nombre de caractères étant restreint à l’espace disponible dans 
l’écran LCD du pupitre de commande MIDI.

Requires Editor Window
Si cette option est validée, l’Assignation de Contrôleur n’est 
active que si la fenêtre d’édition correspondante est ouverte et 
au premier plan. Ce réglage est utile pour éviter des change-
ments indésirables dans l’affichage situé à l’arrière plan.

Ceci vous permet aussi d’envoyer un message contenant un 
même contrôleur aux paramètres de différents appareils ou 
tampons d’édition, qui se commuteront automatiquement 
quand vous ouvrirez les fenêtres d’édition appropriées.
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& Si cette option est désactivée, l’Assignation de Contrôleur reste active, peu importe 
que la fenêtre d’édition soit active ou même ouverte. Même l’appareil contenant le 
paramètre contrôlé n’a nul besoin d’être actif. Les données du tampon d’édition 
doivent cependant avoir été reçues.

Feedback
Ceci détermine si le fait de changer le paramètre contrôlé par 
l’Assignation de Contrôleur doit générer une retransmission 
vers le pupitre de commande MIDI.

& Cette fonction n’est actuellement exécutable que pour les Messages de Contrôleurs 
provenant d’un pupitre de commande MIDI reconnu par un module Fader Box (voir 
le § Modules “Fader Box” à partir de la page 346 et suivantes).

Local Feedback
Pour les Assignations de Contrôleurs qui transmettent le feed-
back (voir ci-dessus), vous pouvez en activant cette option, 
définir si le contrôleur doit afficher la valeur en cours simple-
ment en l’actionnant. C’est généralement le cas pour les faders 
à moteur mécanique. Ainsi, la transmission du feedback n’est 
nécessaire que quand le paramètre est modifié sur l’écran de 
l’ordinateur.

& Cette fonction n’est actuellement exécutable que pour les Messages de Contrôleurs 
provenant d’un pupitre de commande MIDI reconnue par un module Fader Box (voir 
le § Modules “Fader Box” à partir de la page 346 et suivantes).

Si cette option est désactivée par erreur, cela se manifeste 
souvent par une résistance mécanique lors des mouvements 
avec les faders motorisés.

Controller Assignment Set
Ce paramètre détermine dans quelle Configuration l’Assigna-
tion de Contrôleur est active. Pour de plus amples détails, lisez 
le § Configurations d’Assignations de Contrôleurs à partir de la page 
349 et suivantes.
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9.4 Le Mode Learn
Grâce au mode “Learn”, la création et la modification des Assi-
gnations de Contrôleurs sont grandement simplifiées. Sound-
Diver peut entrer le message de contrôleur et certains autres 
paramètres d’une Assignation de Contrôleur en analysant le 
flux des données à l’entrée MIDI.

Caractéristiques du Mode Learn
Le mode Learn à les caractéristiques suivantes :

• Reconnaissance des octets Lo7 et Hi7,

• Reconnaissance des encodeurs transmettant des valeurs 
relatives (de tels appareils envoient parfois la même valeur 
par la suite),

• Reconnaissance des encodeurs utilisant le format “Sign-
Magnitude”,

• Suppression automatique des messages indésirables ex : 
messages de Touch/Release pour les faders motorisés).

& “Lo7 Min ” et “Lo7 Max ” ont toujours les valeurs par défaut 0 et 127. Cela pourrait 
causer des problèmes dans le cas rare où deux contrôles utilisent le même message, 
autre que la plage des valeurs, mais s’avère plus utile pour assigner des faders ou des 
boutons, car vous n’avez pas à bouger le contrôle sur son étendue totale.

Pour que la reconnaissance automatique des paramètres cités 
plus haut fonctionne correctement, vous devez actionner la 
commande dans les deux sens et si possible sur toute son éten-
due.
Si aucune Assignation de Contrôleur n’est sélectionnée lors de 
l’activation du mode “learn”, une nouvelle assignation est auto-
matiquement créée. Sans cela, le message reçu remplacerait 
le(s) précédent(s) dans toutes les Assignations de Contrôleurs 
sans prévenir. 

Le Mode Learn dans la Fenêtre d’Assigna-
tion de Contrôleurs
Sélectionnez la ou les Assignation(s) de Contrôleur(s) dont 
vous souhaitez modifier le message MIDI.
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Activez ensuite le bouton Learn Message, bougez un contrôle (si 
possible lentement et dans les deux sens), puis désactivez le 
bouton.

& N’oubliez pas de quitter le mode Learn après avoir envoyé les messages.

Si aucun message MIDI n’a été reçu par SoundDiver, l’Assi-
gnation de Contrôleur est supprimée, car les Assignations de 
Contrôleurs contenant des messages vides sont inutilisables.

Le Mode Learn dans les Fenêtres Éditeur
De nouvelles Assignations de Contrôleurs peuvent être créées 
à partir d’une fenêtre d’édition, sans même ouvrir la fenêtre 
d’Assignation des Contrôleurs.

Le Mode Learn avec ouverture de la Fenêtre 
d’Assignation des Contrôleurs.
Ouvrez une fenêtre d’édition et cliquez sur un paramètre. 
Sélectionnez Edit > Learn New Controller Assignment. La fenê-
tre d’Assignation des Contrôleurs s’ouvre, la nouvelle Assigna-
tion de Contrôleur est alors sélectionnée.

& N’oubliez pas ! A ce stade, seul un coté de l’Assignation de Contrôleur est défini. Le 
message d’Assignation de Contrôleur doit être déterminé maintenant.

Le mode Learn est maintenant activé. Actionnez le contrôleur 
désiré (si possible dans les deux sens), puis refermez le Mode 
Learn.

Le Mode Learn sans ouverture de la Fenê-
tre d’Assignation des Contrôleurs
Pour rendre la création de nouvelles Assignations de Contrô-
leurs encore plus simple, il existe un raccourci-clavier :

Comme ci-dessus, sélectionnez Edit > Learn New Controller 
Assignment, mais en maintenant une touche morte. Le plus 
simple est d’utiliser la touche Commande tout en maintenant 
appuyé e la touche morte associée à la touche Commande.
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Tandis que vous maintenez toujours la touche morte enfoncée, 
une Bulle d’Aide apparaît (voir le § Les Bulles d’Aide à la page 
177), expliquant les étapes à suivre (affichez le message en 
bougeant/tournant le contrôle, puis relâchez la touche morte.

Quand vous relâchez la touche morte, une nouvelle Assignation 
de Contrôleur est créée, et vous pouvez immédiatement 
bouger le contrôle pour télécommander le paramètre.

Si vous relâchez la touche morte avant qu’un message ne soit 
enregistré, la fenêtre d’Assignation des Contrôleurs s’ouvrira et 
vous obtiendrez des instructions dans la Bulle d’Aide sur la 
façon de terminer la procédure Learn (désactiver le bouton 
Learn Message dans la fenêtre d’Assignation des Contrôleurs).

9.5 Modules “Fader Box”
SoundDiver offre des caractéristiques d’Assignation de Contrô-
leurs avancées grâce à l’aide de modules spécifiques. Actuelle-
ment, il existe deux de ces modules qui gèrent les pupitres CM 
Automation Motor Mix et les SAC-2k de Radikal Technologies.

Les modules “Fader Box” simplifient la création des Assigna-
tions de Contrôleurs et leur usage.

Fenêtres d’édition “Fader Box”
Double-cliquez sur l’icône d’un “Fader Box” dans la fenêtre 
Setup. La fenêtre d’édition s’ouvrira et affichera la façade du 
pupitre de commande MIDI.

Si vous inscrivez du texte dans la page, il sera immédiatement 
envoyé vers l’appareil.

C’est à peu près tout ce que vous pouvez “éditer” ici. Cette 
fenêtre a en fait une utilité différente de celle à laquelle vous 
êtes habitué avec les fenêtres d’édition :
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Définir des Assignations de Contrôleurs par Glisser-
Déposer
Pour définir une nouvelle Assignation de Contrôleur, cliquez 
sur et maintenez un objet de contrôleur dans la fenêtre 
d’édition “Fader Box” (fader, potentiomètre, bouton etc.), et 
déplacez-le vers le paramètre devant être contrôlé (situé dans 
une autre fenêtre d’édition). Le pointeur de la souris se trans-
forme en connecteur.

Dès que le pointeur de la souris atteint le paramètre, il apparaît 
“inversé”. Quand vous relâchez le bouton de la souris, une 
nouvelle Assignation de Contrôleur est créée dans la fenêtre 
d’Assignation des Contrôleurs.

Rechercher des Assignations de Contrôleurs
Un double-clic sur un objet dans la fenêtre d’édition “Fader 
Box” ouvre la fenêtre d’Assignations des Contrôleurs, et sélec-
tionne la ou les Assignation(s) de Contrôleur(s) associée(s).

Étiquetage automatique
Si vous utilisez un contrôleur qui est directement situé à coté 
de l’affichage du “Fader Box” dans une Assignation de Contrô-
leur, son abréviation (voir le § Short name à la page 342) s’inscrira 
automatiquement sur l’affichage.

En fonction de la résolution de l’écran, cela s’affichera sur deux 
lignes : les contrôleurs de nombres impairs seront inscrits sur la 
première ligne, et ceux de nombres pairs sur la seconde.

Vous pouvez changer le nom de l’étiquette en éditant simple-
ment le paramètre de texte Short Name.

Lorsque vous changez l’assignation d’un contrôleur, par exem-
ple en rappelant une Configuration d’Assignation de Contrô-
leur (voir le § Configurations d’Assignations de Contrôleurs à partir 
de la page 349 et suivantes),le nom est automatiquement mis à 
jour. Les noms de contrôleurs actuellement inutilisés sont 
supprimés.
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& Si un contrôleur agit sur plusieurs paramètres de noms différents, seul le nom de 
cette Assignation de Contrôleur est affiché, tout à fait en bas de la liste.

Feedback (Retransmission)
Les modules “Fader Box” gèrent deux types de retransmission 
vers les pupitres de faders : les retransmissions de faders moto-
risés et d’affichage.

Retransmission de Faders Motorisés
A chaque fois qu’un paramètre change, pour lequel il existe une 
Assignation de Contrôleur utilisant un fader motorisé (ou un 
autre contrôle qui affiche la valeur du paramètre), SoundDiver 
envoi un message MIDI qui repositionne le fader motorisé 
selon de la valeur en cours.

C’est également le cas quand la totalité du tampon d’édition 
change (ex. en utilisant AutoAudition) ou que les Assignations 
de Contrôleurs actives sont remplacées, par exemple en rappe-
lant une configuration d’écran.

Bien sur, plusieurs faders motorisés (même provenant de 
plusieurs pupitres de faders) peuvent être assignés au même 
paramètre. Dans ce cas, tous les faders motorisés sont mis à 
jour.

C’est même le cas lorsque le changement de paramètre est dû 
à une Assignation de Contrôleur. Pour éviter toute résistance 
mécanique, aucune retransmission n’est envoyée vers le fader 
motorisé associé (voir aussi le § Local Feedback à la page 343).

& Si un fader motorisé est assigné à plusieurs paramètres, ayant chacun différentes 
valeurs, le fader motorisé affichera toujours le dernier changement de valeur de 
paramètre. Si plusieurs de ces paramètres changent simultanément (ex. via AutoAu-
dition) la valeur affichée ne pourra alors être déterminée.

Retransmission de l’Affichage
Dans SoundDiver, quand un paramètre est modifié à cause 
d’un message de contrôleur reçu (peu importe qu’il provienne 
d’un fader motorisé ou d’un contrôleur normal), le nom et la 
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valeur du paramètre s’affichent sur l’écran du pupitre de 
commande MIDI pendant deux secondes.

& Pour les paramètres utilisant du texte pour afficher les valeurs de paramètres (ex. les 
sélections de formes d’onde ou d’échantillons), même ce texte est affiché par le 
pupitre de commande MIDI, conjointement aux nombres.

Après ce délai, les étiquettes seront à nouveau affichées (voir le 
§ Étiquetage automatique à la page 347). 

L’affichage du nom et de la valeur du paramètre en cours 
d’édition peut être masqué via les réglages du pupitre de 
commande MIDI (fenêtre Setup, section des Paramètres 
Spéciaux). Ceci peut s’avérer utile si la retransmission de l’affi-
chage engendre un trafic trop important sur le port MIDI, ou si 
vous souhaitez le désactiver lors de l’enregistrement de chan-
gements de paramètres en mode AutoLink.

9.6 Configurations 
d’Assignations de 
Contrôleurs

Les Configurations d’Assignations de Contrôleurs vous 
permettent de contrôler tour à tour différents paramètres dans 
un éditeur avec les mêmes contrôleurs. Par exemple, avec la 
Configuration d’Assignation de Contrôleur 1, vous contrôlez les 
paramètres de filtres, et avec la Configuration d’Assignation de 
Contrôleur 2, les paramètres d’effets.

De même que pour les configurations d’écran, une seule Confi-
guration d’Assignation de Contrôleur ne peut être prise en 
compte à n’importe quel stade. La Configuration d’Assignation 
de Contrôleur en cours peut être appelée par des commandes(-
clavier) ou des commandes MIDI. Une alternative consiste à 
contrôler la Configuration d’Assignation de Contrôleur actuelle 
par l’intermédiaire des Assignations de Contrôleurs. 
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La Configuration d’Assignation de 
Contrôleur en cours
Dans le coin supérieur gauche de la fenêtre d’Assignations des 
Contrôleurs, vous pouvez voir un paramètre : la Configuration 
d’Assignation de Contrôleur en cours. Les valeurs possibles 
sont 1 à 9999 et “All”. La Configuration d’Assignation de 
Contrôleur en cours est enregistrée dans les Préférences et 
rappelée lors du chargement d’un fichier de Préférences.

Chaque Assignation de Contrôleur a son paramètre “Controller 
Assignement Set” qui peut être soit “All” ou n’importe quel chif-
fre entre 1 et 9999. Si c’est “All”, l’Assignation de Contrôleur 
est toujours active. Le cas échéant, elle ne sera active que si la 
valeur de la Configuration d’Assignation de Contrôleur en cours 
lui correspond, sauf si la Configuration d’Assignation de 
Contrôleur est sur “All”.

Seules les Assignations de Contrôleurs actives à ce moment 
seront affichées dans la fenêtre d’Assignation des Contrôleurs. 
Ceci inclut toutes les Assignations de Contrôleurs dont la 
valeur est “All” dans le paramètre Controller Assignement Set.

De même, la case des paramètres n’afficheque les caractéristi-
ques des Assignations de Contrôleurs actives et sélectionnées. 
Edit > Cut, Edit > Copy et Edit > Clear ne s’appliquent toujours 
qu’aux Assignations de Contrôleurs actives et sélectionnées.

Vous pouvez changer la Configuration d’Assignation de Contrô-
leur en cours de ces différentes façons:

• avec la souris : cliquez-maintenez et bougez la souris de haut 
en bas

• en entrant une valeur : double-cliquez sur le paramètre et 
inscrivez une nouvelle valeur

• par les raccourcis-clavier Next Controller Assignment Set et 
Previous Controller Assignment Set

• par les Assignations de Contrôleurs (voir la section suivante)
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Affichage de la Configuration 
d’Assignation de Contrôleur en cours sur le 
pupitre de commande MIDI
Si votre pupitre de commande MIDI est géré par un module, la 
Configuration d’Assignation de Contrôleur en cours sera affi-
chée sur l’écran de façade du pupitre de commande MIDI.

& Sur le SAC-2k, cela s’affichera dans le coin supérieur droit de l’écran LCD de droite. 
Sur le pupitre Motor Mix, c’est sur l’afficheur à deux chiffres 7 segments.

Contrôle à Distance de la Configuration 
d’Assignation de Contrôleur en cours

Il existe plusieurs façons de définir des Assignations de Contrô-
leurs contrôlant elles-mêmes la Configuration d’Assignation de 
Contrôleur en cours.

Définir par Glisser-Déposer
Les modules SoundDiver pour Fader Box reconnaissent les 
fonctions spécifiques des boutons de votre pupitre de 
commande MIDI, qui sélectionnent une piste ou un groupe de 
pistes, pour peu que ceux-ci existent.

SoundDiver autorise une destination spéciale pour l’assigna-
tion par glisser-déposer des Assignations de Contrôleurs, en 
dehors des fenêtres d’édition: la Configuration d’Assignation 
de Contrôleur en cours dans la fenêtre d’Assignations des 
Contrôleurs. 

Par conséquent, faire glisser un tel bouton (voir le § Définir des 
Assignations de Contrôleurs par Glisser-Déposer à la page 347) sur 
ce paramètre définira automatiquement une Assignation de 
Contrôleur qui fera exactement ce que vous en attendez, y 
compris la retransmission des LED vers le pupitre de 
commande MIDI.

& Pour le SAC-2k, les boutons de sélection de pistes 1 à 8 et les boutons 1 à 8, 9 à 16, 
17 à 24 et 25 à 32 ont cette fonction spécifique.
Pour les Motor Mix, les boutons de sélection de pistes 1 à 8 et les boutons F1, F2, F3 
et F4 ont cette fonction spécifique.
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Assignations de Contrôleurs prédéfinies
Dans le sous-menu local Assignment > New vous trouverez 
plusieurs options de menu servant à créer un certain nombre 
d’Assignations de Contrôleur, contrôlant elles-même la Confi-
guration d’Assignation de Contrôleur en cours.

Controller Assignement Set Control
Crée une seule Assignation de Contrôleur, contrôlant elle-
même la Configuration d’Assignation de Contrôleur en
cours.

4+4 button Controller Assignement Set Control
Utilisez cette option si votre pupitre de commande MIDI
dispose d’un bouton de sélection de groupe de quatre pis-
tes. Quatre Configurations d’Assignation de Contrôleur
sont créées, chacune sélectionnant une des quatre pistes; et
quatre Configurations d’Assignation de Contrôleur passent
des groupes de pistes 1-4, 5-8, 9-12 à 13-16.

8+4 button Controller Assignement Set Control
Utilisez cette option si votre pupitre de commande MIDI
dispose d’un bouton de sélection de groupe de huit pistes.
Huit Configurations d’Assignation de Contrôleur sont
créées, chacune sélectionnant une des 8 pistes; et quatre
Configurations d’Assignation de Contrôleur passent des
groupes de pistes 1-8, 9-16, 17-24 à 25-32.

16+4 button Controller Assignement Set Control
Utilisez cette option si votre pupitre de commande MIDI
dispose d’un bouton de sélection de groupe de seize pistes.
Seize Configurations d’Assignation de Contrôleur sont
créées, chacune sélectionnant une des 16 pistes; et quatre
Configurations d’Assignation de Contrôleur passent des
groupes de pistes 1-16, 17-32, 33-48 à 49-64.

Maintenant, sélectionnez simplement les Assignations de 
Contrôleur créées, les unes après les autres, et utilisez la fonc-
tion Learn pour définir les messages reçus.
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Définir Manuellement
Dans le paramètre “Device” d’une Assignation de Contrôleur, il 
existe une valeur nommée “Controller Assignement Set”. Quand 
vous choisissez cette valeur, l’Assignation de Contrôleur 
contrôle la Configuration d’Assignation de Contrôleur en cours 
au lieu d’un paramètre dans une fenêtre d’édition.

Dans ce mode, les paramètres “Data Type” et “Entry” n’ont pas 
de signification/effet. Les paramètres “Memory Offset” et “LS 
Bit” déterminent les octets qui seront modifiés dans la Configu-
ration d’Assignation de Contrôleur en cours. Les réglages 
normaux sont “Memory Offset” = 16 et “LS Bit = 0, ce qui signifie 
que tous les octets 16 commençant par l’octet 0 seront modifiés.

Vous pouvez utiliser les modes Direct et Relatif pour modifier la 
Configuration d’Assignation de Contrôleur en cours. En mode 
Direct, le paramètre Factor détermine la Configuration d’Assi-
gnation de Contrôleur sélectionné, moins un.

Par exemple, un facteur de 2.00 sélectionne la Configuration 
d’Assignation de Contrôleur n°3. Pour plus de précisions, voir 
le § Mode à partir de la page 340 et suivantes.

Si vous avez des boutons “Track Select” et “Track Group” sur 
votre pupitre de commande MIDI, et que le nombre de pistes 
est un multiple de 2, vous pouvez utiliser ces boutons pour 
sélectionner les Configurations d’Assignations de Contrôleurs. 
Exemples avec un pupitre de commande MIDI disposant de 8 
“Pistes”:

Bouton Mode Mem. Offs. LS Bit Factor donnea

a. Format binaire. Un “*” signifie que cet octet n’est pas affecté.

Select 1 Direct 3 0 0.00 ∗∗∗∗∗ 000

Select 2 Direct 3 0 1.00 ∗∗∗∗∗ 001

Select 3 Direct 3 0 2.00 ∗∗∗∗∗010

1—8 Direct 13 3 0.00 00000∗∗∗

9—16 Direct 13 3 1.00 00001∗∗∗

17—24 Direct 13 3 2.00 00010∗∗∗

25—32 Direct 13 3 3.00 00011∗∗∗
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Notez que les numéros de Configurations d’Assignations de 
Contrôleurs voient leur valeur augmentée de un à l’affichage. 
Par exemple la Configuration d’Assignation de Contrôleur n°10 
est enregistrée avec le n°9, et se trouve donc enregistrée avec la 
valeur 000001001 en format binaire. Pour la sélectionner, utili-
sez les boutons “9-16” (ce qui sélectionne une valeur 
00001***) et “Select 2/10/18/26” (ce qui sélectionne une valeur 
*****001).
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AutoLink

Si vous utilisez à la fois SoundDiver et un séquenceur Emagic 
de la série Logic, la fonction AutoLink vous permet de relier 
ces deux programmes. Si vous n’utilisez pas (encore) Logic, 
inutile de lire ce chapitre (ou bien lisez-le pour découvrir ce 
que vous manquez!)

& Quand Logic est mentionné dans ce chapitre, cela inclut automatiquement Logic 
Audio Platinum, Gold et Silver, car ces logiciels offrent une fonctionnalité totale de 
l’AutoLink. MicroLogic par contre n’intègre pas l’AutoLink.

10.1 Qu’est-ce que AutoLink ?
L’AutoLink offre, comme son nom l’indique, une liaison 
interne entre SoundDiver et Logic. Lorsque les deux program-
mes sont actifs, vous pouvez contrôler le traitement des sons 
pendant que Logic tourne.

Le “Name Provider” transfère vers Logic les noms des sons qui 
sont utilisés, de façon à ce que les derniers (Multi) Instruments 
affichent les noms des sons actuels.

“MIDI Processing” permet à Logic d’enregistrer toutes vos 
opérations effectuées dans les éditeurs de SoundDiver par le 
biais d’AutoLink. Lorsque vous éditez des paramètres dans la 
fenêtre d’édition, SoundDiver crée une donnée SysEx et 
l’envoi à Logic, où elle est enregistrée directement sur la piste 
active. Ceci vous permet d’automatiser (c.a.d. enregistrer) 
toutes les éditions dynamiques de sons que vous effectuez dans 
SoundDiver

L’AutoLink ne nécessite aucune extension de système externe, 
car SoundDiver et Logic contrôlent toute la communication 
entre eux.

Chapitre 10
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Configuration système requise
Sous Windows, AutoLink nécessite la configuration de système 
suivante:

• Tout PC avec Pentium,
• Windows 95/98, 
• SoundDiver 2.0.6 ou ultérieur. Nous recommandons la nou-

velle version
• Logic 4.0 ou ultérieur. Nous recommandons la nouvelle ver-

sion.

Sur Macintosh, AutoLink nécessite la configuration de système 
suivante:

• Tout Power Macintosh, 
• Système 7.1 ou ultérieur,
• SoundDiver 1.505 ou ultérieur. Nous recommandons la nou-

velle version
• Logic 2.02p ou ultérieur. Nous recommandons la nouvelle 

version.

10.2 Comment démarrer AutoLink ?

Démarrer AutoLink
Démarrer SoundDiver en mode AutoLink est particulièrement 
simple :

• Premièrement, démarrez Logic
• Assurez-vous que l’option Utiliser AutoLink avec SoundDiver 

ou SoundSurfer si disponible est activée dans la page de Logic 
Options > Réglages > Communication Interface MIDI.

&  : Si vous utilisez une version de Logic antérieur à la 2.5, désactivez “Libérer les ports 
Modem et Imprimante en tâche de fond à l’arrêt” ou Logic refermera toutes les 
communications MIDI quand vous “basculerez ” vers SoundDiver, et AutoLink 
cessera de fonctionner.

• Démarrez ensuite SoundDiver. Veuillez respecter cet ordre 
d’allumage (d’abord Logic, puis SoundDiver), car SoundDi-
ver à besoin de repérer un programme Logic actif pour pou-
voir activer AutoLink.
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& Sous Windows, cet ordre peut être modifié seulement si un pilote MIDI multi-client 
est utilisé.

Lors de l’amorçage d’AutoLink vous entendrez un son du style 
“plop”.

Démarrer AutoLink en Mode OMS
Si vous souhaitez utiliser AutoLink et OMS simultanément, 
activez Utiliser OMS si disponible dans les Préférences de Logic 
et réglez Use OMS if available dans les Préférences de SoundDi-
ver sur Always. Lisez également le § Communication avec Logic en 
mode OMS à la page 69.

10.3 La Communication MIDI avec 
AutoLink

Chaque fois qu’AutoLink est activé, SoundDiver utilise les 
entrées et sorties MIDI de Logic. Vous pouvez constater ceci 
dans la fenêtre “Préférences” qui n’affiche plus les deux ports 
MIDI mais ressemble désormais à cela.
Abb. AutoLink-Voreinstellungen

En outre la fenêtre de séquence sera modifiée de façon à ce que 
le mode AutoLink actif puisse également être reconnu :

Quand AutoLink est en fonction, SoundDiver n’utilise plus les 
ports MIDI réglés dans les “Preferences” mais communique en 
interne avec Logic. Toute donnée envoyée et reçue par Sound-
Diver transite par Logic qui agit maintenant comme interface 
MIDI. SoundDiver n’a ensuite plus accès qu’aux ports actifs 
dans Logic.
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Toute donnée arrivant à n’importe quelle entrée MIDI de 
l’ordinateur est acheminée jusqu’à SoundDiver. A l’inverse la 
sortie MIDI de SoundDiver est intégrée à celle de Logic.

& Si vous quittez Logic, SoundDiver reprend automatiquement un contrôle normal de 
sa gestion MIDI. 

Le schéma suivant montre la communication MIDI entre 
SoundDiver et Logic.

Le MIDI Thru en mode AutoLink
La fonction MIDI Thru de SoundDiver fonctionne également 
en conjonction avec AutoLink. Quand elle est active, cette 
option envoie toujours les données reçues à l’appareil corres-
pondant.

SoundDiver cherche automatiquement dans un morceau de 
Logic un Instrument ayant le même canal MIDI et les mêmes 
réglages de ports que l’appareil sélectionné. Si aucun Instru-
ment correspondant ne peut être trouvé, un dialogue apparaît, 
demandant si vous souhaitez créer un nouvel Instrument au 
sein de l’Environnement Logic, avec les réglages appropriés.

Ce dialogue vous propose les trois options suivantes:
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Cancel (Annuler)
Si vous ne souhaitez pas créer d’Instrument.

Create (Créer)
Vous souhaitez créer un Instrument à cette occasion seule-
ment.

Always Create (Toujours créer)
Vous souhaitez toujours que SoundDiver crée automati-
quement un Instrument.

Si le MIDI Thru est désactivé, Logic utilise l’Instrument “No 
Output” qui existe dans chaque morceau et qui ne peut être 
effacé.

Chaque fois que vous repassez dans Logic l’Instrument MIDI 
Thru est automatiquement changé en Instrument de piste, et 
vice-versa.

& Le nouvel Instrument apparaît dans les “Instruments” du 7e niveau de l’Environne-
ment Logic. Pour plus de détails, reportez-vous au fichier Readme accompagnant 
Logic.

& Les Instruments séparés composant un multi-instrument sont également utilisés 
comme Instrument Thru s’ils correspondent aux réglages souhaités.

& Aucun Instrument n’est nécessaire pour envoyer des données aux appareils; le MIDI 
Thru n’est pas utilisé puisque les sorties MIDI sont adressées directement, sans être 
déviées par Logic.

Un changement de canal MIDI ou de sortie dans la case des 
paramètres d’appareil implique la création d’un Instrument 
adéquat, uniquement après que le bouton de la souris ait été 
relâché. Ceci évite la création inutile d’Instruments.

Créer des Instruments Logic
Cette option, des Préférences (onglet “Safety Messages”), 
détermine si vous souhaitez être consulté sur la nécessité pour 
SoundDiver de créer un nouvel Instrument dans le morceau, 
de façon à mettre au point les réglages de MIDI Thru désirés.
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10.4 Noms des sons dans les 
Instruments Logic

Vous devez normalement entrer manuellement les noms de vos 
sons dans Logic puisque Logic ne peut pas les reconnaître au 
travers des transmissions de données SysEx comme le fait 
SoundDiver.

Cependant, dans la mesure où toutes ces informations sont 
disponibles dans la fenêtre Device de SoundDiver et que ce 
dernier sait quel appareil est sur quelle piste, ces données 
peuvent être facilement communiquées à Logic via AutoLink. 
Logic pour sa part, insère les noms des sonorités appropriés 
dans la colonne Instrument et intitule les récents enregistre-
ments en conséquence. Par exemple, au lieu de “Séquence 
enregistrée”, le nom de la séquence pourrait être “E-Piano1 
enregistré”.

AutoLink vous permet de choisir pour une piste le bon son au 
bon moment sans devoir chercher dans l’appareil ou encore 
fouiller dans SoundDiver.

Sélectionner un Son dans Logic
Pour que Logic sache quel son vous avez assigné à un Instru-
ment, vous devez enregistrer sa commande de Changement de 
Programme correspondante dans la case des Paramètres 
d’Instrument.

Pour ceci activez le Changement de Programme dans la case 
des Paramètres d’Instrument qui est cochée.

Maintenant, si vous cliquez-maintenez le 
numéro de Programme, un menu local 
s’ouvre affichant les noms de sons disponi-
bles:

C’est ici que vous sélectionnez un son. 
Celui que vous choisissez apparaîtra désormais automatique-
ment dans la colonne Instrument de la fenêtre d’Arrangement:
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Au premier coup d’œil, vous contrôlez quel son est piloté et par 
quelle piste. N’oubliez pas que ces noms ne sont pas inclus 
dans la sauvegarde d’un morceau (par contre, le contenu des 
Multi-Instruments est lui sauvegardé dans le morceau). Ils sont 
uniquement affichés pendant le temps où SoundDiver et Logic 
sont effectivement reliés (par AutoLink).

Dans SoundDiver, si vous modifiez une entrée, effacez un 
appareil ou changez sa configuration MIDI, cela se répercute 
immédiatement dans l’affichage de Logic.

Configurer le canal MIDI pour la Détection 
des Changements de Programme
Les modules SoundDiver essaient automatiquement d’établir 
un canal MIDI pour l’appareil. Cependant, les Adaptations ne 
le font pas. Ce n’est pas un problème pour les appareils les plus 
simples n’ayant pas de mode “Multi”, car le canal MIDI corres-
pond toujours au numéro Device ID de l’appareil.

Dans le cas d’un appareil dont le canal MIDI ne correspond pas 
toujours au numéro Device ID, le “Canal de Changement de 
Programme” apparaît parmi les paramètres spéciaux de l’appa-
reil. Réglez-le sur le canal MIDI actuel de l’appareil.

Sur les appareils multi-modes, les Changements de Program-
mes passent souvent sur le son correspondant à plusieurs 
canaux MIDI. Dans ce cas, une matrice de connexion (ressem-
blant à celle des Multi-Instruments dans Logic) apparaît parmi 
les paramètres spéciaux. Vous pouvez y définir si des Change-
ments de Programmes doivent s’effectuer sur un canal via le 
canal de base. En fonction de l’appareil, vous devrez effectuer 
ces réglages pour un programme “Multi” ou “Combi”.

Si vous voyez à la fois, le “Canal de Changement de 
Programme” et la matrice, c’est le “Canal de Changement de 
Programme” qui détermine le canal utilisé pour sélectionner 
les Performances, les Multis, etc. Pour les Appareils Roland, ce 
canal est appelé : “Canal de Contrôle”.
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Noms des Sons dans un Multi-Instrument
Vous pouvez utiliser l’Environnement de Logic afin de créer un 
Multi-Instrument pour un appareil multitimbral. Les noms de 
ses sons sont affichés ensemble dans une fenêtre. Ici égale-
ment, AutoLink est utilisé pour une acquisition correcte des 
noms.
Abb. Multi-Instrument

Pour accéder à la fenêtre des noms 
des sons de l’appareil, pour un 
Multi-Instrument, sélectionnez 
simplement Update using Auto-
Link à partir du menu local de la 
fenêtre Multi-Instrument.

& Avec les Multi-Instruments, les noms des 
sons seront sauvegardés comme faisant 
partie d’un morceau Logic, et seront visibles même si SoundDiver est éteint. Cepen-
dant, les changements effectués dans SoundDiver ne seront pas automatiquement 
renvoyés : vous devrez utiliser manuellement “Update Using AutoLink”.

Si AutoLink ne fonctionne pas...
Si au départ, le “Name Provider” ne semble pas fonctionner 
comme prévu, ne paniquez pas! Quelques conditions essentiel-
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les doivent être remplies pour que Logic et SoundDiver puis-
sent communiquer librement. Un peu de patience sera peut-
être nécessaire avant que tout ne fonctionne parfaitement. 
Veuillez s’il vous plaît vous assurer que...

• ...le(s) port(s) MIDI de l’appareil sont réglés de la même 
façon sur Logic et SoundDiver. Vérifiez cette conformité 
dans les cases de paramètres de SoundDiver et de Logic.

&  : Si vous utilisez le “MTP Cable Mode”, n’utilisez alors pas l’option “ALL” dans 
SoundDiver ni dans Logic.

• ...que le canal MIDI dans Logic correspond à la valeur Thru 
Ch de l’appareil dans SoundDiver, si ce dernier n’est pas 
multitimbral (c.a.d. qu’un seul canal MIDI est disponible).

Si un tel canal n’existe pas, le Device ID de l’appareil doit 
correspondre aux canaux respectifs des Instruments dans 
Logic. Sur ces appareils, le Device ID est identique au canal 
MIDI. SoundDiver n’affichera donc que le Device ID de 
l’appareil.

Avec les appareils multitimbraux, vous devez distinguer les 
Modules des Adaptations (vous reconnaîtrez les adaptations 
grâce au menu Adaptation dans la fenêtre Device).

- Avec les Adaptations, le canal doit être ouvert dans la ma-
trice 4x4 de la zone des Paramètres Spéciaux.
Si l’appareil a un canal de contrôle (par ex : pour la sélec-
tion des Performances), et que vous voulez que Logic af-
fiche cette information, ce canal doit correspondre au 
réglage du Canal de Changement de Programme (Pro-
gram Change Ch) dans l’Adaptation. 

- Les Modules peuvent effectuer une “requête” pour ce 
genre de données. Les conditions détaillées sont décrites 
dans l’aide en ligne.

• ....que le format de sélection de banque (Bank Select) 
correct est choisi (si l’appareil gère cette commande MIDI).
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Bien que les Instruments 
“normaux” transmettent des 
“Changements de Programme” 
de sélection des deux banques, 
seule la sélection de banque 
LSB (contrôleur n°32) est modi-
fiable, et seulement dans une 
échelle de 0 à 62. Si le généra-
teur de sons requiert d’autres 
valeurs de sélection de banque, 
utilisez un multi instrument et 
sélectionnez une des options de 

sélection de banque dans l’éditeur de Multi-Instrument. 

Vous pouvez également utiliser la fonction Définir vos propres 
messages de sélection de banque dans Logic 2.5 ou ultérieur (voir le 
§ “Définir vos propres commandes de sélection de banque” au 
chapitre 5 du manuel Logic)
& Dans Logic 2.0x et la première version de Logic 2.5, l’information de sélection de 

banque dans un Multi-Instrument n’était pas acheminée jusqu’à SoundDiver. 
Assurez-vous d’utiliser la dernière mise à jour de Logic 2.5 (ou une version ultérieure).

& Les caractéristiques des appareils déterminant les sélections de banque sont consul-
tables dans la section “AutoLink” du fichier Aide.

• ... que SoundDiver connaisse les canaux MIDI de réception 
de l’appareil, s’il s’agit d’un appareil multitimbral. Pour s’en 
assurer, SoundDiver a normalement besoin des “Données 
Globales” ou des “Réglages de Système”, du programme 
Multi/Combi et de n’importe quel tableau des Changements 
de Programmes dont dispose l’appareil. Si Logic affiche des 
noms de sons vierges ou incorrects, demandez à nouveau ces 
données via SoundDiver. Si ces données ne sont pas dispo-
nibles, le Module SoundDiver considère que l’appareil ne 
peut recevoir que sur le canal MIDI Thru réglé dans la case 
des paramètres d’appareil de SoundDiver. Pour être totale-
ment certain, demandez une fois encore à SoundDiver le 
contenu total de la fenêtre Device. Consultez la section 
“AutoLink” dans l’Aide en ligne du Module correspondant. 
Vous pouvez consulter cette page en la sélectionnant dans 
l’index de l’aide (voir le § Index à la page 173).
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• ...que SoundDiver connaît le mode en cours dans l’appareil. 
Beaucoup d’appareils disposent de plusieurs modes (par ex : 
Programme et Combinaison) au sein desquels les Change-
ments de Programmes reçus sont régis différemment. Pour 
indiquer à SoundDiver quel mode doit être adopté (et donc 
régler l’appareil sur ce mode), vous avez juste à cliquer sur le 
tampon d’édition approprié dans la fenêtre Device. 
Plusieurs appareils reconnaissent certaines commandes de 
Sélection de Banque ou de Changement de Programme et 
changent de mode en conséquence. Si vous transmettez ces 
commandes, SoundDiver vous fournit les noms demandés 
sans intervention supplémentaire de votre part.

• Si plusieurs appareils reçoivent sur le même canal, le nom du 
programme d’un seul de ces appareils sera affiché : le premier 
de ces appareils a avoir été ajouté dans la fenêtre Setup. 
Nous vous recommandons donc de séparer les appareils par 
canal MIDI (distinct) à moins que vous ayez une bonne 
raison de ne pas le faire, par exemple pour superposer des 
sons (ceci est cependant réalisable avec des canaux MIDI 
séparés en utilisant des copies de pistes/séquences). 

Si aucune de ces solutions ne fonctionne, cela peut venir du fait 
que les réglages requis dans l’Adaptation SoundDiver n’ont pas 
encore été effectués. Vous pouvez vérifier si tel est le cas dans le 
fichier “SoundDiver Model List” dans la colonne “AutoLink”: 
un “y” signifie que l’Adaptation gère AutoLink.

Si l’Adaptation ne gère pas encore AutoLink, vous devez 
pouvoir régler cela vous-même.

❏ Ouvrez l’éditeur d’Adaptation à partir de la fenêtre Device,
choisissez Adaptation > Edit Adaptation … et ouvrez le
“Bank Driver” désiré de la banque.

❏ Dans le “Bank Driver”, recherchez les paramètres appelés
Program Change detection. 

CHAN
Cette option sélectionne le canal MIDI auquel doit corres-
pondre l’Instrument Logic pour que le Name Provider
puisse fonctionner. Vous pouvez sélectionner une valeur
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fixe, ou une valeur variable basée sur d’autres critères tel
que le Device ID ou le canal MIDI Thru. 

BANK MSB ou LSB
Une commande de Sélection de Banque, si nécessaire,

FIXED
Un Changement de Programme fixe qui est envoyé en pre-
mier, si nécessaire,

OFFSET
Le numéro de Changement de Programme utilisé pour
sélectionner le premier son dans la banque.

Pour plus de détails, veuillez consulter le SoundDiver Universal 
Module Programming Manual disponible sur le site internet 
Emagic.

& Si aucune de ces étapes n’est efficace, utilisez simplement Edit > Copy (dans la 
fenêtre Device) et Paste avec l’option “Paste All Names” (dans le menu déroulant de 
Multi-Instrument à côté de l’option “Update Using AutoLink”). Pas très élégant... 
mais cette méthode fonctionne toujours.

10.5 Télécommander Logic par 
SoundDiver

AutoLink désactive le séquenceur interne de SoundDiver et 
laisse Logic prendre le relais. La fenêtre s’appelle “AutoLink/
Logic”. Les fonctions de transport dans la fenêtre du Séquen-
ceur SoundDiver télécommandent Logic. Ceci vous permet 
par exemple de préparer une séquence en mode “Cycle” dans 
Logic, et de rechercher ensuite pour une piste en particulier, le 
son approprié dans SoundDiver.

En mode AutoLink, le bouton “Enregistrement” peut égale-
ment être utilisé, vous permettant ainsi de télécommander 
Logic à partir de SoundDiver. Cette possibilité s’avère très 
utile pour enregistrer des changements de paramètres dans un 
éditeur SoundDiver en temps réel (voir le § Enregistrer les chan-
gements de paramètres dans Logic à la page 370).
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Raccourcis clavier pour Logic
SoundDiver répercute tous les raccourcis clavier non-attribués 
dans Logic. En mode AutoLink, les raccourcis clavier pour le 
contrôle du transport de SoundDiver sont ignorés, mais réper-
cutés dans Logic. De cette façon, si vous avez interchangé 
l’attribution du Play et du Stop dans Logic, cette attribution 
s’appliquera aussi dans SoundDiver.

10.6 Changer les Instruments de 
piste de Logic

Une des fonctions pratiques d’AutoLink est la possibilité 
d’écouter une piste enregistrée, avec différents sons de généra-
teurs sonores distincts... le tout d’un simple clic de souris.

Définir un Instrument Logic
Activer cette option dans le menu Options de SoundDiver 
permet de modifier l’Instrument sur la piste sélectionnée dans 
Logic, si vous commencez l’écoute des sons dans SoundDiver. 
Il devient donc facile d’essayer différentes sonorités, même à 
partir de différents Instruments, sur la même piste. 

Pour plus de sécurité, cette option est toujours désactivée lors-
que SoundDiver devient actif.

Si vous désirez changer l’Instrument de la piste, sélectionnez 
cette option de menu. La sélection écoutée à l’instant est main-
tenant rejouée par vos pistes de Logic.
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La modification de l’Instrument de la piste sera maintenue si 
vous retournez dans Logic. Si cette option ne vous convient 
pas, désactivez Set Logic Instrument avant de retourner dans 
Logic. L’Instrument d’origine est alors réassigné à la piste, et le 
morceau reste inchangé.

10.7 Sauvegarder les données de 
morceau dans une 
Bibliothèque

Vous pouvez sauvegarder les sons utilisés pour un morceau 
venant de Logic dans une bibliothèque SoundDiver (si Auto-
Link est actif). Cliquez pour cela sur le menu New > Save 
Library for Logic Song >….

Vous pouvez sélectionner à partir de la même liste d’options 
que dans Build Library... et Save as... Ceci vous permet de cons-
tituer une bibliothèque avec des noms qui ne sont pas utilisés 
dans un morceau.

Sauvegarder les entrées utilisées par les 
Instruments Logic
Il existe en plus une autre option située en bas du sous-menu 
appelée Entries used by Logic Instruments.
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Cela inclut toutes les données rappelées par des Changements 
de Programmes sélectionnés dans les cases des Paramètres 
d’Instrument d’un morceau Logic.

Si vous souhaitez utiliser cette fonction, vous devez :

❏ vous assurer que tous les sons et programmes que vous
désirez sauvegarder comme noms de bibliothèque, sont
rappelés à partir de la case de sélection de Changement de
Programme dans les cases des Paramètres d’Instrument au
sein d’un morceau (les Changements de Programmes ajou-
tés en tant qu’événements dans une séquence ne seront
pas suffisants) ;

❏ appuyer sur le raccourci clavier pour sauvegarder la biblio-
thèque.

Vous pouvez rappeler cette fonction dans Logic via un 
Raccourci-Clavier. Cette fonction peut être affectée à 
n’importe quelle combinaison de touches ou de commandes 
MIDI dans la fenêtre des Raccourcis clavier : 

❏ ouvrez la fenêtre de Raccourcis clavier dans Logic,

❏ allez à la section “Commandes globales” et cliquez sur la
ligne affichant Save used Sound Programs using SoundSurfer/
Diver,

❏ définissez un Raccourci-Clavier ou une commande MIDI.

& Durant un échange, Logic et SoundDiver alternent automatiquement en tant 
qu’application active.

Vous pouvez également utiliser cette fonction en choisissant 
New >Save Library for Logic Song > Entries used by Logic Song 
Instruments dans la fenêtre Setup de SoundDiver (lisez aussi le 
§ Save Library for Logic Song à la page 210).

Charger et sauver automatiquement la 
Bibliothèque
La bibliothèque créée via une des options de sous-menu Save 
Library for Logic Song, porte le même nom que le morceau de 
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Logic (sauf pour l’extension .LIB) et est sauvegardée dans le 
même dossier que le morceau.

Si vous ouvrez ensuite un morceau dans Logic alors que Sound-
Diver est en cours, en mode AutoLink, ce dernier chargera 
automatiquement la bibliothèque (après votre confirmation) et 
transmettra son contenu aux appareils.

& Durant un échange, Logic et SoundDiver alternent automatiquement en tant 
qu’application active.

& Si vous utilisez des fichiers Préférences pour l’archivage de vos projets, pensez peut 
être à utiliser les bibliothèques plutôt que l’option “Save Library for Logic Song” 
puis “Known Entries”.
Avantage : même après avoir modifié votre configuration MIDI (par ex. Les affecta-
tions des sorties MIDI), une telle bibliothèque sera toujours valable, grâce à l’algo-
rithme “intelligent” de recherche de l’appareil récepteur de SoundDiver (voir égale-
ment le § Stratégie de sélection d’appareils lors d’envois depuis une Bibliothèque  à 
la page 212). Si vous voulez charger un ancien fichier de Préférences après avoir 
modifié votre configuration MIDI, il vous faudra ajuster manuellement les réglages 
des sorties MIDI et de Device ID de l’appareil.

& Cette fonction n’est pas transmise automatiquement à chaque sauvegarde du 
morceau dans Logic. Nous vous conseillons de sauvegarder la bibliothèque juste 
avant de fermer le morceau ou de quitter Logic, pour vous assurer de son ultime 
actualisation.

10.8 Enregistrer les changements 
de paramètres dans Logic

Maintenant que nous avons traité du transfert des noms de 
sons, examinons comment AutoLink autorise l’enregistrement 
en temps réel des changements de paramètres. Cela signifie 
que vous avez la possibilité d’enregistrer directement dans 
Logic toutes les éditions de paramètres que vous effectuez 
dans l’éditeur de SoundDiver, permettant par exemple des 
courbes de filtre sur des séquences d’arpèges ou des change-
ments d’amplitude d’impulsion en temps réel, pendant un solo. 
La réaction spécifique d’un appareil à la réception en temps 
réel de données SysEx dépend de l’appareil lui-même. Plus de 
précisions dans les deux paragraphes suivants.
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Pour enregistrer des changements de paramètres SoundDiver 
dans Logic :

❏ Assurez-vous d’abord que l’option permettant l’enregistre-
ment des SysEx est bien validée. Cette option est accessi-
ble via la fenêtre de Logic Options > Settings > MIDI
Options.

❏ A ce stade, nous vous conseillons d’optimiser le positionne-
ment des fenêtres SoundDiver et Logic pour un accès sim-
ple aux zones essentielles de chaque programme. Par
exemple, vous pouvez placer la fenêtre des transports de
Logic proche d’un éditeur SoundDiver. (Vous pouvez ainsi
ouvrir, en alternance, la fenêtre du séquenceur SoundDiver
et y faire débuter l’enregistrement).

L’Easy Page de SoundDiver offre une vue générale des princi-
paux paramètres. Voici un exemple de la façon de disposer les 
fenêtres Logic et SoundDiver :
Abb. Transport + Editor

L’Easy Page de SoundDiver offre une vue générale des princi-
paux paramètres. Voici un exemple de la façon de disposer les 
fenêtres Logic et SoundDiver :

Sous l’éditeur SoundDiver de l’EX5, vous pouvez voir la fenê-
tre de Transport de Logic en position Enregistrement-Pause.

Une fois que vous êtes prêt à débuter l’enregistrement :
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❏ sélectionnez le point de départ désiré dans Logic,

❏ cliquez dans l’éditeur SoundDiver,

❏ commencez l’enregistrement (en utilisant le raccourci-cla-
vier défini dans Logic, généralement *),

❏ ajustez le(s) paramètre(s) dans l’éditeur SoundDiver

❏ lorsque vous avez terminé, cliquez sur le bouton Stop dans
la fenêtre de Transport.

Toutes les fonctions de Logic telles que l’Enregistrement en 
Cycle et l’Autodrop sont totalement disponibles à partir de 
SoundDiver.

& Créez un Screenset portant le même numéro (ex : 98), à la fois dans Logic et Sound-
Diver, qui rappelle la disposition mentionnée ci-dessus. Vous pourrez ensuite faire un 
enregistrement instantané de SysEx puisque la disposition d’écran sera rappelée à la 
fois dans SoundDiver et Logic (si AutoLink est actif).

& Il n’est pas encore possible de définir des faders SysEx dans Logic en envoyant des 
changements de paramètres à partir de SoundDiver.

Précautions à prendre avec l’édition des 
SysEx en temps réel
Les changements de paramètres SysEx véhiculent un flux 
extrêmement dense de données. Logic comporte des routines 
de priorité spécifiques qui garantissent que les durées de notes 
et autres événements MIDI ne sont pas affectés, même par de 
complexes éditions de SysEx. Malgré cela, des problèmes 
parfois inévitables peuvent survenir, dus aux limites mêmes 
des appareils. :

• Le temps de réaction de beaucoup de machines est ralenti 
quand elles reçoivent des notes et des SysEx en même 
temps. Si vous rencontrez cela, essayez d’affecter le para-
mètre fautif à un contrôleur MIDI (par ex. Modulation). Les 
contrôleurs MIDI sont traités plus efficacement par les appa-
reils MIDI et en principe n’affectent pas les durées. Ceci 
parce que les données SysEx ont une priorité temporelle 
subsidiaire et sont traitées par beaucoup de machines 
comme étant d’importance secondaire, contrairement aux 
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Contrôleurs MIDI pour lesquels la réciproque est vraie. 
Dans tous les cas, vérifiez si la fonction choisie au sein de 
votre machine peut être atteinte par un contrôleur MIDI.

• Certains appareils traitent les changements de paramètres 
seulement lorsque les notes sont en cours de jeu. En d’autres 
termes : les réglages de filtres ne peuvent être pris en compte 
quand les notes sont maintenues, mais uniquement quand 
elles sont jouées. Si c’est le cas, essayez l’alternative du 
contrôleur MIDI décrite un peu plus haut. 

10.9 Afficher les changements de 
paramètres enregistrés dans 
SoundDiver

En principe, Logic fait suivre uniquement les événements 
MIDI reçus sur les entrées MIDI jusqu’à SoundDiver, mais pas 
ceux transmis par Logic. Donc, les changements de paramètres 
enregistrés dans une séquence ne sont pas affichés dans Sound-
Diver quand un morceau est relu (lisez le § La Communication 
MIDI avec AutoLink à la page 357).

Pour visualiser ces changements dans une fenêtre d’édition, les 
données doivent être envoyées à SoundDiver.

C’est le rôle de l’objet “AutoLink” de l’Environnement Logic, 
qui agit comme un port virtuel vers SoundDiver.
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Les (pistes de) données Sysex sont lues par un Instrument (1) 
et acheminées par cet Instrument vers un port MIDI (3). En 
utilisant l’objet “AutoLink”, Logic envoie en plus ces mêmes 
données vers SoundDiver.

Comme il n’y a qu’un seul port virtuel vers SoundDiver, Logic 
ne génère qu’un seul objet “AutoLink”.
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Si l’affichage des changements de paramètres est souhaité, vous 
pouvez le configurer dans Logic de cette façon :

❏ Créez un nouvel Instrument interne via le chapitre du
menu local de la fenêtre Environnement New > Internal >
AutoLink. (Si cette option de menu n’apparaît pas, créez à
la place un autre Instrument interne, c.a.d., QuickTime,
Sample Cell ou WaveMaker, et réglez ensuite le type d’Ins-
trument sur “AutoLink 1”). Le paramètre Which n’est pas
utilisé.

❏ Connectez tous les Instruments utilisés par les pistes dont
vous souhaitez écouter les sorties dans SoundDiver au nou-
vel Instrument créé. Si cet Instrument est câblé sur une
sortie physique, un message d’avertissement apparaîtra,
vous demandant si cette connexion doit être annulée.
Choisissez “No” : sans cela, les pistes seraient envoyées à
SoundDiver seulement, et pas aux ports d’Instruments
précédemment attribués.

Désormais lorsque vous démarrerez la lecture dans Logic, 
SoundDiver affichera tous les changements de paramètres dans 
les fenêtres d’édition.

& Cette fonction n’est pas disponible pour tous les Modules SoundDiver, en particulier 
ceux dont les appareils reconnus n’envoient pas eux-mêmes de changements de 
paramètres. De plus amples précisions peuvent être trouvées dans la page “MIDI” de 
l’Aide en ligne pour les Modules correspondants.

10.10 Enregistrer des Transferts 
dans Logic

Si vous préférez sauvegarder les données de sons en cours dans 
un morceau plutôt que de vous en remettre aux Changements 
de Programmes, AutoLink permet facilement d’enregistrer des 
Transferts (Dumps) de SoundDiver vers Logic.

La procédure est la même que celle décrite plus haut dans le § 
Enregistrer les changements de paramètres dans Logic à la page 370.

Plutôt que d’éditer dans les fenêtres d’édition, sélectionnez 
l’entrée à la position choisie et transmettez-la. Cette option 
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peut être automatisée via AutoAudition, bien que vous puissiez 
également présélectionner la ou les entrée(s) et les transmettre 
à la position désirée dans le morceau, par le biais de Edit > 
Transmit. N’oubliez pas qu’avec AutoAudition, le son devient 
immédiatement actif ; parallèlement, quand vous envoyez des 
positions de mémoires, elles doivent être choisies dans le 
morceau par l’intermédiaire des Changements de Programmes.

Vous trouverez plus d’informations dans le § SoundDiver et la 
gestion du MIDI à la page 66.

10.11 Synchroniser les Screensets
Si vous rappelez un Screenset spécifique dans SoundDiver 
(voir le § Mémoriser des Screensets à la page 161), la configuration 
correspondante s’ouvrira dans Logic, et vice -versa. Les deux 
programmes agissent comme un seul, vous permettant d’opti-
miser véritablement votre travail.

Cependant, gardez à l’esprit que la hiérarchie des fenêtres 
(c.a.d. laquelle est en dessous et laquelle est au-dessus) est 
gérée individuellement dans chacun des logiciels. De même, 
copier un Screenset n’est possible qu’à l’intérieur de son 
programme-hôte. 

Si toute cette automatisation finit par vous peser, vous pouvez 
la désactiver dans les Préférences de SoundDiver (page 
“Communication”).
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10.12 Ouvrir SoundDiver pour un 
Instrument

Cette fonction vous permet d’ouvrir très rapidement la fenêtre 
Device d’un appareil utilisé par un Instrument Logic. 

❏ Sélectionnez la piste désirée dans Logic

❏ Sélectionnez Functions > Track > Ouvrir SoundDiver pour
un Instrument. Vous pouvez également y accéder par la
fenêtre des Raccourcis Clavier, dans la section Fenêtre
d’Arrangement. Il est recommandé d’attribuer un raccourci-
clavier à cette fonction.

SoundDiver devient alors actif et ouvre la fenêtre Device de 
l’appareil correspondant. L’appareil SoundDiver assigné à 
l’Instrument Logic est défini comme suit:

• Seuls sont pris en compte les appareils dont la sortie MIDI 
sur l’ordinateur correspond à la sortie attribuée de l’Instru-
ment.

& Pour les comparaisons de noms suivantes le cas est ignoré.

❏ Si un appareil qui renvoie un nom / valeur de Changement
de Programme 0 sur le canal MIDI utilisé par l’Instrument,
et que le nom de l’appareil est identique à celui de l’Instru-
ment, alors la fenêtre Device de cet appareil s’ouvre.

❏ Mais, si un appareil qui renvoie un nom / valeur de Chan-
gement de Programme 0 sur le canal MIDI utilisé par l’Ins-
trument, et que le nom de l’appareil est contenu dans celui
de l’Instrument, alors la fenêtre Device de cet appareil
s’ouvre.

❏ Mais, s’il existe un appareil dont le nom est identique à celui
de l’Instrument, alors la fenêtre Device de cet appareil
s’ouvre.

❏ Mais, s’il existe un appareil qui renvoie un nom / valeur de
Changement de Programme zéro sur le canal MIDI utilisé
par l’Instrument, alors la fenêtre Device de cet appareil
s’ouvre.
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❏ Mais, s’il existe un appareil dont le nom est contenu dans
celui de l’Instrument, alors la fenêtre Device de cet appa-
reil s’ouvre.

Les conditions décrits ci-dessus sont rassemblées dans le 
tableau suivant.

Tableau 8 Assignation d’un Instrument Logic vers un appareil 
SoundDiver

n° la sortie 
correspond

renvoie le nom 
pour le program 
change

le nom 
correspond

le nom est
identique

1 √ √ √

2 √ √ √

3 √ √

4 √ √

5 √ √
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Le Module Universel

La gestion des appareils MIDI par SoundDiver s’effectue de 
deux manières: le module et l’adaptation. Les modules sont 
développés par les ingénieurs Emagic et représentent la plus 
évoluée des deux formes. Un module reflète précisément les 
caractéristiques spécifiques d’un appareil et les exploite pleine-
ment. Ils fonctionnent comme des systèmes complets et indé-
pendants et offrent des possibilités égalant celles des modèles 
de programmes spécifiques d’édition/bibliothèque de sons.

Malheureusement, il est difficilement réalisable de créer un 
module pour chaque appareil MIDI existant sur le marché. Le 
nombre de ventes de beaucoup d’appareils MIDI ne justifie 
tout simplement pas les investissements de temps et d’énergie 
nécessaires à la production d’un module. Heureusement, cela 
ne signifie pas que les autres appareils ne peuvent être recon-
nus, car SoundDiver offre un moyen rapide et simple pour 
gérer ces appareils MIDI non reconnus par les modules.

Cette gestion est rendue possible via un module spécial appelé 
Module Universel. Ce module peut être utilisé pour travailler 
avec pratiquement tous les appareils MIDI grâce aux fichiers 
de pilotes éditables appelés “adaptations”. Ces “adaptations” 
sont configurables par l’utilisateur, donc si vous maîtrisez quel-
que peu les données SysEx vous pouvez créer vos propres 
adaptations ou éditer les adaptations existantes.

Votre logiciel SoundDiver est livré avec des modules et des 
adaptations couvrant plus de 500 appareils MIDI, il est donc 
probable que l’ensemble de votre système MIDI soit compati-
ble avec SoundDiver dès le départ. Le nombre d’adaptations 
fournies augmentera à chaque mise à jour du programme, la 
nécessité de créer vos propres adaptations diminuant par consé-
quent avec le temps. Toutefois, l’option est toujours possible si 
vous souhaitez en profiter.

Chapitre 11
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11.1 Différences entre les 
Modules et les Adaptations

Voici les principales différences entre les modules et les adap-
tations.

Différences de communication MIDI
Seules les adaptations peuvent être crées et éditées par l’utili-
sateur, pas les modules.

• Les adaptations ne peuvent importer de fichiers de données 
non-SoundDiver, excepté le standard MIDI et les fichiers 
SYX/MidiEx.

• Les fonctions d’analyse(Scan) des adaptations ne reconnais-
sent pas les cartes, les cartes d’extensions ni les canaux MIDI.

• Le numéro de version du microprogramme d’un appareil est 
reconnu par les adaptations uniquement si cet appareil gère 
le message “Universal Device Reply”. Même ainsi, l’adapta-
tion ne peut prendre en compte les différences entre les ver-
sions des microprogrammes.

• Les modules reconnaissent souvent plusieurs versions d’un 
même type d’appareil, aussi minimes soient leurs différen-
ces. Ils sont également parfaitement aptes à reconnaître les 
différentes versions logicielles d’un appareil, quand bien 
même de nouvelles possibilités y auront été ajoutées. Ceci 
n’est pas possible avec les adaptations.

• Les modules sont capables de convertir les fichiers d’appa-
reils de même famille (ex: DX7 → SY99). Les adaptations 
également mais de façon plus restreinte.

• Les modules peuvent reconnaître toutes les formes de com-
munication SysEx. Les adaptations ont quelques limites à 
cet égard.(ex: Handshaking, Sample Dump Standard, For-
mats de nom et de Checksum exotiques).

Différences dans les éditeurs
• Les vues d’ensembles (Overview) et Easy Page ne sont pas 

possibles dans les adaptations.
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• Dans les adaptations, il n’y a pas de groupes de paramètres. 
Par conséquent, vous ne pouvez pas sélectionner, couper, co-
pier, coller, initialiser ou rendre aléatoire (Randomize) les 
groupes de paramètres. La fonction New Editor n’est pas dis-
ponible non plus.

• Les éditeurs d’adaptations ont une disposition des objets 
fixe. Tous les objets sont toujours visibles. Dans les modules 
cependant, les objets et les groupes de paramètres peuvent 
être masqués, en fonction de la valeur d’un paramètre. C’est 
souvent le cas dans les éditeurs pour périphériques d’effets 
ou pour la section effets des synthétiseurs : Un paramètre 
“algorithme” définit souvent le statut de tous les autres pa-
ramètres d’effets.

• Les éditeurs de type de données qui ont une structure de 
données dynamique ne sont pas exploitables, ou seulement 
partiellement, dans les adaptations.

• Les objets particuliers (Custom) comme le “Free Algorithm 
Edit” du synthétiseur SY77 ou l’écran 3D du K5000 à syn-
thèse additive ne sont pas reconnus dans les adaptations.

• Les fonctions Range (voir le § Range à la page 324) ne sont 
pas reconnues dans les adaptations.

Autres différences
• Les adaptations peuvent changer automatiquement le canal 

MIDI Thru quand le tampon d’édition actif ou le paramètre 
actuellement en cours change.

• La gestion de la dépendance des entrées ne fonctionne pas 
parfaitement dans toutes les adaptations. Ceci parce que la dé-
finition d’une dépendance est crée avec un objets éditeur spé-
cial. En raison des restrictions dans les éditeurs mentionnées 
plus haut, trop de dépendances sont crées dans certains cas.

• La fonction de nom avec lien automatique (AutoLink name) 
fonctionne de façon limitée dans les adaptations pour les 
appareils multitimbraux, car il est impossible à partir des 
données reçues de déterminer quels sont les canaux MIDI 
utilisés. A la place, l’utilisateur doit définir ces canaux 
manuellement (voir le § Configurer le canal MIDI pour la 
Détection des Changements de Programme à la page 361).
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Pour sélectionner les banques, seuls les messages de contrô-
leur de sélection des deux banques précédés d’un message 
de changement de programme sont reconnus. Les autres 
formats ne le sont pas.

11.2 Édition des Adaptations
La plupart des adaptations livrées avec votre logiciel ont déjà 
été optimisées pour leurs appareils respectifs et ne nécessitent 
pas d’édition supplémentaire. Néanmoins, il se peut que vous 
ayez besoin de modifier les paramètres par défaut. Dans ce cas 
une légère édition sera nécessaire.

Le Menu Adaptation
Dans les fenêtres Device qui sont crées par une adaptation, 
vous trouverez un troisième titre de menu local intitulé Adap-
tation à coté de Entry et View. Ce nouveau menu accède à 
l’éditeur d’adaptation et permet la sauvegarde sur disque des 
adaptations modifiées.

Edit…
A sélectionner pour ouvrir l’éditeur d’adaptation.

Vous pouvez modifier les para-
mètres par défaut dans la partie 
supérieure de l’éditeur d’adapta-
tion.

Save
Sélectionner cette option de 
menu pour sauvegarder le fichier 
de l’adaptation dans le dossier 
Diver.

& Vous pouvez retrouver la version initiale 
en la rechargeant à partir du CD d’origine 
du programme ou en la téléchargeant à 
partir du site internet Emagic (voir ci-
dessous).
382
Emagic
SoundDiver 



Édition des Adaptations
Modifier les paramètres par défaut
Pour savoir comment créer vos propres adaptations, veuillez 
lire le § Créer vos propres Adaptations à la page 384.

Vous avez cependant la possibilité d’effectuer des change-
ments simples sans connaissance approfondie. Nous avons 
volontairement limité l’accès aux seuls paramètres n’altérant 
pas la communication des SysEx entre SoundDiver et l’appa-
reil relié, comme ceux qui modifient simplement l’apparence 
des objets ou changent les paramètres par défaut selon vos 
choix.

Icône
Cliquez-maintenez l’icône afin de sélectionner une icône diffé-
rente pour l’adaptation.

Désormais avec SoundDiver 3.0, il existe une nouvelle option 
pour importer des icônes à partir du menu local.

Sélectionnez Import... dans le menu local d’Icône, un sélecteur 
de fichier apparaîtra. Après l’importation, les données de 
fichiers PNG font partie du fichier Adaptation et sont compati-
bles avec différentes plates-formes informatiques.

Le fichier doit remplir les conditions suivantes:

• Le fichier choisi doit être un fichier PNG (sur Mac: type “PN-
Gf”, Windows: extension .png).

• L’icône doit avoir un canal alpha et doit avoir une définition 
de 128 pixels plus une ombre optionnelle d’au plus 5 pixels. 

• Le canal alpha doit avoir une opacité réduite dans l’ombre.

Voici deux des sites internet où vous pourrez trouver plus 
d’informations sur ce format de fichier et ses particularités.

• http://www.whatis.com/png.htm

• http://www.libpng.org/pub/png/

Réglage par défaut pour Timeout, Send Pause, Play 
Delay
Si vous avez rencontré des problèmes avec ces paramètres 
(peut être dus à un changement dans la version logicielle de 
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l’appareil) et avez trouvé des valeurs plus adaptées, vous 
pouvez les inscrire ici. A partir de ce moment-là, elles devien-
dront les nouvelles valeurs par défaut. Vous en saurez plus sur 
ces paramètres dans le § La Case des Paramètres d’Appareil à 
partir de la page 196 et suivantes.

11.3 Créer vos propres 
Adaptations

Créer vos propres adaptations dans SoundDiver nécessite une 
connaissance approfondie des SysEx, ce qui n’est donc pas 
accessible à tous. En raison du grand nombre de fonctions et 
d’informations requises pour créer une adaptation, nous avons 
édité un guide du programmeur, le SoundDiver Universal 
Module Programming Manual (fichier PDF pour Acrobat Reader, 
en anglais seulement), qui peut être téléchargé à partir de notre 
site internet :

http://www.emagic.de—naviguer jusqu’à Support > Updates > 
SoundDiver
email: info@emagic.de

Ce manuel définit également les conventions nécessaires à 
n’importe quelle adaptation pour faire partie du parc des adap-
tations SoundDiver distribuées par Emagic.
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X

X

Les Préférences

Le menu Préférences est divisé en cinq sections et l’on y 
accède par le menu Options > Settings.

12.1 Communication
Cette page contrôle la communication MIDI entre SoundDiver 
et le(s) interface(s), et peut être ouverte par Options > Settings 
> MIDI Interface Communication….

Cette page s’affichera différemment si AutoLink est actif. Pour 
plus de détails, lisez le § La Communication MIDI avec AutoLink 
à la page 357.

Chapitre 12
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Particularités de Windows
Les paramètres suivants ne sont disponibles que pour la 
version Windows, car ils régissent la communication entre 
SoundDiver et les pilotes MIDI MME.

En mode AutoLink, les paramètres sont masqués, car dans ce 
cas Logic se charge de la communication avec les pilotes MIDI.

MIDI Input Buffers per Port (Mémoires-tampon 
d’entrée MIDI par port)
Ce paramètre détermine combien de Mémoires-Tampon 
d’entrée sont à la disposition de chaque entrée MIDI, de façon 
à recevoir les messages SysEx de manière cyclique. Des valeurs 
importantes peuvent être nécessaires pour les ordinateurs les 
plus lents, pour que les données en cours de réception ne soient 
pas perdues pendant que SoundDiver s’occupe du traitement 
des données déjà reçues. Des valeurs moindres économisent de 
la mémoire. Cependant elles ne doivent pas être inférieures à 2.

KB per MIDI Input Buffer (Kilo-Octets par mémoire-
tampon d’entrée MIDI)
Augmentez cette valeur si vous rencontrez des problèmes de 
communication lors de la réception de transferts (dumps) 
importants de SysEx. Les symptômes : SoundDiver indique 
que l’appareil ne répond pas (bien qu’une partie du transfert ait 
déjà été reçue) ou qu’une erreur de checksum s’est produite.

Pour pouvoir recevoir des messages SysEx, SoundDiver ache-
mine les blocs-mémoire (appelés mémoires-tampon) aux pilo-
tes MIDI, qui sont ensuite écrits avec les messages reçus et 
finalement retournés vers SoundDiver lorsque le message a été 
totalement reçu. Malheureusement, Microsoft n’a pas défini 
précisément la façon dont doit réagir un pilote si un message 
reçu est de taille plus importante que la mémoire-tampon. La 
réaction “idéale” est que le pilote achemine le message en 
plusieurs parties (chacune de la taille de la mémoire-tampon).

C’est le cas avec toutes les interfaces Emagic, Midiman et EES. 
Vous aurez des problèmes si le pilote achemine seulement le 
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début du message (de la taille de la mémoire-tampon), mais 
“avale” le reste. Dans ce cas, la taille des mémoires-tampons 
devra être augmentée en conséquence, pour que cette réaction 
indésirable ne survienne jamais.

Vous devrez donc régler la taille de la mémoire-tampon sur une 
valeur suffisamment grande pour accueillir le plus long 
message de transfert qui puisse transiter par votre installation 
MIDI. Les appareils dont nous savons actuellement qu’ils utili-
sent de très longs messages de transfert sont: les VFX/VFX-SD 
Ensoniq, le SD-1 (programmes internes - environ 60KB) et le 
TS-10/12 Ensoniq (programmes internes - environ 80 
KB).Toutefois, notez que la mémoire totale requise est le résul-
tat de la taille de la mémoire-tampon multipliée par le nombre 
de mémoires-tampon d’entrée MIDI (voir ci-dessus), et le 
nombre d’entrées MIDI. Donc si vous avez une Motu MIDI 
Express XT et une carte-son, cela nécessitera une mémoire de 
3 MB si vous activez 10 mémoires-tampon d’entrée et 30 KB 
par mémoire-tampon d’entrée.

Pour cette raison, SoundDiver ignore ces mêmes paramètres 
pour les interfaces Emagic, et attribue deux mémoires-tampon 
d’1KB chacune par port. Un autre avantage de ce fonctionne-
ment particulier réside dans l’amélioration de la stabilité de la 
barre de progression dans la ligne de statut lorsque SoundDiver 
reçoit d’importants transferts.

& Si nécessaire, vous pouvez contourner ce fonctionnement particulier en maintenant 
S lorsque vous éditez un des paramètres ci-dessus.

Ignore MIDI In Errors (Ignorer les Erreurs MIDI In)
En général, SoundDiver vous prévient si la transmission d’une 
donnée MIDI ne respecte pas les règles du protocole MIDI 
(par ex: des octets de données sont envoyés sans octets de 
statuts joints).

Certains pilotes affichent cette alerte, même si il n’y a pas 
d’erreur de communication. Pour éviter ces messages inutiles, 
le message d’alerte “MIDI-In Errors” peut être supprimé.
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USB Plug & Play
SoundDiver est compatible plug-and-play avec les interfaces 
MIDI USB, c.a.d. quand une interface est ajoutée ou enlevée, 
SoundDiver met à jour automatiquement les ports MIDI dans 
la configuration.

Particularités du Macintosh
Les options suivantes ne sont disponibles que pour la version 
Macintosh, car elles régissent la gestion directe de l’interface 
MIDI.

& Si vous utilisez AppleTalk en mode LocalTalk, il est conseillé de désactiver AppleTalk 
dans le Sélecteur lors de l’utilisation de SoundDiver, ou vous pourriez rencontrer des 
problèmes de communication.

En mode AutoLink, les paramètres sont masqués, car dans ce 
cas Logic se charge de la communication avec l’(es) interface(s) 
MIDI.

Port Modem/Port Imprimante
Si seulement “n/a” (pour “non disponible”) apparaît pour un 
port, cela signifie que le Mac OS indique à SoundDiver que ce 
port n’existe pas. Si vous avez un G3 ou G4 avec un Gee Three 
“Stealth Port” ou Griffin “gPort” installé, vous devez aussi 
installer l’extension système qui accompagne ce matériel. 
Cette extension indique à Mac OS que le modem interne est 
“transformé” en port Modem externe.

& Assurez-vous d’utiliser la dernière version de cette extension, par ex. pour le Mac OS 
9.04 et Stealth, il vous faut “Stealth Serial Port 1.0.3” ou ultérieure.

Si vous ne vous servez que d’un seul des deux ports pour 
SoundDiver, désactivez le second pour permettre à une autre 
application de l’utiliser.

Si SoundDiver ne trouve pas d’interface MIDI sur le(s) port(s) 
activé(s), un dialogue s’affiche, qui vous l’indique et vous 
donne la possibilité de modifier les préférences.

Si cela arrive, vérifiez que l’interface MIDI est bien

❏ connectée
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❏ connectée sur le bon port

❏ allumée.

& Ce message d’alerte ne s’applique que pour la communication entre l’interface MIDI 
et SoundDiver, et non pour d’éventuels appareils MIDI connectés.

& Pour éviter un affichage répété du message, inhérent à toute série d’essais, désac-
tivez simplement les deux ports dans les Préférences.

USB
SoundDiver reconnaît directement les interfaces MIDI USB 
d’Emagic, sans l’aide d’OMS. Vous devez juste déposer le 
fichier “USB Unitor Family Driver” (fournit avec l’interface) 
dans le Dossier Système.

& Utilisez la version du pilote 1.1 ou supérieure. Les versions antérieures ne gèrent pas 
le MT4, et génèrent des problèmes lorsque une clé (dongle) USB Emagic est 
connectée. 

Si votre Macintosh ne dispose pas de ports USB, ou que Sound-
Diver ne détecte pas d’interface USB Emagic, le texte n/a 
(pour “non disponible”) s’affiche sous l’inscription USB. Dans 
le cas contraire, ok s’affiche, ainsi que les interfaces reconnues 
(voir plus bas).

Utiliser des Interfaces MIDI USB autres qu’Emagic

Si vous désirez employer une interface MIDI USB autre 
qu’Emagic, vous devez utiliser SoundDiver en mode OMS. 
Lisez le § OMS à la page 66.

Hot Swapping

Si une interface MIDI Emagic connectée au port USB est 
éteinte ou débranchée, une alerte s’affiche et les ports MIDI de 
l’interface ne sont plus disponibles. Si l’interface USB est allu-
mée à nouveau, les ports MIDI redeviennent disponibles.

Affichage des interfaces reconnues
Si une MTP, une Unitor8 ou une AMT8 ont été détectées, un 
affichage apparaîtra à la droite des icônes des ports Modem, 
Imprimante ou USB. Le texte affiché sera soit :
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MTP
Une ou deux MIDI Time Pieces ou une MIDI Express ont
été détectées. En dessous, vous voyez deux carrés pour les
appareils pouvant être connectés. Pour ceux qui ont été
détectés, les carrés sont coloriés en vert.

MTP II
Comme ci-dessus, mais valable lorsqu’une ou deux MTP II
ou MTP AV, ou une MIDI Express XT ont été détectées.

Unitor8
Une ou plusieurs Unitor8/AMT8 Emagic ont été détec-
tées; la première unité est une Unitor8 ou Unitor8 MkII
dont le numéro de version est affiché entre parenthèses. En
dessous, il y a huit carrés correspondants aux appareils qui
peuvent être connectés. Pour ceux qui ont été détectés, les
carrés sont coloriés en vert. 

AMT8
Une ou plusieurs Unitor8/AMT8 Emagic ont été détec-
tées; la première unité est une AMT8 dont le numéro de
version est affiché entre parenthèses. En dessous, il y a huit
carrés correspondants aux appareils qui peuvent être con-
nectés. Pour ceux qui ont été détectés, les carrés sont colo-
riés en vert.

MT4
Une MT4 Emagic a été détectée; son numéro de version
est affiché entre parenthèses. En dessous, il y a un carré
vert.

Options pour les Ports Modem et Imprimante
Les options suivantes ne s’appliquent qu’aux ports Modem et 
Imprimante et aux interfaces MIDI compatibles avec le stan-
dard “MIDI Time Piece” (MTP). Si vous avez une interface 
différente, ces réglages n’ont aucune utilité.
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Check for MTP

Si cette option est activée, SoundDiver recherche n’importe 
quelle interface compatible MTP qui puisse être connectée, et 
active automatiquement MTP Cable Mode quand il en détecte 
une. Deux MTP peuvent être connectées sur un port (l’une 
réglée sur “1-8” et l’autre sur “9-16”), et SoundDiver saura les 
détecter.

Si une ou plusieurs Unitor8 ou AMT8 sont connectées, elles 
sont détectées si Check for MTP est activé.

Attention: Si vous utilisez une ancienne Studio 4 ou une 
Studio 5 Opcode, cette opération n’est pas possible. Désactivez 
manuellement Check for MTP et activez MTP Cable Mode. Le 
logiciel déterminera donc que vous avez une Studio 5 et acti-
vera les câbles 1 à 16.

MTP Cable Mode

Si cette option est activée, SoundDiver peut adresser toutes les 
sorties MTP séparément. Comme précédemment, “M0” 
permet à toutes les sorties du port modem et “P0” à toutes les 
sorties du port imprimante d’être adressées simultanément, 
bien que ceci n’a généralement pas beaucoup de sens.

Fast Speed

Cette option commute la MTP sur son mode Fast Speed, grâce 
auquel la communication entre le Macintosh et la MTP est à 
peu près cinq fois plus rapide que le MIDI. N’oubliez pas, 
cependant, que cela n’accélère pas la communication entre la 
MTP et les appareils MIDI qui lui sont connectés. Fast Speed 
autorise un débit plus rapide uniquement lorsque des sorties 
simultanées sur plusieurs sorties MIDI existent, ce qui est rare-
ment le cas dans SoundDiver.

Check MTP Configuration

Avant que SoundDiver ne puisse communiquer avec les appa-
reils connectés via une MTP, cette dernière doit être correcte-
ment paramétrée.

• Les canaux MIDI ne doivent pas être renvoyés vers la MTP
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• Les changements de programmes (Program Change) et 
changements de contrôles (Control Change) ne doivent pas 
être filtrés sur aucun canal des entrées ni des sorties.

• Les SysEx ne doivent pas être filtrés sur les entrées ni les 
sorties.

• Toutes les entrées et sorties doivent être connectées au(x) 
port(s) du Macintosh.

Lorsque vous activez Check MTP Configuration, ces paramètres 
sont vérifiés à chaque démarrage du logiciel, et à chaque fois 
que vous activez un port MIDI.

Si un seul de ces paramètres n’est pas réglé correctement, un 
message apparaît:

No further warnings (Plus d’autres alertes)
Désactive Check MTP Configuration.

Don’t configure (Ne pas configurer)
Les réglages pour la MTP demeurent inchangés.

Configure (Configurer)
Notre recommandation. La MTP est configurée de façon à
ce que les conditions mentionnées plus haut soient rem-
plies. Tous les autres réglages demeurent inchangés.

& Attention: La plus récente Studio 4 d’Opcode agit comme une MTP, mais cependant 
pas complètement. Il en résulte que, SoundDiver pense avoir reconnu une MTP mais 
l’option “Configure” ne fonctionne pas, et chaque fois que vous démarrez l’applica-
tion, SoundDiver “se plaint” de la configuration incorrecte de la MTP présumée. 
Dans ce cas, vous devez désactiver Check MTP Configuration.

Use MIDI Manager if Available (Utiliser MIDI 
Manager si installé)
Vous pouvez définir ici la façon dont SoundDiver procédera lors 
de l’initialisation des connexions MIDI, si Apple MIDI Mana-
ger est installé:

Never (Jamais)
Le MIDI Manager est toujours ignoré.
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Ask (Demander)
Un dialogue apparaîtra où vous pourrez décider chaque fois
de la façon de procéder:

Never (Jamais)
L’option “Utiliser le MIDI Manager si installé” devient
“Jamais”, et le MIDI Manager est ignoré.

Don’t use now (Pas maintenant)
Le MIDI Manager n’est pas utilisé cette fois-ci. Lors de la pro-
chaine initialisation des connexions MIDI, le dialogue réap-
paraîtra, pour vous permettre alors de faire d’autres choix.

Use now (Maintenant)
Le MIDI Manager est utilisé cette fois-ci. Lors de la prochaine
initialisation des connexions MIDI, la fenêtre de dialogue
réapparaîtra, pour vous permettre alors de faire d’autres
choix.

Always (Toujours)
L’option “Utiliser le MIDI Manager si installé” devient 
“Toujours”, et le MIDI Manager est utilisé.

Always
Le MIDI Manager est toujours utilisé (sans vous demander
confirmation).

Use OMS if Available (Utiliser OMS si Installé)
Vous pouvez définir à cet endroit la façon dont SoundDiver 
procédera lors de l’initialisation des connexions MIDI, si OMS 
est installé:

Never (Jamais)
OMS est toujours ignoré.

Ask (Demander)
Un dialogue apparaîtra où vous pourrez décider chaque fois
de la façon de procéder:

Never (Jamais)
L’option “Utiliser OMS si installé” devient “Jamais”, et OMS
est ignoré.
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Don’t use now (Pas maintenant)
OMS n’est pas utilisé cette fois-ci. Lors de la prochaine initia-
lisation des connexions MIDI, le dialogue réapparaîtra, pour
vous permettre alors de faire d’autres choix.

Use now (Maintenant)
OMS est utilisé cette fois-ci. Lors de la prochaine initialisa-
tion des connexions MIDI, le dialogue réapparaîtra, pour
vous permettre alors de faire d’autres choix.

Always (Toujours)
L’option “OMS si installé” devient “Toujours”, et OMS est uti-
lisé.

Always (Toujours)
OMS est toujours utilisé (sans vous demander confirma-
tion).

Réglages OMS
Les boutons suivants n’apparaissent qu’en mode OMS.

OMS Studio Setup …

Ce bouton n’apparaît qu’en mode OMS. Cliquer dessus ouvre 
l’OMS Studio Setup actuel, en utilisant l’application “OMS 
Setup”. 

OMS MIDI Setup …

Ce bouton n’apparaît qu’en mode OMS. Cliquer dessus ouvre 
les réglages MIDI OMS actuels, en utilisant l’application 
“OMS Setup”.

Particularités du Mode AutoLink

Synchronize Screensets (Synchroniser les Screen-
sets)
Cette option n’apparaît qu’en mode AutoLink. Pour plus de 
détails, reportez-vous au § Synchroniser les Screensets à la page 
376.
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Process Incoming MIDI only for Active 
Device (Traiter le MIDI reçu seulement pour l’Appareil actif)

Ici, vous pouvez choisir de traiter l’entrée MIDI uniquement 
pour les appareils actifs du moment. Quand cette option est 
désactivée, SoundDiver traite et actualise les données des 
autres appareils, même si ils ne sont pas actifs à cet instant. Si 
une donnée, qui correspond à un appareil dont le Module n’est 
pas encore chargé à cet instant, est reçue, SoundDiver charge 
automatiquement ce Module. Si vous souhaitez qu’il en soit 
autrement, activez cette option.

& SoundDiver se montre plutôt intelligent quant à la façon de décider lequel des appa-
reils virtuels inactifs doivent être “expérimentés”: seuls les messages SysEx sont 
traités pour les appareils inactifs, et seulement lorsque le Device ID du fabricant 
correspond.

Check Device Connections at Startup 
(Vérification des Connexions des Appareils au Démarrage)

Lorsque cette option est activée, SoundDiver recherche au 
démarrage tous les appareils et attend une réponse de leur part.

Si un appareil ne répond pas, un message d’alerte apparaît. 

Abort (Abandonner)
Annule totalement la vérification. Ceci s’avère utile si
l’ordinateur n’est à cet instant pas connecté à une interface
MIDI, mais que SD est activé en mode de démonstration
seulement.

Skip (Passer)
“Passe” l’appareil, et continu avec le prochain dans la con-
figuration. C’est utile si l’appareil est momentanément
indisponible.
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Delete (Effacer)
Efface l’appareil de la liste. C’est utile si l’appareil a été
effacé de la configuration.

Retry (Réessayer)
Réessaie de trouver l’appareil. C’est utile si vous avez
oublié d’allumer l’appareil ou l’interface MIDI.

Re-scan (Réexplorer)
Efface l’appareil de la configuration et sélectionne le modè-
le pour l’exploration.

Après vérification de tous les appareils, tous ceux ayant été 
sélectionnés par “Re-scan” sont recherchés, comme s’ils 
étaient sélectionnés dans la fenêtre Install (voir le § Scanner à la 
page 60).

Additional Timeout (Temps Supplémentaire)

Cette valeur ajoute une durée globale supplémentaire de 
temps d’attente aux messages MIDI reçus. Cela s’avère prati-
que quand vous avez un appareil MIDI inséré entre l’interface 
et l’appareil en fin de chaîne (baie de raccordement, boîtier de 
Thru, autre processeur MIDI) qui retarde la communication 
MIDI.

Il se peut que vous deviez augmenter cette valeur lorsque des 
appareils ne peuvent être repérés par la recherche.

Request Retries (Réessayer les Requêtes)

Cette option détermine la fréquence avec laquelle SoundDiver 
tente des demandes d’entrées avant qu’un message d’échec 
n’apparaisse. Avec certaines machines cela vaut la peine 
d’essayer plusieurs fois, si elles sont lentes à réagir. Le temps 
d’attente, toutefois, devient inutilement long si l’appareil 
refuse obstinément de répondre (par ex: s’il est éteint). Vous 
devrez donc régler cette valeur conformément à la limite de 
votre patience...
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12.2 Global Settings

Save Device Entries in Preferences File 
(Sauvegarder les Entrées d’Appareils dans le Fichier Préférences)

Si cette option est activée, certaines entrées de tous les appa-
reils installés dans la fenêtre Setup sont sauvegardées dans le 
fichier Préférences quand vous quittez SoundDiver ou que 
vous sauvez les Préférences:

None (Aucune)
Rien n’est sauvegardé ;

I
Seule la mémoire interne est sauvée (pas les cartes, ni la
ROM) ;

I+C
Seule la mémoire interne et toutes les cartes RAM disponi-
bles sont sauvées;

I+C+R
Tout est sauvé sauf le contenu des tampons d’édition;

All (Tout)
Tout est sauvegardé.
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Les entrées que vous choisissez seront disponibles dès que 
vous démarrerez SoundDiver, et vous n’aurez pas besoin 
d’utiliser AutoRequest ni ManualRequest pour les obtenir.

& Si vous préférez être tranquille, n’utilisez pas cette fonction (réglez-la sur “None”); à 
la place, activez la fonction AutoRequest dans tous les appareils. Vous parviendrez 
finalement au même résultat, mais il sera toujours actualisé. Bien entendu, cela 
implique que vous devrez patienter pour que chacun de vos appareils effectue un 
transfert SysEx complet, chaque fois que vous lancerez SoundDiver.

Lisez également le § Auto Request à partir de la page 204 et 
suivantes.

Auto Snapshot Every x s (Instantané automatique 

toutes les x secondes)

Ce paramètre est disponible pour SoundDiver uniquement. Si 
vous entrez une valeur (x) supérieure à zéro, les tampons 
d’édition qui sont en cours d’édition sont régulièrement sauve-
gardés dans la bibliothèque de Snapshots chaque x secondes 
(voir Snapshot (Instantané) à la page 319 du Chapitre 8 L’édition 
dans SoundDiver).

& Il arrive souvent lors de vos expérimentations avec divers paramètres, que vous soyez 
trop occupé pour penser à faire appel à la routine de Snapshot, et vous risquez alors 
de perdre certaines de vos idées. Cette fonction vous garantit de ne rien perdre.

& Grâce à la bibliothèque qui sauvegarde également l’heure de chaque Instantané, 
vous pouvez savoir quand l’Instantané a été fait.

Cette fonction affecte toutes les entrées éditées, que la fenêtre 
d’édition correspondante soit ouverte ou pas. Ce qui signifie 

Il est très important de noter ce qui suit: si vous utilisez 
cette option, vous ne devez jamais modifier le contenu 
de la mémoire dans l’appareil lui-même ni par l’inter-
médiaire d’autres applications. Le cas échéant, vous 
courrez le risque de provoquer d’importantes incohé-
rences entre SoundDiver et le contenu de la mémoire 
de votre appareil. Ceci pourrait conduire à une super-
position accidentelle de vos nouveaux et précieux sons 
parce que SoundDiver travaille conformément à une 
ancienne version du contenu de la mémoire.
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que vous êtes libre d’ouvrir et de fermer des fenêtres, de chan-
ger les tampons d’édition ou d’éditer différents appareils.

Pour désactiver cette fonction, entrez un zéro (affiché comme 
un champ vide).

Dependency Management (Gestion des Dépendances)

Quand cette option est désactivée, aucune dépendance (liens) 
n’est prise en compte, ni dans les fenêtres Device ni dans les 
Bibliothèques. Pour plus de détails concernant la gestion des 
dépendances, reportez-vous au § Gestion de la Dépendance des 
Entrées à la page 216. Par défaut: activée.

Mouse as Slider (Souris comme Curseur)

Cette option détermine de quelle façon les valeurs numériques 
sont modifiées par la souris.

• Quand elle est activée (réglage par défaut) : cliquez-main-
tenez la valeur et modifiez-la en bougeant la souris en avant/
en arrière. Si vous double-cliquez sur la valeur, une zone 
s’ouvre ou vous pouvez inscrire la valeur manuellement via 
le pavé numérique de l’ordinateur.

• Quand elle est désactivée : un clic sur la valeur l’augmente 
d’un pas et un C- clic la diminue.

Fader Tracking (Vitesse du curseur)

Ce paramètre contrôle l’action du pointeur de la souris en inter-
polant entre de brefs mouvements de souris et une édition 
précise. Si la distance entre le minimum et le maximum est trop 
longue, ou que le nombre de pas est trop petit, utilisez cette 
fonction pour modifier la sensibilité de la souris. Si vous 
augmentez la valeur de FaderTracking, un mouvement de 
souris plus long sera réglé de façon à changer un paramètre. 
Ceci est particulièrement utile avec de petits objets.

La valeur par défaut est 3.0, ce qui signifie que le pointeur de la 
souris doit déplacer 300 pixels au moins.
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Si un objet est plus grand ou plus large que cette valeur, c’est la 
plus grande valeur de objet qui est utilisée.

On peut imiter les réglages des anciennes versions de Sound-
Diver en réglant la valeur sur 1.0.

& Ce paramètre n’affecte pas les performances de la molette sur une souris qui en est 
munie. 

Num Lock (Verr num.)

Lorsque cette option est activée, au lieu d’utiliser le pavé 
numérique du clavier informatique pour rappeler des Screen-
sets, vous pouvez entrer des nombres avec.

Vous pouvez également activer/désactiver le Verrouillage 
Numérique grâce au raccourci-clavier Num Lock.

Pour plus de détails, lisez le § Entrée de valeurs au clavier à la 
page 306.

& Ne confondez pas Num Lock avec Verr. Maj. Voir le § Sélectionner des entrées en 
utilisant les noms à partir de la page 225 et suivantes.

Deauthorize (Désautoriser)

Ce bouton vous permet de retirer l’autorisation SoundDiver du 
disque dur. Pour cette tâche, le CD SoundDiver n’est pas 
nécessaire. SoundDiver continuera de fonctionner. Toutefois, 
la prochaine fois que vous le lancerez, vous devrez soit autoriser 
à nouveau le lecteur soit laisser le CD SoundDiver inséré. 
Consultez également le § Supprimer une autorisation (Désautori-
ser) à la page 55.
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X

12.3 Réglage de l’Affichage

Different Appearance (Autre aspect)
Cette option modifie l’apparence en revenant à celle de 
l’ancienne mise en page (version 2.0). Raccourci-clavier : Toggle 
look.

Hide Value in Linear Parameters (Masquer les 

valeurs dans les paramètres linéaires)

Cette option masque les valeurs numériques dans la fenêtre 
d’édition, pour rendre cette dernière plus nette, puisque beau-
coup de nombres et de lignes de séparation sont masquées. 
Raccourci-clavier : Toggle Parameter Value Display.

Si cette option est activée, le graphisme des curseurs et des 
boutons est plus grand, car les valeurs numériques ne sont pas 
affichées. Ces dernières sont remplacées par un potentiomètre 
mais uniquement si elles ne sont pas atteintes par un menu 
local, si elles disposent d’au moins 3 valeurs possibles et 
qu’elles ne sont pas des valeurs de numéro de notes. 

Les illustrations ci-dessous montrent une partie de la fenêtre 
d’édition d’un EX5: à gauche avec l’option activée, à droite 
désactivée.
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3D Look (Aspect 3D)

SoundDiver est visuellement plus clair quand cette option est 
activée, comme montré ci-dessus. Dans ce cas, le fond d’écran 
et tous les graphismes de faders et de potentiomètres sont affi-
chés avec une apparence 3D, si 256 couleurs (ou plus) sont 
disponibles.
SoundDiver fonctionnera plus rapidement avec le fond d’écran 
gris neutre et des élément noirs sur blanc.

Sound Effects (Effets Sonores)

SoundDiver a une gamme de signaux audio qui annoncent par 
ex: le démarrage, l’apparition des messages d’alerte ou l’achè-
vement d’une opération. Activez-les ici.

Show Progress (Afficher la progression)

Lorsque cette option active, SoundDiver montre, par l’inter-
médiaire d’une barre de progression, ou en est le cours du trai-
tement d’un calcul ou d’une opération sur les entrées/sorties. 
Sous Windows, elle apparaît dans la ligne de statut. Cette fonc-
tion ralentit quelque peu le programme, mais vous permet de 
connaître le temps d’attente restant.

Flicker-free Display (Affichage Anti-Scintillement)

Lorsque cette option est allumée, les rafraîchissements 
d’écrans sont d’abord préparés en arrière-plan, et ensuite 
copiés à l’écran dans leur totalité. Il en résulte une apparence 
plus nette, particulièrement lorsque vous faites défiler et 
travaillez sur les enveloppes et les curseurs 3D.
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L’affichage anti-scintillements a temporairement besoin de 
mémoire, dont la quantité dépend de la taille de la fenêtre et du 
nombre de couleurs. S’il n’y a pas suffisamment de mémoire 
disponible, l’affichage va directement à l’écran. A la première 
apparition de ce problème, vous aurez un message d’alerte. Dans 
ce cas, il vous faut soit désactiver l’écran anti-scintillements, ou 
(sur Macintosh) augmenter la mémoire pour SoundDiver.

ToolTips (Bulles d’aide)

Maintenir le pointeur de la souris pendant une seconde sur un 
objet sans le déplacer fait apparaître une bulle d’aide à côté de 
cet objet (normalement en dessous), qui affiche le nom exact de 
celui-ci. Après 10 secondes (ou si la souris est déplacée vers un 
autre objet ou qu’une touche est appuyée), elle se referme. 
Lisez également le § Les Bulles d’Aide à la page 177.
&  : If Help > Show Balloons est activé, les bulles d’aide s’ouvrent immédiatement 

et ne se referment que si le pointeur de la souris est déplacé dans une zone où il n’y 
a aucun objet susceptible de faire apparaître la bulle d’aide.

When Pointing on Objects (En pointant les Objets)

Quand cette option est activée, SoundDiver affiche les bulles 
d’aide lorsque le pointeur de la souris est placé sur un objet.

While Editing (En éditant)

Lorsque cette option est activée, les bulles d’aide s’affichent 
lorsqu’un paramètre est édité dans les fenêtres d’édition.
& Cette option est particulièrement utile lorsque vous désactivez également l’affichage 

des valeurs de paramètres (voir le § Hide Value in Linear Parameters (Masquer les 
valeurs dans les paramètres linéaires) à la page 401.

Language (Langue)

Grâce à ce menu local, la langue peut être choisie. Ces change-
ments prendront effet après le redémarrage de SoundDiver.
& Le réglage de la langue se charge à partir du fichier par défaut “SoundDiver Prefe-

rences 3.0”. Le fait de démarrer SoundDiver à partir d’un autre dossier de préfé-
rences n’annule pas ce réglage.

Vous trouverez de plus amples détails au § Langue à la page 413.
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12.4 Messages de Sécurité

Ne désactivez les messages de sécurité que lorsque vous vous 
sentez à l’aise pour travailler avec SoundDiver et souhaitez 
accélérer votre travail.

Charger des Entrées d’Appareil à partir des 
Préférences
Après chargement des préférences contenant les entrées 
d’appareil (voir le § Save Device Entries in Preferences File (Sauve-
garder les Entrées d’Appareils dans le Fichier Préférences) à la page 
397), le message suivant apparaît:

Cliquez OK pour remplacer le 
contenu de la mémoire de vos 
appareils. Ceci assure que 
SoundDiver et vos appareils 
utilisent des données corres-
pondantes. Si vous n’avez pas 
besoin voir ce message, cliquez 

sur le bouton No further warnings ou désactivez after loading Device 
Entries from Preferences dans les Préférences.
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Saving Preferences (Sauvegarder les Préférences)

Lorsque cette option est activée, il vous sera demandé si vous 
voulez sauver les fichiers de préférences. Sinon, les fichiers de 
préférences seront automatiquement sauvés sans avertisse-
ment. Ces options ne peuvent être désactivées.

& Comme cette option est sauvée dans le fichier de préférences lui-même, vous devez 
la régler séparément pour chaque fichier de préférences, si vous utilisez plusieurs 
fichiers de préférences.

& Vous pouvez néanmoins quitter SoundDiver sans sauver les préférences (et sans le 
message d’alerte) en maintenant S ( : O) ou par le raccourci-clavier Quit without 
saving Preferences.

Overwriting Memory Entries (Remplacer des 

Entrées Mémoire)

Lorsque cette option est activée (réglage par défaut), un 
message d’alerte apparaît à chaque collage ou copie effectuée 
avec la souris dans la fenêtre Appareil.

Lorsque cette option est désactivée, la question de sécurité ne 
s’affiche que quand vous utilisez Edit > Paste, et pas lorsque 
vous déplacez quelque chose avec la souris.

Deleting Doubles (Doublons)

Cette option n’est effective que si la fonction Check doubles 
(dans l’onglet “Library”) est active. Quand cette option est 
active, une question de sécurité s’affiche dès que deux entrées 
identiques sont localisées. Ceci vous permet d’opter ou non 
pour l’effacement de l’entrée double.

Si l’option n’est pas active, les doublons sont effacés sans aver-
tissement.
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Editing Unknown Entries (Éditer des entrées incon-

nues)

Cette option détermine si SoundDiver doit vous demander de 
créer une entrée initialisée, ou d’en faire la requête auprès de 
l’appareil en double-cliquant sur une entrée vierge (inconnue). 

Si ce message est désactivé, l’entrée est automatiquement 
demandée à l’appareil. Si l’appareil ne peut pas être ques-
tionné, l’entrée est initialisée.

Closing Altered Editor Windows (Fermer les 

fenêtres d’édition modifiées)

Si vous avez édité une entrée dans l’éditeur et souhaitez fermer 
la dernière fenêtre d’édition, SoundDiver sauvegardera norma-
lement les changements automatiquement.
Si ce message de sécurité est activé, un dialogue apparaît dans 
lequel vous pouvez
❏ confirmer la sauvegarde de l’entrée
❏ sélectionner une entrée de destination différente pour la

sauvegarde
❏ fermer la fenêtre sans sauvegarder
❏ décider finalement de ne pas fermer la fenêtre.
Si ce même message est inactivé, SoundDiver sauvera les chan-
gements dans l’entrée source, si elle est disponible. Cela peut 
également être une entrée de bibliothèque si vous avez ouvert 
l’éditeur à partir d’une bibliothèque.

Overwriting Edited Entries (Remplacer les entrées 

éditées)

Si vous avez édité une entrée dans l’éditeur, mais ne l’avez pas 
encore sauvée, il se peut qu’elle soit remplacée lors de certaines 
étapes. Ceci peut se produire lors d’une opération d’AutoAudi-
tion, ou lorsque vous voulez ouvrir la fenêtre d’édition d’une 
autre entrée utilisant le même tampon d’édition. Grâce à cette 
option, vous pouvez décider de ce que doit faire SoundDiver.
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Si Overwriting edited entries est activé, un dialogue apparaît. 
Confirmez avec OK si vous voulez remplacer l’entrée. Vous 
perdrez alors toutes vos éditions. Si vous sélectionnez Cancel, le 
remplacement est annulé et vous pourrez sauver vos éditions 
ultérieurement.
Si cette option est désactivée, l’entrée éditée est remplacée 
sans avertissement.

Create Logic Instruments (Créer des Instruments Logic)

Voir le § Créer des Instruments Logic à partir de la page 359 et 
suivantes.

12.5 Bibliothèque

Auto-save Libraries Every x min (Sauvegarde 

automatique des Bibliothèques toutes les x mn)

Si vous entrez une valeur (x) supérieure à zéro, les bibliothè-
ques qui ont été éditées sont sauvegardées régulièrement 
toutes les x minutes. Pour désactiver cette fonction, entrez un 
zéro (champ vide). Si de nouvelles bibliothèques sont concer-
nées, il vous sera demandé de leur donner un nom de fichier. 
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Cette fonction protège vos données aussi souvent que néces-
saire.

Quelques secondes avant que la sauvegarde automatique n’ait 
lieu, vous verrez une barre de décompte. Vous pourrez conti-
nuer de travailler durant l’affichage de cette dernière.

Cette fonction est valable pour toutes les bibliothèques conte-
nant des éditions (même la bibliothèque de Snapshot), même 
si leurs fenêtres sont fermées.

& Pour garantir la protection de vos données, réglez-la sur 1 min.

& Rappelez-vous cependant que l’article “Revert” du menu File n’est désormais plus 
d’une grande utilité car vous ne pouvez charger que le dernier fichier sauvé, qu’il l’ait 
été automatiquement ou manuellement.

Reopen Libraries (Rouvrir les Bibliothèques)

Lors de sa fermeture, SoundDiver créé un rapport sur les 
bibliothèques ouvertes dans les préférences, et les ouvre auto-
matiquement quand le programme est redémarré (ou lorsque le 
fichier Préférences est rechargé). Si vous ne souhaitez pas qu’il 
en soit ainsi, désactivez cette option.

Check Doubles (Vérifier les Doublons)

Quand cette option est activée, chaque fois que vous faites un 
collage dans une Bibliothèque, le programme recherche si une 
entrée identique est déjà présente dans la fenêtre de destina-
tion. Si c’est le cas, le nouveau double sera automatiquement 
effacé.

Prefer Selected Devices as Target (Préférer les 

Appareils sélectionnés comme Destination)

Lorsque cette option est activée, les appareils sélectionnés 
dans la fenêtre Setup sont préférés, même s’il existe un autre 
appareil convenant mieux pour les entrées à transmettre. Ceci 
s’applique à AutoAudition, Audition et Transmit à l’intérieur 
d’une fenêtre de Bibliothèque.
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Par défaut: désactivé.

Voir aussi le § Stratégie de sélection d’appareils lors d’envois depuis 
une Bibliothèque à la page 212.

12.6 Fichier Préférences
SoundDiver permet de paramétrer le logiciel comme vous le 
souhaitez, afin de pouvoir ensuite rappeler ces réglages lors de 
sa prochaine ouverture. Pour cela, SoundDiver sauve tous les 
réglages par défaut dans un fichier.

Cette option est pratique lorsque vous avez besoin que Sound-
Diver s’adapte à différentes situations. Admettons, par exem-
ple, que vous utilisiez SoundDiver à la fois chez vous et en 
studio, avec dans les deux cas des systèmes MIDI différents, ou 
que vous souhaitiez vous en servir parfois avec un module, et 
d’autres fois avec tous vos appareils MIDI en même temps.

La configuration de SoundDiver est chargée à partir du fichier 
que vous utilisez pour démarrer SoundDiver. Vous pouvez 
adapter le logiciel à un système différent en démarrant Sound-
Diver avec un fichier de préférences adéquat. Si vous démarrez 
SoundDiver directement, les préférences standards seront 
utilisées (voir ci-dessous).

Contenu du Fichier Préférences
Voici une liste des paramètres sauvegardés dans ce fichier et 
rappelés au démarrage du logiciel:

• tous les réglages généraux des appareils installés (c.a.d. tous 
les paramètres de la case des paramètres d’appareil, ainsi que 
les données internes spécifiques à chaque appareil, qui ne 
sont pas affichées);

• en fonction de l’option Save device entries in Preferences, 
certaines entrées d’appareils;

• les positions des icônes dans la fenêtre Setup;
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• tous les réglages de la fenêtre Séquenceur (tempo du 
séquenceur interne, durée de l’AutoPlay);

• le nombre de Screensets actuellement sélectionnées;

• tous les réglages de la fenêtre Préférences;

& Sous Windows, la langue actuellement sélectionnée est sauvegardée séparément 
dans le Registre. Voir le § Langue à la page 413.

• tous les réglages du menu Options (AutoPlay, AutoAudition, 
MIDI Thru);

• tous les réglages de la fenêtre Find;

• tous les réglages du dialogue Page Setup ;

• le nom des modèles et des types de données de tous les 
Modules (sauf le Module Universel);

• les noms de fichiers (y compris les chemins d’accès) de 
toutes les bibliothèques chargées;

• tous les Screensets (sans les Screensets de bibliothèques, qui 
sont stockés à l’intérieur du fichier Bibliothèque);

• tous les raccourcis-clavier; 

• tous les réglages de la fenêtre d’Assignation de Contrôleur;

• toute autre donnée permettant au logiciel de fonctionner 
avec plus de stabilité;

Créer le Fichier Préférences
Quand vous quittez SoundDiver, son état en cours est sauvé sur 
disque: 

Sous Windows dans le fichier DIVER\SoundDiver 3.0 Preferen-
ces.PRF et 

 : dans le dossier “Preferences” du Dossier Système du 
Macintosh sous SoundDiver 3.0 Preferences.

Pour créer un nouveau fichier de préférences, utilisez la fonc-
tion File > Save Preferences as… (voir le § Save Preferences as… 
à la page 142) et inscrivez un nom de fichier différent.
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Si vous ouvrez maintenant ce fichier, SoundDiver démarre à 
partir d’ici et sauvegarde également les modifications de ces 
réglages dans ce fichier (sauf la langue comme précédemment 
expliqué).

Sous Windows, SoundDiver n’est lancé que quand vous cliquez 
sur ce fichier, si vous avez d’abord déplacé le fichier sur l’icône 
du logiciel ou assigné le type de fichier PRF à SoundDiver dans 
Windows Explorer (voir le manuel de Windows 95/98).

&  : La langue sélectionnée est toujours stockée dans le fichier Préférences par défaut, 
même si SoundDiver est lancé par un fichier Préférences différent.

& Sous Windows, la langue actuellement sélectionnée est sauvegardée séparément 
dans le Registre. Voir le § Langue à la page 413.

& Dans les précédentes versions de SoundDiver, le nom du fichier Préférences par 
défaut était “SoundDiver Preferences”. Puisque le nom a été changé dans la version 
3.0, il est possible de démarrer SoundDiver 2.X et 3.0 avec différents réglages sans 
modifier les réglages des autres versions.

& Si SoundDiver ne trouve pas le fichier “SoundDiver 3.0 Preferences”, le fichier 
“SoundDiver Preferences” est chargé et sauvegardé sous le nom “SoundDiver 3.0 
Preferences”.

Saving Preferences Automatically (Sauver auto-

matiquement les Préférences)

Les préférences sont automatiquement sauvegardées sur 
disque chaque fois que vous quittez SoundDiver. Il vous suffit 
de sélectionner File > Quit.

Saving Preferences Manually (Sauver manuelle-

ment les Préférences)

Saving Preferences in the Current File (Sauver les Préfé-
rences dans le fichier actuel)

Vous pouvez sauver les préférences n’importe quand en sélec-
tionnant File > Save Preferences (voir le § Page Setup… (Format 
d’impression) à la page 142).
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Save Preferences under a Different File Name (Sauver 
les Préférences sous un nom de fichier différent)

Pour créer un nouveau fichier de préférences, appelez File > 
Save Prefs as…. N’oubliez pas que durant une sauvegarde 
manuelle ou automatique (voir ci-dessus) ce fichier sera 
remplacé.

& Consacrer environ un quart d’heure à configurer SoundDiver selon vos souhaits avec 
l’aide de la liste ci-dessus est une excellente idée. Effectuez vos réglages par défaut, 
disposez la fenêtre Setup ainsi que les autres fenêtres, créez une bibliothèque Auto-
load et quelques Screensets puis sauvegardez toutes ces préférences.

Charger les Préférences
Même au milieu d’une séance de travail, vous pouvez charger 
d’autres préférences (par exemple celles d’un collègue) en 
sélectionnant File > Open, et SoundDiver sera immédiatement 
reconfiguré.

 : Les nouvelles préférences peuvent aussi être chargées par 
un simple double-clic sur leur icône.

Un message vous demandera si vous souhaitez d’abord sauver 
les préférences existantes.

Reconstruire le Contenu de la Fenêtre Install
SoundDiver sauvegarde le contenu de la fenêtre Install dans 
une mémoire-cache au sein du fichier de préférences. Si cette 
mémoire-cache est incomplète ou endommagée, SoundDiver 
peut être obligé de recharger le contenu.

Lorsque vous chargez un fichier de préférences tout en mainte-
nant appuyé S, SoundDiver ignorera le modèle mis dans la 
mémoire-cache et les noms de types de données et rechargera 
tous les Modules à l’ouverture de la fenêtre Install.

Recharger les Icônes
Lorsque vous chargez les préférences et que vous maintenez 
ç ( : C), les images d’icônes mises dans la mémoire-cache 
sont ignorées.
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Ceci est utile si un Module contient de nouveaux graphiques 
que vous voulez actualiser. Lisez également le § Importer de 
nouvelles icônes à la page 194.

Réinitialiser les Préférences
Pour réinitialiser tous les réglages des préférences, sélectionnez 
Options > Initialize > All Preferences except Commands. Voir 
aussi le § Initialiser des assignations de touches ou d’événements 
MIDI à la page 87.

Langue
SoundDiver peut sélectionner une langue (à ce jour Anglais ou 
Allemand uniquement) indépendante de la configuration-
clavier.

Lors du premier démarrage, il vous est demandé de choisir la 
langue. Auto attribue la langue correspondant à la configura-
tion-clavier.

La langue peut être modifiée ultérieurement dans le menu 
Préférences des réglages Généraux (Global). Ceci requiert 
toutefois un redémarrage de SoundDiver.

Sous Windows: La sélection de la langue est mémorisée dans le 
Registre sous :
HKEY_LOCAL_MACHINE:Software:Emagic:SoundDiver:Locale
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Différents raccourcis clavier
Raccourcis clavier

Les tableaux suivants dressent la liste des raccourcis clavier des 
fenêtres de SoundDiver, pour Macintosh et Windows. Pour 
vous aider à retrouver rapidement un raccourci clavier, ces 
tableaux correspondent chacun à une fenêtre, les raccourcis cla-
vier y sont classés par ordre alphabétique.

A.1 Différents raccourcis clavier
Si vous devez faire fonctionner SoundDiver sur une autre 
plate-forme, voici une liste des différences concernant les rac-
courcis clavier.

& Ces différences s’appliquent à la plupart des raccourcis clavier par défaut. Comme ils 
sont redéfinissables, vos réglages peuvent être différents.

& çS sous Windows correspondent à CO sur le Macintosh. Ceci correspond à la 
convention Macintosh où O, et pas S est utilisée comme touche morte. Cepen-
dant, Windows ne recommande pas l’usage de çA afin d’éviter certaines combi-
naisons telles que çA∂ qui réinitialiseraient l’ordinateur.

La “fonction NumLock” (~ sur le Macintosh) commute le 
mode du pavé numérique. Si elle est activée, vous pouvez entrer 
des valeurs via le pavé numérique. Si elle est désactivée, vous 
pouvez utiliser ces touches pour choisir les Screensets et pour 
contrôler le séquenceur.

Opération Windows Macintosh
raccourci clavier ç-caractère C-caractère

raccourci clavier modifié çS-caractère CO-caractère

défillement par page PageU, PageN U, N

coin sup. gauche/inf. droit Û, ˙ ª, ¬

Annexe A
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Si vous faites fonctionner SoundDiver sous M•ROS, les com-
mandes çS-@…¯ ne sont pas valides puisque réservées 
au changement de partition M•ROS.

A.2 Raccourcis clavier
Voici un résumé des raccourcis clavier définis.

Vous trouverez la liste des raccourcis clavier redéfinissables 
dans la fenêtres des Raccourcis Clavier (voir le § La fenêtre Key 
Commands (Raccourcis-clavier) à partir de la page 81).

Windows Macintosh Opération
Toutes les fenêtres

™ ™, C… Annuler la communication MIDI 

@ — Ouvrir la fenêtre d’Aide correspondante 
pour une assistance contextuelle

B B Effacer

“ ~ NumLock (Marche/Arrêt)

1…9 1…ø Rappel des Screensets 1…9

A1…
A9

ç1…
çø

Rappel des Screensets 11…99

S1…
S9

S1…
Sø

Mémoriser la disposition actuelle comme 
Screenset 1…9

SA1…
SA9

Sç1…
Sçø

Mémoriser la disposition actuelle comme 
Screenset 11…99

!…) !…) Rappel des Screensets 1…9 (NumLock 
actif)

A!…
A)

ç!…
ç)

Rappel des Screensets 11…99 (NumLock 
actif)

S!…
S)

S!…
S)

Mémoriser la disposition actuelle comme 
Screenset 1…9 (NumLock actif)

SA!…
SA)

Sç!…
Sç)

Mémoriser la disposition actuelle comme 
Screen set 11…99 (NumLock actif)
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Library, Setup, Install, Device

a…z a…z Sélectionne l’objet commençant par le(s) 
caractère(s) tapé(s) (Caps Lock activé)

T T Sélectionne l’objet suivant dans l’ordre 
alphabétique

ST ST Sélectionne l’objet précédent dans l’ordre 
alphabétique

SI SI Étend la sélection d’un objet au-dessus

SM SM Étend la sélection d’un objet en-dessous

Fenêtre Library

I I Sélectionne l’entrée précédente

M M Sélectionne l’entrée suivante

SI et 
SM

SI et 
SM

Étend la sélection d’une entrée précé-
dente ou suivante

SU et 
SN

SU et 
SN

Étend la sélection d’une page

SÛ et 
S˙

Sª et 
S˙

Étend la sélection jusqu’au début ou à la 
fin

Fenêtre Install

I/M I /M Curseur haut/bas

SI et 
SM

SI et 
SM

Étend la sélection au modèle précédent 
ou suivant

SU et 
SN

SU et 
SN

Étend la sélection d’une page

SÛ et 
S˙

Sª et 
S˙

Étend la sélection jusqu’au début ou à la 
fin

@ — Ouvre la fenêtre d’Aide pour l’installation 
de l’Appareil sélectionné

™ ™ Ferme la fenêtre

Fenêtre Setup

çSs COs Mémorise toutes les éditions

Windows Macintosh Opération
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R R Ouvre la fenêtre Device pour les Appareils 
sélectionnés

IMJK IMJK Sélectionne l’Appareil dans la direction 
donnée

SI et 
SM

SI et 
SM

Étend la sélection à l’appareil précédent 
ou suivant

SJ et 
SK

SJ et 
SK

Étend la sélection à l’appareil de gauche 
ou droite (en vue Icône uniquement)

Fenêtre Device

IMJK IMJK Sélectionne l’entrée suivante dans la 
direction donnée

SI et 
SM

SI et 
SM

Étend la sélection à l’entrée située au-
dessus ou en-dessous

SJ et 
SK

SJ et 
SK

Étend la sélection à l’entrée située à gau-
che ou à droite

Fenêtre Find

™ ™ Ferme la fenêtre

R R Lance la recherche

Fenêtre Help

IM IM Une ligne plus haut ou plus bas

Dialogues

™ ™, Cz, 
SR, SE

Bouton “Cancel” ou “Abort”

R, E R, E Bouton à bord large

@ H Bouton d’Aide

a…z a…z Le bouton commençant par cette lettre

Éditeur

IMJK IMJK Sélectionne le paramètre suivant

=…) =…) Saisie de valeur (NumLock actif)

Windows Macintosh Opération
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e changement
nne les autres

 précédent défi-

me le clic, mais 
ns AutoAudition 

nêtre Device 

leur”

nés.
e les objets. Les 
ue ou un autre 

erchange les 

il ou une autre 

res

les entrées sélec-

és à l’intérieur 

jets situés à 
Usage de la souris

Windows Macintosh Opération

Clic sur un objet si l’objet est déjà sélectionné : pas d
sinon : sélectionne l’objet, désélectio

ç-clic S-clic Inverse la sélection des objets

S-clic ç-clic sélection par bloc (fin du bloc; le clic
nit le début du bloc)

— C-clic dans les fenêtres Library/Device : com
en inversant AutoAudition (c.à.d. sa
si elle était activée)

Double clic Fenêtre Setup : ouvre ou active la fe
Fenêtre Install : scan des appareils
Device/Library : ouvre l’éditeur
Editeur: ouvre une case “saisie de va

Clic + glisser Déplace ou copie les objets sélection
Library: Dans la bibliothèque, déplac
faire glisser vers une autre bibliothèq
appareil copie les entrées
Fenêtre Device : Dans l’appareil : int
entrées
Les faire glisser vers un autre appare
bibliothèque copie les entrées

S-Clic + glisser Éditeur: copie le groupe de paramèt

A-clic + glisser O-clik + glisser Dans une fenêtre Device : duplique 
tionnées

Clic sur le fond+ glisser Élastique : sélectionne les objets situ
ou touchés, désélectionne les autres

S-clic sur le fond + glisser Élastique : inverse la sélection des ob
l’intérieur ou touchés

Annexe B
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Dépannage

Ce chapitre apporte les réponses aux plus fréquentes questions 
soulevées par l’utilisation de SoundDiver

Merci de ne pas oublier le fichier “SoundDiverReadme” sur le 
CD du programme, contenant les réponses aux toutes derniè-
res questions.

C.1 Général

Quelle version de SoundDiver ai-je ?

Démarrez SoundDiver: au démarrage, la fenêtre d’Info de 
SoundDiver

• L’écran fugitif s’affiche. En bas à droite, le numéro exact de 
la version et la date de création de celle-ci apparaissent. Vous 
pouvez également ouvrir la fenêtre d’Info lorsque SoundDi-
ver tourne.

•  : Dans le Finder, cliquez une fois sur l’icône du programme 
SoundDiver et choisissez l’option de menu “ire les Informa-
tions” dans le menu Fichier.

• Windows : cliquez sur le fichier “SoundDiver.EXE” dans 
l’Explorateur Windows avec le bouton droit de la souris et 
choisissez “Propriétés” dans le menu contextuel qui s’affi-
che. Cliquez sur l’onglet “Version”.

Annexe C
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Quelle est la version d’un module SoundDiver Spécifique ?

Activez un appareil correspondant dans la fenêtre de Configu-
ration et cliquez sur le nom du module juste à côté de 
“Module” dans la case des paramètres d’appareil. Un dialogue 
apparaît qui affiche le nom du module, le numéro de version, le 
numéro de lancement, la date de création et une note sur les 
droits d’auteur.

Veuillez noter que le numéro de lancement n’est pas modifié à 
chaque petite amélioration. Il est conseillé de contrôler simple-
ment à la date de modification du fichier.

Quelle est la version d’une Adaptation SoundDiver 
spécifique ?

Les Adaptations n’ont pas de numéro de version. Vérifiez sim-
plement la date du fichier.

Comment puis-je obtenir les dernières versions de 
SoundDiver ?

• Si vous avez un accès Internet, faites votre marché sur notre 
site WWW: http ://www.emagic.de

• Veuillez contactez Emagic or votre revendeur local Emagic.

Comment puis-je obtenir de nouvelles adaptations ?

Vous pouvez les obtenir ainsi que de nouvelles bibliothèques 
sur Internet également.

J’ai créé ma propre Adaptation. Comment puis-je la par-
tager avec d’autres utilisateurs de SoundDiver ?

Veuillez envoyer un email à info@emagic.de.
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Le message “Text not found. Check Text Resource for ID 
'xx'” s’affiche.

Traduction : “Texte pas trouvé. Vérifiez les Ressources de 
Texte pour ID ’xx’”.

Ceci signifie qu’une ressource de texte est manquante dans 
SoundDiver ou un de ces modules. Merci de nous en informer 
(envoyez un email à support@emagic.de). Ce problème n’est 
pas grave, le texte devant être affiché apparaît simplement 
comme “Texte non trouvé”.

 : Le message suivant s’affiche “SoundDiver is about to 
terminate unexpectedly. Try to save your files. It’s better 
to not overwrite the existing files. Please report how 
this occurred. Email: support@emagic.de—Don’t save—
Save”. Que suis-je sensé faire ?

Traduction : “SoundDiver va s’interrompre inopinément. 
Essayez de sauver vos fichiers. Il vaut mieux ne pas remplacer 
les fichiers existants. Merci de nous rapporter ce qui s’est pro-
duit. Email : support@emagic.de-Ne pas sauver-Sauver”.

SoundDiver s’est bloqué à cause d’une erreur logicielle. Bien 
sûr, ça ne devrait pas arriver mais... personne n’est parfait. Pour 
éviter de perdre vos données, vous pouvez sauver les bibliothè-
ques ouvertes et éditées, les adaptations et les préférences dans 
de nouveaux fichiers après avoir cliqué sur “Save”. Pour chacun 
de ces fichiers, vous obtenez un sélecteur de fichier.

Ne remplacez pas les fichiers existants. Il est probable que les 
fichiers ouverts ne puissent être sauvés convenablement à 
cause du blocage. Choisissez donc un nom de fichier comme 
“Ma Bibliothèque- récupération du blocage”.

Merci de nous envoyer un rapport d’erreur à support@ema-
gic.de. Veuillez ne pas oublier de préciser:
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• La version de SoundDiver (et si Autolink est utilisé, le ver-
sion de Logic) 

• Le modèle d’ordinateur, la version du logiciel système

• Le modèle d’interface MIDI, la version du pilote (driver) (si 
un pilote est utilisé)

• Une description précise des opérations effectuées immédia-
tement avant que le blocage ne survienne. Essayez de repro-
duire le blocage. Parfois, un blocage ne peut être provoqué 
une seconde fois. Dans ce cas, il est difficile de retracer l’er-
reur.

 : Le message “Memory is tight for flicker-free drawing. 
Please increase partition size, use lower screen color re-
solution, or switch off “flicker-free redraws” in the Pre-
ferences” s’affiche.

Traduction : “La mémoire est faible pour l’affichage anti-scin-
tillement. Veuillez augmenter la taille de la partition, utiliser 
une plus petite résolution de couleurs d’écran, ou désactiver 
“flicker-free redraws” dans les Préférences”

L’affichage anti-scintillement a momentanément besoin de 
beaucoup de mémoire. La quantité dépend de la taille de la 
fenêtre et du nombre de couleurs que l’écran peut actuelle-
ment afficher. Si vous voulez l’affichage anti-scintillement, 
vous devez attribuer plus de mémoire à SoundDiver (sélection-
nez son icône dans le Finder, ouvrez la fenêtre Info avec Ci et 
changez “Taille souhaitée”).
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C.2 Installation

Windows: Après l’installation d’un pilote MIDI dans Win-
dows 95, il se produit un blocage dans MMSYSTEM.DLL.

C’est un problème connu avec Windows 95 et survient quand 
vous essayez d’installer plus de 11 ports MIDI, ce qui peut arri-
ver lorsque vous voulez utiliser deux MIDI Time Piece en 
réseau. 

Il ne s’agit pas d’une erreur dans les pilotes MIDI ou dans 
SoundDiver, mais dans Windows 95. Cette erreur a été résolue 
dans Windows 98. Veuillez utiliser Window 98 ou ultérieur.

Comment puis-je installer de nouvelles versions de 
Module ou d’Adaptation, que j’ai téléchargées à partir 
d’Internet ?

1. Quittez SoundDiver

2. Assurez-vous que le fichier soit décompacté.

&  : Les fichiers sont compactés au format Stufflt 5.0. Les anciennes versions de Stufflt 
ne gèrent pas ce format. Nous recommandons d’utiliser la version gratuite (freeware) 
Stufflt Expander 5.5 ou ultérieure.

& Windows: Assurez-vous que l’outil de décompactage utilisé sait gérer les noms de 
fichiers longs. WinZip version 6.0 ou supérieure, VisualZip et Alladin Expander 
conviennent. PKZIP et Stufflt Expander 1.0 ne conviennent pas.

3. Déplacez le fichier dans le dossier “Diver” situé dans le 
même dossier que le fichier de l’application SoundDiver.

4. Ouvrez SoundDiver. La nouvelle version est automatique-
ment utilisée.

5. Si le Module permet la gestion de nouveaux modèles, ils se 
peut qu’ils ne soient pas encore affichés dans la fenêtre Ins-
tall. Dans ce cas, installez simplement un autre appareil 
reconnu par le Module (ce qui impliquera le chargement 
du Module), et la liste sera mise à jour.
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C.3 Démarrage

Windows: Au démarrage, l’erreur “MMSYSTEM020” 
s’affiche.

Un pilote MIDI défectueux est installé. Le nom du port MIDI 
affecté est affiché dans la barre de titre du message d’erreur. 
Veuillez contacter le fabricant de l’interface MIDI.

Vous pouvez configurer SoundDiver pour qu’il ignore le pilote 
fautif. Voir le § Comment bloquer les ports MIDI (Windows:) à partir 
de la page 74.

Windows: Au démarrage SoundDiver “se crash” ou blo-
que.

À nouveau, un pilote MIDI défectueux est probablement la 
cause du problème. Voir ci-dessus.

Le message d’erreur “fichier non trouvé” s’affiche.

Il est probable que SoundDiver ait essayé d’ouvrir un fichier de 
bibliothèque qui a été effacé. Pas de panique. Rouvrez simple-
ment la bibliothèque désirée, et le prochain démarrage s’effec-
tuera parfaitement.

Le message “Entries for device “x” have been saved 
using a different version of SoundDiver Module “y”. Loa-
ding them with the current Module might lead to wrong 
data. Load them nevertheless?—Cancel—Skip—Load” 
s’affiche.

Traduction : “Les entrées pour l’appareil “x” ont été sauvegar-
dées en utilisant une version différente du Module “y” Sound-
Diver. Les charger avec le Module actuel peut occasionner de 
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Exploration (Scanning)
fausses données. Les charger néanmoins? -Annuler-Passer-
Charger”.

Lors du développement et de l’amélioration des Modules 
SoundDiver, il est parfois nécessaire de changer l’ordre interne 
des entrées. Afin d’accélérer le chargement, une entrée d’appa-
reil est sauvée dans le fichier préférences avec un compteur 
interne, pas le communiqué complet des emplacements-
mémoire. Le message indique que l’ordre interne a pu être 
modifié. Après avoir cliqué sur “Charger“, vérifiez d’abord si 
toutes les données sont chargées dans les emplacements-
mémoire corrects. Sinon (ou si les noms ne sont pas affichés cor-
rectement), vous devrez redemander les données à l’appareil, 
juste pour être sûr.

C.4 Exploration (Scanning)

L’exploration ne trouve pas certains appareils.

• L’appareil est-il allumé et correctement connecté dans les 
deux directions?

• L’appareil gère-t-il les messages SysEx?

• Certains appareils ne réagissent pas correctement quand leur 
ID d’appareil est réglé sur “omni” ou “all”. Réglez l’ID 
d’appareil sur une valeur différente.

• Vérifiez que les appareils compatibles sont réglées sur diffé-
rents ID. Ceci s’applique également aux appareils quelque 
peu différents, mais qui reconnaissent l’Universal Device 
Inquiry.

• Les baies de raccordement (Patchbays) qui ne sont pas gé-
rées par un Module spécial ne peuvent être pleinement ex-
plorées par SoundDiver. Seul le réglage actuel de la baie de 
raccordement est exploré. Programmez votre baie de raccor-
dement pour qu’autant de sorties que possible (sauf celles 
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vers l’ordinateur) soient branchées dans l’entrée à partir de 
l’ordinateur, et qu’autant d’entrées que possible (sauf celles 
à partir de l’ordinateur) soient branchées dans l’entrée vers 
l’ordinateur. Faîtes maintenant une Exploration et insérez, 
pour l’appareil trouvé, le numéro du programme actuel de la 
baie de raccordement dans le paramètre “Patchbay Prg”, en 
même temps que les autres paramètres utiles (voir le § Pro-
grammation du Patchbay à la page 202).

• Il se peut que vous utilisiez une baie de raccordement ou un 
boîtier Thru (une Thru box) qui retarde les données MIDI. 
Si c’est le cas, augmentez la valeur du paramètre “Additional 
Timeout” (Temps supplémentaire) dans les Préférences.

Quand j’explore une baie de raccordement, le message 
“No patchbay connection found” s’affiche.

Traduction : “Pas de connexion de Patchbay trouvée”.

Suivez le conseil du fichier d’Aide (mots-clef “Installation” et 
“Scan”) décrivant  quel est le port de la baie de raccordement 
auquel doit être connecté l’ordinateur, et comment doit être 
configurée la baie.

Certaines baies de raccordement (par ex la MIDITEMP PMM-
44/88) ne réagissent pas au SysEx sur “l’Entrée de Contrôle” 
mais sur chaque entrée pour laquelle une connexion vers une 
sortie a été définie. Cependant, dès que SoundDiver démarre 
l’exploration et envoie un message SysEx qui reprogramme la 
baie de raccordement, la connexion peut se voir interrompue et 
la baie de raccordement rester muette. Si les “Entrées de Con-
trôle” n’ont pas été réglées correctement, vous pourrez trouver 
une situation où la baie de raccordement commence à réagir 
mais où SoundDiver ne peut plus déterminer à quelles entrées 
et sorties l’ordinateur est connecté.
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C.5 Communication MIDI

 : Le message “The Modem/Printer Port is used by ano-
ther program, LocalTalk or ARA” s’affiche.

Traduction : “Le Port Modem/Imprimante est utilisé par un 
autre programme, LocalTalk ou ARA”.

Vérifiez si un autre programme utilise le port en question. Cela 
peut être un programme de terminal modem, ou un logiciel de 
fax. Les ports modem ou imprimante doivent être libres avant 
de démarrer SoundDiver.

Conseil : Si vous utilisez FaxSTF, vous pouvez libérer très rapi-
dement le port en utilisant le programme “Fax State” livré avec 
l’application.

Si AppleTalk est activé et fonctionne en mode LocalTalk (ce 
sera toujours le cas tant que vous n’avez pas EtherNet), le port 
imprimante est réservé. Il vaut mieux (donc) désactiver Apple-
Talk avant de démarrer SoundDiver. 

 :Le message “MIDI data could not be sent…” s’affiche.

Traduction : “Les données MIDI n’ont pu être envoyées...”

SoundDiver n’a pu trouver d’interface MIDI sur ce port. Sui-
vez les conseils du § Port Modem/Port Imprimante à la page 388.

J’ai parfois des erreurs de transmission ou de somme de 
contrôle (checksum).

•  : AppleTalk doit être désactivé. AppleTalk interfère avec le 
MIDI et ceci devient évident lors les communications SysEx.

•  : Le Port Imprimante des modèles PowerBook (en particu-
lier des séries 1xx) n’est pas fiable. Utilisez plutôt le Port 
Modem.
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• Si l’appareil ne parvient pas parfois à réagir aux requêtes, 
augmentez le paramètre “Temps Supplémentaire”.

• Si l’appareil ne parvient pas parfois à recevoir un vidage 
(Dump), augmentez le paramètre “Send Pause”.

•  : Il est simplement envisageable que les périphériques 
SCSI non-installés (par ex CD-ROM, disque dur amovible 
ou MO) puissent interférer avec le MIDI, car le périphéri-
que recherche continuellement si un média est présent. In-
sérez le média, ou éteignez le périphérique et redémarrez le 
Macintosh.

•  : Les modèles PowerBook des séries 1xx (sauf le Power-
Book 190) ont un problème commun lorsqu’ils reçoivent de 
grandes quantités de données aux ports série. Ceci ne peut 
actuellement être résolu qu’avec OMS 2.2 ou ultérieur. Uti-
lisez plutôt SoundDiver en mode OMS (voir le § OMS à la 
page 66).

Quand j’envoie des transferts à un appareil, il ne les re-
çoit pas (il arrive qu’un message “mémoire protégée” 
s’affiche à l’écran).

Certains appareils (surtout les appareils Yamaha) activent par 
défaut leur protection mémoire au démarrage. Pour ces appa-
reils, SoundDiver a une fonction “Auto Bulk Protect Off” que 
vous pouvez trouver dans les “paramètres spéciaux”. Cette 
fonction n’a toutefois d’effet que si SoundDiver est démarré 
après que tous les appareils ont été allumés. Allumez donc tou-
jours les appareils en premier, puis démarrez SoundDiver.

Le message “SysEx communication error” s’affiche.

Traduction : “Erreur de communication SysEx”

Ceci peut avoir différentes causes.

Voici comment identifier le problème.
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• Tout d’abord, cliquez sur “Abort” pour mettre SoundDiver à 
nouveau en “fonctionnement normal”.

Note : Chaque fois que vous trouvez une source d’erreur 
potentielle, et que le transfert de données ne fonctionne tou-
jours pas, reprenez la procédure de dépannage depuis le début.

1.  L’appareil transmet-il les données ?

Essayez de déterminer si l’appareil transmet à la base les don-
nées désirées. Certains appareils signalent cette opération dans 
leur écran. Si vous ne voyez aucune activité à cet endroit, regar-
dez la LED MIDI In de l’interface MIDI, si elle en est pour-
vue.

L’analyseur MIDI est à cet égard très utile. Recommandé: le 
Studiomaster MA-36

• Oui : passez à l’article 8 page 433.

• Non :

2.  L’appareil est-il dans le mode correct ?

Certains appareils (par ex le Roland JD-800) ne peuvent trans-
mettre les données d’un certain type que s’ils sont dans le 
mode approprié (par ex le JD-880 ne peut transmettre les Per-
formances qu’en mode Performance).Tous les Modules et les 
Adaptations essaient, si possible, de changer automatiquement 
le mode de l’appareil.Toutefois, certains appareils ne permet-
tent pas de changer leur mode via MIDI. Dans ce cas, vous 
trouverez une note dans le fichier Aide. Ou alors, l’appareil n’a 
pas reçu le message de changement de mode pour une autre 
raison.

• Non: réglez l’appareil sur le mode approprié.

• Oui:

3.  L’appareil possède-t-il à la base les données 
demandées ?

Les entrées de cartes ne peuvent bien sûr être demandées que 
lorsqu’une carte est insérée.
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• Non: alors les données ne peuvent être demandées.

Solution : Insérez une carte, ou désactivez la carte dans les 
“Paramètres Spéciaux”.

• Oui:

4.  L’appareil reconnaît-il les messages SysEx.

Sur certains appareils la reconnaissance des SysEx n’est pas 
activée par défaut. Cependant, dans ce cas la fonction d’explo-
ration aura déjà dû échouer.

• Non: l’appareil doit pouvoir reconnaître les messages SysEx.

Solution : Consultez le fichier Aide de SoundDiver, page “Ins-
tallation” ainsi que le mode d’emploi de l’appareil. Le paramè-
tre concerné se trouve, dans la plupart des cas, dans les données 
“Système” ou “Globales”.

Certains appareils (par ex l’Ensoniq ESQ-1) désactivent les 
SysEx à chaque allumage. Vous devez donc activer les SysEx à 
chaque fois.

• Oui:

5.  Le Device ID correspond-il ?

Si l’appareil a été exploré par SoundDiver, le Device ID doit 
être correct. Mais il a pu être modifié dans l’appareil à cause 
d’une réinitialisation ou d’un blocage.

• Non: faites correspondre le Device ID avec celui dans 
SoundDiver.

Solution : Déterminez le Device ID et inscrivez la même 
valeur dans la case de Paramètres d’Appareil de SoundDiver.

La plupart des appareils comptent le Device ID à partir de 1, 
bien que d’autres le fassent de 0 à 17. SoundDiver prend en 
compte ce fait.

Conseil : Évitez les réglages comme “all” ou “omni” dans 
l’appareil.

• Oui:
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6.  Les numéros de Sorties et de câbles sont-ils corrects ?

Vous avez probablement changé le câblage MIDI et avez 
oublié de l’indiquer dans SoundDiver. Ou bien vous avez ins-
tallé l’appareil manuellement et non avec la fonction d’Explo-
ration, et avez oublié d’ajuster ces réglages.

• Non: réglez le câble et/ou la sortie correcte.

• Oui:

7.  Le câblage MIDI allant de la sortie de l’ordinateur vers 
l’entrée de l’appareil est-il correct ?

Vérifiez le câblage MIDI. Avez-vous vraiment branché le câble 
dans la prise MIDI In de l’appareil est non dans la prise Out ? 
La prise est-elle bien branchée ? Le câble est peut-être défec-
tueux ou être mal branché.

• Non: corrigez le câblage. Essayez un autre câble MIDI plus 
court.

• Oui: soit l’appareil a une vieille version logicielle, non com-
patible avec l’Adaptation du Module SoundDiver (par ex: 
Ensoniq TS-10 V1.x), ou il y a une erreur logicielle dans le 
Module ou l’Adaptation.

Solution : Veuillez contacter le distributeur de l’appareil et/ou 
Emagic. Il s’avérera utile d’avoir effectué un essai de pro-
gramme (test run) avec la fenêtre de Monitor MIDI ouverte, 
pour nous permettre de vérifier le message de requête transmit.

8.  L’ordinateur reçoit-il le MIDI ?

Vous pouvez vérifier ceci de deux façons :

Ouvrez la fenêtre du Séquenceur. Si les données arrivent, une 
barre apparaîtra à la place de “NO IN”, avec un X à gauche 
(dans le cas de données SysEx).

Ouvrez la fenêtre MIDI In. Les données reçues s’affichent 
sous la forme de nombres hexadécimaux.

• Oui: passez à l’article 12 page 435.

• Non :
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9.  Y a-t-il une baie de raccordement ou une interface 
MIDI “intelligente” entre l’appareil et l’ordinateur ?

(Ces dernières incluent des interfaces telles que la Motu MIDI 
Time Piece ou l’Opcode Studio 4/5)

• Oui: alors la baie de raccordement n’est pas réglée correcte-
ment.

Solution : Essayez d’abord de déterminer si le transfert arrive 
à la baie de raccordement. Vérifiez ceci avec la LED d’entrée, 
ou activez un moniteur ou encore le mode EYE. Si les données 
parviennent (bien) à la baie, elle est incorrectement paramè-
trée. Configurez la baie de raccordement pour qu’il existe une 
liaison partant de l’appareil et allant vers l’ordinateur, et que 
rien ne soit filtré (surtout pas les SySex). 

SoundDiver effectue ceci automatiquement avec les Patchbays 
reconnues (à ce jour les Miditemp PMM-44/88, Roland-880, 
Waldorf Midibay, J.L.Cooper Synapse et Ensoniq KMX-8/16). 
Si cela ne fonctionne toujours pas, c’est qu’il existe une erreur 
de programme. Veuillez contacter Emagic.

• Non:

10.  Le port ordinateur correspondant est correctement 
réglé ?

Ouvrez les Préférences, page “Communication”. Le port cor-
respondant est-il activé ? Le “Fast Mode” correspond-il aux 
réglages de l’interface ? Le “Cable Mode“ est-il activé, dans le 
cas ou vous utilisez une interface MIDI compatible MTP?

• Non: configurez correctement le port. L’interface est peut 
être bloquée. Pour en être sur, éteignez puis rallumez l’inter-
face et réglez Fast Mode et Cable Mode en conséquence.

Pour pouvoir transmettre et recevoir des données MIDI, le port 
de l’ordinateur doit être activé. Normalement, SoundDiver 
indique immédiatement s’il ne peut pas envoyer de données, 
ou au démarrage si aucun port n’est activé.

• Oui:
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11.  Il n’y a pas de connexion entre la sortie de l’appareil 
et l’entrée l’ordinateur.

Solution : Vérifiez le câblage MIDI. Avez-vous vraiment bran-
ché le câble dans la prise MIDI In de l’appareil est non dans la 
prise Out? La prise est-elle bien branchée ? Le câble est peut-
être défectueux ou être mal branché.

Certains appareils comme les Lexicon LXP-1 ou LXP-5 ont 
une borne mixte Out/Thru qui doit être réglée sur le mode Out 
grâce à un interrupteur situé à l’intérieur de l’appareil ou sur le 
panneau arrière. Vous trouverez une explication appropriée 
dans le fichier Aide.

12.  Les données arrivent-elles parfois incorrectement ?

Cela signifie que les noms sont remplacés par un ou deux carac-
tères, ou que des caractères étranges apparaissent.

• Oui:

Windows : le pilote MIDI ne fonctionne probablement pas cor-
rectement.

Solution : essayez d’obtenir une mise à jour du pilote auprès 
du fabriquant, ou utilisez une autre interface MIDI.

 : AppleTalk est probablement activé.

Solution : Désactivez AppleTalk dans la fenêtre du Sélecteur.

AppleTalk en mode LocalTalk est incompatible avec la récep-
tion de grandes quantités de données sur un port série, car il 
empêche parfois que des octets reçus soient lus ce qui crée un 
“engorgement”. Si vous avez vraiment besoin des fonctions de 
réseau, envisagez de passer de LocalTalk à EtherTalk. Veuillez 
contactez votre revendeur Apple pour plus de détails.

• Non:
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13.  Y a-t-il un transfert (Dump) en cours ?

Essayez de faire transmettre manuellement les données sou-
haitées à l’appareil. SoundDiver affiche-t-il maintenant les 
données transmises ?

• Oui: passez à l’article 15 page 436.

• Non :

14.  Le Device ID est-il réglé sur “all” ou “omni” ?

• Oui: ce réglage ne peut fonctionner avec SoundDiver. La 
plupart des Modules SoundDiver vous affichent un message 
dans ce cas.

Solution : Réglez un numéro Device ID d’appareil différent 
sur l’appareil. N’oubliez pas de répercuter les mêmes réglages 
dans SoundDiver.

Le réglage “all” signifie que l’appareil répond à toutes les 
requêtes, (peu importe quel Device ID elles utilisent), trans-
mettant néanmoins ses propres transferts avec le Device ID  1 
ou 128. Ceci peut provoquer des conflits.

• Non: alors le câble MIDI sortant de l’appareil et entrant dans 
l’ordinateur est défectueux

15.  Avez-vous plusieurs appareils compatibles SysEx 
(reconnaissant les mêmes SysEx) ?

Il peut même s’agir de plusieurs appareils d’une même gamme, 
comme les TX802 et DX7 ou les SD-1 et VFX.

• Oui: alors plusieurs appareils réagissent simultanément, ce 
que SoundDiver ne peut pas reconnaître, car les SysEx arri-
vant simultanément ne sont pas correctement fusionnés.

Solution : Assurez-vous que tous les appareils compatibles ont 
différents Device ID  (n’oubliez pas de répercuter ces mêmes 
changements dans SoundDiver). Si cela n’est pas possible, vous 
devrez connecter les appareils aux différentes sorties de l’ordi-
nateur.
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Certaines anciennes machines (par ex Yamaha DX7, TX816) 
transmettent toujours le Device ID 1 bien qu’elles soient 
réglées sur un canal différent. Le Module DX7 prend en 
compte ce fait. Pour plus de détails, voir le fichier d’aide du 
DX7.

• Non: alors le Timeout est trop court.

Solution : Augmentez le paramètre “Timeout” dans la case des 
paramètres d’appareil. Il vaut mieux augmenter par pas de 
1000ms ; dans ce cas, vous êtes simplement “pénalisé” par une 
pause plus longue si l’appareil ne répond pas.

Ce cas peut se produire si des baies de raccordement ou des 
interfaces MIDI sont insérées, ce qui cause un retard significa-
tif des données MIDI, ou si le logiciel de votre appareil réagit 
plus lentement que celui avec lequel le Module ou l’Adapta-
tion ont été développé. Dans le premier cas, augmentez plutôt 
le paramètre “Temps Supplémentaire” dans les Préférences, 
puisque ce retard s’applique à tous les appareils.

Chaque fois que j’active un appareil donné, un pro-
gramme est inutilement rappelé dans cet appareil ou 
dans un autre.

Vous avez défini un “Patchbay PRG” pour cet appareil, mais 
n’avez pas réglé le canal MIDI en conséquence. Ce canal MIDI 
peut n’être utilisé par la baie de raccordement que pour être 
activée. Si l’appareil est connecté à l’ordinateur, l’utilisation 
d’un “Patchbay PRG” n’est pas nécessaire et ne fait que pro-
duire des retards indésirables.
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C.6 Bibliothèque

J’ai plusieurs préréglages (Presets) de deux appareils si-
milaires (par ex Emu Proteus 1 et Proteus 2), chacun avec 
un Device ID différent. Lorsque je clique dessus quand 
AutoAudition est activé, ces préréglages sont toujours 
envoyés au même appareil.

Si vous ne voulez pas cela, assurez-vous qu’aucun appareil ne 
soit sélectionné dans la fenêtre Setup avant de cliquer sur une 
entrée. Vous pouvez également désactiver “Préférer les appa-
reils sélectionnés comme destination” dans les préférences 
(voir le § Prefer Selected Devices as Target (Préférer les Appareils 
sélectionnés comme Destination) à la page 408).

C.7 Fenêtre Device

Je ne peux pas trouver une certaine Carte ou banque 
ROM.

Ouvrez les “Paramètres spéciaux”. Peut-être devrez-vous acti-
ver d’abord manuellement la banque désirée. C’est le cas pour 
toutes les Adaptations, puisque les Adaptations (contrairement 
aux Modules) ne peuvent trouver automatiquement quelles 
banques sont présentes dans l’appareil.

S’il n’existe pas de sélecteur pour la banque désirée, c’est que 
la banque n’est pas reconnue par SoundDiver car l’appareil ne 
connaît pas les commandes SysEx nécessaires. Une alternative 
possible consiste à sélectionner un par un les sons de la banque 
sur le panneau avant de l’appareil et ensuite d’effectuer une 
requête du tampon d’édition dans SoundDiver. Vous pouvez 
facilement créer une bibliothèque de cette banque en utilisant 
la fonction “Append to Library” (Ajouter à la bibliothèque), 
(voir le § Append to Library à la page 232).
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X

Lorsque “AutoAudition” est activé, les entrées sélection-
nées sont transmises au tampon d’édition de l’appareil, 
mais soit un son différent est audible soit il n’y a aucun 
son.

Dans les Adaptations pour appareils multitimbraux, le canal 
MIDI Thru n’est pas réglé automatiquement sur le canal cor-
respondant. Vous devrez le faire manuellement dans la case des 
Paramètres d’Appareil. Voir le § Thru Channel (Canal Thru) à la 
page 200.

Ce problème ne peut exister que lorsqu’il est possible de régler 
individuellement les canaux MIDI des parties d’un Multi 
(Combis, Performances), mais que SoundDiver ne connaît pas 
actuellement ce Multi. SoundDiver ne peut donc pas définir 
quel canal Thru doit être réglé. Solution: faites une requête de 
l’Edit Multi (Edit Combi, Temporary Performance).

C.8 Éditeur

Quelle fonction un paramètre donné a-t-il, et comment 
l’utiliser ?

Cliquez sur le paramètre et choisissez Window > Help pour affi-
cher une fenêtre d’Aide vous donnant des informations sur ce 
paramètre.

Et que signifie “No help available” (Pas d’aide disponi-
ble) dans la fenêtre d’Aide.

Cela signifie qu’il n’existe pas encore de fichier d’Aide pour 
cette Adaptation. Veuillez contacter Emagic ou l’auteur de 
l’Adaptation.
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Je ne peux pas saisir un point d’enveloppe (il est en de-
hors du cadre).

Dans cette situation, une petite flèche apparaît et pointe vers 
celui-ci. Cliquez sur la flèche.

Je ne peux pas voir un point d’enveloppe, bien que l’en-
veloppe soit entièrement visible.

Ceci peut arriver si deux points coïncident. Raisons possibles:

• La durée temporelle entre deux points est zéro.

• Pour certains appareils (par ex Roland D-50), un segment de 
l’enveloppe est masqué si deux points ont un niveau de 
même valeur.

Déplacez simplement plus loin le point visible ; l’autre point, 
jusque-là caché, apparaîtra.

Quand j’utilise les potentiomètres ou les curseurs, je ne 
peux pas obtenir une valeur donnée car le mouvement 
de la souris est trop peu précis.

Maintenez ç enfoncé tout en bougeant la souris. Ou bien cli-
quez sur le paramètre, ce qui le fera clignoter, puis entrez la 
valeur avec le pavé numérique et/ou  et _ .

Ouvrir un menu-local prend beaucoup de temps.

Appuyez sur ç quand vous cliquez et bougez la souris de haut 
en bas.
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Je ne peux pas taper de nombres.

Activez “Num Lock” (voir le § Entrée de valeurs au clavier à par-
tir de la page 306), et tapez les nombres à l’aide di pavé numé-
rique.

Avec certains paramètres, j’obtiens des valeurs incorrec-
tes ou trop peu de valeurs ; certains paramètres ne sont 
même pas visibles.

• Le modèle correct a-t-il été installé/exploré ?

• Le Module reconnaît-il ce modèle spécifique ?

Je n’entends pas ce que j’édite.

• L’appareil a-t-il été réglé sur un mode différent par erreur?

• Il se peut que l’entrée en cours d’édition doive d’abord être 
activée dans un éditeur différent (par ex pour les Panorami-
ques, les table d’accord, les tables de forme d’ondes, les for-
mes d’onde, etc.). Certains Modules ont toutefois un mode 
de “monitoring” spécifique pour cette opération.

• Si l’appareil est connecté à une baie de raccordement et 
qu’un “PRG standard” soit défini pour celle-ci, le pro-
gramme doit inclure une connexion à partir de l’ordinateur 
vers l’appareil en cours d’édition.

• Certains appareils bloquent s’ils reçoivent des successions 
rapides de messages de changements de paramètres. Toute-
fois, les Modules et les Adaptations ont été optimisés pour 
éviter cet inconvénient. Il s’avérera sans doute utile d’aug-
menter la valeur du paramètre “Send Pause”.

• Il se peut que le canal MIDI Thru ne soit pas correct. Les 
Modules peuvent le régler automatiquement, bien qu’il 
puisse être nécessaire que les tampons d’édition pour les 
Multis ou Combis et/ou les Données Globales ou Réglages 
Système aient été reçus. Vous trouverez de plus amples in-
formations dans l’aide en ligne.
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“Coller” est impossible.

Les types de groupes de paramètres source et destination ne 
concordent pas. Ils se ressemblent parfois, mais peuvent pré-
senter de petites différences.

Lorsque je change de tampon d’édition, un message me 
demande d’appuyer sur une touche.

Soit c’est une particularité de l’appareil, soit SoundDiver ne 
connaît pas la version de votre appareil et suppose qu’il s’agit 
de l’ancienne version.

Les dernières versions de certains appareils offrent de nouvel-
les caractéristiques SysEx qui peuvent être utilisées par le 
module, uniquement si celui-ci peut déterminer que l’appareil 
utilise cette dernière version. Cet appareil doit être installé via 
l’Exploration (Scan), pas manuellement.

Je ne peux pas trouver un paramètre donné.

Certains paramètres n’apparaissent que si SoundDiver sait de 
façon sûre que l’appareil les connaît également. SoundDiver 
peut déterminer ceci en vérifiant le numéro de version logi-
cielle  de l’appareil. Pour que SoundDiver connaisse le numéro 
de version, l’appareil doit être installé via “Exploration”(Scan), 
pas manuellement. Vérifiez dans la case des Paramètres 
d’Appareil si cette version spécifique est reconnue.

Lorsque j’édite un seul paramètre, tous les paramètres 
de l’Easy Page sont réglés sur 0.

C’est exigé par le programme pour des raisons techniques, et 
est tout à fait normal.
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C.9 AutoLink

 : Lors du démarrage, Logic indique “The Modem/Prin-
ter Port is used by another Program”.

Traduction : “Le Port Modem/Imprimante est utilisé par un 
autre programme”.

Logic essaie d’accéder aux ports série avant que SoundDiver 
n’ait pu savoir que Logic a été démarré et donc libéré les ports. 
C’est pourquoi il est conseillé de toujours démarrer Logic en 
premier, puis SoundDiver. S’il vous arrive de lancer les pro-
grammes dans l’ordre inverse, cliquez sur “Annuler” dans le 
message d’erreur qui s’affichent, attendez le signal sonore 
(“plop!”) d’AutoLink et réactivez les ports dans les préférences 
de Logic.

Les noms des sons d’un appareil s’affichent vierges ou 
erronés.

Lire le conseil donné au § Si AutoLink ne fonctionne pas... à la 
page 362.

Logic transmet tout à partir de la même sortie, sans tenir 
compte de mes réglages dans SoundDiver.

Vous utilisez probablement Logic en mode OMS. Si vous vou-
lez utiliser AutoLink et OMS simultanément, vous devez acti-
ver OMS dans SoundDiver également. Voir le § Communication 
avec Logic en mode OMS à la page 69 et le § Use OMS if Available 
(Utiliser OMS si Installé) à la page 393.
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Le MIDI Thru ne peut être ni activé ni désactivé ; le canal 
et le port MIDI Thru ne sont pas réglés correctement.

Il vous faut la Version 1.505 ou ultérieure de SoundDiver et la 
Version 2.5 ou ultérieure de Logic.

Lorsque j’enregistre dans Logic des SysEx venant de 
SoundDiver, l’appareil ne les reconnaît pas.

SoundDiver est normalement capable d’indiquer exactement à 
Logic quel port et câble doivent être utilisés pour envoyer un 
message MIDI. Ce n’est pas possible durant l’enregistrement. 
A la place, pendant le mode d’Enregistrement, toutes les don-
nées sont envoyées via l’Instrument de la piste active. Celui-ci 
doit donc être réglé correctement.
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Glossaire

Ce glossaire explique les termes les plus courants dans Sound-
Diver.

Adaptation  Un fichier interne de SoundDiver qui permet la 
gestion des données d’un appareil. Les Adaptations fonction-
nant au sein du Module Universel, peuvent être créées par 
l’utilisateur et sont éditables.

Affichage détaillé  Un mode de visualisation dans l’→Édi-
teur, dans lequel les paramètres sont affichés en détail.→Vue 
d’ensemble.

Aide →Aide en ligne.

Aide en ligne  La partie du programme qui contient une assis-
tance à l’utilisateur, sous la forme de textes d’informations affi-
chés à l’écran. SoundDiver offre des fonctions contextuelles 
interactives qui affichent des textes d’aides à l’écran dans cer-
taines situations.

Appareil actif  L’appareil dont les paramètres sont actuelle-
ment affichés dans la case des paramètres d’appareil de la fenê-
tre de Configuration. Le MIDI Thru est toujours réglé sur l’~ 
(sauf s’il y a un →Programme Standard de Patchbay ou que 
“Préserver le port/canal Thru” est activé). Lorsque vous acti-
vez une fenêtre d’Appareil ou d’Edition, l’appareil approprié 
est automatiquement activé.

Appareil (Device) Un synthétiseur ou échantillonneur MIDI 
ou une autre unité MIDI (baie de raccordement, processeur 
d’effets), reconnu par un Module ou une Adaptation SoundDi-
ver.

Apparence 3D  Une apparence en trois dimensions des motifs 
d’arrière- plan, des curseurs et boutons dans les écrans de 
SoundDiver.

Annexe D
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All Notes Off  Une commande MIDI qui élimine le maintien 
des notes sur tous les canaux.

Assignation de Contrôleur  Une fonction qui définie le con-
trôle à distance d’un paramètre.

Audition  Envoyer une ou plusieurs entrées vers le → tampon 
d’édition d’un appareil, afin qu’elle(s) puisse(nt) être écou-
tée(s).

Autorisation  L’installation de la protection contre la copie de 
SoundDiver sur le disque dur; également, le nom du fichier de 
protection contre la copie lui-même.

AutoAudition  Envoie automatiquement une entrée sélec-
tionnée vers le → tampon d’édition approprié de l’appareil 
(voir aussi →Audition).

AutoLink  La connexion interne entre →Logic et SoundDiver. 
AutoLink est utilisé pour l’échange direct des noms de sons et 
des données MIDI entre les deux programmes.

Autoplay  La fonction qui envoie une note-test à l’appareil 
MIDI chaque fois qu’une entrée est sélectionnée. 

Auto Request La fonction qui demande automatiquement le 
contenu de la mémoire des appareils connectés lorsque Sound-
Diver est lancé en premier.

AutoSort  La fonction de bibliothèque qui classe automati-
quement la bibliothèque après chaque modification de son con-
tenu.

AutoSurf  Terme initialement utilisé pour→AutoAudition.

Banque  Un certain nombre d’→Entrées de même →Type de 
donnée.

Baie de raccordement MIDI  Un appareil qui permet de diri-
ger les signaux MIDI vers différentes destinations. Certaines 
baies de raccordement peuvent être télécommandées via les 
→Modules de Patchbays SoundDiver.
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Bibliothèque  Un fichier SoundDiver qui peut contenir toutes 
sortes de données (sons, configurations, tampons d’édition) 
provenant de toutes sortes d’appareils. 

La taille du fichier n’est limitée que par la capacité de la RAM 
de l’ordinateur. Le contenu d’une bibliothèque peut être classé 
selon certains critères, et des entrées particulières peuvent être 
spécifiées et recherchées grâce à la fonction Find.

Bibliothèque Autoload  Le fichier de bibliothèque appelé 
“Autoload.lib” (  : “Autoload”) et qui doit se trouver dans le 
dossier “Libraries” pour pouvoir être chargé automatiquement 
lorsque le programme est lancé.   

Bibliothèque commune  Une Bibliothèque qui contient les 
données de plusieurs appareils.

Carte  Carte-mémoire utilisée par les synthétiseurs etc. pour 
stocker une →donnée d’entrée.

Chemin d’accès  Indique les coordonnées de l’emplacement 
d’un fichier sur un disque, c.a.d. la partition (si c’est un disque 
dur) et le(s) dossier(s).

Comparer  Une fonction de comparaison: en alternant entre 
les versions d’origine et éditées, vous pouvez vérifier la progres-
sion de votre édition.

Contrôleur  Un contrôle sur un →pupitre de commande MIDI 
qui génère un message MIDI donné.

Configuration  La représentation, dans SoundDiver, de votre 
système MIDI. Les appareils peuvent être explorés automati-
quement ou ajoutés manuellement à la Configuration.

Configuration d’Assignation de Contrôleur  Une configu-
ration d’→ Assignations de Contrôleur qui peut être activée. 

Conversion  La transformation des sons d’un appareil dans le 
format d’un appareil différent, quoique parent.

Par exemple, les modules SoundDiver convertissent automati-
quement et intelligemment les sons DX7 en sons pour un 
SY77.
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Curseur  La mise en évidence d’un objet à l’écran lorsqu’il est 
prêt à être édité -prend la forme d’une flèche d’un bloc ou 
d’une inversion de couleur ; la bordure clignotante autour d’un 
paramètre.

Cohérence des données Dans SoundDiver: la similitude 
entre une fenêtre Dévice et le contenu de la mémoire de 
l’appareil lui correspondant (contrôlé automatiquement par 
SoundDiver).

Défaut (par) La présélection ou les premiers réglages appa-
raissants dans le programme-peut normalement être modifié 
par l’utilisateur.

Dialogue  Une case qui nécessite une décision de l’utilisateur 
(oui, non, choix d’une option). Le choix par défaut (normale-
ment le plus sûr ou le plus logique) a une bordure plus large et 
peut être sélectionné par R. Ce n’est pas une vraie fenêtre.

Dive!  Terme initialement utilisé pour →Édition.

Duplication  La copie d’un objet (comme une entrée d’Appa-
reil) à l’intérieur d’une fenêtre.

Easy Page  Fait partie de la →Vue d’ensemble dans →l’Édi-
teur. L’~ contient une sélection des principaux paramètres d’un 
son, ceux qui offrent une “satisfaction immédiate” durant l’édi-
tion des sons.

Écoute MIDI  Une fonction dans l’ →Éditeur, lorsque vous 
appuyez sur S les événements MIDI reçus modifient directe-
ment la valeur du paramètre en cours.

Édition  Dans les fenêtres de Bibliothèque et Device : pour 
ouvrir une fenêtre d’édition d’une ou plusieurs fenêtres d’édi-
tion. Chaque ~ contient une →Audition.

Éditeur  Une fenêtre SoundDiver affichant les paramètres de 
sons et de programmes d’un appareil sous forme de graphismes 
et de chiffres détaillés, ou les entrées peuvent être éditées.

Emplacement  Un paramètre de bibliothèque qui contient 
l’adresse de l’emplacement-mémoire d’une entrée. C’est l’un 
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des facteurs pris en compte lorsqu’une entrée est envoyée. Ce 
paramètre garantit que les emplacements des entrées au sein 
de l’appareil sont protégés, même lorsque vous éditez la Biblio-
thèque.

Entrée  Le nom donné a un paquet de données provenant d’un 
appareil (par ex des sons, multi, donnée de système, kit de bat-
terie).

Entrée fille →Entrée ayant d’autres entrées (→ entrées 
parents) dépendantes.

Entrée parent →Entrée ayant des dépendances avec d’autres 
entrées (→entrées enfants).

Entrées utilisées  Entrées utilisées par d’autres entrées à 
l’intérieur d’un Appareil ou d’une Bibliothèque, comme les 
programmes de combinaison d’un synthé ou les voix au sein 
d’un programme-multi.

Exploration (Scan)  dans SoundDiver: le programme recher-
che automatiquement les appareils qu’il peut reconnaître, et 
qui sont connectés au système MIDI. S’il en détecte, ils seront 
installés et affichés dans la →fenêtre de Configuration.

Fader Box  voir →Pupitre de commande MIDI

Fenêtre Install La fenêtre d’Installation est l’endroit où 
SoundDiver gère les appareils qui sont nécessaires à la Confi-
guration. C’est aussi ici que les modules et adaptations Sound-
Diver sont installés sur le disque dur, et les modèles d’appareils 
ajoutés ou enlevés.

Gestion de la dépendances des entrées  Anciennement 
appelé “Item Link Management”; une fonction SoundDiver 
qui contrôle l’interdépendance ou les références croisées des 
entrées. La ~ modifie par ex un Programme-Multi lorsque ses 
sons sont déplacés vers des emplacements différents au sein 
des Appareils.

Icône  Un symbole graphique à l’écran qui représente un objet 
(par ex un appareil).
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ID (Numéro d’identification)  (également appelé Device ID, 
N° d’Appareil, N° d’Unité, Canal de Base): un numéro d’iden-
tification exclusif d’appareil qui permet à ses données SysEx 
d’être distinguées de celles des autres appareils dans un sys-
tème. Selon l’appareil, l’ID peut être réglé indépendamment 
du canal MIDI de base.

Importer  Charger les fichiers d’autres programmes directe-
ment dans une bibliothèque SoundDiver.

Initialiser  Remettre à zéro (ou sur d’autres valeurs par défaut) 
les paramètres d’une entrée (son, programme).

Initialisation  Le processus par lequel les paramètres d’une 
entrée sont réglés sur des valeurs neutres ou sur zéro. Beaucoup 
d’appareils MIDI offrent une fonction d’initialisation.

Installation  L’opération par laquelle SoundDiver et ses 
fichiers (modules, adaptations) sont copiés sur un disque autre 
que le CD d’origine utilisant le programme d’installation. 
L’installation doit s’effectuer via le programme d’installation, 
ce dernier garantissant que les données sont correctement pla-
cées.

Interface utilisateur  Tous les objets et fonctions visibles dans 
l’affichage du programme, utilisés pour contrôler le programme, 
par ex souris, fenêtre ou opération dans les menus.

Lien (Fonction) La fonction qui actualise automatiquement le 
contenu d’une fenêtre conformément à ce qui a été sélectionné 
dans une autre fenêtre. 

Liste de dépendance  Un affichage dans les fenêtres de →Bi-
bliothèque et →Device montrant les différentes dépendances 
vers les →entrées filles (“utilise...”) et à partir des →entrées 
parents (“est utilisé par...”).

Logic  Le logiciel de séquences et d’édition de partitions 
vedette d’Emagic, pouvant communiquer avec SoundDiver via 
→AutoLink.
450
Emagic
SoundDiver 



AutoLink
Memory Manager  La fonction au sein de SoundDiver qui 
représente le contenu de la mémoire d’un appareil MIDI. Elle 
permet de copier, déplacer, effacer etc. les sons et autres don-
nées.

Message de contrôleur  Le message MIDI généré par un 
→contrôleur.

Menu  Une liste de fonctions ou d’options qui peuvent être 
sélectionnées avec la souris.

Menu local  Une liste de choix qui apparaissent quand la zone 
appropriée est cliquée-maintenue-bouger la souris surligne les 
différents choix, et relâcher le bouton de la souris active le der-
nier choix sélectionné puis fait disparaître la liste.

Menus locaux  Menus appartenants à une fenêtre spécifique 
et non au programme dans sa totalité.

MIDI Thru  a) La fonction SoundDiver qui dirige toutes les 
données MIDI reçues directement vers l’appareil MIDI actif. 
Elle permet également le changement du canal MIDI. b) La 
plupart des appareils MIDI ont un port MIDI Thru permettant 
à d’autres appareils MIDI d’être connectés au système.

Mini-séquenceur →Séquenceur

Mise à jour  Installer une nouvelle version.

Modèle  Les fabricants d’appareils MIDI proposent habituel-
lement différents modèles au sein d’une famille d’appareils, et 
ces derniers sont tous à même d’être adressés par SoundDiver. 
Souvent, un module est compatible avec plusieurs modèles 
(par ex DX7II, TX802).

Module  Contrôle la communication entre SoundDiver et les 
divers appareils, et offre à SoundDiver les fonctions nécessaires 
à cette tâche. Un Module est beaucoup plus complet et puis-
sant qu’une →Adaptation, mais ne peut être édité.

Module de Fader Box  Le module pour un →Pupitre de com-
mande MIDI; il contient des fonctions spécifiques pour les 
→Assignations de Contrôleur.
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Module de Patchbay  Le module pour une →baie de raccor-
dement MIDI; il contient des fonctions spéciales pour l’→Ex-
ploration et pour commuter le routage MIDI.

Module universel  Le →module SoundDiver qui gère les 
adaptations pouvant être éditées, pour toutes sortes d’appareils 
MIDI.

Name Provider (Fournisseur de nom)  Un composant 
d’→AutoLink. Le ~ fournit les noms des entrées à un Instru-
ment dans →Logic.

Outil de défilement x/y La petite case dans le coin inférieur 
gauche d’une fenêtre SoundDiver pouvant être bougée afin de 
déplacer simultanément le contenu d’une fenêtre horizontale-
ment et verticalement.

Overview voir →Vue d’ensemble

Paramètre contrôlé  Un paramètre dans un éditeur SoundDiver 
qui peut être contrôlé en utilisant une →Assignation de Con-
trôleur.

Patchbay voir →Baie de raccordement

Presse-papiers  La partie de la mémoire de l’ordinateur utilisée 
lors des opérations de Couper, Copier et Coller.

Protection contre la copie  Un mal nécessaire qui est là pour 
protéger la propriété intellectuelle des auteurs en évitant le clo-
nage et la duplication d’un programme informatique par des 
voleurs sans scrupules. La protection contre la copie de Sound-
Diver est programmée sur le CD d’origine et peut être transfé-
rée sur un disque dur (→Autorisation).

Pupitre de commande MIDI  Un appareil qui transmet des 
messages MIDI et crée donc une →Assignation de Contrôleur.

Raccourcis-clavier  La combinaison d’une touche d’ordina-
teur normale avec une ou plusieurs →touches-mortes pour 
effectuer une opération particulière. Ils sont utilisés comme 
alternatives aux opérations avec la souris.
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Requête de transfert (dump)  La commande MIDI envoyée 
par l’appareil récepteur, demandant une transmission des don-
nées de système exclusif. Ceci permet à l’appareil d’être “déva-
lisé” de ses données par un appareil externe ou un programme 
tel que SoundDiver.

Saisir  Cliquer-maintenir un objet-par ex avant de le déplacer.

Screenset   Une configuration de fenêtres qui peut être mémo-
risée et instantanément rappelée via un raccourci-clavier.

Scan voir →Exploration

Séquenceur  Un enregistreur MIDI pour enregistrer et rejouer 
des notes et d’autres données MIDI. SoundDiver offre un 
mini-séquenceur, permettant de créer des séquences afin 
d’écouter les sons.

Setup voir →Configuration

Snapshot (Instantané)  Une mémoire-tampon provisoire 
contenant l’entrée en cours de traitement dans l’Editeur. Le ~ 
est copié dans une bibliothèque du même nom. La fonction ~ 
permet le stockage des nombreux stades intermédiaires de 
votre édition en vue d’une récupération ultérieure.

Surf!  Terme anciennement utilisé pour →Audition.

SysEx, données de Système Exclusif  Messages MIDI qui 
décrivent les sons et d’autres données complexes. C’est le lan-
gage utilisé par SoundDiver, mais il n’est pas nécessaire que 
vous le connaissiez!

Système MIDItasking  Une extension du système d’exploita-
tion d’un ordinateur qui gère la communication multitâche 
MIDI entre différents programmes cohabitant dans la RAM de 
l’ordinateur au même instant.

Tampon d’édition  Une mémoire temporaire dans un appa-
reil, utilisée pour des données pouvant être éditées, comme les 
sons ou les multis.
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Touches-mortes  Ce sont les touches de l’ordinateur qui sont 
utilisées en combinaison avec d’autres touches pour composer 
une variété de →raccourcis-clavier (C, ç, S, ‚, O, A).

Type de donnée  Classe ou genre d’une →entrée. En fonction 
du fabricant et de l’appareil, les types de données peuvent 
s’appeler “Multi”, “Combi”, “Performance”, “Programme”, 
“Performance”, “Réglages Globaux” etc.

Universal Device Inquiry  Un →message SysEx standard qui 
sert à reconnaître les appareils connectés à votre système 
MIDI.

Valeur entrante  La valeur transmise à l’intérieur d’un →mes-
sage de contrôleur entrant.

Valeur résultante  La valeur calculée à partir d’une valeur 
→entrante, utilisant divers calculs basés sur les propriétés de 
l’→Assignation de Contrôleur et du →paramètre contrôlé. La 
valeur résultante deviendra la nouvelle valeur du paramètre 
contrôlé.

Vue d’ensemble  Un mode de visualisation dans l’→Éditeur : 
il offre une vue générale des groupements de paramètres d’édi-
tion, facilitant votre navigation au sein de l’Éditeur. De plus, 
cliquer sur un groupe de paramètres agit comme inscrire une 
entrée dans l’→affichage détaillé de ce groupe.
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